# 1. KeyShot 8 Manual

## 1.1 KeyShot 8 Online Manual

### 1.1.1 What Is KeyShot?

### 1.1.2 What's New

- 1.1.2.1 Feature Highlights
- 1.1.2.2 Additional Features
- 1.1.2.3 Product Updates
- 1.1.2.4 KeyShot Library Updates
- 1.1.2.5 User Interface Updates
- 1.1.2.6 Release Notes

#### 1.1.2.6.1 KeyShot 8.0 Release Notes

### 1.1.3 Getting Started

### 1.1.4 Installation

#### 1.1.4.1 Migration Assistant

#### 1.1.4.2 Resource Folder

#### 1.1.4.3 Pro Floating Installation

- 1.1.4.3.1 Pro Floating Quick Start Setup
- 1.1.4.3.2 Luxion License Server Installation
- 1.1.4.3.3 License Server Installation (Linux)
- 1.1.4.3.4 KeyShot Pro Floating Installation
- 1.1.4.3.5 Pro Floating Troubleshooting
- 1.1.4.3.6 Pro Floating Advanced Setup

#### 1.1.4.7 Floating License Definitions

#### 1.1.4.4 Silent Install (PC)

### 1.1.5 User Interface

#### 1.1.5.1 Real-time View

#### 1.1.5.2 Main Menu

#### 1.1.5.3 Toolbar

#### 1.1.5.4 Ribbon

#### 1.1.5.5 Workspaces

#### 1.1.5.6 Library Window

- 1.1.5.6.1 Materials Tab
- 1.1.5.6.2 Colors Tab
- 1.1.5.6.3 Environments Tab
- 1.1.5.6.4 Textures Tab
- 1.1.5.6.5 Backplates Tab
- 1.1.5.6.6 Favorites Tab

#### 1.1.5.7 Project Window

- 1.1.5.7.1 Scene Tab
- 1.1.5.7.2 Material Tab
- 1.1.5.7.3 Environment Tab
- 1.1.5.7.4 Lighting Tab
- 1.1.5.7.5 Camera Tab
- 1.1.5.7.6 Image Tab

#### 1.1.5.8 Animation Timeline

#### 1.1.5.9 Geometry View Window

#### 1.1.5.10 Material Template Window

#### 1.1.5.11 Welcome Window

#### 1.1.5.12 Hotkeys

#### 1.1.5.13 Multi-touch

#### 1.1.5.14 Tessellation Settings Window
1.1.7.8.16 Metallic Paint .................................................. 231
1.1.7.8.17 Multi-Layer Optics ........................................... 234
1.1.7.8.18 Plastic (Cloudy) .............................................. 236
1.1.7.8.19 Plastic (Transparent) ....................................... 237
1.1.7.8.20 Scattering Medium .......................................... 240
1.1.7.8.21 Translucent (Advanced) .................................... 242
1.1.7.8.22 Velvet .......................................................... 244
1.1.7.8.23 Light Sources .................................................. 245
1.1.7.8.24 Cutaway ....................................................... 265
1.1.7.8.25 Emissive ....................................................... 267
1.1.7.8.26 Ground ......................................................... 286
1.1.7.8.27 Toon .......................................................... 269
1.1.7.8.28 Wireframe ..................................................... 272
1.1.7.8.29 Axalta Paint .................................................. 273
1.1.7.8.30 Xray .......................................................... 274
1.1.7.9 Color Library ...................................................... 275
1.1.7.10 Color Picker ...................................................... 278
1.1.7.11 Material Graph .................................................. 281
1.1.7.11.1 Material Graph User Interface ............................ 283
1.1.7.11.2 Material Graph Nodes ..................................... 286
1.1.7.12 Multi-Materials .................................................... 316
1.1.7.13 Material Templates ............................................. 319
1.1.8 Textures ............................................................... 322
1.1.8.1 Texture Library ................................................... 323
1.1.8.2 Texture Types ..................................................... 326
1.1.8.2.1 Texture Map ................................................... 327
1.1.8.2.2 Tiled UV ....................................................... 328
1.1.8.2.3 Tri-Planar ..................................................... 331
1.1.8.2.4 Video Map .................................................... 336
1.1.8.2.5 Brushed ....................................................... 339
1.1.8.2.6 Mesh .......................................................... 340
1.1.8.2.7 Weave ........................................................ 342
1.1.8.2.8 Brushed (Radial) ............................................. 343
1.1.8.2.9 Camouflage ................................................... 344
1.1.8.2.10 Cellular ....................................................... 345
1.1.8.2.11 Color Gradient .............................................. 346
1.1.8.2.12 Curvature .................................................... 347
1.1.8.2.13 Granite ....................................................... 348
1.1.8.2.14 Leather ....................................................... 349
1.1.8.2.15 Marble ....................................................... 350
1.1.8.2.16 Noise (Fractal) ............................................. 351
1.1.8.2.17 Noise (Texture) ............................................. 352
1.1.8.2.18 Occlusion .................................................... 353
1.1.8.2.19 Scratches ..................................................... 354
1.1.8.2.20 Spots ........................................................ 355
1.1.8.2.21 Vertex Color ................................................ 356
1.1.8.2.22 Volume Map ................................................ 357
1.1.8.2.23 Wood ........................................................ 358
1.1.8.2.24 Wood (Advanced) ........................................ 359
1.1.8.3 Map Types ......................................................... 361
1.1.8.4 Mapping Types ................................................... 365
1.1.8.5 Move Texture ..................................................... 367
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1.17.5 Animation Effects</td>
<td>503</td>
</tr>
<tr>
<td>1.1.17.5.1 Motion Blur</td>
<td>504</td>
</tr>
<tr>
<td>1.1.17.5.2 Motion Ease</td>
<td>505</td>
</tr>
<tr>
<td>1.1.18 KeyShotXR</td>
<td>507</td>
</tr>
<tr>
<td>1.1.18.1 KeyShotXR Wizard</td>
<td>509</td>
</tr>
<tr>
<td>1.1.18.2 KeyShotXR Animation</td>
<td>515</td>
</tr>
<tr>
<td>1.1.18.3 KeyShotXR Variables</td>
<td>516</td>
</tr>
<tr>
<td>1.1.18.4 Embedding KeyShotXR</td>
<td>526</td>
</tr>
<tr>
<td>1.1.18.4.1 Embedding a KeyShotXR in iBooks</td>
<td>527</td>
</tr>
<tr>
<td>1.1.18.4.2 Embedding a KeyShotXR in PowerPoint</td>
<td>530</td>
</tr>
<tr>
<td>1.1.18.4.3 Embedding a KeyShotXR in Wordpress</td>
<td>532</td>
</tr>
<tr>
<td>1.1.19 Configurator</td>
<td>534</td>
</tr>
<tr>
<td>1.1.20 KeyShot Viewer</td>
<td>548</td>
</tr>
<tr>
<td>1.1.21 Virtual Reality</td>
<td>554</td>
</tr>
<tr>
<td>1.1.21.1 VR Overview</td>
<td>556</td>
</tr>
<tr>
<td>1.1.21.2 Render VR Images</td>
<td>559</td>
</tr>
<tr>
<td>1.1.21.3 Work In Real-Time VR</td>
<td>560</td>
</tr>
<tr>
<td>1.1.22 KeyShot Cloud</td>
<td>562</td>
</tr>
<tr>
<td>1.1.22.1 KeyShot Cloud User Interface</td>
<td>564</td>
</tr>
<tr>
<td>1.1.22.2 KeyShot Cloud Account</td>
<td>567</td>
</tr>
<tr>
<td>1.1.22.3 KeyShot Cloud Search</td>
<td>568</td>
</tr>
<tr>
<td>1.1.22.4 Uploading/Downloading Resources</td>
<td>571</td>
</tr>
<tr>
<td>1.1.22.5 KeyShot Cloud Release Notes</td>
<td>573</td>
</tr>
<tr>
<td>1.1.23 Preferences</td>
<td>574</td>
</tr>
<tr>
<td>1.1.23.1 Interface Preferences</td>
<td>576</td>
</tr>
<tr>
<td>1.1.24 General Preferences</td>
<td>579</td>
</tr>
<tr>
<td>1.1.24.1 Interface Preferences</td>
<td>576</td>
</tr>
<tr>
<td>1.1.24.3 Folders Preferences</td>
<td>582</td>
</tr>
<tr>
<td>1.1.24.4 Plugins Preferences</td>
<td>583</td>
</tr>
<tr>
<td>1.1.24.5 Color Management</td>
<td>585</td>
</tr>
<tr>
<td>1.1.24.6 Hotkeys Preferences</td>
<td>586</td>
</tr>
<tr>
<td>1.1.25 End-User License Agreement</td>
<td>588</td>
</tr>
</tbody>
</table>
What Is KeyShot?

KeyShot is a stand-alone, real-time ray tracing and global illumination program used to create 3D renderings, animations and interactive visuals. With its CPU-based architecture, photorealistic real-time rendering can be achieved on both Mac and PC, even on laptops, without the need for high-end graphics cards.

KeyShot supports more 3D file formats than any other rendering software, importing over 25 different file types. It has a simple user interface with drag-n-drop material and environment presets, interactive labeling, texture mapping, physical lighting, animation and much more.

KeyShot is...

Fast
Everything inside KeyShot happens in real-time. KeyShot uses unique rendering technology which makes it possible to see all changes to materials, lighting, and cameras instantly.

Easy
You don’t have to be a rendering expert to create photorealistic images of your 3D models. Simply import your data, assign materials by dragging and dropping them onto the model, adjust the lighting, and move the camera. Done.

Accurate
KeyShot is the most accurate rendering solution for your 3D data. KeyShot is built on Luxion’s internally developed, physically correct render engine based on research in the areas of scientifically accurate material representation and global illumination.
What's New

KeyShot 8 is focused on delivering a tighter workflow inside KeyShot with an emphasis on flow and less on work. KeyShot 8 requires less switching between other apps, giving you more time to create. KeyShot 8 provides the advanced features and flexibility to boost your workflow, enhance your visuals, elevate your experience, and extend your reach.

Explore Feature Highlights

Boost Your Workflow
Bring your custom assets into KeyShot 8 faster with the Migration Assistant. Control all aspects of your Studio setup. Find and apply KeyShot Cloud resources from within KeyShot. Move faster through your workflow with tighter menus, more visible resources, and improved scene tree filtering.

Elevate Your Visuals
KeyShot 8 presents new ways to display and manipulate light, materials, and texture. Control lighting better with spotlights and IES light axis selection. Use cutaways to view assemblies in new ways. Add scattering volumes to scenes as quickly as any material. Then animate it all for unmatched realism and style.

Enhance Your Experience
KeyShot 8 introduces powerful capabilities for advanced texture and image creation. New features in the KeyShot Material Graph bring control over the very geometry itself to generate displacement or create flakes and bubbles. Create any number of Image Styles to adjust tone-mapping and control curve, color and image effects right inside KeyShot.

Extend Your Reach
The KeyShot Configurator and KeyShot Viewer offer more ways to visualize and share design variations. KeyShot 8 builds on this with new ways to generate studios and display material combinations in a touch-friendly environment. New Configurator and Presentation Mode updates, plus support for glTF/GLB output give you more ways to share and extend your reach.
The new geometry displacement in KeyShot 8 - Rendered by John Seymour
Feature Highlights
KeyShot 8 brings usability improvements for increased workflow efficiency, new material types for more ways to visualize your products, powerful new tools that help you spend less time in other applications and more ways to share your scenes.

Feature Categories

- Material and Volume
- Lighting and Optics
- Advanced Geometry
- Image and Output
- Collaboration

Top Features

- Image Styles
- Cutaway
- Scattering Medium
- Geometry Shaders (PRO)
- KeyShot Viewer

Migration Assistant

To improve the upgrade process from KeyShot 7 to KeyShot 8 a new Migration Assistant is activated when a previous installation of KeyShot is found on the computer. The Migration Assistant will help you transfer your settings and resources to KeyShot 8. Learn more about the Migration Assistant in KeyShot Installation.

How it Works

If you have KeyShot 7 installed, after installation of KeyShot 8, the Migration Assistant window will appear with options to migrate Settings, Resources or both. Select the preferred option and select OK, or select Cancel to bypass the migration of any settings or custom resources.

Integrated KeyShot Cloud

KeyShot Cloud now launches directly in the KeyShot user interface as a dockable window. Additionally, only resources compatible with the version of KeyShot being used are shown. With the latest release of KeyShot Cloud, there are updates that improve login, search, and download across all KeyShot versions. Learn more about all the new updates in the KeyShot Cloud release notes.

How it Works

Select the KeyShot Cloud icon from the Toolbar or select Window, Cloud Library... from the main menu. A new dockable window will appear. The KeyShot Cloud window may be docked to the left or right side of the KeyShot Real-time View.

Material and Volume
Cutaway

The Cutaway feature in KeyShot 8 allows you to use geometry to cutaway other geometry by assigning the Cutaway material. The Cutaway material allows you to add and define the Cutaway Caps as a shaded color, the same material as the object being cut or a custom material. Learn more about Cutaway here.

How it Works
Select the Cutaway as the option from the Material Type drop-down. Select the material and the object that should be used to cut.

In the Material Graph, a material node may be connected to the Caps Material input (try a Toon material for example). Show Caps needs to be checked for the material to be shown.

Show Caps is intended to be used together with fully closed surfaces (solids). Caps may show artifacts with non-closed geometry.

Caps may also show artifacts if two or more objects being cut have co-planar (touching) surfaces.

Scattering Medium & VDB Support

Scattering Medium is a new Material Type in KeyShot 8 that allows you to simulate particle scattering such as smoke and fog.
This can be useful for visualizing beams of light. Learn more about Scattering Medium [here](#).

**How it Works**
Select Scattering Medium as the material type for an object. Textures can be assigned to the Density Texture in the Textures tab. OpenVDB files can be loaded by selecting Volume Map from the Texture drop-down or via the Material Graph and applying the Volume Map to Density Texture on the Scattering Medium material node.

**Liquid Interfaces**
The approach to rendering liquids has been completely updated to support nested dielectrics and make rendering liquids much faster and easier. Previously, separate surfaces for the different liquid-glass and liquid-air interfaces were needed for accurate appearance. Now, separate surfaces for liquid-glass and liquid-air interfaces are no longer required. Learn more about the liquid material [here](#).

**How it Works**
To take advantage of the new support for nested dielectrics import your model with a single object for the liquid and a single object for the glass. The liquid should slightly overlap the glass for the best results.

**Lighting and Optics**
Spotlight

Spotlight is a flexible new light source Material Type that allows you to control the *Beam Angle* and assign a *Color Stencil Texture* to simulate a gobo.

**How it Works**
To use Spotlight, edit a material and change the type to Spotlight. The direction of the beam is in the -Y and can be adjusted using the Move Tool.

IES Light Axis Selection

You can now define the IES light direction based on the local axis of the object. This provides a solution that can eliminate the need to rotate light objects in a scene to achieve the desired projection direction.

**How it Works**
When editing the material properties of an IES light you will now see radio button selections for the different axis.

Multi-Layer Optics

This is a new Material Type for simulating high-end optics elements. It supports an arbitrary number of thin-films on top of a dispersive dielectric or metal.

**How it Works**
To build a Multi-Layer Optics material from scratch select *Multi-Layer Optics* from the material drop-down menu. If the original material is a dielectric based material (i.e. glass, gem, liquid) this will be set as the substrate. If it is not a dielectric based material click the add layer icon to add a Crown Glass substrate. Click the add layer button again to add thin-film layers. With a layer selected click the add button next to the Layer Material drop-down menu to change the material of the layer and populate the drop-down menu to be able to reuse it again for other layers. The folder button will allow you to import .ior files to use materials other than dielectric as thin-film layers.

Advanced Geometry

KeyShot 8 introduces an entirely new approach to working with geometry in KeyShot. Through the Material Graph, the advance material editor in KeyShot, you now have three new types of geometry nodes (shaders) to modify the geometry of an object with displacement, bubbles or flakes.
Displace (PRO)

Displace is a geometry shader that allows you to modify the polygons of an object through the use of displacement maps (textures). Displacement maps define the topology of a material similar to a bump map but instead of simulating the height of a surface it actually modifies it.

How it Works

In the Material Graph, there is a new section of nodes called Geometry. Add a Displace node and connect this to the Geometry input of the base material node. Assign any texture (procedural or image-based) to the node, adjust height, resolution, offset, or triangle count. A geometry node is not executed until you click the Execute Geometry Nodes button on the far right of the Material Graph toolbar or in the material properties window. It may take some time to execute the geometry shaders depending on the complexity. You must press the Execute Geometry Nodes button again for adjustments made to the Displace parameters to update.

Flakes (PRO)

Flakes is a geometry shader that modifies the polygons of an object. Flakes allow you to turn any object into a three-dimensional volume of square or spherical flakes.

How it Works

To use Flakes, add the node, select square or spherical flakes and execute. Make adjustments if desired and execute again.
The Flake node will randomly add flakes inside the volume of the geometry it is applied to. The geometry is assumed to be closed. The material of the flakes is defined by the material of the object. You will need to duplicate geometry if you want the flakes to be enclosed in an object. A texture can be used to define the density of the flakes.

**Bubbles (PRO)**

Bubbles is a geometry shader that modifies the polygons of an object. Bubbles will add spherical cavities within an object.

**How it Works**

To use Bubbles, add the node and execute. Make adjustments if desired and execute again. The bubbles node will randomly add spherical cavities inside the volume of the material of the base geometry. The geometry is assumed to be closed. A texture can be used to define the density of the bubbles.

**Image and Output**

![Image of sunglasses](image)

**Image Styles**

Image Styles is a new feature that provides the ability to provide photographic adjustments to the KeyShot scene prior to or after rendering. Multiple Image Styles may be created and added to a list for a range of different styles that can be used in KeyShot Studios. The Photographic option includes adjustments for Tone-Mapping, Curve control, Color adjustments, Background color
override, and the ability to apply a Frontplate. See Image Styles for more information.

How it Works
From Project > Image tab, you can find an Image Styles list similar to Cameras and Environments. You can copy an Image Style by clicking on the first button and add a new 'Basic' style. The basic style is similar to the one used in KeyShot 7 and earlier.

The Photographic style allows for additional non-destructive manipulations of the real-time image while also applying a tone-mapping procedure which more accurately emulates how light is transferred to film-cameras and is able to provide a more photographic look. Bright colors will be desaturated and colors do not burn out the same way.

The Photographic style also allows inserting a full-frame Frontplate and overriding the background color with a solid color. This is particularly useful when in need of a pure white background when using the Photographic style.

All changes are non-destructive, i.e. settings can be changed without the render resetting to a noisy image.

Hex Color Codes
When changing colors using the RGB color space, the ability to set colors using RGB Hex codes is now possible. The hex code is a six-digit hexadecimal alpha-numeric code used in HTML, CSS, SVG, and other computing applications to quickly represent colors. Along with this, whenever a Color is applied from the KeyShot Color Library, the corresponding Hex code will appear in the Color Picker. Learn more about the Hex Color Code on the Color Picker page.

How it Works
The Hex color code can be found in the Color Picker for the RGB color space below the Red, Green, Blue sliders. To apply or change color using the Hex color code, click any Color property to activate the Color Picker. Ensure RGB is selected from the color space drop-down menu.

glTF/GLB Export (PRO)
This new export option provides a way to share your KeyShot scenes to other platforms. Export as GLB can then be posted to your Facebook feed or added to a PowerPoint presentation on Windows.

How it Works
The File > Export menu now has an option for GLB/GLTF. The format is selected in the native OS save dialog. Textures must be UV mapped to appear correct in the exported file. Basic materials and colors are maintained.

New Scripting Functions (PRO)
New Scripting Functions include:

- `lux.importFile()` returns a dictionary of added/updated nodes.
- `lux.renderXR()` takes `opts` argument as an instance of `lux.RenderOptions`.
- `lux.getLibraryMaterials()`, `lux.getLibraryEnvironments()`, `lux.getLibraryBackplates()`, `lux.getLibraryTextures()` have the new `filter` argument.
- `lux.getActiveEnvironment()` returns an instance of `lux.Env` that has several functions to manipulate the environment.
- `lux.getRenderLayers()` returns the list of all known render layers in the scene.
- `lux.exportFile()` makes it possible to export scenes to file.
- lux.SceneNode.setName()
- lux.SceneNode.centerAndFit()
- lux.SceneNode.snapToGround()

**How it Works**

- Get/set multiple model sets at the same time
- Support for renaming nodes via scripting
- Filtering of materials, environments, backplates, textures via scripting
- Unset node’s render layer for unspecified or empty name argument
- Create/change render layer for node
- Get render layer of scene node
- Get globally defined render layers
- Scripting checks that max time and send-to-network options cannot be set simultaneously
- Get/manipulate environment: brightness, size, height, rotation, backplate, lighting environment, background color, ground shadows, occlusion ground shadows, ground reflections, flattening of ground, ground size
- Get node transform via scripting
- Fixed dark style and scripting console object name
- Yield exception if trying center-and-fit with locked active camera via scripting

**Collaboration**
KeyShot Viewer

KeyShot Viewer is a new, feature-rich application to compliment your design review, presentations, and collaboration. With it, you can open, view and interact with a KeyShot scene in real-time using mouse, touch, pen or stylus to explore the scene or change materials and lighting. Learn more in the manual here.

How it Works
After downloading and installing, KeyShot Viewer can be used to open any KeyShot Package file (.ksp) to interact with the scene. When you move the camera view or make changes the scene will update instantly. Users of KeyShot Pro can use the Configurator to include Studio, Model, and Material variations, which will be available when KeyShot Viewer is in full-screen presentation mode.

Studio Improvements (PRO)

Studios now come with custom thumbnails and provide the ability to re-order the Studios list by drag-and-drop. Studios also have the ability to include Image Styles. See Studios for more information.

How it Works
Select Window, Studios... from the main menu or hit the U-key to show the Studios panel. Thumbnails will now be automatically generated when a Studio is created based on what is visible in the real-time view at that time. You can re-render a thumbnail and adjust thumbnail settings in the gear icon menu. To adjust the order of Studios in the list simply drag-and-drop.

Configurator Improvements (PRO)

Updates include:

- Material Ways (To “sync” sub-materials across Multi-materials for concurrent changes).
- Layout page UI update.
- Presentation Mode UI update.
- Interactive Preview mode for adjusting UI.
- Studio creation included in Configurator Wizard.

How it Works
The Configurator Wizard can be accessed from the Ribbon. Learn more about KeyShot Configurator here.
**Additional Features**

The additional features and updates are also included in KeyShot 8:

**Rhino 6 Support** - Direct import for Rhino 6 on Mac and Windows is now supported.

**Inventor 2019 Support** - Direct import of Autodesk Inventor 2019 on Windows is now supported.

**Scene Tree Filtering** - Filter Scene Tree by Hidden Items.

**New Screenshot Preferences** - Option to Include Alpha (Transparency) with PNG screenshot output. Save metadata option for XMP or Simple (.meta) output (PRO)

**Bloom Threshold** - Allows you to clamp bloom by pixel brightness.

**Material Graph Root Node** - The Material Graph now shows a root node where the Surface material (base material), Label Materials and Geometry Nodes will be connected to. Scenes from KeyShot 7 and earlier will automatically reflect this restructuring when opened in KeyShot 8.
Product Updates
With KeyShot 8, we have the following product updates:

KeyShot Cloud Re-integration
With KeyShot 8, KeyShot Cloud has been re-integrated back into the KeyShot user interface as a dockable window. In addition, login is no longer required to browse and download KeyShot resources. See KeyShot Cloud Release Notes for more information on new features and improvements.
KeyShot Library Updates

Below is a summary of changes made to the KeyShot 8 Library. All new additions to the Library can be found in the KeyShot 8 Favorites folder.

New Materials

- Cutaway
  - Cutaway Basic Red Caps.mtl
  - Cutaway Cross-Hatching Lines Caps.mtl
  - Cutaway Hatching Double Lines Caps.mtl
  - Cutaway Hatching Lines Caps.mtl
  - Cutaway Inherit Caps.mtl
  - Cutaway No Caps.mtl
  - Cutaway Paint Gloss Red Caps.mtl

- Light
  - Advanced
    - Flakes
      - Area Light Fireflies Blue Flakes Sphere.mtl
      - Area Light Fireflies Green Flakes Sphere.mtl
      - Area Light Fireflies Red Flakes Sphere.mtl
      - Emissive Fireflies Blue Flakes Sphere.mtl
      - Emissive Fireflies Green Flakes Sphere.mtl
      - Emissive Fireflies Red Flakes Sphere.mtl
  - Spotlight
    - Basic
      - Spotlight 120 degrees 1200 Lumen Neutral.mtl
      - Spotlight 120 degrees 6000 Lumen Neutral.mtl
      - Spotlight 15 degrees 1200 Lumen Neutral.mtl
      - Spotlight 15 degrees 6000 Lumen Neutral.mtl
      - Spotlight 30 degrees 1200 Lumen Neutral.mtl
      - Spotlight 30 degrees 6000 Lumen Neutral.mtl
      - Spotlight 45 degrees 1200 Lumen Neutral.mtl
      - Spotlight 45 degrees 6000 Lumen Neutral.mtl
      - Spotlight 60 degrees 1200 Lumen Neutral.mtl
      - Spotlight 60 degrees 6000 Lumen Neutral.mtl
      - Spotlight 90 degrees 1200 Lumen Neutral.mtl
      - Spotlight 90 degrees 6000 Lumen Neutral.mtl
    - Textured
      - Spotlight 60 degrees 1200 Lumen Cellular.mtl
      - Spotlight 60 degrees 1200 Lumen Color Gradient.mtl
      - Spotlight 60 degrees 1200 Lumen Fractal Noise.mtl
      - Spotlight 60 degrees 1200 Lumen KeyShot Icon Color.mtl
      - Spotlight 60 degrees 1200 Lumen KeyShot Icon White.mtl
      - Spotlight 60 degrees 1200 Lumen Mesh Hexagon.mtl
      - Spotlight 60 degrees 1200 Lumen Mesh Lines.mtl
      - Spotlight 60 degrees 1200 Lumen Mesh Square.mtl
      - Spotlight 60 degrees 1200 Lumen Rings.mtl

- Liquids
  - Basic
Cloudy Blue Lagoon Cocktail.mtl
Cloudy Energy Drink Lime.mtl
Cloudy Mango Juice.mtl
Cloudy Orange Soda.mtl
Cloudy Tomato Juice.mtl
Liquid Cola.mtl
Liquid KeyShot Render Juice.mtl

• **Bubbles**
  Cloudy Energy Drink Lime Bubbles.mtl
  Cloudy Mango Juice Bubbles.mtl
  Cloudy Orange Soda Bubbles.mtl
  Cloudy Tomato Juice Bubbles.mtl
  Liquid Beer Bubbles.mtl
  Liquid Cola Bubbles.mtl
  Liquid Water Bubbles.mtl

• **Displace**
  Liquid Sea Water Ripples Displace.mtl
  Liquid Water Ripples Displace.mtl

• **Metal**
  • **Aluminum**
    • **Displace**
      aluminum Rough Diamond Plate 01 Displace.mtl
      aluminum Rough Diamond Plate 02 Displace.mtl
  • **Anodized**
    • **Brushed**
      anodized Aluminum Brushed 90° Black.mtl
      anodized Aluminum Brushed Black.mtl
    • **Polished**
      anodized Aluminum Polished Black.mtl
    • **Rough**
      anodized Aluminum Rough Black.mtl
  • **Precious**
    • **Gold**
      • **Flakes**
        gold 24k Polished Flakes Sphere.mtl
        gold 24k Polished Flakes Square.mtl
  • **Stainless Steel**
    stainless Steel Polished.mtl
    stainless Steel Rough.mtl
  • **Steel**
    • **Displace**
      steel rough 10mm Circular Mesh Displace.mtl
      steel rough 10mm Hexagonal Mesh Displace.mtl
      steel Rough Diamond Plate 01 Displace.mtl
      steel Rough Diamond Plate 02 Displace.mtl

• **Miscellaneous**
  • **Flakes**
    plastic Cloudy Shiny Red Flakes Sphere.mtl
    Soap Bubble Flakes Sphere.mtl
  • **Multi-Layer Optics**
    Anti-Reflex 500 nm.mtl
Dielectric mirror.mtl

- Plastic
  - Packaging
    - Plastic PET Shiny Blue 3mm.mtl
    - Plastic PET Shiny Green 3mm.mtl
    - Plastic PET Shiny White 3mm.mtl
  - Displace
    - Plastic Expanded Polystyrene Displace.mtl
    - Translucent Expanded Polystyrene Displace.mtl
  - Rubber
    - Silicone Rubber White.mtl
    - Bubbles
      - Silicone Rubber White Bubbles.mtl
  - Scattering Medium
    - Foam
      - Scattering Medium Open-Cell Foam Large Thick Grey.mtl
      - Scattering Medium Open-Cell Foam Large Thin Grey.mtl
      - Scattering Medium Open-Cell Foam Small Thick Grey.mtl
      - Scattering Medium Open-Cell Foam Small Thin Grey.mtl
      - Scattering Medium Sponge.mtl
    - Fog
      - Scattering Medium Fog Basic.mtl
      - Scattering Medium Fog Textured.mtl
    - OpenVDB
      - Scattering Medium VDB Cloud Blue 100mm.mtl
      - Scattering Medium VDB Cloud Pink 100mm.mtl
      - Scattering Medium VDB Cloud White 100mm.mtl

New Backplates

- Frontplates
  - KeyShot-Logo-Frontplate-Black-4k.png
  - KeyShot-Logo-Frontplate-White-4k.png
  - KeyShot-Logo-Watermark-Frontplate-Black-4k.png
  - KeyShot-Logo-Watermark-Frontplate-White-4k.png
- Backplates
  - Concrete Wall 1 - Rawpixel 16x9.jpg
  - Concrete Wall 1 - Rawpixel 1x1.jpg
  - Concrete Wall 2 - Rawpixel 16x9.jpg
  - Concrete Wall 2 - Rawpixel 1x1.jpg
  - Corridor 3 - Phil Desforges 16x9.jpg
  - Corridor 3 - Phil Desforges 1x1.jpg
  - Kitchen Counter - Charles Deluvio - 16x9.jpg
  - Kitchen Counter - Charles Deluvio - 1x1.jpg
  - Wood Table - Andrej Lisakov 16x9.jpg
  - Wood Table - Andrej Lisakov 1x1.jpg
User Interface Updates
The KeyShot 8 user interface has been vastly improved to be more consistent and responsive.

Updates and improvements include the following:

- Icons have been added to context (right-click) menus
- Icons have been added to Texture/Label properties flip, repeat, two-sided and sync
- New icon for Render Region
- Render Region numeric size can be set directly from the Real-time View
- Library thumbnail names remain visible at smaller sizes
- Multi-material thumbnails are displayed with a label in Material Library and In-project Library
- Model Set thumbnails adapt to panel size
- Thumbnails have been added to Studios panel
- Image Styles have been added to Studios panel
- Undo/Redo list have been added to Main Menu, Edit, Undo/Redo
- Preferences dialog layout has been rearranged - Advanced tab settings added to Interface and General as applicable
- Clear Cache option added to Preferences, General, KeyShot Cloud
- Include Alpha (Transparency) option has been added to Preferences, General, Screenshot
- Metadata-output format selection has been added to Preferences, General, Screenshot.
- Hex color input is now available in Color Picker for RGB color space
- In Render Output Window, Image Styles Panel replaces Effects Panel
Release Notes
The following pages contain updates on the major releases for KeyShot 8. For an overview of major features, please see the Feature Highlights.

Noteworthy KeyShot 8.0 Bug Fixes

- Fixed issue with locked orthographic cameras showing a stretched image.
- Fixed issue with emissive/area light visibility settings being respected by render output with alpha.
- Fixed issues with emissive/area light visibility settings being respected by render passes.
- Fixed issue with ground shadow visibility after saving with them disabled.
- Fixed issue that caused artifacts with a Threadripper CPU.
- Fixed issue with hot pixels caused by anisotropic materials in Product Mode.
- Fixed crash when updating geometry with deleted parts.
- Fixed negative pin brightness.
- Fixed issue with empty groups in .wire imports.
- Fixed discrepancy of Translucent Advanced between Interior Mode and Product Mode.
- Fixed issue with unlocking parts when the parent group is locked.
- Fixed issues with resolution/aspect ratio not being respected properly.
- Fixed fade animation in Interior Mode.
- Fixed shared folders in color library.
- Fixed visibility toggle for certain files.

Noteworthy KeyShot Network Rendering 8.0 Bug Fixes

- Fixed pausing slave via slave tray on Windows.
- Fixed "use all cores on sign out".
KeyShot 8.0 Release Notes

The following is a summary of new features and known issues for KeyShot 8.0.

Version: 8.0
Release Date: 10/02/2018

New Features
See KeyShot 8 What's New - Feature Highlights

Known Issues
See Limitation & Known Issues
Limitations & Known Issues

On this page you will find known issues and limitations that the development team is aware of, along with workarounds where applicable.

### Rendering

<table>
<thead>
<tr>
<th>Feature</th>
<th>Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interior mode</strong></td>
<td>Banding can occur on still-images in Interior Mode, when rendered with Network Rendering.</td>
</tr>
<tr>
<td></td>
<td>- Details and possible solution</td>
</tr>
<tr>
<td></td>
<td>Region mismatches (brighter/darker) can happen when using Interior Mode for Network Rendering, especially for lower resolutions.</td>
</tr>
<tr>
<td></td>
<td><strong>Possible solution:</strong> Try to increase the resolution of the image.</td>
</tr>
<tr>
<td></td>
<td>The Global Illumination sampling for Interior Mode has been improved for KeyShot 8 and may cause scenes to be brighter than KeyShot 7.</td>
</tr>
<tr>
<td></td>
<td>Interior Mode does not support material samples.</td>
</tr>
<tr>
<td><strong>Caustics</strong></td>
<td>Caustics have a different appearance in the Real-Time View and rendered output.</td>
</tr>
<tr>
<td></td>
<td>- Details and possible solution</td>
</tr>
<tr>
<td></td>
<td>The Real-Time View uses a slightly different approach from the Output window when rendering, this is especially apparent when dealing with caustics with Interior Mode.</td>
</tr>
<tr>
<td></td>
<td><strong>Possible solution:</strong> Try to increase the amount of samples.</td>
</tr>
<tr>
<td></td>
<td>Caustics work inherently with volumes (e.g. scattering media), however, caustics will only be applied to light sources outside the volume and this is only supported in interior mode.</td>
</tr>
<tr>
<td><strong>Render Passes</strong></td>
<td>Passes with Interior Mode are missing Specular Reflections of Light Source materials.</td>
</tr>
<tr>
<td></td>
<td>Depth Pass has artifacts when rendering is stopped before finishing with Interior Mode.</td>
</tr>
<tr>
<td></td>
<td>Opacity textures produce noise in Clown render pass in Product Mode.</td>
</tr>
<tr>
<td></td>
<td>Opacity textures produce noise in Diffuse pass in Product Mode.</td>
</tr>
<tr>
<td></td>
<td>Opacity textures are not supported by Shadow render pass in Product Mode.</td>
</tr>
<tr>
<td></td>
<td>Opacity textures are not supported by Lighting render pass in Product Mode.</td>
</tr>
<tr>
<td></td>
<td>Opacity textures are not supported by Depth render pass in Product Mode.</td>
</tr>
<tr>
<td></td>
<td>Opacity textures are not supported by Refraction render pass in Interior Mode.</td>
</tr>
</tbody>
</table>

### On this page

- Rendering
  - Interior mode
  - Render Passes
  - Settings
- Materials and Textures
  - Cutaway
  - Scattering Medium
  - Geometry nodes
  - Displacement
  - Area Light
  - Multi-Layer Optics
- Importers
  - Creo
- Plugins
  - NX
  - Rhino
Bump textures are not supported by Render passes in Product Mode

Global Illumination quality slider for Custom Control has no effect when Global Illumination Cache is disabled.

<table>
<thead>
<tr>
<th>Materials and Textures</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Material</strong></td>
</tr>
<tr>
<td>Cutaway</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>
Co-planar surfaces may produce artifacts with inherit/material caps

Details
If you have two co-planar parts where one is excluded from the cutaway and you use inherit caps or material caps. Artefacts can occur on the surface of the excluded material.

Cutaway material may interfere with shadows on the environment ground

Details and workaround
If the cutaway object touches the environment ground it will cut that just as it cuts into regular parts.

Workaround: Add a ground plane (Edit > Add Geometry > Add Ground Plane) and exclude it from the cutaway.

When the Camera is inside the cutaway object, Color caps and Material caps are not working as intended

Details
If the camera is positioned inside the cutaway object, Color caps do not show.
When using material caps all objects in the scene will be displayed with the cap material.

Cutaway with inherit caps used on transparent materials may produce artefacts.

Affected materials
Following materials are affected:
- Glass (solid)
- Translucent
- Dielectric
- Gem
- Multi-Layer optics
- Plastic (Cloudy)
- Plastic (Transparent)

Excluded objects in cutaway have incorrect reflections

Details
Objects excluded by cutaway show reflections of the inside of the object being cut.

Bad shadows on excluded cutaway objects

Details
The shadows on excluded objects appear as if the cut objects are still visible.

Basic Glass and Thin Film appear as metal when applied to an excluded cutaway object - Product mode only!

Details
Basic Glass and Thin Film appear as metal (no transparency) when applied to an excluded cutaway object and cause the scene to become very slow. This only occurs in Product Mode.
Wrong shading on **Toon** material when used for cutaway with inherit caps or as material caps.  

### Details and workaround
The cut will appear to have color caps instead of the desired Toon appearance.

**Possible workaround:** Try to disable Material Contour in the Advanced settings of the Toon material.

<table>
<thead>
<tr>
<th>Scattering Medium</th>
<th>Scattering Medium shows unusable Transmission Texture button in Texture tab.</th>
</tr>
</thead>
</table>

| Geometry nodes | Attaching a Curve Color Randomizer to a Geometry node causes crash. | Some geometry may not show Flakes/Bubbles.  

#### Details
Some CAD formats i.e. .3dm, .c4d may be imported as several triangle groups and then merged making the body unfit for Flakes/Bubbles.

**Workaround:** Import with NURBS and Re-Tessellate. |
|----------------|------------------------------------------------------------------|

Geometry nodes don’t respect disabled state.

| Displacement | When applying Displacement to geometry with hard edges, these edges become split.  

#### Details
Hard model edges become split. Left cube is with hard edges, on the right the cube has a small fillet on the edges.  

**Workaround:** Applying blends in CAD usually solves the issue. |
|----------------|------------------------------------------------------------------|

| Area Light | ZSpheres transferred from ZBrush are not supported for Area Light |

| Multi-Layer Optics | Multi-Layer Optics do not support nested dielectrics/liquid interfaces. |

**Importers**
### Creo

<table>
<thead>
<tr>
<th>Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Different units in the same model may cause issues with animation when importing into KeyShot.</td>
</tr>
<tr>
<td>Details</td>
</tr>
<tr>
<td>If the imported Creo assembly overall is in inches but one or more parts are in millimeters, animation on those parts might not act as expected in regards of size and position.</td>
</tr>
</tbody>
</table>

### Plugins

<table>
<thead>
<tr>
<th>from</th>
<th>Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>NX</td>
<td>NX plugin always opens KeyShot 7 if installed.</td>
</tr>
<tr>
<td></td>
<td>Details</td>
</tr>
<tr>
<td></td>
<td><em>Workaround:</em> Uninstall KeyShot 7, Export using NX plugin, or save scene from KeyShot 7 and open in KeyShot 8.</td>
</tr>
<tr>
<td></td>
<td>NX plugin always opens new KeyShot session when clicking Update.</td>
</tr>
<tr>
<td></td>
<td>Details</td>
</tr>
<tr>
<td></td>
<td><em>Workaround:</em> Export .bip from plugin and use Import &gt; Update Geometry.</td>
</tr>
<tr>
<td></td>
<td>NX plugin does not show progress dialog when sending to KeyShot 8.</td>
</tr>
<tr>
<td>Rhino</td>
<td>Rhino plugin always opens new KeyShot session when clicking Update.</td>
</tr>
<tr>
<td></td>
<td>Details</td>
</tr>
<tr>
<td></td>
<td><em>Workaround:</em> Export .bip from plugin and use Import &gt; Update Geometry.</td>
</tr>
</tbody>
</table>
Getting Started

How Easy is KeyShot?

KeyShot’s drag and drop based workflow will have you rendering images in minutes. With a simple interface providing many advanced features and instant real-time feedback, you save time while focusing on your design.

Step 1: Import Your 3D Model

Launch KeyShot. Import your 3D model via File, Import... KeyShot supports over 20 3D file formats, including SketchUp, SolidWorks, Solid Edge, Pro/ENGINEER, PTC Creo, Rhinoceros, Maya, 3ds Max, IGES, STEP, OBJ, 3ds, Collada, and FBX. KeyShot also features many plugins with more features, including KeyShot BIP export and LiveLinking. Learn More

Step 2: Assign Your Materials

From the Library Window, select the Materials tab. Apply any of the 600+ scientifically accurate materials from the material library by simply dragging and dropping them onto your model in the Real-time View. Changes appear on your model instantly with accurate color and lighting under the current lighting conditions. Learn More
Step 3: Choose Your Environment

Now select the *Environment* tab. Drag and drop an Interior, Outdoor or Studio lighting environment (HDRI) into your scene. You will see the change in the scientifically accurate, real world lighting immediately and how it affects the appearance of your colors, materials and finishes.
Step 4: Adjust Your Camera

Use your mouse to adjust the camera. Additional settings are available in the Project, Camera tab. Adjust the angle and distance, control perspective with focal length and field of view settings, and easily add depth of field to your scene. Learn More
Step 5: Enjoy the Perfect Image

Hit *Render* on the main toolbar. Use the default setting or adjust the output options. Select the *Render* button to watch your image render right before your eyes. [Learn More](#)
Installation

System Requirements

Before installation, confirm that your system meets the necessary hardware and operating system requirements. You can view the system requirements here.

Installing Your License

The standard node-locked license of KeyShot can only be active on one machine at a time. However, you can transfer your license repeatedly between up to three machines of mixed platforms.

Automatic Install

When you receive your `keyshot8.lic` file, save it to your computer. Next, start KeyShot, and select Install a license file (*.lic) and browse to the `keyshot8.lic` file. If your license fails to install, check to ensure you have full permissions set on your KeyShot 8 resources folder.

Manual Install

When you receive your `keyshot8.lic` file, you can manually copy it to the Keyshot 8 resources folder on PC or Mac.

Transferring Your License

During the license transfer process, an Internet connection is required. Once the license has been successfully transferred, KeyShot can run without being connected to the Internet.

How to Transfer Your License

To transfer your license, ensure you are connected to the Internet on the active machine.

1. Start KeyShot and go to Help, Deactivate License on this Computer...
2. Next, ensure the new machine is connected to the internet and KeyShot is installed. Start the software, fill out your information on the activation screen, and press Next.
3. On the following screen you will be asked for your KeyShot serial code. Type in your information and press Next to finalize the activation.
Migration Assistant

If you have KeyShot 7 installed on your PC/Mac, when installing KeyShot 8 for the first time, the Migration Assistant will help you transfer your settings and resources to KeyShot 8. You can choose to migrate Settings, Resources or both.

Migrating Settings

Preferences

Any alterations you have made to the default Preferences setup will be transferred.

Workspaces

You won't have to re-create your favorite Workspaces.

Swatches saved in Color Picker

If you have added any color swatches to the Color Picker, these will also be transferred.

License Information

- Node Locked license: Information about name, company etc. will be prefilled in the Registration dialog.
- Floating license: KeyShot 8 will connect to the same license server as you used in KeyShot 7. If there are no licenses for KeyShot 8 on the server all your information will be prefilled in the Registration dialog.

Migrating Resources

Library resources

All non-stock resources will be copied into the respective KeyShot 8 libraries. Here they will be located in the Migrated folder.

If you have customized the folder settings all KeyShot 8 resources will be added to your custom folders.

Material Templates

Any Material Templates you have created will be copied to KeyShot 8.

Scripts

All custom scripts will be copied into your scripts list where they will be located in the Migrated folder.
Resource Folder

KeyShot Resource Folder

Your KeyShot installation contains a folder of preset KeyShot resources (or assets). Resources such as materials, environments, and textures are stored here. When you open a .bip file, KeyShot references the KeyShot resources folder location and loads any files that apply to the scene. You can specify the location of the KeyShot resources folder under the Folder Preferences tab.

On Windows, you will find Preferences in the Main Menu under Edit, Preferences and on Mac in the Main Menu under KeyShot, Preferences.

The KeyShot resources folder contains the following sub-folders:

Animations

Animations will be saved to this folder by default. At render time, other locations can be specified in the Render Options window.

Backplates

The KeyShot Library loads backplates from the this location and saves imported backplates to this folder by default.

Colors

The KeyShot Library loads color library files from the this location and saves imported color library files to this folder by default.

Downloads

Resources downloaded from the KeyShot Cloud will be saved to this location.

Environments

The KeyShot Library loads environments from this location and saves imported environments to this folder by default.

Favorites

This folder is empty until a favorite list of resources is created. Once created, the favorite list is saved to this location as a XML file.

Materials

The KeyShot Library loads materials this location and saves imported materials to this location by default.

Material Templates

This folder is empty until a material template is created. Once created, the material template is saved to this location.

Models
This folder contains standard primitives that you can import into KeyShot.

**Renderings**

Renderings will be saved to this folder by default. At render time, other locations can be specified inside the Render Options window.

**Scenes**

This folder contains sample scenes that you can only open with KeyShot. These scenes are saved as BIP files.

**Scripts**

This folder contains sample scripts that you can use with KeyShot.

**Textures**

The KeyShot Library loads textures from this location and saves imported textures to this folder by default.

---

**PC Location**

After KeyShot 8 is installed, a “KeyShot 8 Resources” shortcut will be created on your desktop. By default, this shortcut points to: Documents/KeyShot 8.

**Setting Permissions**

You must have read and write permissions for your KeyShot 8 folder in order to save renders, animations, and more. Here’s how to set permissions:

- Right click the KeyShot 8 resources folder and select “Properties”.
- Go to the Security tab and highlight your group or user name.
- Click the “Edit” button.
- Set permissions to “Full Control.”
- Click “Apply” and “OK.”

---

**Mac Location**

On a Mac, your KeyShot 8 resources folder is saved inside the “Application Support”: /Library/Application Support/KeyShot8
Setting Permissions

You must have read and write permissions to your KeyShot 8 folder in order to save renders, animations, and more. Here’s how to set permissions:

1. Right click the KeyShot 8 resources folder and select “Get Info.”
2. Expand “Sharing & Permissions” and unlock access.
3. Change all privileges to “Read & Write.”
4. Click the settings button and select “Apply to enclosed items…”
5. Click “OK” and close the window.
Pro Floating Installation

Welcome to the KeyShot Pro Floating Installation Guide! This guide will walk you through the installation process starting with the license management application: Luxion License Server (Windows & Mac) or lmgrd (Linux). You will then install and configure the client application: KeyShot! We have also included a list of features and add-ons, a troubleshooting guide, and licensing terminology with definitions.

Server Setup

<table>
<thead>
<tr>
<th>Luxion License Server</th>
<th>Imgrd (Linux)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Luxion License Server is the license management application for Mac and Windows</td>
<td>Imgrd (Unix executable file) is the license management process for Linux.</td>
</tr>
<tr>
<td>Requires: Windows Server 2008 and later. Mac OS X 10.10 and later</td>
<td></td>
</tr>
</tbody>
</table>

You can also visit the Pro Floating Advanced Setup pages for help with manual setup.

All license management applications utilize the latest FlexNet licensing tools by Flexera Software LLC. KeyShot Pro Floating and Luxion License Server are both provided by Luxion Inc.

Client Setup

KeyShot 8 Floating Installation

Amazing Rendering and Animation in real-time

- Download KeyShot 8
Pro Floating Quick Start Setup

**KeyShot Pro Floating - Server Installation**

All license management applications utilize the latest FlexNet licensing tools by Flexera Software LLC. KeyShot Pro Floating and KeyShot License Manager are both provided by Luxion Inc. Please follow the instructions below to install the license server and have your license file issued.

During license setup, you will install the server on a single computer in your network. This computer will host your license file and will be referred to as the license server. Note: The server must be a local central server - a dedicated machine for the FlexNet server software to be installed on and powered on and connected to the network at all times.

Before You Begin

Your KeyShot Pro Floating license will be sent via email. If you have a previous installation, please save the license file to your license server folder (e.g. C:\FlexLM on Windows) overwriting the previous file. If you changed the port number in the original file, please make sure your new license reflects that. It is important to note that the latest client software installation requires the latest KeyShot license server software. Without the latest license server software, KeyShot will display an "unknown error".

**1. Download the license server software**
   KeyShot License Server - Windows
   KeyShot License Server - MacOS
   KeyShot License Server - Linux

**2. Install the license server**
   1. Download and unpack the server software on the machine that will host the licenses.
   2. Start the server software.
   3. The server software will automatically provide the Host Name and the Host ID.
   4. Send the following information to license@luxion.com.
      - Company name
      - Serial code
      - Computer Host name
      - Computer MAC Address

**How to Restart a Windows Server**

1. Go to the server’s C:\FlexLM folder
2. Launch LMTTools.exe
3. Go to the START/STOP/REREAD tab
4. Enable Force Server Shutdown
5. Click Stop Server and wait for the server to stop
6. After a minute, click Start Server

The service will restart. Client computers will be able to connect as usual.

**How to Restart a Mac Server**

1. Launch KeyShot License Manager.app
2. Make sure to select Install License File
3. Click Browse and browse to your new license file
4. Click Stop
5. Click Start/Restart
The service will restart. Client computers will be able to connect as usual.

**How to Restart a Linux Server**
Using the command line on a Windows system running the FlexLM license server:

1. **Stop server:** Enter
   ```
   lmutil lmdown -c [path to license file]
   ```
2. **Start server:** Enter
   ```
   lmutil lmgrd -c [path to license file]
   ```

The service will restart. Client computers will be able to connect as usual.

**How to move the license server**
Should you need to move the KeyShot Floating license server to a new computer, please follow the following instructions to ensure you are up and running quickly.

1. Follow the steps above for installing the license server on the new machine.
2. Send the following information to license@luxion.com.
   - Old license file
   - New Computer Host name
   - New Computer MAC Address
   - Letter on company letterhead stating the old license server will be removed.

We will usually send your license file within 24 hours during business days (Mon-Fri). Should you have any questions please contact us at license@luxion.com.

**KeyShot Pro Floating - Client Installation**

1. **Gather Server Information**
   Before installing, make sure that the KeyShot Floating license server has been installed on a computer in the network and gather the following information from that computer:
   - Computer Host name
   - Computer IP Address

2. **Install KeyShot Pro Floating**
   Install the KeyShot Pro Floating (FL) client software on all the user's computers. You may download the KeyShot Floating client application here:
   - KeyShot Pro Floating - Windows
   - KeyShot Pro Floating - MacOS

3. **Enter Server Information**
   When first installed, the KeyShot Floating client application will ask you to Specify the License Server System.
   - **Windows** - Enter the Computer Name at the first prompt
   - **Mac** - Enter port number@server's IP address (e.g. 27000@192.168.1.123)

   KeyShot Pro Floating will remember the server location from now on. For more information please refer to the relevant section for your installation in the Pro Floating Installation manual.

   Should you have any questions, please contact us at license@luxion.com.
Luxion License Server Installation

The instructions below will walk you through a typical first-time license service setup. Our licensing team will provide you with a license file and the appropriate software links. You may reach our licensing team at license@luxion.com.

1. Install Server

Install Luxion License Server. Our licensing team will provide software download links once your purchase has been processed.

2. Request License

Click on the Request License tab to generate a request-message for our licensing team.

1. Name: Enter your name
2. Company Name: Enter your company name
3. Serial: Enter the 20 character serial code that was provided to you by our licensing team
4. Hostname: Is pre-filled with your computer's information.
5. MAC address: Is pre-filled with your computer's information.
6. Message: The information entered above will be combined into the message for our licensing team.
7. Email: this will send the request by email to license@luxion.com
8. Copy to clipboard: allows you to easily copy the entire message.

3. Install License

Click on the install License Tab to install the .lic file you have received from our licensing team.

1. Click the Install License button.
2. Locate and select the .lic file in the explorer/finder window.
3. The License info is displayed.
4. Check that the service is started.
5. The Luxion License Server window can now be closed, it is not necessary to keep it open for the floating licenses to be available.
they can be accessed as long as the server is online, and the service is not stopped.

4. Status - available/used licenses

To monitor available/used licenses:

1. Click Status button to trigger the status window
2. The Status window will display the types of licenses available and how many are in use.

Notice that "keyshot2" are Floating pro licenses and "keyshot_vr" are the XR add-on licenses.
5. Set Server Ports

If you have a Firewall or have other License servers running on the same machine you may need to change the Server Ports, this can be done by clicking the Server Ports button.

- **FlexLM Port**: Change this to avoid port conflicts if you have other License servers - the default is 27000
- **Deamon Port**: This is only used for network setups with a Firewall. If a Firewall is used, both ports need to be set and opened in the Firewall.

6. License Folder

The License Folder button is mainly present for support purposes. It leads to the License Folder where log files, etc. regarding the License Server are stored.

Default locations for the License folder are.

- **Windows**: C:\ProgramData\Luxion\License
- **Mac**: /Applications/LuxionLicenseServer.app/Contents/License

**Related**
- KeyShot Pro Floating Installation
- Changing Server Connection.
License Server Installation (Linux)

The instructions below will walk you through the typical first-time license service setup on Linux. Our licensing team will provide you with a license file and the appropriate software links. You may reach our licensing team at license@luxion.com.

**License Server Setup Instructions**

If you are running RedHat Linux skip steps 3, 4 and 5.

1. Download and unzip the "KeyShot_Floating_LICENSE_Server_LINUX.zip" file into the your home folder ("/home/<your username>" or "~/")

2. Open the terminal (usually Ctrl + Alt + T) and change your current directory to the luxion_flexlm folder ("~/luxion_flexlm")

    ```
    cd luxion_flexlm/
    ```

If you are running RedHat Linux skip the next 3 steps.
3. Run the following command:

```
ls -l /lib64/ld*
```

4. Take note of the return value before the arrow (highlighted in the picture).

5. Run the following command where `<value from step three before the arrow>` is the value from step 3 before the arrow.

```
sudo ln -s <value from step 3> /lib64/ld-1sb-x86-64.so.3
```
6. Move your license file to your luxion_flexlm folder, where your file would have your computer name instead of MyCompany.

mv ~/Desktop/keyshot_floating_MyCompany.lic ~/luxion_flexlm/
7. Run the following command to start the service, where your file would have your computer name instead of `MyCompany`.

```
./lmgrd -C keyshot-floating_MyCompany.lic
```
8. Run the following command to check the service status:

```
./lmstat -a
```

The lmstat output will confirm that the license server is up. The output message will also show you how many license seats are issued (available).
KeyShot Pro Floating Installation

Now that your server is up and running, you are ready for the client setup on your computer. The instructions below will walk you through the registration process for floating licenses.

**KeyShot Pro Floating Setup Instructions**

1. Download and install the KeyShot Pro Floating application. To download KeyShot, click [here](#).
2. Launch KeyShot 8.
3. Select *Floating License* and click *Continue*

If you are currently in demo mode, open the registration wizard from

- **Windows**: Help > Register License
- **Mac**: KeyShot > Register License (Mac)
4. Enter the hostname of your license server. If the server uses another FlexLM port than the standard (27000) you need to specify the port number, followed by the "@" sign and the server's hostname (for example, 27000@KeyShotServer.local). Click Connect.
You may also use the server's IP Address (use the IP Address if your license server is a PC). For example, 27000@192.168.1.1
23. Click Connect.
4. Review your license features, select the type of license you want to use and if you need KeyShot XR and Click Done.
KeyShot Pro Floating will start. From now on, KeyShot will remember the server information. You will be able to check out the license as long as your system can connect to the computer acting as the license server.

**Technical Tip:** If your service status window does not look similar to the above image or if you are getting an error message when you start the server, you can use the troubleshooting guide for diagnosis. You may also contact Luxion Customer Support at support@luxion.com for assistance.
Borrowing A License

As you know, to check out a KeyShot Pro Floating license, your computer must be connected to the license server. To continue using KeyShot Pro Floating, the connection must be maintained at all times. But what if you want to work from a remote location and take KeyShot with you? Well, then you borrow the license.

The client and server must be connected during the borrowing process. Once you’ve borrowed the license, you can take your laptop and KeyShot anywhere for up to 30 days. Educational license holders must submit a request with their IT staff to activate this feature.

How To Borrow A License

1. Ensure that your client computer can connect to the server.
2. Open KeyShot Pro Floating.
3. **Windows**: In the Main menu click Help, Borrow Floating License.
4. Select a return date and click **OK**.
5. You will receive a confirmation message. Click **OK**.

How To Return A Borrowed License

1. Ensure that your client computer can connect to the server (otherwise, this will not work).
2. Open KeyShot Pro Floating.
3. **Windows**: In the Main menu click Help, Return Borrowed Floating License.
4. **Mac**: In the Main menu click KeyShot, Return Borrowed Floating License.
5. You will be asked to confirm this action. Click **Yes**.
6. You will receive a confirmation message. Click **OK**.

**Note:** Other clients cannot checkout or borrow a license seat that has already been borrowed. The borrowed license seat remains with the client that borrowed it until the return date expires or until the client manually returns the license seat. If your license server holds more than one license seat, the remaining seats can still be checked out normally.
Changing Server Connection

For larger companies, there may be more than one KeyShot license server at the same or multiple locations.

KeyShot allows you to choose between different license servers. Below you will find instructions for changing the license server connection within KeyShot.

Please contact your IT department for VPN connection instructions when trying to connect to a remote license server.

How To Change Your License Server Connection

1. Ensure that your client computer can connect to the current server.
2. Open KeyShot Pro Floating.
3. **Windows**: Go to the main menu and click Help, Change Floating License Server.
   **Mac**: Go to the main menu and click KeyShot, Change Floating License Server.
4. Change the port number and the hostname/IP address as needed. Click OK.

Technical Tip

Please refer to the included troubleshooting section if you are unable to establish your new client-server connection.
Enabling KeyShotXR

KeyShotXR is included with your KeyShot Enterprise license. Otherwise, it is sold separately as an add-on.

KeyShotXR allows you to create interactive (touch-enabled) visuals for your website. Please refer to the KeyShotXR section for additional information regarding KeyShotXR features.

How To Enable KeyShotXR

1. Windows: Go to the main menu and click Help, Select Floating License Type.
   Mac: Go to the main menu and click KeyShot, Select Floating License Type.
2. Enable Check out KeyShotXR feature from license server.
3. Click OK. KeyShot will restart and KeyShotXR will be enabled.

Note
If your license does not contain the KeyShoXR feature, then KeyShot will tell you that there are "no additional options available".
Pro Floating Troubleshooting

This troubleshooting guide will help you diagnose the cause of an error message and assist you in finding a solution. Below, we list errors under two main categories: server errors and client errors. Errors inside KeyShot License Manager are server errors. Errors from KeyShot Pro Floating are client errors. Please find your error in the categories shown below.

In this section

- Server Error: Invalid Hostname (unpublished)
- Server Error: Invalid Mac Address (unpublished)
- Server Error: Expired License (unpublished)
- Server Error: Cannot Connect (unpublished)
- Server Error: Unknown Hostname (unpublished)
- Server Error: License File Not Found
- Client Error: Looping Prompt
- Client Error: No Licenses Available
- Client Error: Unsupported KeyShot Version
- Client Error: Unknown Error
Server Error: License File Not Found

Reason: The licensing software (lmgrd) is unable to read the license file in your FlexLM folder.

How To Fix It:
1. Browse to `C:\ProgramData\Luxion`.
2. Right-click the License folder and select Permissions.
3. Select "Properties"
4. Disable “Read only”
5. Go to the Security tab
6. Click the Edit button. Ensure that all users have read and write permissions
7. Click Apply and OK
8. Click Apply and OK once more.
9. Once all users have read and write permissions into the License folder and its contents, re-start the license service from LMTools.

Technical Tip: You may also contact Luxion Customer Support at support@luxion.com for assistance.
Client Error: Looping Prompt

Reason: This means that KeyShot is unable to connect to KeyShot License Manager on your license server.

Please check

Server status

Is your license server running properly? You can check the service status within the LUXION.log file (found inside your License Folder). If you find any problems, see server errors for troubleshooting.

Computer connection

Make sure that your client computer can ping the license server and that your client computer can “see” the server in your office network. Contact your IT department if you are using a VPN connection.

Server Ports

Remember that KeyShot uses port number 27000 by default. It is possible that another application in your computer is using this port. You can try to change the port number in the license first and then inside KeyShot Pro Floating. Please refer to instructions on how to change the port number.

Firewall/Anti-virus settings

Turn off the firewall on the server and the client. If this is already the case, then you can try to add LUXION.exe and lmgrd.exe to the list of programs allowed through the firewall and through the anti-virus. Please consult your IT representative for further assistance with firewall/anti-virus settings.

Client Environment Variable/Registry

Depending on your system’s restrictions, it is possible that KeyShot is unable to save the Server information. If so, you can manually edit this:

- PC: registry entry
- Mac: environment variable.

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also contact Luxion Customer Support at support@luxion.com for assistance.
**Edit Registry (PC)**

Earlier you learned how to connected KeyShot Pro Floating to the license server system. When you specify the server name in KeyShot, a registry entry is created. Depending on your system’s restrictions, it is possible that KeyShot is unable to write into the Windows registry. If so, you can manually edit this registry entry.

**How To Edit The Registry Entry**

1. Make sure that the KeyShot application is closed. Then, click the Windows Start button and search for "regedit.exe".

2. Launch the Registry Editor (regedit.exe)

3. Go to HKEY_CURRENT_USER > Software > FlexLM License Manager.

4. While the FlexLM License Manager key is selected you will see a string called LUXION_LICENSE_FILE. If you don’t see this string, then create a new string. You can go to Edit > New > String Value and name it LUXION_LICENSE_FILE.

**Note:** You may also create the FlexLM License Manager key inside HKEY_CURRENT_USER, Software (i.e. Edit > New > Key).

5. Right-click the LUXION_LICENSE_FILE string and select "Modify".

6. Change the Value data to the correct port number at the server’s IP Address (e.g. 27000@192.168.1.123). Click OK, then close the Registry Editor.

7. You may now open KeyShot on your client computer.
Environment Variable (Mac)

Earlier, you learned how to connected KeyShot Pro Floating to the license server system. When you specify the server name in KeyShot, an environment variable is created. Depending on your system's restrictions, it is possible that KeyShot is unable to write into the environment variable. If so, you can manually edit this file.

How To Edit The Environment Variable

1. Open up the terminal. Make sure you are in the home directory.
2. Type the following command to open the environment variable in vim (text editor): `vim .flexlmrc`
3. Press `Enter`.
4. Press the `i` key to start insert mode.
5. Change the IP Address or hostname to the correct server location (e.g. 27000@192.168.1.123). Once done, Press ESC on your keyboard to exit insert mode.
6. Hold Shift and press the `semicolon/colon` key.
7. Type the following command to write and quit: `wq`
8. Press `Enter`. You will be brought back to the screen shown in step 2 above.
9. You may now open KeyShot on your client computer.
Client Error: No Licenses Available

**Reason:** There are no more licenses available on the server. This means that the license server has issued all the available license seats to other clients in your office network.

**How To Fix It:**

1. Close KeyShot Pro Floating on one of your other clients.
2. Re-open KeyShot Pro Floating on the desired client.

**Technical Tip:** If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also contact Luxion Customer Support at support@luxion.com for assistance.
Client Error: Unsupported KeyShot Version

Reason: Your current floating license does not support the version of KeyShot that you are trying to open.

How To Fix It:

1. Send an email to license@luxion.com describing the error message. You will want to attach the Luxion.log and your current license file found in the License folder.

2. Once you receive your new license file, follow the license replacement instructions.

3. If KeyShot is not connecting to the server automatically, change the Server information manually:
   - PC: Editing the registry entry
   - Mac: Editing the environment variable.

Technical Tip: If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also contact Luxion Customer Support at support@luxion.com for assistance.
Client Error: Unknown Error

Reason: The Unknown Error error means that your license server is running outdated software.

How To Fix It:

1. Download the latest Luxion License Server update.
   - Luxion License Server - Windows
   - Luxion License Server - Mac OS X

2. Run the installer file and follow the prompts on the installation wizard.

3. Launch the Luxion License Server application and click New License to reload the license.

4. It is also a good idea to update KeyShot itself. You can check for updates from the Help menu inside KeyShot.

5. Once your server is up to date and running, KeyShot will start properly.
Pro Floating Advanced Setup

FlexNet licensing tools and methods are commonly utilized in the software industry. This licensing method includes a myriad of different advanced features. In fact, there is an entire FlexNet licensing manual on the web. In this section, you will find definitions to common terminology and useful information for your advanced IT specialist.

<table>
<thead>
<tr>
<th>In this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Server Installation (PC) - Custom</td>
</tr>
<tr>
<td>License Server Installation (Mac) - Custom</td>
</tr>
<tr>
<td>Replace License File</td>
</tr>
</tbody>
</table>
License Server Installation (PC) - Custom

The Floating License Configurator application automatically creates a service in LMTools. But what if you wish to create a custom license service? Then, you will need to understand LMTools in greater detail. The instructions below will walk you through creating your very own custom license service. Our licensing team will provide you with a license file and the appropriate software links. You may reach our licensing team at license@luxion.com. If you already have a license server set up you can then make changes.

Custom License Server Setup Instructions

1. Download and run the “keyshot_floating_license_server.exe” installer. Follow the prompts and make sure that “Run KeyShot Floating License Server 1.0” is disabled. Click Finish.

2. Launch the LMTools application (found inside C:\FlexLM) and go to the Config Services tab.
3. Write a new service name.

4. Browse to the `lmgrd.exe`, license (.lic), and `debug.log` files. You should be able to find all of these files in your `C:\FlexLM` folder. Note that the `debug.log` is created after you start the service. For now, you can simply specify the correct path: `C:\FlexLM\debug.log`
5. Enable **Start Server at Power Up** and **Use Services**. Then click **Save Service** and confirm.
6. Launch LMTools and go to the Start/Stop/Reread tab. Enable Force Server Shutdown and click Stop Server. You may also stop the KeyShot Floating service within the Windows Services dialog (services.exe).
7. Click Start Server. You may also start the KeyShot Floating service within the Windows Services dialog (services.exe).
8. Open the `debug.log` file inside your `C:\FlexLM` folder (this folder contains the licensing software). The debug log will reference your license file and tell you that the server started on your computer system.
Setting The License server up with a Fire-Wall:

It is important to note that FlexLM uses 2 Ports for the license server the LMGRD port(27000 by default) and the LUXION Vendor Daemon Port(assigned randomly unless Fixed in the License file).

These ports can be set in the License File.

- The lmgrd Port is set after the Computers Mac Address on the “SERVER Line”.
- The vendor daemon port is set on the “VENDOR Line” after the Vendor Name using the syntax: port=<your port>

Below is an example, for the ports 27000 and 27010:
SERVER Hostname ffffffffffff 27000
VENDOR LUXION port=27010
FEATURE keyshot2 LUXION 7.0 permanent 2 DUP_GROUP=UHD BORROW=720 \
SIGN="XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX \
XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX \
XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX" \
XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX XXXX"

In the given example you will have to open the ports 27000 and 27010 in the firewall for the server to function.

**Technical Tip:** If your debug log does not look similar to the above image or if you are getting an error message inside *Floating License Configurator*, then you can use the *troubleshooting guide* for guidance. You may also contact Luxion Customer Support at support@luxion.com for assistance.
License Server Installation (Mac) - Custom

The KeyShot License Manager application is just a graphical user interface to FlexNet licensing tools. KeyShot License Manager is great for quick setups. However, for better troubleshooting and customization your IT department may prefer to have direct access to the license manager (lmgrd) and the license manager status application (lmstat). In that case, you can create your license service manually.

Custom License Server Setup Instructions

1. Launch the Activity Monitor.app. Organize your processes by name. Find the lmgrd process and click Force Quit (click the crossed-stop-sign button). This will stop any existing license services.

2. Download the latest FlexLM license server update from here.

3. Once downloaded, move the FlexLM.zip file to your Applications folder and unzip it. Your FlexLM folder contains the main license management application, lmgrd and other useful applications that help you check the status of your service such as lmstat. Inside the FlexLM folder you will also be able to find the installation guide PDF.
4. Rename your KeyShot license file to “keyshot.lic” and move it into the FlexLM folder. This is very important.
5. Right-click the FlexLMAutostart.app and select Open. If you are asked to confirm, then click Open once more. Your KeyShot license service will start right up.
6. To confirm that your service is up and running, you can run the `lmstat` application inside the FlexLM folder.

Launch Terminal.app and change the directory to `/Applications/FlexLM`:

```
cd /Applications/FlexLM
```

Press Enter. Then, type:

```
sudo ./lmstat -a
```

Press Enter and type your password (no characters will appear as you type). If you think you made a mistake, simply delete and start over.
Press Enter one more time. If your service is running, `lmstat` will return a message stating that the "license server is UP (MAST ER)…" and it will tell you the number of licenses issued as well as the number of licenses in use. Otherwise, please send a screenshot of the `lmstat` output to support@luxion.com for further assistance.
7. To ensure that your license service starts every time that you restart your computer, open your System Preferences.app and
go to Users&Groups > Login Items. Click the Add button (+) and browse to your Applications/FlexLM folder. Select the
FlexLMAutostart.app and click Add.
These items will open automatically when you log in:

<table>
<thead>
<tr>
<th>Hide</th>
<th>Item</th>
<th>Kind</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Alfred</td>
<td>Application</td>
</tr>
<tr>
<td></td>
<td>WDDriveUtil</td>
<td>Application</td>
</tr>
<tr>
<td></td>
<td>nightly</td>
<td>Folder</td>
</tr>
</tbody>
</table>

To hide an application when you log in, select the checkbox in the Hide column next to the application.

Click the lock to make changes.
8. Close System Preferences.app. You can now launch KeyShot and point it to the server as outlined in the KeyShot Pro Floating Installation.
Replace License File
If you’ve received a new license file from us, you can easily replace the old license and update the license server.

How To Replace The License File:
1. Save the license file to your computer.
2. Launch the Luxion License Server
3. Go to the _Install License_ tab
4. Click "New License"
5. Browse to the License file.
   • The Server should now Load the License file and restart.
   • If you changed the port number in the original file, Click "Set Server Ports" and make sure the ports are set.

Client computers will be able to connect as usual.

**Technical Tip:** If results are not consistent with the above, please reference other possible solutions in the troubleshooting guide. You may also contact Luxion Customer Support at support@luxion.com for assistance.
Floating License Definitions

**Floating License**: This is a type of license that can be accessed by various computer systems. The actual license file is saved on the license server system. Your license file is an encoded text file that tells the license server which port to use, how many seats are available for checkout, and when will the license expire.

**Seat**: The number of seats in a license file tells the license server how many client computers can check out the floating license at the same time. This number is displayed and encoded in the license file.

**License Server**: The computer that hosts and manages the license file. Any Windows PC or Mac computer can be a license server. We recommend that you select a desktop computer in your office network that your design team can access during regular business hours or later if needed.

**Client**: In this manual, we refer to any computer in which KeyShot Pro Floating is installed as the client. If KeyShot Pro Floating is installed on your license server, then your license server computer is also a client.

**Server Host Name**: This is the name of your computer as listed under your computer network. The host name is a label used for identification.

**Server MAC Address**: Your computer has various ways to connect to other computers on your network and to the internet. The most common connections are the ethernet adapter and the wireless adapter. Each of your adapters has a unique physical address also known as the mac address. The KeyShot Pro Floating license is tied to your server’s MAC address.
Silent Install (PC)
You or your IT department may wish to run the KeyShot Installer for PC* as a silent installation. The KeyShot installer takes the following arguments:

Commands

/S – for a silent installation.
/AllUsers – installs for all users with shortcuts in start menu.
/USERNAME=somepath – changes the destination folder for the KeyShot Resources folder.
/FLEXLM=27000@myserver – set the FlexLM server’s port and hostname. Only use this command if you have a floating license for multiple computers.
/D=C:\Program Files\KeyShot 8 – set the program files destination. This must be placed at the end of the command line.
/FloatingFeature=feature – set the feature to check out (if more than one is available): keyshot2, keyshot_enterprise, or keyshot_base.
/NO_AUTOUPDATE – disable updates.
/NO_CLOUD – disable KeyShot Cloud Library.

Examples

KeyShot HD/Pro
keyshot_w64_8.x.x.exe /S /USERNAME=C:\Users\Luxion\Documents /D=C:\Program Files\KeyShot 8

KeyShot Pro Floating
keyshot_w64_8.x.x.exe /S /USERNAME=C:\Users\Luxion\Documents /FLEXLM=27000@myserver /D=C:\Program Files\KeyShot 8

Unattended Uninstall
C:\Program Files\KeyShot 8\uninst.exe /S _?=C:\Program Files\KeyShot 8

*Silent install commands for Mac are currently not available.
**User Interface**

This section provides information on the KeyShot user interface and its elements (windows, menus and commands). Its purpose is to explain:

1. the location of elements
2. purpose of elements
3. menus and commands
4. customization.

Information on the function of elements and how they work are located in the latter sections.

KeyShot is a single interface built around the Real-time View of your scene. The docking windows allow scene authoring capabilities while the floating windows contain setting and output options.

You can customize and save the interface to suit your workflow with **Workspaces**.

<table>
<thead>
<tr>
<th>Main Interface</th>
<th>Docking Windows</th>
<th>Floating Windows</th>
<th>Extras</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-time View</td>
<td>Library Window</td>
<td>Preferences</td>
<td>Welcome Window</td>
</tr>
<tr>
<td>Main Menu</td>
<td>Project Window</td>
<td>Render</td>
<td>Hotkeys</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Animation Timeline</td>
<td>Output Window</td>
<td>Multi-Touch</td>
</tr>
<tr>
<td>Ribbon</td>
<td>Geometry View</td>
<td>HDRi Editor</td>
<td>Workspaces</td>
</tr>
<tr>
<td></td>
<td>Material View</td>
<td>Material Graph (Pro Only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Studios</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cloud Library</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


Real-time View

The KeyShot Real-time View is the main viewport in the KeyShot user interface. All real-time rendering of your 3D model will occur here. You can navigate your scene using the camera controls, multi-select objects and right-click directly on your model or in the area around it to view more options.

Heads Up Display

For information concerning the Real-time View you can turn on the Heads-Up Display via the Main Menu under View > Heads-Up Display.

The Heads-Up Display will be located in the top left corner of the Real-time View. It shows frames per second, time and number of samples the Real-time View has been rendering, the amount of triangles and NURBS in the scene, the Real-time View resolution, and the current focal length of the camera.

Coordinate Legend

To help orientate in the Real-time View you can turn on the Coordinate Legend. This will show the X,Y and Z axis of the current view. Turn on the Coordinate Legend via the Main Menu under View > Coordinate Legend.

Docking windows

Windows with resources and editing options (see which here) can be docked inside the Real-time View. You can dock windows on the sides and in the bottom of the view - and in multiple columns/rows if desired. To dock a window drag it by the title-bar towards the middle of the edge you want to dock it to, when a grey docking area is expanded, simply drop the window there. To undock drag the window, by the title bar, away from the dock area.

The Real-time View will respect the resolution/aspect ratio set in the Image tab and docked windows can only be resized accordingly.
Main Menu

File

- **New...**
  Open a new blank scene in KeyShot.
- **Import...**
  Import a 3D file into an open or new scene. See Importing section for more details.
- **Open...**
  This will open a KeyShot scene, or opens the import panel.
- **Open Recent**
  KeyShot lists the last 10 scenes that were opened/saved so you can quickly open them.
- **Save**
  Save the currently open scene in KeyShot (.bip).
- **Save As...**
  Save the current scene in Keyshot (.bip) with the option to change the name of the file.
- **Save Package...**
  Save a KeyShot Package (.ksp) which includes the model, materials, environments, textures, cameras, and backplates used in a given scene.
  *It is very important to use this saving method when sharing or moving a scene across different computers.*
- **Save for KeyShot Viewer...**
  Save a KeyShot Package (.ksp) for viewing in KeyShot Viewer. The file can be Password protected and you can choose to show the KeyShot logo and/or watermark.
- **Save Active Model Sets...**
  Save only the Model Set(s) displayed in order to share Model Sets with non-Pro users.
- **Revisions Manager...**
  Opens Revision Manager to preview, revert to or delete revisions. This is not enabled by default. To enable the Revision Manager, enable **Backup Revisions** under Edit > Preferences > General (PC) or KeyShot > Preferences > General (Mac).
- **Export (Pro only)**
  Export model file to OBJ, FBX, GLTF, STL, and ZPR file formats.
- **Connect to Onshape...**
  Launch the Onshape integration dialog. Plugin and Onshape and account are required. The plugin can be downloaded here.
- **Exit** (PC only - On Mac Quit is located under KeyShot in the Main Menu)
  Quit and leave KeyShot.

Edit

- **Undo**
  Undo previous actions.
- **Redo**
  Redo an action that was undone.
- **Add Geometry**
  Add pre-installed primitives into your scene. You can also place commonly used models into the “Models” folder in your KeyShot Resources directory.
- **Edit Geometry**
  Opens the Geometry Editor. See Geometry Editor for more details.
- **Clear Geometry**
  Clears all geometry in the scene.
- **Set Scene Units**
  Change the set units used in the scene. For accurate results, use the same units the model was created in.

- **Preferences** (PC only - On Mac Preferences are located under KeyShot in the Main Menu)
  Set KeyShot preferences. See Preferences for more details.

**Environment**

- **Background**
  Toggle background mode between Lighting Environment, Color, and Backplate image.

- **Ground Shadows**
  Toggle Ground Shadows on and off.

- **Occlusion Ground Shadows**
  Toggle Occlusion Ground Shadows on and off. Ground Shadows must be enabled for this option to be available.

- **Ground Reflections**
  Toggle Ground Reflections on and off.

- **Flatten Ground**
  Toggle Flatten Ground on and off.

**Lighting**

- **Performance Mode**
  Toggle the performance mode on/off.

- **Basic, Product, Interior, Jewelry, Custom**
  Choose a lighting preset that best suits your scene. If you have a created a custom preset, this option becomes available under Custom.

- **Self Shadows, Global Illumination, Ground Illumination, Caustics, Interior Mode**
  Toggle these settings on/off. See Lighting for more information.

**Camera**

- **Cameras**
  Choose a saved camera. Cameras that are saved from your list of saved cameras is populated here.

- **Lock Camera**
  Lock the camera in the Real-time View.

- **Add Camera**
  Add a Camera to your saved camera list.

- **Tumble/Pan/Dolly**
  Toggle the default left mouse button action.

- **Perspective/Orthographic/Shift**
  Toggle camera lens settings. See Lens Settings for more information.

- **Standard Views**
  Choose from the preset orthographic camera views.

- **Stay Above Ground**
  Toggle camera to stay above ground.

- **Grid**
  Enable grid.

- **Ground Grid**
  Enable ground grid.
- **Match Backplate Perspective**
  Enable the match backplate tool.
- **Walkthrough Mode**
  Adds a new camera and enables *Real-time View* navigation controls.
- **Enable VR**
  When you have a VR headset connected to your computer the *Enable VR* option enable the *Head Mounted Display* option in the *Stereo* section of the *Project, Camera* tab and add a *Panoramic* camera to the *Camera List*. See the *Virtual Reality* section to learn more.
- **Adaptive Performance mode**
  Toggle the use of performance mode if FPS is lower than 20 in the *Real-time View*.

### Image

- **Resolution Presets**
  Select from a list of *Real-time View* Resolution Presets.
- **Lock Aspect**
  Toggle Lock Aspect of the *Real-time View*.
- **Lock Resolution**
  Toggle Lock Resolution of the *Real-time View*.

### Render

- **Pause Real-time Render**
  Toggle pause of the *Real-time View*.
- **Render NURBS**
  Toggle on/off the display of NURBS in the *Real-time View*.
- **Motion Blur**
  Toggle on/off the display of Motion Blur when animations are present in the scene.
- **Save Screenshot**
  Create an image file of the current *Real-time View*.
- **Add to Queue**
  Create a render job in the *Render Queue* using the current Render Options.
- **Render**
  Open the *Render Options* window.

### View

- **Model Sets**
  Cycle Model Sets or select a specific Model Set from the list.
- **Show Fullscreen**
  Toggle fullscreen mode.
- **Presentation Mode**
  Toggle presentation mode.
- **Retina mode** (Mac only)
  Toggle Retina mode.
- **Heads-Up Display**
  Hide or show the Heads-Up Display which contains frames per second, time and number of samples the *Real-time View* has been rendering, the amount of triangles and NURBS in the scene, the *Real-time View* resolution, and the
current focal length of the camera.

- **Show Coordinate Legend**
  Hide or show the coordinate legend on the lower left corner of the real-time render window.

- **Selection Outlines**
  Toggle selection outlines to be shown.

- **Show Light Sources**
  Hide or show physical light sources.

**Window**

- **Toolbar**
  Hide or show the Toolbar.

- **Ribbon**
  Hide or show the Ribbon.

- **Cloud Library...**
  Hide or show the Cloud Library window.

- **Library**
  Hide or show the Library window.

- **Project**
  Hide or show the Project window.

- **Animation...**
  Hide or show the Animation window.

- **KeyShotXR...**
  Open the KeyShotXR wizard (only available with applicable licenses).

- **Show Geometry View**
  Hide or show the Geometry View window.

- **Material Templates...**
  Hide or show the Material Templates window.

- **Studios**
  Hide or show the Studios window.

- **Configurator Wizard**
  Hide or show the Configurator Wizard.

- **Scripting Console...**
  Hide or show the Scripting console window.

- **Enable Docking**
  Toggle to allow window docking in the Real-time View.

- **Dock Windows**
  Auto-docks all open windows to default locations.

- **Restore Tab Order**
  Restores the default tab order for the Library and Project windows.

**Help**

- **Help...**
  Loads https://help.keyshot.com/ for quick access to the Luxion Support staff, FAQs, Troubleshooting and more.

- **Manual...**
  Loads the KeyShot online manual, which also contains links to download the PDF manual.

- **Hotkeys Overview...**
  Displays the KeyShot hotkeys panel (or toggle off/on using the *K-key*).
• **Welcome Dialog...**
  Displays the Welcome Window for access to the latest learning and 'What's New' content along with recent and demo scenes.

• **Learning**
  Opens the “Keyshot Learning” page for tutorials, webinars and quick tips.

• **Register License...** (PC only - On Mac Register License... is located under KeyShot in the Main Menu)
  Opens the KeyShot license registration window.

• **Activate KeyShotXR...**
  If you have purchased the KeyShotXR add-on separately, click here to activate it.

• **Deactivate License on this Computer...** (PC only - On Mac Deactivate License on this Computer... is located under KeyShot in the Main Menu)
  Deactivate your license so it can be used on a different computer.

• **Show License Information...** (PC only - On Mac Show License information... is located under KeyShot in the Main Menu)
  Shows KeyShot version and active licenses.

• **Disclaimers...**
  Opens disclaimers pertaining to KeyShot partners.

• **Check for Updates...** (PC only - On Mac Check for Updates... is located under KeyShot in the Main Menu)
  Checks online for the latest version of KeyShot. Requires an internet connection.

• **Log...**
  Opens log window to view the source of any errors.

• **About...** (PC only - On Mac About... is located under KeyShot in the Main Menu)
  Displays the KeyShot About window, including KeyShot version number and link to Disclaimers

**Related pages:**

There are no related labels.
The Toolbar provides quick and easy access to the most common windows and features in KeyShot. The center grouping of icons provides a general order of operations when working in KeyShot from Import to Render. You can right-click on the Toolbar for icon size options and the ability to disable text. Click and drag on the handle on the left side of the Toolbar to tear it off from the main window to leave it floating or to dock along the top or either side.

Cloud Library
Opens the Cloud Library window. See Cloud Library for more details.

Import
Opens the browse to file dialog to import scenes and 3D data into KeyShot. See Working With Models for more details.

Library
Opens the Library window. See Library Window section for more details.

Project
Opens the Project window. See Project Window for more details.

Animation
Opens the Animation Timeline and Animation Properties window. See Animation Timeline for more details.

KeyShotXR
Opens the KeyShotXR Wizard. See KeyShotXR for more details.

Presentation
Enters full-screen Presentation Mode. This button is only displayed on the Toolbar for KeyShot Pro users, if the Configurator has been set up in the scene. See Configurator for more details.

Render
Opens the Render window. See Render for more details.

Screenshot
Takes a Screenshot of the real-time view and saves it to your Renderings resources folder.
Ribbon
The KeyShot Ribbon

The Ribbon provides quick access to commonly used settings, tools, commands, and windows in KeyShot.

Workspaces
Select a predefined Workspace, create and manager your own, or select between the Light and Dark theme interface.

CPU Usage
Select the number of cores used for the real-time render window.

Pause
Pauses real-time rendering.

Performance Mode
Toggle on to lower real-time render settings for faster performance. Performance Mode is also accessible via the Lighting tab.

NURBS Mode (Pro Only)
Enables NURBS Data to be rendered in the realtime rendering window.

Region (Pro Only)
Enables Region rendering.

Move Tool
Enables the Move Tool and prompts to make a selection if nothing is already selected.

Tumble, Pan, Dolly Camera
Select the default left mouse button behavior. This is especially helpful when working on a laptop with only a trackpad.

Perspective
Quick access to the Camera Perspective value.

Add Camera
Add a new Camera to your saved Camera list.

Cycle Cameras
Cycle through saved Cameras.

Reset Camera
Reset the current Camera to its saved state.

Lock Camera
Lock the properties of the current Camera.

Add Studio
Add a new Camera to your saved Camera list.

**Cycle Studios**
Cycle through saved Studios.

**Studios**
Show/hide the Studios window.

**Material Templates**
Show/hide the Material Templates window.

**Geometry View**
Show/hide the Geometry View window.

**Configurator Wizard**
Opens Configurator Wizard.
Workspaces

Workspaces allow you to select preset user interface (UI) arrangements or save your own custom arrangements of the KeyShot UI to best suit the way you work. Workspaces remember window dock state, position and size, Library and Project tab order, tab visibility, torn-off tab state, Toolbar and Ribbon position and Ribbon icon visibility.

Using Workspaces

The Ribbon at the top of the KeyShot UI now contains a dropdown menu at the far left where you can select, add, and manage Workspaces. To create your own custom Workspace make adjustments to any of the items mentioned above, click the Workspaces dropdown and select Add... to launch a name entry field and save. To save changes to an existing Workspace click Apply Changes... To adjust display order, import, export, or delete Workspaces click Manage...

Theme Options

KeyShot has both light and dark theme options. From the Workspace dropdown, select Light Theme or Dark Theme.
Library Window
The KeyShot Library has stock materials, colors, textures, environments, and backplates that you can use in your scenes.

Files in the Library are stored locally on your computer and they are read from your KeyShot resources folder by default. To pull resources from a different folder, you can point to it from Keyshot Preferences > Folders. More Materials, Textures, Environments, and Backplates are available for download from the Cloud Library.

In this section
- Materials Tab
- Colors Tab
- Environments Tab
- Textures Tab
- Backplates Tab
- Favorites Tab
Materials Tab

The Materials tab is located in the Library window and contains all the preset and saved materials in your library.

1. **Search**
   Type in any keyword to search for a material by name.

2. **Add Folder**
   Click this button to add custom material folders.

3. **Import**
   Import a KMP material file.

4. **Refresh**
   Refresh material list if any changes were made.

5. **Folder Tree**
   Contains the folder structure of the material folders.

6. **Material Thumbnails**
   Mat ball swatches of materials within the selected folder.

7. **List/Thumbnail Toggle**
   Switch displaying the materials with thumbnails and in a list view.

8. **Zoom Slider**
   Slide to change the size of the thumbnails. You can also use +/- to change in steps.

9. **Upload to Cloud Library**
   Click this button to upload a custom material to the Cloud Library.

10. **Export**
    Export a saved material as a KMP file.
Colors Tab

The Colors tab contains all preset color libraries and saved colors.

1. **Search**
   - Type in any keyword to search for a color by name.
2. **Add Folder**
   - Click this button to add custom color folders.
3. **Import**
   - Import a KCP or CSV color file.
4. **Refresh**
   - Refresh color list if any changes were made.
5. **Color Search**
   - Opens color picker panel to search by closest color match.
6. **Folder Tree**
   - Contains the folder structure of the color folders. It contains folders for RAL and Pantone Color Libraries.
7. **Color Swatches**
   - Displays color swatches within the selected folder.
8. **List/Thumbnail Toggle**
   - Switch between displaying the color with thumbnails and in a list view.
9. **Zoom Slider**
   - Slide to change the size of the thumbnails. Use +/- to change in steps
10. **Export**
    - Export a KCP color file.

See the Color Library page for more info.
Environments Tab

The *Environments* tab contains all preset environments and any saved environments in your library.

1. **Search**
   - Type in any keyword to search for an environment by name.

2. **Add Folder**
   - Click this button to add custom environments folders.

3. **Import**
   - Import a HDR, HDZ, EXR, DDS file.

4. **Refresh**
   - Refresh environments list if any changes were made.

5. **Folder Tree**
   - Contains the folder structure of the environment folders.

6. **Environment Thumbnails**
   - Thumbnails of environments within the selected folder.

7. **List/Thumbnail Toggle**
   - Switch displaying the environments with thumbnails and a list view.

8. **Zoom Slider**
   - Slide to change the size of the thumbnails. Use +/- to change in steps.

9. **Upload to Cloud Library**
   - Click this button to upload a custom environment to the Cloud Library.

10. **Export**
    - Export environment file.
Textures Tab

The Textures tab contains all preset and saved textures in your library.

1. **Search**
   Type in any keyword to search for a texture by name.

2. **Add Folder**
   Click this button to add custom texture folders.

3. **Import**
   Import an image file.

4. **Refresh**
   Refresh texture list if any changes were made.

5. **Folder Tree**
   Contains the folder structure of the texture folders.

6. **Texture Thumbnails**
   Thumbnails of textures within the selected folder.

7. **List/Thumbnail Toggle**
   Switch between displaying the textures with thumbnails, or a list view.

8. **Zoom Slider**
   Slide to change the size of the thumbnails use +/− to change in steps.

9. **Upload to Cloud Library**
   Click this button to upload a custom texture to the Cloud Library.

10. **Export**
    Export an image file.
Backplates Tab

The Backplates tab contains all preset or saved backplates in your library.

1. **Search**
   Type in any keyword to search for a backplate by name.

2. **Add Folder**
   Click this button to add custom backplate folders.

3. **Import**
   Import an image file.

4. **Refresh**
   Refresh backplate list if any changes were made.

5. **Folder Tree**
   Contains the folder structure of the backplate folders.

6. **Backplate Thumbnails**
   Thumbnails of backplates within the selected folder.

7. **List/Thumbnail Toggle**
   Switch between displaying the backplates with thumbnails, or a list view.

8. **Zoom Slider**
   Slide to change the size of the thumbnails use +/- to change in steps.

9. **Upload to Cloud Library**
   Click this button to upload a custom backplate to the Cloud Library.

10. **Export**
    Export an image file.
Favorites Tab

The Favorites tab allows you to organize commonly used resources into collections for a faster workflow. Right-click a resource in your library, select Add to Favorite, and select the folder you would like to add the resource to or select Add to new Favorite to create a new collection.

1. **Search**
   - Type in any keyword to search for a resource by name.
2. **Add Folder**
   - Click this button to add a favorites folders.
3. **Refresh**
   - Refresh favorites list if any changes were made.
4. **Folder Tree**
   - Contains the folder structure of the favorites folders. Each favorites folder contains categories for backplates, colors, environments, materials, and textures.
5. **Favorites Thumbnails**
   - Thumbnails of resources within the selected folder.
6. **List/Thumbnail Toggle**
   - Switch between displaying the favorites with thumbnails, or a list view.
7. **Zoom Slider**
   - Slide to change the size of the thumbnails use +/- to change in steps.
Project Window

The Project window contains all the setup and setting for everything in your scene, organized into six tabs: Scene, Material, Environment, Lighting, Camera and Image.

You can show/hide the Project window via the Toolbar or with the Space bar.
Scene Tab

The Scene tab contains all the items in your scene:

1. Scene tree

The hierarchy of elements in your scene, Models > Groups > Parts, Animations (Pro Only) and Cameras. See Working With Models > Scene Tree for more details.

2. Model Sets (Pro only)

With Model Sets you can have several independent Scene Tree variations within your file, making it easier to handle product variations. See Working With Models > Model Sets for more detail.

3. Properties

Properties of the currently highlighted Model Set or item in the Scene Tree.

4. Position

Here you can set the size/position of the selected Model, Group or Part. Also see Working With Models > Moving Models and Parts.

5. Materials

This is the In-Project library which lists all materials in the current scene.
Material Tab

The Material tab is where you can edit the properties of your material such as changing the roughness, adding textures or labels.

1. Material Name

The name of the material as it appears in the In-Project library - if the project has multiple instances of the same material (unlinked) a number will be appended to the materials.

2. Save

Saves a copy of the material in the Material Library

3. Preview

Preview of the current material. The current material can be replaced by dragging another material from the Material Library onto the preview.

4. Material Graph (Pro Only)

The Material Graph opens in a separate window and displays materials, textures, labels and more as nodes in a graph view to visualize connections and relationships within complex materials. See the Material Graph section for more details.

5. Multi-Material (Pro Only)

Any material can be turned into a Multi-Material to facilitate non-destructive material swapping, variations or color studies. The Multi-Material allows you to cycle through a variety of materials within a single “container” material. See Multi-Materials section for more details.

6. Type

Here you can change the type of material on the selected part. See Material Types for description of the types available. When changing material types KeyShot will transfer any properties that can be translated between the types.

7. Properties/Textures/Labels

Each type of material has a set of properties that can be adjusted as well as the option to add labels and textures. The texture icon denotes settings that are able to have textures applied.

8. In-Project Library

Lists all materials in the current scene. See the In-Project Library section for more details.

9. Material View

Tree-view showing all Labels/textures etc. (nodes) of the current material.
Environment Tab

The Environment tab is located in the Project window and is where you can add and edit the HDR lighting of your scene as well as the background and ground properties.

1. Environment List

With the Environment List you can set up and easily toggle between multiple environments in your project.

2. HDRI Preview

Preview of the HDRI. In the Pro version light pins can be adjusted here as well as in the HDRI Editor Canvas.

3. Settings

The Settings tab located below the Environment List and HDRI preview allows you to control the properties of the selected Environment. See Adjusting Environments for more details.

4. HDRI Editor (PRO)

The HDRI Editor tab located below the Environment List and HDRI preview allows you to edit the selected HDRI, add light pins and change background options. See HDRI Editor for more details.
Lighting Tab

In the Lighting tab you can control the interpretation of lighting in your scene. The actual light sources are set up via Lighting Environments and Light Source materials.

1. Lighting Presets

KeyShot comes with 5 Lighting Presets which make applying global light settings faster. You can find the description of each preset in the Lighting Section.

2. Custom

Here you can access your own custom presets.

To add a new preset, adjust the settings, select the '+' symbol.

3. Lighting settings

This allows complete control over lighting options. Learn more about the individual settings on the Custom Lighting Preset page.
Camera Tab

The Camera tab is used to create cameras to capture the desired area of your project as well as various effects to enhance your camera view.

1. Camera List

With the Camera List you can set up/save multiple cameras in your scene. This facilitates cameras to be re-used, modified, animated or used in Studios.

In the camera list, the Free Camera is always available and cannot be locked or overwritten, it can always be selected and remains independent of camera animations.

Go to the Camera List section for more details.

2. Position and Orientation

While the camera position can be changed by clicking and dragging the scene, this section will give you a more precise way of positioning the camera and allows you to set the camera target.

See the Position and Orientation section to learn more.

3. Lens Settings

As the title indicates, this section allows you to change the camera lens settings.

- Perspective
- Orthographic
- Shift
- Panoramic (pro only)

4. Stereo

The Stereo mode will allow you to either render a VR-ready image that can be viewed through a head-mounted VR display or to see the scene in real-time through a VR headset such as the Oculus Rift or the HTC Vive. See the Stereo (VR) page and the Virtual Reality section for more information.

5. Depth of Field

Depth of Field allows you to set the focus distance and the f-stop of the camera just like you would with a regular camera.

See the Depth of Field section for more details.
**Image Tab**

**Resolution**

The Resolution can be set in specific pixels or with a fixed ratio. You can also choose from a number of standard presets - and even add your own presets to suit your workflow.

The Resolution page offers more details.

**Image Styles**

**Image Style List**

The Image Style List allows you to create multiple Image Styles in the same scene.

- **Add Image Style** - Adds a new Image Style to the list.
- **Duplicate Image Style** - Adds a copy of the current Image Style to the list.
- **Delete Image Style** - Deletes the current Image Style.

**Image Style type**

- **Basic** - Almost identical to the Image Adjustments and Image Effects options in previous versions of KeyShot. If you open a legacy scene with Image Adjustments/Effects they will be added as a Basic Image Style.

- **Photographic** - Offers more versatile adjustments e.g via Tone Mapping and Curves. See the

**Properties**

This is where you set up the current Image Style - Learn more in the Image Styles section.

---

**Note:** In KeyShot 8 the Region Rendering settings have been moved from the Image tab to the Ribbon - see more on the Render Region page.
Animation Timeline

Animation Timeline Interface

1. **Time Stamp**
   This will show where the preview line currently is on the timeline.

2. **Current Time Indicator Line**
   This line is the marker for the where in the timeline the real-time render window is rendering from. When you play a real-time preview, this line will move in time with the animation. Click and drag the line to scrub to a point in the animation you would like to preview.

3. **Start/End Markers (Work area)**
   Use this to designate the actual animation to be rendered. The space between these markers is called the *Work Area*.

4. **Ruler**
   This shows the timeline in the units chosen (seconds or frames.)

5. **Nodes**
   Each animation is represented in the timeline as a colored bar called a “Node.” Most nodes can be selected at the ends and dragged to change the duration of the animation. Click on the body of the node to move along the timeline. Hold SHIFT while dragging to snap to another node.
   - Green nodes - Part animations
   - Blue nodes - Camera animations
   - Red nodes - Material animations

6. **Folder Nodes**
   Yellow Nodes are “Folder Nodes.” Changing the duration and location of a folder node affects all animation nodes contained within it.

7. **Node List**
   This lists all animation nodes and folders. Use the check boxes to toggle the active state of the animation nodes.
1. **Animation Wizard**
   - This opens the Animation Wizard.
2. **FPS drop-down**
   - Select from common frame rates used in video production.
3. **Real-time Preview Buttons**
   - These buttons will allow you to quickly jump to the beginning or end of your animation, scrub through the animation one frame at a time, and play a real-time preview of your animation in the real-time render window. To see a more accurate portrayal of materials and motion, click the “preview” button on the animation toolbar.
4. **Loop**
   - Enable this to loop the animation when playing in the real-time window.
5. **Motion Blur**
   - Enable this to create motion blur in your rendered animation output.
6. **Animation Settings**
   Click the settings icon to open the settings panel where you can select from *Max seconds per frame* to limit the render time of the preview, or choose *Max samples per frames* to limit the quality of the preview. You can also choose to in-/exclude the last frame and if Geometry nodes should be executed for the animation - see the *Geometry Node types* page for more info.

7. **Render Preview**
   Click this button to begin rendering a small video file of your animation with more accurate results than the realtime preview.

8. **Zoom Slider**
   Use this to change the scale of the Animation Timeline.
Geometry View Window
The Geometry View window provides a secondary OpenGL viewer for use as a secondary view for lighting, camera or animation setup.

Geometry View

1. **Settings**
   - Set the background color and customize what is visible: ground grid, lights, cameras, etc.
2. **Display Style**
   - Controls your model's display style: shaded, flat, wireframe, shaded wireframe, and bounding.
3. **Camera Type**
   - Choose to sync with the active camera or navigate independently in this view.
4. **Standard Views**
   - Snap to a pre-defined standard camera view: front, right, top, etc.
5. **Move Tool**
   - Click this button to launch the Move Tool.
6. **Edit Geometry**
   - Click this button to launch the Geometry Editor.
7. **Geometry View**
   - OpenGL viewer that can be viewed next to the Real-Time View.

Learn more about what you can do in the Geometry View section.
Material Template Window

The Material Templates window can be accessed from Window under the Main Menu or via the Material Template button in the Ribbon.

1. **Search**
   Type in any keyword to search for a material template.

2. **Add Template**
   Click this button to add a material template.

3. **Import**
   Import a KMTP material template file.

4. **Export**
   Export a KMTP material template file.

5. **Delete**
   Click this button to delete a material template.

6. **Material Templates List**
   Contains a list of all material templates available in your resources folder.

7. **Add Rule**
   Click this button to add a rule.

8. **Delete Rule**
   Click this button to delete a rule.

9. **Template Rules**
   Contains a list of all the rules in the template.

10. **Apply**
    Applies the template to your scene or selection.

Go to the Material Templates page to learn more.
Welcome Window
The KeyShot Welcome Window will appear after you launch KeyShot. The Welcome Window will display:

- Recently opened scenes
- Demo scenes
- Latest KeyShot News
- Latest KeyShot Tips

Click on a recently open scene to open it immediately or select *Import Model or Open Scene* to load another model or scene.

You can disable/enable the Welcome Window on startup in the Preferences:

- Windows: Go to Edit, Preferences and in the General section, uncheck/check *Show Welcome Window at start up.*
- Mac: Go to Help, Preferences and in the General section, uncheck/check *Show Welcome Window at start up.*
Hotkeys

Hotkeys

Learning and using the KeyShot hotkeys will speed up the process of working inside KeyShot. You can access the list of hotkeys and their functionality by pressing the K-key on PC or Mac.

Hotkey Overview

Display the Hotkey Overview window by hitting the K-key or selecting Help, Hotkeys Overview...

- **Setup/Details...**
  Opens the Hotkeys Preference window to set custom hotkeys.

- **Save as Image...**
  Allows you to save an image of the Hotkey Overview for reference or print.

Customizing KeyShot Hotkeys

KeyShot also allows you to assign custom hotkeys for many KeyShot commands. The Hotkeys preferences can be accessed by selecting Edit, Preferences (windows) or Keyshot, Preferences (mac) and selecting the Hotkeys section or by pressing the K-key to show the Hotkeys Overview where you will see a button for Setup/Details... in the bottom right corner. This will take you to the Hotkeys section of the Preferences page. Here you can set custom Hotkeys for any of the listed actions.
### KeyShot

**Camera**
- Tumble: LMB Drag
- Cycle Camera: "N" (Ctrl+RMB)
- Focal Length: Alt+Wheel
- Twist: Alt+Ctrl+Wheel
- Depth of Field: D

**Environment**
- Brightness: Ctrl+LMB Drag
- Large Change: Up/Down
- Small Change: Left/Right
- Open Environment: Ctrl+Alt+P
- Open Backplate: Ctrl+B

**File**
- New Project: Ctrl+N
- Save: Ctrl+S
- Quit: Ctrl+Q

**General**
- Copy: Ctrl+C
- Paste: Ctrl+V
- Undo: Ctrl+Z
- Redo: Ctrl+Y
- Render: Ctrl+P

**Interface**
- Project: Space
- Library: M
- Heads-Up Display: F
- Show Only: Alt+LMB
- Coordinate Legend: Z
- Light Sources: L
- Marquee Selection: Ctrl+LMB Drag*

**Materials**
- Edit Material: Ctrl+C
- Apply Selected: Ctrl+RMB
- Apply Copy: Ctrl+Alt+RMB

**Real-time**
- Performance Mode: Alt+S
- Pease: Ctrl+F
- Self Shadows: S
- Render Region: Ctrl+Shift+R

**Animation**
- Play/Pause: 0=Space
- Animation Timeline: A

---

### KeyShot

**Camera**
- Tumble: LMB Drag
- Cycle Camera: "N" (Ctrl+RMB)
- Focal Length: Alt+Wheel
- Twist: Alt+Ctrl+Wheel
- Depth of Field: D

**Environment**
- Brightness: Ctrl+LMB Drag
- Large Change: Up/Down
- Small Change: Left/Right
- Open Environment: Ctrl+Alt+B
- Open Backplate: Ctrl+B

**File**
- New Project: Ctrl+N
- Open Project: Ctrl+O
- Save As: Ctrl+Alt+S
- Import Model: Ctrl+I

**General**
- Copy: Ctrl+C
- Paste: Ctrl+V
- Undo: Ctrl+Z
- Redo: Ctrl+Y
- Render: Ctrl+P

**Interface**
- Project: Space
- Library: M
- Heads-Up Display: F
- Show Only: Alt+LMB
- Coordinate Legend: Z
- Light Sources: L
- Marquee Selection: Ctrl+LMB Drag*

**Materials**
- Edit Material: Ctrl+C
- Apply Selected: Ctrl+RMB
- Apply Copy: Ctrl+Alt+RMB

**Real-time**
- Performance Mode: Alt+S
- Pease: Ctrl+F
- Self Shadows: S
- Render Region: Ctrl+Shift+R

**Animation**
- Play/Pause: 0=Space
- Animation Timeline: A

---

* Right to left = Cross - Left to right = Window
Adjust Value Fields with CTRL+LMB Scroll (+Shift for minor steps)
Multi-touch

KeyShot supports multi-touch input for touch-enabled screens and tablets. The following gestures can be used on the touch screen when running KeyShot:

- 1 Finger – Tumble camera
- 2 Finger Pinch – Zoom
- 3 Finger Drag – Pan
- 5 Finger Touch – Reset camera
- Tap and Hold – Access right mouse button menu
- Single Finger Drag and Drop – Access Library assets
Tessellation Settings Window

The Tessellation Settings window can be accessed by right-clicking your model or part and selecting Re-Tessellate or by selecting the model/part in the Scene Tree and selecting Re-Tessellate in the Properties tap below.

1. **Tessellation Quality**
   The quality of your surfaces. A lower value will yield rough surfaces. A higher value will yield smooth surfaces.

2. **Angle Tolerance**
   The maximum allowed angle measurement between adjacent triangles on your model's surface.

3. **Distance Tolerance**
   The maximum allowed distance deviation – expressed as a percentage of the model's bounding box – measured from any triangle to the actual NURBS surface. A lower value will yield smooth surfaces.

4. **Maximum Edge Length**
   The maximum side length – expressed as a percentage of the model's bounding box – for any one triangle on your model's surface. A lower value will yield smooth surfaces.

5. **Tessellate**
   Click to make your model appear in the Tessellation Preview at the specified Tessellation Quality.

6. **Apply**
   Click to Apply the Tessellation Quality to your model in the real-time view.

7. **Tessellation Preview**
   Shows you a preview of the detail on your model's surface.

8. **Triangles**
   Displays the total number of triangles that make up your model's surface.

9. **Appearance**
   Select Wireframe for a polygon view or Glossy to see how smooth the surfaces will look.

10. **Cancel**
    Click to undo any changes to your model's tessellation and close the Tessellation Settings window.

11. **Done**
    Click to accept your changes and apply them to your scene. Note that you cannot undo the changes once you click Done.

See more about Re-Tessellation.
Working With Models

Overview

This section covers import, export, model setup and working with 3D CAD data.

With KeyShot, you can directly import all major 3D file formats, plus KeyShot has many free plugins for 3D modeling software. On import, KeyShot will automatically recognize your model's up orientation and match it. Other import options allow you to quickly adjust the location and import quality.

KeyShot allows you to control the model units, show/hide parts, group, duplicate parts/assemblies and create patterns of your imported data. We'll start with bringing your model in, then go over navigation and manipulating the models in your scene.

KeyShot Pro brings additional export options to KeyShot, allowing you to export formats to use in other 3D modeling and 3D printing software or upload to view in a web browser.

In this section

- Supported File Formats
- Import Dialog
- KeyShot Plugins
- Scene Units
- Scene Tree
- Hiding And Showing Parts
- Regrouping Parts
- Moving Models and Parts
- Duplicating Models
- Pattern Tool
- Rounded Edges
- Re-Tessellate
- Revision Manager
- Geometry View
- Model Sets
- Export
KeyShot supports the following 3D file formats on both Mac and PC.

- 3ds Max (.3ds) [1]
- ALIAS 2018 and prior [2]
- AutoCAD (.dwg, .dxf)
- CATIA v5-6 (.3dxml, .cgr, .catpart)
- Cinema 4D R18 and prior (.c4d)
- Creo 4.0 and prior (.prt, .asm)
- Creo View (.pvz, .pvs, .edz, .ed, .c3di, .ol)
- Inventor 2019 and prior (.ipt, .iam)
- Maya 2017 and prior (.ma, .mb) [2]
- NX 12 and prior (.prt)
- Onshape [1]
- Pro/ENGINEER Wildfire 2-5 (.prt, .asm)
- Revit 2018 and prior [1]
- Rhinoceros 6 and prior (.3dm)
- SketchUp 2018 and prior (.skp)
- Solid Edge ST10 and prior (.par, .asm, .psm)
- SolidWorks 2018 and prior (.prt, .sldprt, .asm, .sldasm)
- Acis (.sat)
- Alembic (.abc) [3]
- 3DS (.3ds)
- 3DXML (.3dxml)
- Collada (.dae)
- FBX (.fbx) [3]
- IGES (.igs, .iges)
- JT (.j)
- OBJ (.obj)
- Parasolid (.x_t)
- STEP (.stp, .step)
- STL (.stl)
- ZPR (.zpr)

[1] Plugin only
[2] Requires licensed installation of software
[3] Includes animation

Plugins

See list of plugins with LiveLinking here.

Download plugins here.
Import Dialog

KeyShot Import

Supported file types can be imported into KeyShot in several ways:

- by pressing Import on the Toolbar.
- by dragging and dropping them into the Real-time View.
- via the main menu File, Import…

When a file is designated for import, the KeyShot Import window will be displayed on the screen. Based on the type of model you are importing, some of the options below might not be displayed in your import dialog.

Location

- **Center Geometry**
  When checked, “Center Geometry” will import the model and place it in the very center of the environment. Any original 3D coordinates for the model are removed when center geometry is selected. If this option is not selected, the model will be placed in the same position in 3D space where it was originally created.
- **Snap to Ground**
  When checked, “Snap to Ground” will import the model and position it directly on the ground plane. This will also remove any original 3D coordinate information.
- **Keep Original**
  When checked, “Keep Original” will import the model and retain the location of the model in relation to the original origin point. Use this for multi-import assemblies with a shared CAD origin.

Size

- **Geometry Unit**
  Use this dropdown menu to choose the correct units the geometry was modeled in for the first import. The model scale will be adjusted accordingly upon second import if a different unit is selected. Available only for .wire, .3ds, .obj and .stl file formats.

Up Orientation

Not all modeling applications define the up-axis in the same manner. Depending on your application, you may need to set a different orientation other than the default “Y Up” setting. Although KeyShot will recognize the up orientation of the 3D modeling software, your model may have been built in a different orientation. If your model comes in on its side, try setting a different orientation.

Environment and Camera

- **Adjust Camera to Look at Geometry**
  When checked, the camera will center to fit the imported geometry in the scene upon import.
- **Adjust Environment to Fit Geometry**
  When checked, the environment will size to fit the imported geometry in the scene upon import.
- **Import Cameras**
  This will add native CAD cameras to the KeyShot camera list. Only available for .fbx, .ma, .mb.
Materials and Structure

- **Group by**
  Use this dropdown box to group the Scene Tree structure by Object (name), Material (type), Layer, Shader. Different options will show depending on file format. Group by Object/Layer retains assembly structure and naming for accuracy and flexibility. Group by Material/Shader flattens the hierarchy for a simpler tree structure by creating a single part for each material/shader.

- **Separate Materials by Part/Layer**
  This option will isolate linked materials to each part by prefixing a part name to each material name.

- **Keep Individual Parts**
  This option avoids merging of objects for troubleshooting purposes. It is recommended to try importing with this option disabled first to avoid excess separation of surfaces. Only available for .wire, .dwg, .dxf, .igs, .obj and .skp.

- **Retain Materials**
  This option appears for Update and Add to Scene imports to ensure that materials that have already been assigned in the scene will be applied to the new import if the native CAD materials names match.

- **Import Layers as Groups**
  Uses Layers setup in Maya to define tree structure. Available for .ma and .mb only.

- **Collapse Hierarchy**
  Flattens tree structure to simplify Scene Tree. Available for .ma and .mb only.

- **Assign Materials from Library**
  When this is enabled materials will be auto-assigned upon import if the native CAD materials have the same name as materials in the KeyShot Library.

- **Use Material Template**
  If you have Material Templates set up in KeyShot you will have the option of using one to with the import. Material Templates can bulk assign materials from the KeyShot library to the imported parts based on the name of each part's original material. See the Material Templates page to learn more.

Geometry

- **Tessellation Quality**
  Use this slider or input box to input the tessellation quality of the geometry. Lower values will import faster and higher values will import slower. It is recommended to use the default value of .2.

- **Accurate Tessellation**
  This option will optimize tessellation triangle size for improved performance. It is suggested to enable this option if available for your import format.

- **Import NURBS Data (Pro)**
  This option will bring in NURBS geometry that ensures no faceting on the model for completely smooth curves.

- **Cached Geometry**
  This option allows importing of an assembly without the contained part files. Available for SolidWorks and SolidEdge only.

- **Calculate Normals**
  Available for .obj only. It is recommended to try importing first with this option disabled as normals may already be included in the file.

Additional Options

- **Animation**
  Keyframed Transforms imports non-deformation animations. Specific Frame imports i.e. deformations at a specified frame and does not import animations to the Timeline. Available for .abc, .ma and .mb only.

- **Curve Import Options**
Curve Radius Modified adjusts imported curve thickness. Available for .abc, .fbx, .ma and .mb only.

Importing a Second Model

The import dialogue parameters change slightly when a model is already loaded in a scene and another model is selected for import or dragged and dropped onto the Real-time View. You will see three available options:

**Scene**

- **Add to Scene**
  When checked, this will add your model to the existing scene.

- **Update Geometry**
  With this checked, the newly added geometry will update the existing geometry, if part names match, replacing the old geometry.

Importing a KeyShot BIP File

A KeyShot BIP file may also be imported. In addition to the options above, you will see new keyshot BIP options.

**KeyShot BIP Import**

- **Open File**
  Select this if you want to open the scene in its original scene.

- **Import File**
  Select this option if you want to import the scene into the currently open scene.

**Environment and Camera**

- **Import Cameras**
  Since a BIP file is a KeyShot scene, you also have the option to import any saved cameras within the scene. Select this option if you want to import cameras in the KeyShot BIP.
KeyShot Plugins

KeyShot offers free plugins to make your workflow from CAD to KeyShot as seamless and effortless as possible. By installing a plugin for your chosen CAD package, you can export your active geometry from within the CAD application directly into KeyShot. To download a plugin and to find the most up to date information of the plugins we offer, please visit the KeyShot Plugins page. To learn more about installing plugins see KeyShot Plugins.

LiveLinking

Plugins developed by Luxion (and some third-party plugins) include Luxion’s LiveLinking technology. LiveLinking connects your modeling application with KeyShot, and allows you to update the model inside KeyShot without losing any material assignments, animations, lighting, and camera settings.

KeyShot Plugins

- 3DS Max 2014-2017
- Cinema 4D 19 and prior
- Creo 3.0 and prior
- Fusion 360
- Maya 2016-2018
- NX 8.5-12 and prior
- Pro/ENGINEER Wildfire 4-5
- Rhinoceros 6 and prior
- SketchUp 2018 and prior
- SolidWorks 2018 and prior

Note: All KeyShot plugins include LiveLinking

Third-Party Plugins

- Geomagic Control
- Geomagic Design
- Geomagic Design X
- Geomagic Freeform
- Geomagic Freeform Plus
- Geomagic Sculpt
- Geomagic Studio
- Geomagic Wrap
- IronCAD
- JewelCAD
- Siemens Solid Edge*
- SolidThinking Evolve
- SpaceClaim
- Pixologic ZBrush 4.7*
- ZWSOft ZW3D

*Include LiveLinking
LiveLinking

Luxion's LiveLinking technology allows you to establish a link between your 3D modeling software and KeyShot. This keeps the software separate, allowing you to continue working and refining your model in the CAD application, then send all changes over to KeyShot with the click of a button. All without losing any views, materials, textures or animations already applied.

**Download Plugin**

To establish LiveLinking between your CAD application and KeyShot, you must first [download and install](#) the KeyShot plugin for your CAD application. Each plugin comes with its own [installer](#) and unique setup instructions. For specific setup instructions, click [here](#).

**Enable LiveLinking**

LiveLinking is enabled by default. To change this go to Edit, Preferences, General on Windows and Keyshot, Preferences, General on Mac.

**Unable to connect**

If your 3D modeling software is unable to connect to KeyShot via the plugin, try to change the Port Range in the KeyShot Preferences.
Scene Units

Scene units control model scale, light intensity, color density, and texture mapping.

To achieve physical accuracy and better control over your material and texture settings, the scene units should match the scale of your model. For example, if you wish to render a car, you should set the scene units to meters or feet. On the other hand, if you wish to render a pair of sunglasses, you should set the scene units to centimeters or inches.

Changing the Scene Units

1. To change the model units, go to Edit > Set Scene Units and choose the new unit.

2. Select one of the two options: Keep Scene Size or Scale Scene.

Keep Scene Size
Applies the proper unit-conversion multiplier to your model and the KeyShot environment. When you convert scene units, say from centimeter to millimeter, you are telling KeyShot to make your 1 centimeter model into a 10 millimeter model.

When you start with an empty scene in KeyShot, it will use non-specific scene units. The units will either be set when you import a model into the empty scene or when you manually set/change the scene units.
Yes, mathematically they are both equivalent to each other. However, in KeyShot your model will occupy ten times as much space as it did before. Use this option when you wish to correct model size, light intensity, color density in glass, or your camera distance slider.

**Scale Scene**
Re-calibrates texture mapping on your model. When you correlate scene units, say from centimeter to millimeter, you are telling texture maps that one centimeter along your model is now treated as one millimeter along your model. Your model will keep its size, but texture images will re-size according to the new scale. Use this option when you wish to correct texture units.
Scene Tree

The Scene Tree displays Model Sets/models and their hierarchies along with any cameras that exist in a scene. Animations are also represented in the scene tree in versions of the software that include the animation add-on.

Collapse Scene Tree

Collapsing the scene tree hierarchy can be very useful if your model has a lot of parts. You can collapse/expand single groups or models by clicking the -/+. You can also right-click the section you would like to collapse and select “Collapse.” The full hierarchy can be collapsed when you select “Collapse All.”

Hide/show

Models and parts can be hidden and shown using the icon next to the name. The icon displayed next to animations can be used to disable and enable animations that are applied. See more on Hiding And Showing Parts.

Lock

If there is a icon next to a model or part, the geometry is present in the scene, but can not be moved/edited. Models and parts can be locked/unlocked either by right-clicking the part/model and selecting lock/unlock or in the properties tab just below the Scene Tree, where the icon can be clicked to lock/unlock.

Re-order

Models and parts can be re-ordered in the Scene Tree via drag-and-drop.

Rename

Models and parts can be renamed in the properties tab just below the Scene Tree. The Properties section always show the details for the selected part/model, including the name.

Note: It is best practice to control the naming and ordering in CAD but if you decide to do it in KeyShot it is recommended to do so before assigning textures or labels as it may cause mapping to shift. Changing the scene hierarchy will also break Live Linking and Update Geometry.
Hiding And Showing Parts

In some cases, materials may need to be assigned to parts that are enclosed in or hidden behind other pieces of geometry. In such cases hiding a part/model may come in handy.

Hiding Parts.

To hide parts, right-click on the part and select Hide Part.

A single part of a model can be shown when you right click on a part and select Show Only.

Parts can also be hidden by clicking the icon in the Scene Tree.

Showing Parts

To display a hidden part, right-click in the interface and select Undo Hide Part.

To bring back all previously hidden parts select Show All Parts.

Parts can also be shown by clicking the icon in the Scene Tree.
Regrouping Parts

Grouping gives you the ability to organize the scene tree.

**Add to Group**

When you use Add to Group you can either add to an existing group or create a new group in the desired location.

- Right-click the part or group (model) you want to re-group in the Scene Tree.
- Select Add to Group - the Add to Group Dialog is displayed.
- **Add to existing:** Select the group you want to add to and click OK.
- **Create new group:** Select the group to which you want to add the new group and click New Group.
  - Name the new group and click OK.
  - click OK.

**Add Sub-Group**

When you are dealing with groups, you can also Add sub group, without moving anything immediately - maybe to be ready for drag and drop reorganizing.

- Right-click the group (model) to which you want to add a sub-group.
- Give the group a name.

**Note:** Reordering parts and sub-assemblies will disable LiveLinking and Update Geometry.
Moving Models and Parts

With the Move tool you can translate, rotate and scale a model, part or selection.

Launch the Move Tool

The move tool can be triggered in different ways:

- Right-click a selected part/model in the Scene Tree and choose Move.
- Right-click a part in the Real-Time View and choose Move Selection, Move Part or Move Model, depending on what you want to move.
- Click the Move button in the Ribbon or in the Scene tab of the Project Panel. If no part(s) are selected, this will trigger a dialog, where you can choose which part(s) you want to move.
- Use the hotkey ctrl+d on Windows and cmd+d on Mac. If no part(s) are selected, this will trigger a dialog, where you can choose which part(s) you want to move.

Once you have selected what to transform, the Move Tool will be visible in the Real-Time View. The Move Tool consists of different handles that control translation, rotation, and scale in the X, Y, and Z directions.

Mode

Select which handles you want to see on the move tool. When rotating you can press Shift while dragging to make the rotation snap in 15° increments.

Axis

Choose an axis from which to reference your transformations.

- Local uses the axis inherent in the part or model
- Global uses the XYZ coordinates from the KeyShot scene

Pivot

By default the Pivot is in the center of the current selection. To select another pivot point click Pick to launch the Pivot Selection dialog.

- Pick: When the Pivot Selection dialog is displayed you can select a part or a model/group to use as Pivot - either in the Pivot Selection dialog itself or by clicking on the part in the Real-Time View - followed by OK. This effectively sets the center of the selection as the pivot. The name in the pivot field is changed to the name of the part/group and the Move tool is moved to the pivot point.
- Reset: The reset button will return the pivot point to the original position in the center of the part(s) and the text in the pivot field now says Self again.

Snap

Snap to Pivot
The *Snap to Pivot* option will move the part(s) to the selected pivot. More precisely will the option align the center of the part(s) with the center of the pivot object.

**Snap to Lower Object**
The *Snap to Lower Object* option will automatically move the bottom edge of the object’s bounding box to the top edge of the bounding box of the part located below.

**Snap to Ground**
The *Snap to Ground* quickly moves the model in the Y-direction (up-down) to snap the lowest point on the model’s bounding box to the ground plane. This is useful when the model has been moved and is no longer touching the ground plane.
Duplicating Models
Models and parts can be duplicated by:

- Right clicking the model/part in the Scene Tree
- Select Duplicate.

This action duplicates the model along with any assigned materials and animations, to the same level in the Scene Tree.

Tip: If you want a copy of the entire model, maybe to try out model variations - take a look at Model Sets.
Pattern Tool

The Pattern Tool allows you to create instances of models instead of duplicates, which increases speed and decreases file size. Right click a model in the Scene Tree, and select Make Pattern to open the Pattern Tool dialog.

Pattern Tool Settings

Linear

Instances (Linear)
This allows you to set how many instances are created along the X, Y, and Z axes.

Spacing (Linear)
This allows you to set the spacing of the instances for X, Y, and Z.

Rotate Objects
Instances can be rotated along the Y of each local access to dynamically position them in the scene. Use this field to choose how far instances will be rotated along the Y axis.

Scattering
Use this to randomly place patterned objects. Useful for scenes where a more random distribution of objects is desired.

Displacement
This controls the amount of deviation occurs from the original pattern matrix.

Y Rotation
This changes the amount an object is randomly rotated by in the Y axis.

Circular

Count
This allows you to set how many instances are arrayed around an axis.
Radius
This allows you to set the distance from the instances to center or pattern axis.

Fill Angle
The angle at which to array the instances. 360 is a full circle.

Rotate Objects
Instances can be rotated along the Y of each local access to dynamically position them in the scene. Use this field to choose how far instances will be rotated along the Y axis.

Scattering
Use this to randomly place patterned objects. Useful for scenes where a more random distribution of objects is desired.

Radial
This determines how much the instances may differ from the given radius.

Angular
This determines how much the instance-angle may differ from the default position on the given Fill Angle.

Y Rotation
This changes the amount an object is randomly rotated by in the Y axis.

Center
Centers the pattern to the scene.

Resize Environment
Automatically increase the environment size to accommodate all instances.
Adjust Camera
Enable this to have the camera automatically shift to include all instance within the field of view.

Editing Patterns
In the scene tree, right click on patterned object and select "edit pattern" to open the Pattern window to make changes.
Rounded Edges

The Rounded Edges feature allows you to simulate fillets on parts, without actually altering the geometry in your modelling software and thus causing an increase of triangle-count.

The adjustment sliders can be accessed by selecting one or more part-level objects in the Scene Tree, which will then display the Rounded Edges accordion in the Properties sub-tab below.

**Radius**

The *Radius* slider is unit-aware to your Scene Units. Because it is a simulated effect, you will experience the best results if you keep this value low.

**Minimum Edge Angle**

The Minimum Edge Angle slider allows you to limit Rounded Edges to corners greater than the set degree value.
Re-Tessellate
Models that contain NURBS data can be re-tessellated directly in the scene without having to import the model all over again.

Re-Tessellate allows you to fine tune tessellation quality of entire models or individual parts in your scene. Increasing the tessellation value will yield smoother surfaces on your model and increase scene file size. In order to Re-Tessellate, you must enable the Import NURBS Data checkbox at import (Geometry section inside the Import dialog).

How to Re-Tessellate:

1. Right-click on a model, part, or multi-selection of parts in the scene tree or real-time view.

2. Select Re-Tessellate.

3. This will open the Tessellation Settings dialog. Change the Tessellation Quality or drill down to access finer adjustments including Angle Tolerance, Distance Tolerance, and Maximum Edge Length. For more information about settings, click here.

4. Click the Tessellate button to show a preview in the Tessellation Settings dialog, which can be displayed as a Wireframe or Glossy representation.

5. Click Apply and Done to commit the changes to the scene. Cancel will revert all changes and exit the dialog.
Revision Manager

Instead of overwriting the BIP file, the Revision Manager will create a serialized backup every time that you save your scene. The result is a .BIP.XX file (where "XX" is the revision index number) every time that you save. This allows you to revert to any saved version of your BIP file or delete revisions that you don't need anymore.

Enable Revision Manager

The instructions below assume that you've enabled Backup Revisions

- **Windows**: Edit > Preferences > General
- **Mac**: KeyShot > Preferences > General

And that you've saved your scene at least twice.

Manage your revisions

1. With your scene open, go to File > Revision Manager. The Revision Manager window appears.
2. From the Revisions list, select the version (revision) of your scene to which you wish to revert. Then, click *Revert to selected version*. 
3. To delete a revision, simply select it and click *Delete old revisions*.
Geometry View

This highly responsive OpenGL secondary viewer complements the Real-time View to add more capabilities and a faster workflow for setting up your scene. Some benefits of the Geometry View are:

- Animations can be played back at a true 1:1 speed.
- A secondary camera can be used to position physical lights easily in a scene.
- Scene transformations and composition setup are faster.
- All Camera Path Animations can be viewed and edited.
Geometry View Settings

On the Geometry View Ribbon, click on the gear icon to access the Geometry View Settings panel.

**Background Color**
Select the background color of the Geometry View.

**Checkboxes**
Click each checkbox to toggle the display of the different elements in the Geometry View.

**MatCap**
Add/Refresh/Delete image file to use for MatCap shading of the Geometry View. To activate the MatCap shading see Display Style.
Display Style

On the Geometry View Ribbon, click on the Display Style dropdown to change the Display Style of models in the Geometry View. The style choices are: Shaded, Flat, Shaded Wireframe, Wireframe, or Bounding.

Shaded

The Shaded Display State displays the geometry with solid colors and shaded areas.

Flat

The Flat Display State displays the geometry with solid colors and no shading.

Shaded Wireframe

The Shaded Wireframe Display State displays the geometry with solid colors and shaded areas with the geometry wireframe on top.
<table>
<thead>
<tr>
<th>Display State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Wireframe</strong></td>
<td>The Wireframe Display State displays the geometry with only a representation of the wireframe.</td>
</tr>
<tr>
<td><strong>Bounding Box</strong></td>
<td>The Bound Box Display State displays the geometry with wireframe box representations of the extents of the model and part geometry.</td>
</tr>
<tr>
<td><strong>MatCap</strong></td>
<td>The MatCap Display State displays the geometry with a MatCap shading. If you want to use another MatCap this can be set via Geometry View Settings</td>
</tr>
</tbody>
</table>
MatCap+Color

The MatCap Display State displays the geometry with a MatCap shading, where the colors of the objects also are displayed.
Camera Type
The Camera Type options change the view mode in the Geometry View.

Choose Camera Type
From the Camera Type drop-down choose a camera from these available options—Active Camera, Perspective, or Orthographic.

Active Camera
The Active Camera option changes the view mode to display what is seen in the frame of the current active camera. This is the camera that is active in the Real-Time View as well. This allows you to adjust the camera just as you would in the Real-time View.

Perspective
The Perspective option changes the view mode to display a perspective view of the entire scene.

Orthographic
The Orthographic option changes the view mode to display an orthographic view of the entire scene.

Controlling the Active Camera
When you use the Perspective or Orthographic camera inside the Geometry View, you can control the Active Camera of the Real-Time View. As the camera is moved in the Geometry View, the Real-time View and camera properties in the Project window update as well. The active camera is highlighted in red, while any other cameras in the scene are gray. You can switch to a camera by clicking it.

If a camera is locked, you will need to right-click and select Unlock Camera to unlock the camera prior to moving it.

The Active Camera can be manipulated with a move tool inside the Geometry View. This feature makes positioning cameras in interiors much easier.

Move Active Camera Position
This changes the actual position of the camera. With the camera unlocked, right-click in the Geometry View and select Move Active Camera Position. Use the Move Tool to change the position.

- **Show**: Toggle the visibility of the Translation and Rotation handles.
- **Keep View Direction**: When Keep View Direction is on, the translation will move the camera parallel to the field of view, and not pivot the camera target which is the default behavior.
- **Axis**: Select Local or Global axis as the base of the Translation. Note that Rotation can only be done based on the
Local scale.

**Move Active Camera Target**

This changes the 'look at' point of the camera. With the camera unlocked, right-click in the Geometry View and select *Move Active Camera Target*. The Move Tool will appear on the Camera Target. Use the Move Tool to change the position.

- **Keep View Direction**: When *Keep View Direction* is on, the translation will move both the camera and camera target, and not pivot the camera which is the default behavior.

**Saving Active Camera Changes**

Any changes you have made to a camera are still *unsaved* and will be reset if you switch camera.

Right-click and select *Save Camera* to update the current camera position or target, or select *Add Camera* to create a new camera. The new camera will appear in the Project window, Camera tab where the camera changes may be saved or added as well.
Standard Views

From the Standard Views dropdown, you can also select a display orientation of Front, Back, Left, Right, Top, Bottom or Isometric.

**Note**
Selecting a Standard View when the Active Camera Type is selected will also update the Real-Time View.

Choose the Perspective or Orthographic Camera Type to unlink the real-time viewing mode from the Geometry View allowing you to control the two views independently of each other. However, you will still see the real-time movement and position of the active camera.
**Geometry Editor**

Enjoy the freedom of splitting surfaces, calculating vertex normals, and closing open boundaries directly inside of the KeyShot OpenGL View.

Click *Edit Geometry* on the *Geometry View* ribbon and select a part from the part list. You can also right-click on a part in the Scene Tree or Real-time View and select *Edit Geometry* to launch the *Geometry View* and the *Geometry Editor* dialog.

### Geometry Editor Mode

- **Split Object Surfaces**
  - Use the *Split Object Surfaces* option if you would like to split specific polygons from a single part. This is useful if you would like to apply separate materials to a single part, or when parts are modeled together and you would like to work with the separately.
    - **Splitting Angle**
      - Use this to let KeyShot automatically determine where you would like to split the part based on the angle adjacent polygons. Any polygon that has a face at an angle that is less than the value entered will be highlighted. This is useful when the split is a clear crease or angle in the part.
    - **Polygons**
      - Use this to select individual polygons from the surface. Hold control while you click on the part to highlight the individual polygons.
    - **Show Wireframe**
      - Enable this to show the wireframe of the part.
  - **Split All**
    - Once the polygons you want split are selected, click *Split All* to create a part for each individual polygon selected.
  - **Split Object**
    - Click *Split Object* to group the selected polygons into a single part.
  - **Merge Selection**
    - If you would like to merge certain split parts back, hold shift and select the parts you would like to merge and click *Merge Selection*.
    - To finalize the split, click *Apply* to create the new parts in the scene tree.

### On this page

- Geometry Editor Mode
- Split Object Surfaces
- Split Separate Objects
- Edit Normals
- Close Mesh
Split Separate Objects

Use Split Object when a your model has separate objects grouped into a single part.

Edit Normals

A normal is the direction that is perpendicular to a mesh surface. In a 3D model, the directions of your normals should all be facing the same direction, otherwise holes might appear. Also if your vertex normals are not aligned, flat spots might appear on what you thought would be a curved surface.

If your model appears to have a hole or flat areas, try to unify the normals by using the Edit Normals tool.

Select the faulty part, and enable the Show Vertex Normals and Show Face Normals. If you see the normal of the missing polygon pointing in the opposite direction or if the vertex normals from adjacent polygons are not aligned, use the Calculate Vertex Normals.

Adjust the Minimum Edge Angle to ensure that edges that do have a crease are not aligned as well.
Close Mesh

If you have an open polygon with a hole, use Close Mesh to fill in missing polygons.

In the Close Mesh window, KeyShot will list the open edges of the part you selected. You can select individual continuous holes and click Close Selected Edges and KeyShot will create the polygons to fill in the hole. If you have 2 holes in a part and want to create a solid connection between those two holes like a donut, select the 2 holes and click Join Selected Edges.
Close Mesh

Select a continuous edge boundary to close or a group of edges to connect.

<table>
<thead>
<tr>
<th>Index</th>
<th>Edges</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>1</td>
<td>71</td>
</tr>
<tr>
<td>0</td>
<td>117</td>
</tr>
</tbody>
</table>

[Close Selected Edges] [Connect Selected Edges]
Model Sets

Model Sets allow you to save independent Scene Tree variations in a single .bip file.

The Model Sets interface is located in the Project > Scene tab as a sidebar on the left side of the panel.

When a Model Set is selected in the sidebar it's properties will be displayed in the sub-tab below and the contained Models will be listed in the Scene Tree.

- **Show/Hide** Visibility of Model Sets can be toggled via the checkbox in the sidebar or by right-clicking and selecting Make Model Set Active. More than one Model Set can be active at a time.
- **Switch** Double-clicking a Model Set in the sidebar will make it active and deactivate all others (except Always Visible).
- **Lock/Unlock** Locking a Model Set will lock all contained models and parts.
- **Reorder** Model Sets can be reordered by drag-and-drop in the sidebar list.
- **Rename** Model Sets can be renamed via the right-click menu in the sidebar or in the Model Set properties sub-tab.
- **Always Visible** Model Sets can be set to Always Visible via the right-click menu in the sidebar or in the Model Set properties sub-tab. This will hide the checkbox in the sidebar. This is mostly useful for staging geometry such as a ground plane or props.

Adding Model Sets

A new Model Set can be added by clicking the Add Model Set icon above the Model Sets sidebar, which will launch the Add Model Set dialog. Here you can give it a name, specify some options and see an overview of the models to be cloned into the new Model Set.

You can also access this dialog by selecting the models/parts in the Scene Tree you wish to include in the new Model Set > right-click and select Create Model Set from Selection.

Model Set Preview Thumbnails

A preview thumbnail will automatically be generated at the time of creation based on what is currently visible in the Real-time view.

**Render Preview:** The preview thumbnail can be manually generated at any time by clicking the Render Preview button in the Model Set properties tab, via the right-click menu in the Model Sets sidebar or via the icon above the Model Sets sidebar.

**Thumbnail Size:** Also available via the icon is the ability to select the size of the thumbnails that are displayed in the
sidebar or the option to not show them at all.

Thumbnail Render Settings:

- **Samples**: number of samples used to render the thumbnails and enable
- **Center and Fit**: If you wish to use the current camera for the thumbnail preview make sure Center and Fit is disabled.
- **Render High Res**: If you are using the Configurator and wish to display your Model variation thumbnails larger than 256px you will have to select Thumbnail Render Settings from the settings dropdown menu and enable "Render High Res".
Export
There are three primary methods for generating output from KeyShot.

1. Screenshots
A screenshot of the Real-time View can be generated by selecting the Screenshot button on the Toolbar or by hitting the P-key. Learn more about the Screenshot option here.

File format output:
- JPEG
- PNG

2. Render Output
KeyShot can create still images, animations, and interactive web visuals with unlimited resolution. Learn more about render output options here.

File format output:

<table>
<thead>
<tr>
<th>Still Images</th>
<th>Animations</th>
<th>KeyShotXR</th>
<th>Configurator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Output</td>
<td>Video Output †</td>
<td>Image Output</td>
<td>Image Output †</td>
</tr>
<tr>
<td>• JPEG</td>
<td>• AVI (MPEG4)</td>
<td>• JPEG</td>
<td>• JPEG</td>
</tr>
<tr>
<td>• TIFF* (8 bit)</td>
<td>• AVI (Uncompressed)</td>
<td>• PNG*</td>
<td>• TIFF* (8 bit)</td>
</tr>
<tr>
<td>• TIFF* (32 bit)</td>
<td>• Quicktime (MPEG4)</td>
<td>• Supporting Files</td>
<td></td>
</tr>
<tr>
<td>• EXR* (32 bit)</td>
<td>• Quicktime (Uncompressed)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• PNG*</td>
<td>• Flash Video</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• PSD†</td>
<td>• HTML</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• PSD† (32 bit)</td>
<td>• JS</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Frame Output † |
| • JPEG       |
| • TIFF* (8 bit) |
| • TIFF* (32 bit) |
| • EXR* (32 bit) |
| • PNG*       |
| • PSD*       |
| • PSD* (32 bit) |

*alpha channel option
† KeyShot Pro only

3. Export Options
KeyShot Pro adds additional 3D output options to extend operations for specific workflows. The export options can be found in the KeyShot File menu.

File format output:
• **OBJ** - A simple, but ubiquitously supported 3D format.
• **FBX** - Widely supported 3D format owned by Autodesk.
• **GLB/GLTF** - "The jpeg of 3D". Designed to bridge the gap between 3D content creation tools and modern 3D applications. See the following guides for additional information on working with glTF data: GLB Tutorials on Facebook
• **STL** - A common 3D format mostly used in 3D printing.
• **ZPR (Windows only)** - A 3d format developed by Z Corporation. Used in 3D printing.

**Note**
The GLTF format does not support following material types: Flat, Thin Film, Translucent, Advanced, Anisotropic, Gem.
Materials
The sections here cover where to find materials, how to work with materials, common material parameters, and all of the material types and their parameters. Since KeyShot is designed for anyone to create realistic visuals, an understanding of these concepts is not necessary, but can help you gain a deeper understanding of how rendering and material creation work.

In this section
- Material Library
- Assigning Materials
- Editing Materials
- Copying Materials
- Saving Materials
- In-Project Library
- General Parameters
- Material Types
- Color Library
- Color Picker
- Material Graph
- Multi-Materials
- Material Templates
Material Library

Material presets are found in the KeyShot Library, Material tab.

The material presets you see are all created using a KeyShot Material Type. Each library material has been designed to be easy to use with as few parameters as needed. For example, the Metal library materials use the Metal material type and will only display the parameters needed for metal materials. Likewise, the Plastic library materials use the Plastic material type will have only the parameters needed for plastic materials.

Stock Materials

KeyShot ships with 750+ materials ranging from cloths and leathers to metals, plastic and even smoke. The materials are arranged in folders

Custom Materials

You can create your own materials use the library materials as a starting point to edit, copy and save your own materials.

KeyShot Cloud Materials

Thousands of KeyShot materials generated by Luxion, KeyShot partners and KeyShot users are available on KeyShot Cloud. You can access KeyShot Cloud from the far left side of the KeyShot Toolbar or at https://cloud.keyshot.com. Learn more about KeyShot Cloud here.

Additional Materials

A KeyShot Content installer is available for KeyShot 8 users on both Windows and Mac. The installer contains high-quality materials with textures from Poligon that have been excluded form the regular Keyshot installer because of their size. The materials in the Installer are the same as offered in the Content installer for KeyShot 7, but they have been updated to take full advantage of the improvements to KeyShot 8 materials....

Download the installer here:

- KeyShot 8 Content (Win) 700 MB
- KeyShot 8 Content (Mac) 710 MB

Content Installation

After downloading, run the installer. During installation, the new resources will be added to your KeyShot Resource folder and visible in the KeyShot library, Materials tab next time KeyShot is launched. The new Poligon folder will be added to your Materials folder.
Note
If you installed the Poliigon material pack in KeyShot 7 and chose to migrate your resources to KeyShot 8. The Poliigon materials will only be overwritten with the new version, if the folder has been moved from the migration folder to the root of the Material library at the time you install the KeyShot 8 Content pack - Otherwise you will have 2 versions of the "same" material.
**Poliigon Textured Materials**

Poliigon textures in KeyShot are encrypted and can only be used inside KeyShot. Below is a cross-reference for all KeyShot Materials using Poliigon textures. If you need the textures for other purposes.

<table>
<thead>
<tr>
<th>Folder</th>
<th>KeyShot Material Name</th>
<th>Poliigon Texture Name</th>
<th>Poliigon Texture Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bricks</td>
<td>Poliigon - Bricks Grey 1,</td>
<td>Bricks 03</td>
<td><a href="https://www.poliigon.com/texture/50">https://www.poliigon.com/texture/50</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Bricks Grey 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Bricks Red 1,</td>
<td>Bricks 02</td>
<td><a href="https://www.poliigon.com/texture/49">https://www.poliigon.com/texture/49</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Bricks Red 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Concrete</td>
<td>Poliigon - Concrete Pitted 1,</td>
<td>Concrete 24</td>
<td><a href="https://www.poliigon.com/texture/18">https://www.poliigon.com/texture/18</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Pitted 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Plates 1,</td>
<td>Concrete Plates 01</td>
<td><a href="https://www.poliigon.com/texture/20">https://www.poliigon.com/texture/20</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Plates 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Spots 1,</td>
<td>Concrete 03</td>
<td><a href="https://www.poliigon.com/texture/16">https://www.poliigon.com/texture/16</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Spots 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Stripes 1,</td>
<td>Concrete 04</td>
<td><a href="https://www.poliigon.com/texture/16">https://www.poliigon.com/texture/16</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Stripes 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Textured 1,</td>
<td>Concrete 36</td>
<td><a href="https://www.poliigon.com/texture/19">https://www.poliigon.com/texture/19</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Concrete Textured 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Grunge Wall 1,</td>
<td>Grunge Wall 039</td>
<td><a href="https://www.poliigon.com/texture/95">https://www.poliigon.com/texture/95</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Grunge Wall 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stone</td>
<td>Poliigon - Granite,</td>
<td>Marble 40</td>
<td><a href="https://www.poliigon.com/texture/11">https://www.poliigon.com/texture/11</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Granite Shiny</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Marble</td>
<td>Marble 11</td>
<td><a href="https://www.poliigon.com/texture/10">https://www.poliigon.com/texture/10</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Solid Surface Countertop 1,</td>
<td>Tiles 19</td>
<td><a href="https://www.poliigon.com/texture/16">https://www.poliigon.com/texture/16</a></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Solid Surface Countertop 1 Shiny,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Solid Surface Countertop 2,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Poliigon - Solid Surface Countertop 2 Shiny</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Material Types**

- Bricks
- Concrete
- Stone
- Plaster
- Tiles
- Wood Flooring
- Fabric
- Wood
<table>
<thead>
<tr>
<th>Material</th>
<th>Texture Description</th>
<th>Tiles</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tiles</strong></td>
<td>Poligon - Tiles Stone Warm 1, Poligon - Tiles Stone Warm 1 Shiny, Poligon - Tiles Stone Warm 2, Poligon - Tiles Stone Warm 2 Shiny</td>
<td>Tiles 03</td>
<td><a href="https://www.poliigon.com/texture/16">https://www.poliigon.com/texture/16</a> 45</td>
</tr>
<tr>
<td></td>
<td>Plaster 1, Poligon - Plaster 2</td>
<td>Plaster 35</td>
<td><a href="https://www.poliigon.com/texture/14">https://www.poliigon.com/texture/14</a> 02</td>
</tr>
<tr>
<td></td>
<td>Poligon - Tiles Marble White, Poligon - Tiles Marble White 2</td>
<td>Tiles Rectangular Marble 001</td>
<td><a href="https://www.poliigon.com/texture/23">https://www.poliigon.com/texture/23</a> 03</td>
</tr>
<tr>
<td></td>
<td>Poligon - Tiles Polished Black</td>
<td>Rectangular Mirror Black 001</td>
<td><a href="https://www.poliigon.com/texture/23">https://www.poliigon.com/texture/23</a> 04</td>
</tr>
<tr>
<td></td>
<td>Poligon - Tiles Polished White</td>
<td>Rectangular Mirror White 001</td>
<td><a href="https://www.poliigon.com/texture/23">https://www.poliigon.com/texture/23</a> 08</td>
</tr>
<tr>
<td></td>
<td>Poligon - Tiles Rectangular Brushed, Poligon - Tiles Rectangular Brushed Shiny</td>
<td>Rectangular Brushed 001</td>
<td><a href="https://www.poliigon.com/texture/22">https://www.poliigon.com/texture/22</a> 99</td>
</tr>
<tr>
<td><strong>Fabric</strong></td>
<td>Poligon - Linen 1, Poligon - Linen 2</td>
<td>Fabric Linen 001</td>
<td><a href="https://www.poliigon.com/texture/24">https://www.poliigon.com/texture/24</a> 1</td>
</tr>
<tr>
<td>Material</td>
<td>Texture Type</td>
<td>Subtype</td>
<td>Website Link</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------</td>
<td>------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Poligon - Wool Basic 1,</td>
<td>Fabric Wool 002</td>
<td>Poligon - Wool Basic 2</td>
<td><a href="https://www.poliigon.com/texture/249">https://www.poliigon.com/texture/249</a></td>
</tr>
<tr>
<td>Poligon - Wool Basic 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Wool Woven 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Poligon - Ash Dark,</td>
<td></td>
<td>Poligon - Ash Dark Shiny</td>
<td></td>
</tr>
<tr>
<td>Wood</td>
<td></td>
<td>Poligon - Beech</td>
<td></td>
</tr>
<tr>
<td>Poligon - Beech,</td>
<td></td>
<td>Poligon - Beech Shiny</td>
<td></td>
</tr>
<tr>
<td>Poligon - Birch,</td>
<td></td>
<td>Poligon - Birch Shiny</td>
<td></td>
</tr>
<tr>
<td>Poligon - Birch</td>
<td></td>
<td>Poligon - Birch</td>
<td></td>
</tr>
<tr>
<td>Wood</td>
<td></td>
<td>Poligon - Cherry 1,</td>
<td></td>
</tr>
<tr>
<td>Poligon - Cherry 1 Shiny,</td>
<td></td>
<td>Poligon - Cherry 2,</td>
<td></td>
</tr>
<tr>
<td>Poligon - Cherry 2,</td>
<td></td>
<td>Poligon - Cherry 2 Shiny</td>
<td></td>
</tr>
<tr>
<td>Wood</td>
<td></td>
<td>Poligon - Oriented Strand Board (OSB) 1,</td>
<td><a href="https://www.poliigon.com/texture/1709">https://www.poliigon.com/texture/1709</a></td>
</tr>
<tr>
<td>Poligon - Oriented Strand Board (OSB) 2</td>
<td></td>
<td>Poligon - Oriented Strand Board (OSB) 2</td>
<td></td>
</tr>
<tr>
<td>Poligon - Plywood Old 1,</td>
<td></td>
<td>Poligon - Plywood Old 2</td>
<td></td>
</tr>
<tr>
<td>Poligon - Plywood Side 1,</td>
<td></td>
<td>Poligon - Plywood Side 2</td>
<td></td>
</tr>
<tr>
<td>Poligon - Walnut Dark,</td>
<td></td>
<td>Poligon - Walnut Dark Shiny,</td>
<td><a href="https://www.poliigon.com/texture/1685">https://www.poliigon.com/texture/1685</a></td>
</tr>
<tr>
<td>Poligon - Walnut Light,</td>
<td></td>
<td>Poligon - Walnut Light</td>
<td></td>
</tr>
<tr>
<td>Poligon - Walnut Light Shiny</td>
<td></td>
<td>Poligon - Walnut Light Shiny</td>
<td></td>
</tr>
</tbody>
</table>
Assigning Materials

To assign materials to models, drag and drop them from the Materials library onto a part in the Real-time View or in the Scene Tree. Before you drop the material onto the part, you will see a preview of the material on the part beneath the mouse cursor. The material will not be assigned until you let go of the left mouse button.

Once the material has been loaded from the library, a copy will be placed into the In-Project Library in the Material Tab of the Project Window. Any additional materials assigned to the model will also be added to the In-Project Library. If the same material already exists in the In-Project Library, a copy will be created and a number will be appended to that material.

Linked Materials

In some cases a user may want to have one material assigned to multiple parts to be able to make changes to that material, and to have the changes affect all parts. You can add Linked Materials in 3 ways:

- Drag an existing material from the In-Project library onto the parts you want linked.
- Copy a material by selecting a part in the Real-time View with the desired material, right-click and choose Copy Material > Select the part you want linked, right-click and choose Paste Linked Material.
- Drag the same material from the Material Library repeatedly and KeyShot will ask if you want to link the materials.

You can unlink materials by right-clicking on the part and choosing Unlink Material - this will create a numbered copy of the material in the In-Project Library.

Retaining Textures and Labels

If you are dragging a material onto a part that has an existing texture or label, you can retain them and apply them to the new material by holding Alt for textures, or Ctrl for labels.
Editing Materials

There are multiple methods of navigating to the material properties to make changes, but all editing is done in the Material Tab of the Project Window.

You can access the Material Properties using any of the following four methods:

1. Double-click a part on a model in the Real-time View.
2. Double-click the material thumbnail in the In-Project Library.
3. Right-click a part in the scene tree and select Edit Material.
4. Select the part in the Scene Tree and select Edit Material from the Properties pane.

Any of these methods will activate the Project window, Material, Properties for the material assigned to the part. All material edits made will update interactively in the Real-time View. For more detailed information on material settings and types please see the Material Types.

If you are a KeyShot Pro user you can also use the Material Graph for editing the materials.
Copy Materials

When Copying materials it is important to decide if you want separate versions of the same materials or if the materials should be linked.

Linked Materials

When two parts have a linked material any edits made to the material will affect all parts.

There are several methods of copying and pasting materials you want to be linked:

- Press “Shift + Left Click” on a material assigned to a model. That will copy the material. Next, to paste the material, press “Shift + Right Click” on another part. That will copy the same material from the In-Project Library and paste it to another part. This will paste the material as a linked material.
- Drag and drop a material from the In-Project Library onto a part that does not already have that material assigned.
- Right-click a part and select Copy Material in the context menu. Right-click another part and select Paste Linked Material.

Separate Materials

Every time you apply materials that are not linked, an instanced copy of the material will be created in the In-Project Library.

- Press “Shift + Left Click” on a material assigned to a model. That will copy the material. Next, to paste the material, press “Shift + Alt + Right Click” on another part. That will copy the material in the In-Project Library and paste it to another part.
- Drag and drop a material from the Material Library on different parts. Keyshot will ask if you want to link.
- Right-click a part and select Copy Material in the context menu. Right-click another part and select Paste Material.

Hotkeys

Shift + Left Click – Copy Material (Select Material)
Shift + Right Click – Paste Linked Material (Apply material)
Shift + Alt + Right Click – Paste Material (Apply Copy)
Saving Materials
There are two ways to save materials.

- Right-click a material directly on the model and select *Add Material to Library*.
- Click the *Save to Library* icon on the Material Tab in the Project Window.

Once you have gone through either step, a dialogue will prompt you to designate a destination folder in the material library. After the folder location has been selected, the new material will be saved to the library.

**Note**
You can create your own folder to save custom materials. Simply click the add folder icon in the Material Library.
**In-Project Library**

The “In-Project Library” is found in the lower half of the Scene tab (under materials) and in the Material tab below the properties of the current material. Here all materials in the scene will be represented in the form of material ball thumbnails or in a list view.

When a material is pulled from the material library and assigned to a model, a copy of that material is placed in the In-Project Library. If the material is already present in the scene you will be asked if you want to link the materials. If you say no, an instanced version of the material will be added to the In-Project library.

If a material is no longer being used in the scene, it will be automatically removed from the In-Project Library. For example, if a material is assigned to only one part and a new material is assigned to that part, the previous material will be removed from the “In-Project Library” since it is no longer used in the scene.

Multi-Materials (pro feature) will be labeled for easy discovery.

Below the material thumbnails you can select list/grid view, set the thumbnail size and choose to filter what is shown in the In-Project Library.

---

**Material View**

The In-Project library in the material tab also has a Material View option. This will show the structure of advanced materials, created in KeyShot Pro, and allows you to adjust the effects of the nodes even if you are not a KeyShot Pro user.

*In the example to the left you see the properties of a Displace node that creates the water drops on the glass in the ice-water demo-scene that is bundled with KeyShot 8*
The In-Project Library in the Scene tab of the Project panel
General Parameters
Here you will find descriptions of general parameters used in KeyShot materials.

- Diffuse Parameter
- Specular Parameter
- Refractive Index
- Roughness Parameter
Diffuse Parameter

The *Diffuse* parameter will be found throughout many of the material types.

The most basic way to think of diffuse when working in KeyShot is a material’s overall color. However, there is a more technical explanation of what this is that can help when creating materials “scattered” or “spread out.”

Diffuse in the rendering world refers to how light reflects off of materials. Depending on the surface of a material, light rays will behave differently when they hit the surface. If a surface has few or no imperfections, like a polished surface, light rays will bounce straight off. This will produce a shiny or reflective surface. If the surface has many imperfections, like concrete, light rays will be scattered across the surface creating a matte look. This is why concrete is not reflective or shiny.

The diffuse slider on many materials will control the color of the diffuse rays on a material.
Specular Parameter

The Specular parameter is another parameter that will be found with many material types.

Specular reflections are reflections that are bounced off a material surface without scattering. Materials appear reflective or shiny when a surface is polished and has few to no imperfections. When the specular color is set to black, a material will have no specular reflections and will not appear reflective or shiny.

Specular color set to white will give 100% reflectivity for that material. Metals do not have diffuse color so any color will be derived entirely from the specular color. The specular color of plastics should be set to a grayscale value.

The specular parameter will control the color and intensity of the specular light reflections on a material.
Refractive Index

Refractive Index is a material parameter that is found in multiple KeyShot material types. The term might not be familiar, but refraction is something that is seen every day. A good example is when a person sticks their hand in a pool. The light is bent, or "refracted" and the arm looks broken.

Refraction occurs because light travels through different media at different speeds. This reduction in speed is referred to as a material's refractive index (or index of refraction) and is represented by a number. For example, water has an index of refraction of 1.33, glass has an index of refraction of 1.5 and diamonds have an index of refraction of 2.4. This means that light travels through water 1.33 times slower than it does through a vacuum. Light travels through glass 1.5 times slower, through diamonds 2.4 times slower and so on. The slower light travels, the more it is bent and distorted.

Refractive indices for different materials can be easily found online. Once the value is found, it may be entered into the Refractive Index property of a material, and will be accurately represented in KeyShot.

Caustics

Caustics is the pattern of light and color that occur when light rays are refracted or reflected. In everyday life you encounter caustics when you for
example place a glass of water on a table.

**Volume Caustics**
Caustics will now work inherently with volumes (e.g. scattering media), however, caustics will only be applied to light sources outside the volume and this is only supported in interior mode.
Roughness Parameter

The *Roughness* parameter is another setting that will be found on multiple material types in KeyShot.

This is a slider that will add microscopic levels of imperfections to surfaces to create rough materials. The diagram that explains the *Diffuse* parameter can also help explain why materials appear rough. When roughness is added, light rays are scattered across the surface which causes specular reflections to break up. Due to the additional light scattering, rough materials are more challenging and take more processing power to render than perfectly reflective surfaces.

**Samples**

Since glossy materials with some roughness are more complex to render, KeyShot has a setting built in that can improve the accuracy of these rough materials. This setting is called Samples. This allows you to set how many rays are emitted from a pixel in a rendered image. Each ray collects information from its surrounding environment and returns this information back to the pixel to determine the final appearance. You will see the *Sample* slider when you click the expand arrow next to the *Roughness* slider.

**Note**

Interior Mode uses a different and more intelligent approach to samples than the one Product mode uses. The improved approach means that customization of *Samples* only has effect in Product Mode as it is not necessary in Interior Mode.

**Roughness Texture**

If the Roughness parameter has a checkered box next to it, this means

*Increasing samples*
a texture can be applied to control the glossy appearance of the surface. When a texture is applied, dark areas of the texture will have a glossy appearance and white areas of the texture will have a matte appearance.

Read more on the difference between Roughness Textures and Bump Maps [here](#).
Material Types

Material Types bring the power to quickly apply real world, physically accurate material properties to your parts. Each Material Type comes preset with settings to quickly apply or change material with the option to adjust each setting as desired. There are five categories of KeyShot Material Types:

<table>
<thead>
<tr>
<th>Basic</th>
<th>Advanced</th>
<th>Light Sources</th>
<th>Special</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Diffuse</td>
<td>• Advanced</td>
<td>• Area Light</td>
<td>• Cutaway</td>
<td>• Axalta Paint</td>
</tr>
<tr>
<td>• Flat</td>
<td>• Anisotropic</td>
<td>• Point Light</td>
<td>• Emissive</td>
<td></td>
</tr>
<tr>
<td>• Glass</td>
<td>• Dielectric</td>
<td>• IES Light</td>
<td>• Ground</td>
<td></td>
</tr>
<tr>
<td>• Glass (Solid)</td>
<td>• Gern</td>
<td>• Spotlight</td>
<td>• Toon</td>
<td></td>
</tr>
<tr>
<td>• Liquid</td>
<td>• Measured</td>
<td></td>
<td>• Wireframe</td>
<td></td>
</tr>
<tr>
<td>• Metal</td>
<td>• Metallic Paint</td>
<td></td>
<td>• Xray</td>
<td></td>
</tr>
<tr>
<td>• Paint</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Plastic</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Thin Film</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Translucent</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Change material type

This quicktip shows how to change the material type of all parts in the scene in one action. It was made for a previous version of Keyshot, so some elements have changed (e.g. Model Sets) but the overall tip may still be useful.
Diffuse

The *Diffuse* material type is useful for easily creating any kind of matte or non-reflective material. It has only one setting, the diffuse color. Since it is an entirely diffuse material, specular maps are not available.

**Color**

This setting controls the color of the diffuse material. Select the color box to display the Color Picker and select the desired color.
Flat

The Flat Material Type is a very simple material type that produces an unshaded, perfectly even color over the entire part to which it is applied.

This material is often used as a black-out material behind car grills or other meshes. It is also useful to create “Clown Pass” areas, which has uniquely colored flat materials applied to the different parts of a model so that these solid colors can be used to easily create selections in an image editing software. See Layers and Passes to automatically create a Clown Pass.

Color

Click the color thumbnail to launch the Color Picker, which allows you to select the color of the material. The flat material has no shading or other surface properties. It will show the solid color you have selected over the entire part that the material is applied to.
Glass
This is a simple Material Type for creating glass materials.

Compared to the Solid Glass material, this material type lacks the roughness and color density settings. However, it adds the two-sided option which is very useful when you have a part that is just a single surface (no thickness) and you want to make it reflective and transparent, but not refractive. This is commonly used for car windshields.

Color
This sets the overall color of the glass material. Click the color box to open the Color Picker and select your desired color.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts that have this type of material. The default of 1.5 is accurate for simulating most types of glass, but you can increase the value to create a more dramatic refraction within the surface.

Refractive
This can enable or disable the refractive property of the material. When enabled, the material will appear refractive. When it is disabled, the material will not be refractive. You will see reflections on the surface and the surface will be transparent, but light will not bend as it passes through the surface. Disabling this option is very useful when you want to see things that lay behind a surface without the distorted effect that results from refraction.
Glass (Solid)

The Glass (Solid) Material Type provides a physically accurate glass material. Unlike the simpler glass material type, you will find that solid glass simulates the effect color in the glass accurately as it takes into account the thickness of your model.

Color
This controls the overall color of this material type. When light enters the surface, it will take on the color set here. The amount of color that you see in this material is highly dependent on the transparency setting as well. If you have set a color, but it looks too faint, skip down to the transparency section.

Transparency Distance
(Formerly Color Density) This slider controls the depth of the color selected in the Color setting, depending on the thickness of the part to which the material is applied. After setting a color in the Color setting, use Transparency Distance to make that color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at the color of the shallow water at a beach versus the deep blue of a deep ocean. Without this you would see through to the bottom of the deepest ocean as easily as to the bottom of a swimming pool.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts on your model that have this type of material. The default of 1.5 is accurate for simulating most types of glass, but you can increase the value to create a more dramatic refraction within the surface.

Roughness
Roughness on this type of material will spread out highlights on the surface similar to what you see on other, non-transparent, materials. However, it also spreads out the light that is transmitted through the material. This is used to create a frosted glass look. Expand this parameter and you will see a samples setting. This can be set to a low value to produce a more imperfect/noisy result or to a higher value to smooth out the noise/grain for a smoother frosted look.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.
Liquid

The Liquid Material Type is a variant of the Solid Glass material that has the added ability to set the outside refractive index. This allows you to accurately create surfaces that represent the interface between, for example, a glass container and water. See description here.

Color
This controls the overall color of this material type. When light enters the surface, it will take on the color set here. The amount of color that you see in this material is highly dependent on the transparency setting as well.

Transparency Distance
This slider controls the depth of the color selected in the Color setting, depending on the thickness of the part to which the material is applied. After setting a color in the Color setting, use Transparency Distance to make that color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at the color of the shallow water at a beach versus the deep blue of a deep ocean. Without this you would see through to the bottom of the deepest ocean as easily as to the bottom of a swimming pool.

Refractive Index
This controls how much light will bend or "refract" as it passes through parts that have this type of material.

Advanced

Color Out
This option controls the color of the light on the outside of the material. It is an advanced and complex setting, but it is needed when rendering containers with liquid. In the example of a water glass, you will need to have a dedicated surface for where the liquid and glass meet. On this surface, you should set the color of the glass with the transmission out setting and control the color of the liquid with the transmission setting. If the glass and liquid are both clear, set both transmission and transmission out to white.

Refractive Index Outside
This is an advanced, but powerful, setting that allows you to accurately simulate the interface between two different refracting materials. The most common use for this is when you are working on a container with liquid inside, like a water glass. In such a scene you will need a single surface to represent where the glass and water meet. On this surface, you have the liquid on the "inside" and therefore, you should set the refractive index to 1.33. On the "outside," you have the glass, and you should set the refractive index outside to 1.5.

Liquid interfaces
With Keyshot 8 we have improved the handling of liquid interfaces - so you no longer have to split your liquid geometry and set the refractive index separately. Now you can use any material e.g. glass or cloudy plastic to create your liquids. All you have to make sure is that the liquid and the glass geometry overlap ever so slightly.
Liquid interfaces done in Keyshot 8, with overlapping geometry. Rendering from the ice_water.ksp demoscene.
Metal
The Metal material type is a simple way to create polished or rough looking metal materials. It provides quick color adjustment, metal presets and simple settings for quick creation of metal materials.

Metal Type
The Metal material type gives you the option to control the metal by Color or by Measured material preset or complex IOR file.

Color
The Color option provides a quick preset metal appearance with control over Color and Roughness.

Color
This setting is visible when Metal Type is set to Color. This controls the color of reflected light on the metal surface. Select the color box to display the Color Picker and select the desired color.

Roughness
This adds microscopic levels of imperfections to the surface of the material when the values are increased. When this is set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

You can also add a roughness texture by clicking the texture icon next to the roughness setting. Click the texture thumbnail to view and adjust the texture settings or right-click and select Delete to remove it.

Some of the Library materials have a slider icon next to the Roughness setting, in these cases extra adjustment controls have been added for finer tuning of the roughness.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.

Measured
Metal Presets
The Measured options includes 13 scientifically accurate metal presets including Aluminum, Brass, Chromium, Copper, Gold, Iron Magnesium, Nickel, Niobium, Platinum, Silver, Titanium, and Zinc, along with the ability to load Complex IOR files (.ior, .nk, .csv). All metal presets and Custom IOR files provide the additional ability to add an anodized coating with control of Film Refractive Index, Film Extinction Coefficient, and Film Thickness.

Roughness
This adds microscopic levels of imperfections to the surface of the material when the values are increased. When this is set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.

Anodized
Anodized settings are available for all metal presets selected from the Metal Type dropdown as well as loaded Complex IOR files. The colors you see when Anodized is enabled are the result of light interfering with itself in the anodized film and can therefore be hard to predict the outcome. However, the following setting descriptions will help you learn better how to control it.
**Film Refractive Index**
The *Film Refractive Index* setting for anodized metals provides more or less reflection on the surface. Increase the value to get more reflection intensity. The actual film color will be affected by the *Refractive Index*. However, you can shift the colors with the *Film Thickness* setting, so typically you will focus only on finding the desired amount of reflection with the *Film Refractive Index* setting.

**Film Extinction Coefficient**
The *Film Refractive Index* and *Film Extinction Coefficient* determines how light reflects and refracts through the thin film on the metal. The *Film Extinction Coefficient* controls the absorption of light through the film. For small to moderate values, a positive extinction coefficient will darken the color but large values will lead to a bright white metallic reflection. Use an extinction coefficient of 0 for dielectric coatings and use a non-zero extinction coefficient for metallic coatings.

**Film Thickness**
Changing the *Film Thickness* setting will shift the colors you see for the metal with *Anodized* enabled. Increasing the setting to a very high value will result in the effect of layers of colored rings on the surface. It is generally a good idea to stay within a range of 100-1000 nm.

**Controlling Anodized Color**
In general, a larger *Film Thickness/Refractive Index* leads to more colors and an *Film Extinction Coefficient* will darken colors and dampen variation. For all the metal presets, even if anodized is enabled or not, the color can depend on the viewing angle (just as with the color of real-world metals). You will notice slight color tints at grazing angles, especially for Gold and Aluminum.
Paint

The *Paint* Material Type is used when a plain, non-metallic paint appearance is desired. It provides a quick way to set a base color and then control the clear-coat on top.

**Color**
Color is your base layer of paint and the overall color of the material. Click the color thumbnail to open the Color Picker and select your desired color.

**Roughness**
This will add microscopic levels of imperfections to the surface of the material when the values are increased. When this is set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

**Samples**
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will smooth out and provide a more evenly distributed roughness.

**Refractive Index**
This controls the intensity of the clear-coat. 1.5 is a good general starting point. If a more shiny paint is desired, increase the value. Bringing the value down closer to 1 reduces the clear coat effect. This can be useful for making a matte finish.
Plastic

The Plastic Material Type provides the basic settings needed to create simple plastic materials. Set the diffuse (overall color) and add some specular (reflections), then adjust the roughness. This is a very versatile material type that is used for anything from concrete to woods.

Diffuse
This can be thought of as the overall color of the material. Click the color box to open the Color Picker and select your desired color.

Specular
This is the color and intensity of the reflection of light sources within the scene. Black will completely turn off reflections, while white will provide a very shiny plastic look. Realistic plastic does not have color in the specular value, so generally you should use some level of gray or white. However, adding color can give the plastic material a metallic effect.

Roughness
This will add microscopic levels of imperfections to the surface of the material when the values are increased. When set to 0 a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts that have this type of material. The default of 1.5 is accurate for simulating most types of plastics, but you can increase the value to create a more dramatic refraction within the surface.
Thin Film

The Thin Film material type produces an iridescent effect similar to a soap bubble.

Refractive Index

The Refractive Index setting for Thin Film provides more or less reflection on the surface. Increase the value to get more reflection intensity. The actual colors you see in the thin film will be affected by the Refractive Index. However, you can shift the colors with the Thickness setting, so typically you will focus only on finding the desired amount of reflection with the Refractive Index setting.

Thickness

Changing the Thickness setting will shift the colors that you see on the surface set as Thin Film. Increasing the setting to a very high value will result in the effect of layers of colored rings on the surface. It is generally a good idea to stay within a range of 100-1000.

Color Filter

The Color Filter setting acts as a color multiplier for the Thin Film material type. When the Color Filter is set to white the color of the material will be determined by the Thickness setting. Less saturated colors can be used to add subtle hue shifts while fully saturated colors have a greater influence. The Color Filter setting can be textured with color maps to create material breakups such as those seen on solar cells or to add surface imperfections to an optical lens or automotive headlight.
Translucent

The Translucent material type provides control over subsurface scattering properties that are found in many skin, plastic and other materials.

Surface Color
This controls the diffuse color of the outer surface of the material. Consider this the overall color of the material. Something to be aware of with this unique material type is that you will not see the translucent effect of the subsurface color if the surface color is completely black.

Subsurface Color
This setting controls the color that light will take on as it passes through the material. Your own skin is a great example of the subsurface scattering effect. When a bright light shines through the thin parts of an ear or the thin skin between fingers, the light is colored by what lies beneath the surface and comes back more red.

While the light is passing through the surface, it is bounced around in many random directions. This creates the soft translucent effect rather than the direct refraction effect of glass and similar materials.

For plastic materials, you will often set this color to something very similar to the surface color, but perhaps a a bit brighter.

Translucency
This controls how deep light penetrates into and through the surface depending on the units set under Edit, Set Scene Units. The higher your translucency value, the more of the subsurface color you will see coming through the surface. Higher translucency values will also create a softer looking material.

Texture
This affects the Surface Color setting. This color multiplies and blends the surface color. For instance, when the Surface Color is yellow and the Texture Color is blue, the result will be green. When set to white, it will not affect the surface color.

Specular
This controls the intensity of the reflections on the surface. This works together with the Refractive Index setting to further increase or decrease the strength of the reflections on the surface.

Roughness
Increasing roughness will spread and distribute reflections over the surface and create a more matte surface.

Advanced

Refractive Index
This controls how much light will bend or refract as it hits and passes through parts that have this type of material. The default of 1.4 is a good starting point, but you can increase the value to create a more dramatic refraction within the surface.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.

Global Illumination
This options enables Global Illumination for the material independent of the General Lighting setting for Global Illumination.
Advanced

The Advanced material is the most versatile of all KeyShot material types. There are more parameters in this material than in any other. With this variety of parameters, materials such as metals, plastics, transparent or cloudy plastics, glass, leathers and diffuse materials can all be created from this single material type. Material types that cannot be created are translucent materials and metallic paints.

Diffuse
This can be thought of as the overall color of the material. Transparent materials will have little or no diffuse. Metals will have no diffuse with all the color derived from the specular. To fully understand this parameter see the section on diffuse.

Specular
This is the color and intensity of the reflection of light sources within the scene. Black will be 0% intensity and the material will not be reflective. White will be 100% intensity and will be completely reflective. If a plastic material is being created, the specular color should be gray to reduce reflectivity.

Ambient
This will control the color of self shadowing on the material in areas that are not receiving direct light. It can produce unrealistic looks, so it is recommended to keep this set to black unless it is needed.

On the left the material has a green ambient color - on the right the ambient color is black.

Roughness
This will add microscopic levels of imperfections to the surface of the material when the values are increased. When set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.
On the left the material has a roughness of 0 - on the right it is 0.04.

**Refractive Index**
This will control the level of refraction on the material.

On the left the refractive index is 1.3 - on the right it is 2.3

**Diffuse Transmission**
This will cause additional light to be scattered across the surface of the material, which can simulate a translucent effect. It will increase render time, so if it is not needed, the recommendation is to leave it at black.

**Specular Transmission**
This can be thought of as the transparency of the material. Black will be 100% opaque and white will be 100% transparent.
If a transparent glass or plastic is being created, the diffuse should be black with all the color derived from this parameter. Transparent glasses or plastics should also have the specular set to white. If a cloudy plastic is desired, the diffuse can be set to a very dark version of the color set here.

**Roughness Transmission**
This will control the roughness of the refraction. The main difference between this parameter and roughness is that roughness is on the internal portion of the material. This can be used to create a frosted look while still maintaining a shiny surface. The material needs to have some transparency through the specular transmission for the effect to show.

**Samples**
This will control the accuracy of glossy (rough) reflections by increasing the samples that are used.

**Fresnel**
This will control the intensity of the reflections that are perpendicular to the camera. In the real world, materials are more reflective around the edges of objects than they are on areas of objects that are directly facing the viewer or camera. This is enabled by default.

The material on the left has Fresnel checked - the one on the right does not.

**Use Diffuse Map Alpha**
This setting is present for legacy purposes. If you want to have opacity maps on your material, please use the opacity texture.
Anisotropic

The Anisotropic material type gives you advanced control over the highlights on the material surface. On other material types that have a single "Roughness" slider, increasing this value causes the highlights on the surface spread out evenly in all directions. Anisotropic gives you control over the highlight shape by controlling the roughness in two directions with two independent sliders. This material type is often used to simulate a finely brushed metal surface.

Color
When trying to create a metal, the diffuse should be set to black. When set to anything other than pure black, this material type will take on more a plastic look.

Specular
This is the color and intensity of the reflection of light sources within the scene. Black will be 0 intensity and the material will not be reflective. White will be 100% intensity and will be completely reflective.

If a metal material is being created, this is where the color is set.

Roughness X and Y
These sliders control the spread of the highlights on the surface. The X and Y roughness sliders control the highlight spread in independent directions. As you offset the values, the highlights on the surface will stretch out and give a finely brushed effect.

Setting both sliders to the same value will yield reflections that are spread evenly in all directions. In the image,

![Image showing Anisotropic material with different roughness settings]

The material ball on the left has offset values and the right has equal values.

Angle
This rotates the stretched highlights that are produced when the roughness x and y values are offset. The value is in degrees and goes from 0 to 360.
The material ball on the left has an angle of 0 and the right an angle of 90.

**Mode**
This advanced setting controls how the highlights are stretched. There are three unique modes.

- **Linear** (default) which will stretch highlights in a linear way, and is independent of any UV coordinate mapping you may have on the model.
- **Radial mode** is an anisotropic method which simulates the effect you might observe on the play side of a CD. Enabling this mode allows you to choose the center point of the radial roughness with the
- **UV mode** is dependent on your UV coordinates. You can use this to manipulate the anisotropic highlights based on the mapping from your modeling software.

**Linear, Radial and UV mode.**

**Samples**
A low samples setting (8 or lower) will tend to make the surface look more noisy which will give a more imperfect and rough look. As you increase the value the noise will even out more and provide a more evenly distributed roughness.
Dielectric

The Dielectric material type is a more advanced way to create glass materials. Compared to the Solid Glass Material Type, you will find additional settings for dispersion (Abbe Number) and it can also be used to create an accurate interface between glass and liquid.

Transmission

This option controls the overall color of this material type. When light enters the surface it will take on the color set here. The amount of color that you see in this material is highly dependent on the Transparency Distance setting as well. If you have set a color in the transmission, but it looks too faint, try to decrease the Transparency Distance.

Transparency Distance

This slider controls the depth of the color selected in the Transmission setting, depending on the thickness of the part to which the material is applied. After setting a color in the Transmission setting, use Transparency Distance to make that color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at the color of the shallow water at a beach versus the deep blue of a deep ocean. Without this you would see through to the bottom of the deepest ocean as easily as to the bottom of a swimming pool.

Refractive Index

This slider controls how much light will bend or refract as it passes through parts on your model that have this type of material. The default of 1.5 is accurate for simulating most types of glass, but you can increase the value to create a more dramatic refraction within the surface.

Transmission Out

This option controls the color of the light on the outside of the material. It is an advanced and complex setting, but it is needed when rendering containers with liquid. In the example of a water glass, you will need to have a dedicated surface for where the liquid and glass meet. On this surface, you should set the color of the glass with the transmission out setting and control the color of the liquid with the transmission setting. If the glass and liquid are both clear, set both transmission and transmission out to white.

Refractive Index Outside

This slider is an advanced but powerful setting that allows you to accurately simulate the interface between two different refracting materials. The most common use for this is when you are working on a container with liquid inside, like a water glass. In such a scene, you will need a single surface to represent where the glass and water meet. On this surface, you have the liquid on the “inside,” and therefore you should set the refractive index to 1.33. On the “outside,” the glass the refractive index outside should be set to 1.5.

Roughness

Roughness on this type of material will spread out highlights on the surface similar to what you see on non-transparent, materials. However, it also spreads out the light that is transmitted through the material. This is used to create a frosted glass look.

Expand this parameter, and you will see a samples setting. This can be used with a low setting to produce a more imperfect/noisy result or a higher value to smooth out the noise/grain for a smoother frosted look.

Samples

A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.

Abbe Number (Dispersion)
The Abbe number slider controls dispersion of light as it is transmitted through the surface and produces a prismatic effect. This prismatic color effect can be used to create the “fire” effect often desired when rendering gem stones.

A value of zero will disable the dispersion effect entirely. A low value will show heavy dispersion, and as you increase the value, the effect will become more subtle. A setting around 35-55 is a good starting point if a subtle dispersion effect is desired.

**Dispersion Samples**
A low samples setting (8 or lower) will produce a more imperfect/noisy result while a higher value will smooth out the noise/grain and give a smoother look.

**Roughness Transmission**
This will control the roughness of the refractions. The main difference between this parameter and roughness is that the roughness is on the internal portion of the material. This can be used to create a frosted look while still maintaining a shiny surface. The material needs to have some transparency through the specular transmission for the effect to show.
Gem

The Gem Material Type is related to the Solid Glass, Dielectric, and Liquid Material Type. The settings have been optimized to be relevant to rendering gem stones. The Abbe Number (dispersion) control is especially important for gem stone rendering as it produces the “fire” effect that is often desired.

Color
This controls the overall color of the gemstone. When light enters the surface it will take on the color set here. The amount of color you see in this material is highly dependent on the transparency setting as well.

Transparency Distance
(Formerly Transparency) This slider controls the depth of the color selected in the Color setting, depending on the thickness of the part to which the material is applied. After setting a color in the Color setting, use Transparency Distance to make that color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at the color of the shallow water at a beach versus the deep blue of a deep ocean. Without this you would see through to the bottom of the deepest ocean as easily as to the bottom of a swimming pool.

Refractive Index
This controls how much light will bend or “refract” as it passes through parts on your model that have this type of material. The default of 1.5 (the Refractive Index of Lapis Lazuli) is a general setting and will need adjusted depending on the gem you desire. A Table of Refractive Index for Gemstones can be found on the International Gem Society website.

Roughness
Roughness on this type of material will spread out highlights on the surface similar to what you see on other, non-transparent, materials. However, it also spreads out the light that is transmitted through the material. This is used to create a frosted glass look.

Samples
This can be used with a low setting to produce a more imperfect/noisy result or a high setting to smooth out the noise/grain for a smoother frosted look.

Abbe Number (Dispersion)
The Abbe number controls dispersion of light as it is transmitted through the surface and produces a prismatic effect. This prismatic color effect can be used to create the “fire” effect often desired when rendering gem stones. A value of zero will disable the dispersion effect entirely. A low value will show heavy dispersion, and as you increase the value, the effect will become more subtle. A setting around 35-55 is a good starting point if a subtle dispersion effect is desired.

Dispersion Samples
This can be used with a low setting to produce a more imperfect/noisy result or a higher value to smooth out the noise/grain for a smoother look.

Ignore intersecting geometry
When enabled overlapping geometry will be ignored. This is useful for e.g. the prong setting of diamond ring, where the real life deformation made to the prongs when fixing the gemstone is not modeled and the geometry is in fact overlapping.
The Measured material type supports the import of the X-Rite Appearance exchange Format (AxF) and Radiance BSDF format. These formats contain vendor neutral digital material representations that captures the light scattering characteristics for specific physical materials.

**The X-Rite AxF Material Format**

AxF is a digital file format developed by X-Rite that delivers a standardized appearance representation. AxF materials are created from physical material samples scanned using an X-Rite TAC7 Scanner which captures and creates the accurate digital material specifications in the AxF file. AxF files can be accessed from digital material catalogs such as the PatoneLIVE Cloud and imported directly into KeyShot using a Measured material type. Learn more about AxF and how to create them at xrite.com/axf/.

Download AxF sample files from X-Rite

**The Radiance XML BSDF Format**

BSDF (bidirectional scattering distribution function) is a mathematical model used to describe light interactions with surfaces. Developed for the Radiance Renderer, the BSDF file format supported in KeyShot is an XML format containing measured BSDFs defining the distribution function that dictates how the light is scattered and how the material appears.

**Importing Measured Materials**

While editing a material in the Projects, Material tab, select Measured from the Material Type dropdown, the part will appear black and a File location field will appear in the Properties tab. Select the folder icon to select a measured file format. Both the .axf and .xml file extensions are supported.
Metallic Paint

The Metallic Paint material type simulates a two-layer paint job: a base coat and a clear-coat that provides a clean reflection over the entire material.

**Paint Settings**

**Base Color**

This is the overall color of the material for the base coat of paint.

**Metal Color**

This can be thought of as a coat of metal “flakes” sprayed over the base coat. You can choose a color that is similar to base color to get a subtle metal flake effect, or you can choose a contrasting color to get some interesting results. A white or gray metal color is also commonly used for realistic paints. The metal color in the material will show more in the directly lit or brightly highlighted areas of the surface while the base color will show more in the less illuminated areas.

**Metal Coverage**

This controls the ratio of base color to metal color. When it is set to 0, you will see only the base color. When it is set to 1, the surface will be almost entirely covered in the metal color. For most metallic paint materials, you will want this value set close to 0. A setting of 0.25 is the default and a good starting point.

**Metal Roughness**

This controls the spread of the metal color over the surface. When it is set to a low value, you will see the metal color only in small areas around the highlight areas. When it is set higher, the metal will spread more evenly across the entire surface. A setting of 0.15 is the default and a good starting point.

**Metal Flake Size**

Controls the size of the metal flakes - extremely large values recreate a "bass boat" paint.

**Metal Flake Visibility**

Controls the opacity of the metal flakes, on a scale from 0 - 1.

**Samples**

This will control how imperfect or refined the metal effect in the paint will look. A low setting will result in a more noticeable “flake” effect. A higher setting will smooth out the distribution of the metal effect, and it will have less noise/grain. When seeking a pearl effect, use a higher setting.

**Clear-coat Settings**

The clear-coat settings control the top clear-coat layer. Settings are unit-aware and can have a bump map applied that does not affect the base coat.

**Clear-coat Color**

Sets the color for the clear-coat layer. The lighter the color, the lighter the clear-coat. The default is white (completely clear).

**Clear-coat Roughness**

The metallic paint clear-coat layer, by default, provides perfectly clean reflections. However, if a satin or matte paint effect is desired, the clear-coat roughness value may be increased. This will spread out the reflections on the surface for a matte look.

**Clear-coat Refractive Index**

This slider controls the intensity of the clear-coat. 1.5 is the default and a good starting point. If a more shiny paint is desired, increase the value. Bringing the value down, closer to 1, reduces the clear-coat effect. This can be useful for making a matte finish or simulating plastics that have a metallic flake effect.
**Clear-coat Thickness**
Sets the thickness of the clear-coat. This is set as a thickness multiplier that can be textured. A higher value will darken the clear-coat. This setting can be textured by clicking on the texture icon next to the setting. This will override the value and provide additional settings for the texture type selected.

**Clear-coat Bump**
Right-click on the icon to add a texture to the Clear-coat Bump. This will only affect the Clear-coat layer while adding a Bump through the Textures tab will affect both the base and the clear-coat.
Multi-Layer Optics

Layer list
Lists all layers of the material. Note that the first layer is the "base" layer (substrate).

Add layer
You can either add a layer from a file, add a new dielectric layer or add a

Delete layer
This will delete the current layer from the layer list, but the definition will still be available in the Layer Material dropdown.

Layer properties
These properties apply to the layer that is highlighted in the Layer list

- **Layer Thickness** Set the thickness of the layer. The thickness of first layer can not be set, as it is the main material (substrate) of the part.
- **Layer material** Select the material for the layer. The list contains all the materials you have had in the list, also ones from layers that have been deleted. The next to the material drop-down will delete the specification of the current material and replace all instances.
- **Material Name** Here you can edit the name of the material, note that the name will change the name of the material not the layer.
- **Refractive index** This slider controls how much light will bend or refract as it passes through the material. The default of 1.5 is accurate for simulating most types of glass.
- **Abbe Number** The Abbe number controls dispersion of light as it is transmitted through the surface and produces a prismatic effect. A value of zero will disable the dispersion effect entirely. A low value will show heavy dispersion, and as you increase the value, the effect will become more subtle. A setting around 35-55 is a good starting point if a subtle dispersion effect is desired.

Edit specification
Allows you to enter/edit the entire material, including all layers in plain text.

Encrypt Specification
If you want to protect the specifications of your material, you can encrypt it. This will hide information about the layers in the material and the material can no longer be edited.

When the material is encrypted you can Clear Specification. This will delete the specification of the the current material and let you start from scratch. Encrypted materials can not be un-encrypted!

Color
This option controls the overall color of this material type. When light enters the surface it will take on the color set here.

Transparency Distance
This slider controls the depth of the color selected in the Transmission setting, depending on the thickness of the part to which the material is applied. After setting a color in the Transmission setting, use Transparency Distance to make that color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

This physically accurate parameter simulates the effect you can observe by looking at the color of the shallow water at a beach versus the deep blue of a deep ocean. Without this you would see through to the bottom of the deepest ocean as easily as to the bottom of a swimming pool.

Refractive Index Outside
This slider is an advanced but powerful setting that allows you to accurately simulate the interface between two different refracting materials.

**Simulate Substrate Dispersion**
Enabling this will simulate caustics in the substrate if it is a transparent material.

You can learn more about Caustics on the Refractive Index page.
Plastic (Cloudy)

The Plastic (Cloudy) material contains light-scattering particles to replicate complex, scientifically accurate materials such as Polycarbonate or ABS. This material has parameters to control light Transmission, Roughness, Refractive Index, Transparency Distance and Cloudiness. When editing an existing material select Plastic (Cloudy) from the Material Type drop-down.

**Transmission**
This sets the overall light transmission of the cloudy plastic material. A lighter color will allow more transmission. A darker color will provide less transmission. Click the color thumbnail to open the color picker then select your desired color.

**Transparency Distance**
Controls the distance at which the transparency is affected.

**Cloudiness**
This setting affects the overall cloudiness of the plastics. A value of 0 is no cloudiness at all.

**Refractive Index**
This controls how much light will bend or "refract" as it passes through parts that have this type of material. The default of 1.5 is accurate for simulating most types of plastic, but you can increase the value to create a more dramatic refraction within the surface.

**Roughness**
This will add microscopic levels of imperfections to the surface of the material when the values are increased. When set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

**Advanced**

**Cloudiness Color**
This sets a specific color for the internal cloudiness of the plastic.

**Scattering Directionality**
Controls how the light is scattered. A value of 0 is uniform scattering, a negative value will scatter light backwards, a positive value with scatter light forwards.

**Samples**
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.
Plastic (Transparent)

The Plastic (Transparent) material provides the basic settings needed to create simple plastic materials. Set the diffuse (overall color) and add some specular (reflections), then adjust the roughness. This is a very versatile material type that is used for anything from concrete to woods.

Diffuse
This can be thought of as the overall color of the material. Transparent materials will have little or no diffuse color applied.

Specular
This is the color and intensity of the reflection of light sources within the scene. Black will completely turn off reflections, while white will provide a very shiny plastic look. Realistic plastic does not have color in the specular value, so generally you should use some level of gray or white. However, adding color can give the plastic material a metallic effect.

Roughness
This will add microscopic levels of imperfections to the surface of the material when the values are increased. When set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more rough as light is diffused across the surface.

Samples
Within the roughness parameter, you will find a samples setting. A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will smooth out and provide a more evenly distributed roughness.

Diffuse Transmission
This will cause additional light to be scattered across the surface of the material which can simulate a translucent effect. It will increase render time, so if it is not needed, the recommendation is to leave it at black.
Specular Transmission

This can be thought of as the transparency of the material. Black will be 100% opaque and white will be 100% transparent.

If a transparent glass or plastic is being created, the Diffuse Color should be black with all the color derived from this parameter. Transparent glasses or plastics should also have the specular set to white. If a cloudy plastic is desired, the Diffuse Color can be set to a very dark version of the color set here.
Refractive Index
This controls how much light will bend or “refract” as it passes through parts on your model that have this type of material.
Increase the value to create a more dramatic refraction within the surface.
Scattering Medium

With scattering medium you can simulate particle scattering to create such effects as fog or smoke or volumetric lighting such as visualizing beams or rays of light.

Applying Scattering Medium

In the Project window, Material tab, select Scattering Medium from the Type dropdown menu. Textures can be assigned to the Density Texture in the Textures tab. OpenVDB files can be loaded by selecting Volume Map from the Texture dropdown or via the Material Graph and applying it to Density Texture on the Scattering Medium material node.

Adjusting Scattering medium

Properties

Transmission
This option controls the overall color of this material type. When light enters the surface it will take on the color set here. The amount of color that you see in this material is highly dependent on the color density setting as well. If you have set a color in the transmission, but it looks too faint, skip down to the color density section.

Transparency Distance
This slider controls the depth of the color selected in the Transmission setting, depending on the thickness of the part to which the material is applied. Use Transparency Distance to make the Transmission color more or less saturated and prominent. A lower setting will show the color more in thin areas of the model, and a high setting will make the color faint in the thin areas.

Density
Determines how close the particles are - High Density values will make the scattering medium seem more solid, where a low density

Multiple Scattering
When checked the rays will bounce multiple times inside the geometry. This will create a more physically correct representation of the material, but it affects the processing time.

Advanced

Albedo
Albedo is the color of the light scattered by small particles inside the scattering medium. Note, that in media with Multiple Scattering the color of the medium may be the inverse of the albedo color, since the scattering process can prevent light from reaching the observer as it travels through the medium.

Scattering Directionality
Controls how the light is scattered. A value of 0 is uniform scattering, a negative value will scatter light backwards, a positive value with scatter light forwards.

Samples
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.

Textures
Density Texture
The density texture will act as a sort of mask on the material - where the texture is black, no particles will be shown and the amount of particles will increase where the texture is lighter. To use VDB filed on the density texture, add a Volume Map.

Labels
With labels you can add another material onto the surface of the scattering medium. Control the label with the 4 primary Map Types - Diffuse, Specular, Bump and Opacity. - just make sure to add an opacity map when using a label - otherwise you won't be able to see the scattering medium.

Volume Caustics
Caustics work inherently with volumes (e.g. scattering media), however, caustics will only be applied to light sources outside the volume and this is only supported with interior mode.
Translucent (Advanced)

The Translucent material type provides control over subsurface scattering properties that are found in many skin, plastic and other materials. Compared to the Translucent material type, this generally will resolve faster.

Surface Color
This controls the diffuse color of the outer surface of the material. Consider this the overall color of the material. Something to be aware of with this unique material type is that you will not see the translucent effect of the subsurface color if the surface color is completely black.

Subsurface Color
This setting controls the color that light will take on as it passes through the material. Your own skin is a great example of the subsurface scattering effect. When a bright light shines through the thin parts of an ear or the thin skin between fingers, the light is colored by what lies beneath the surface and comes back more red.

While the light is passing through the surface, it is bounced around in many random directions. This creates the soft translucent effect rather than the direct refraction effect of glass and similar materials.

For plastic materials, you will often set this color to something very similar to the surface color, but perhaps a a bit brighter.

Translucency
This controls how deep light penetrates into and through the surface depending on the units set under Edit, Set Scene Units. The higher your translucency value, the more of the subsurface color you will see coming through the surface. Higher translucency values will also create a softer looking material.

Specular
This controls the intensity of the reflections on the surface. This works together with the Refractive Index setting to further increase or decrease the strength of the reflections on the surface.

Roughness
Increasing *Roughness* will spread and distribute reflections over the surface and create a more matte surface.

**Refractive Index**
This controls how much light will bend or refract as it hits and passes through parts that have this type of material. The default of 1.4 is a good starting point, but you can increase the value to create a more dramatic refraction within the surface.

**Samples**
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will even out more and provide a more evenly distributed roughness.
Velvet

The Velvet material is very useful for creating soft fabrics that have the distinct light catching effects that result from the soft fibers in finely woven fabrics.

You will generally be able to do fabric materials well with the plastic or advanced material types - but the velvet material provides control over parameters not found in other material types.

Diffuse

This can be thought of as the overall color of the material. A dark color is generally preferred for both the diffuse and sheen settings as this material can become unnaturally bright when light colors are used.

Sheen

The sheen color is observed as light that appears to be reflected back across the surface from behind, almost as though the surface is backlit. This setting is combined with the edginess control to add a soft sheen across the entire material. The backscatter parameter also gets its color from the sheen setting. Generally, this should be set to a color very similar to the diffuse color, but a bit brighter.

Roughness

The roughness setting determines how evenly the backscatter effect is distributed across the surface. When this is set to a low value, the backscattered light will stay contained within smaller areas. A high value will spread the light across the entire object evenly.

Backscatter

This is light that is scattered across the entire object and is especially apparent in the shadowed areas of the object. It can be used to give an overall soft look to the surface. The color of the backscatter light is set with the sheen control.

Edginess

This controls how far the sheen effect spreads over the surface. A low value will cause the sheen to fade out gradually, while a high value will produce a bright border of sheen around the edges of the surface. A setting of zero disables the sheen effect.

Samples

The samples setting controls how imperfect or refined the backscatter effect appears. A higher value will smooth out this scattered light and will cause it to appear more even. A low value will show a coarser grain/noisiness in the backscattered light. A higher setting, around 32, is often preferred for this setting as it provides a smoother result.
Light Sources

In KeyShot, physical lights are designed as materials that may be applied to parts. Any geometry can be turned into a light source. You can either import new geometry, use existing geometry or add a primitive (Edit, Add Geometry...). Light sources are labeled in the Project window, Scene Tree by a light bulb icon next to the part name.

**Light Source Material Types**

- Area Light
- Point Light
- IES Light
- Spotlight
Area Light

*Area Light* is a material type that will give you a wide range of light dispersion. This will function similarly to a flood light.

![Area Light Material](image)

**Type:**

- **Area Light**

**Properties**

- **Color**

**Power**

- **1 Watt**

**Advanced**

- **Apply to front of geometry**
- **Apply to back of geometry**
- **Visible to Camera**
- **Visible in reflections**
- **Visible in Shadows**

**Samples**

- **9**

**Color**

Here, you can choose the color the light will cast. You can also place a texture in front of the light source to color and mask the emitted light.

The example below shows a planar area light with a **Color Gradient** texture.
For accurate lighting colors, use the Kelvin scale to select accurate lighting temperatures.

<table>
<thead>
<tr>
<th>Color</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>3000 Kelvin</td>
<td><img src="image" alt="3000 Kelvin" /></td>
</tr>
<tr>
<td>4000 Kelvin</td>
<td><img src="image" alt="4000 Kelvin" /></td>
</tr>
<tr>
<td>5000 Kelvin</td>
<td><img src="image" alt="5000 Kelvin" /></td>
</tr>
<tr>
<td>6500 Kelvin</td>
<td><img src="image" alt="6500 Kelvin" /></td>
</tr>
</tbody>
</table>

**Power**

The power of the light can be controlled in either Watt, Lumen or Lux. Lumen or Lux are recommended for best results. The choice between Lumen or Lux depends on the preferred workflow.

**Lumen**

When the Power unit is set to Lumen, then the light output is specified as luminous flux. **Total light output will be constant** for
area light objects of different sizes.

The examples below show the effect of increasing the size of a square area light from 10 to 200 mm. Power is a constant 250 Lumen.

<table>
<thead>
<tr>
<th>Size</th>
<th>Lux</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 mm x 10 mm</td>
<td></td>
</tr>
<tr>
<td>50 mm x 50 mm</td>
<td></td>
</tr>
<tr>
<td>100 mm x 100 mm</td>
<td></td>
</tr>
<tr>
<td>200 mm x 200 mm</td>
<td></td>
</tr>
</tbody>
</table>

**Lux**

When the Power unit is set to Lux, then the light output is specified as luminous emittance. 1 Lux equals 1 Lumen per square meter of light-emitting surface. **Total light output will vary** for area light objects of different sizes. Small area lights are dim, while large area lights are brighter, since the light-emitting surface area is larger.

The examples below show the effect of increasing the size of a square area light from 10 to 200 mm. Power is a constant 25000 Lux.
Apply to Geometry

There are two checkboxes to make an area light emit from the front, back or both sides of the geometry. Which side of the geometry is interpreted as front or back depends on the orientation of the surface normals.

Toggling these options is most useful for surface geometry without thickness.

Apply to Front of Geometry

Select this to make the light source emit from the front side of the surface geometry.

The example below shows a planar area light, emitting from the front side.

Tip!
The softness of shadows from an area light is closely related to its size. A large area light produces soft shadows, while a small area light results in harder shadows with crisply defined, sharp edges.
Apply to Back of Geometry

Make the light source emit from the back side of the surface geometry.

The example below shows a planar area light, emitting from the back side.

The example below shows a planar area light, emitting from both the front and back side.
Visible to Camera

Here, you can toggle whether or not the light source geometry is shown in real-time window and renderings.

The examples below show the effect of toggling visibility to camera.

Visible in Reflections

Here, you can toggle whether or not the reflection of the light source is shown in real-time window and renderings.
The examples below show the effect of toggling visibility in reflections.

<table>
<thead>
<tr>
<th>Reflections in Plastic material</th>
<th>Reflections in Metal material</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible in Reflections = checked</td>
<td>Visible in Reflections = unchecked</td>
</tr>
<tr>
<td>Visible in Reflections = checked</td>
<td>Visible in Reflections = unchecked</td>
</tr>
</tbody>
</table>

Visible in Shadows

Here, you can toggle whether or not the light source geometry casts a shadow in the real-time window. Disabling allows light to pass through the area light object. This option is disabled by default so as not to block any other light sources, including HDRI lighting.

The examples below show the effect of toggling visibility in shadows. The scene is lit by a large area light with a warm color (HSV: 30°, 90%, 100%) and a slightly smaller area light with a cool color (HSV: 225°, 35%, 100%) directly below it. Visible in Shadows is toggled for the smaller, cool area light.
With Visible in Shadows checked, the cool area light blocks the warm area light. As a result, the cool area light is the predominant light source in the scene, causing a clear blue cast.

With Visible in Shadows unchecked, light from the warm area light is able to pass through the cool area light. As a result, both area lights are contributing more or less equally to the scene’s lighting. The cool and warm light now blend, causing a warmer cast.

**Samples**

Use this slider to control the amount of samples used in the render.

**Limitation**

ZSpheres transferred from ZBrush are not yet supported as Area Lights.
Point Light

Applying a *Point Light* to geometry replaces it with a point located in the parts center.

**Properties**

- **Color**
  - Color = 3000 Kelvin
  - Color = 4000 Kelvin
  - Color = 5000 Kelvin
  - Color = 6500 Kelvin

- **Power**
  - 1,808 Watt

- **Radius**
  - 2,165 mm

Color

Here, you can choose the color the light will cast. For accurate lighting colors, use the Kelvin scale to select accurate lighting temperatures.
Power

Power determines how strong the light source is. It can be set in Lumen or Watt, where Lumen is recommended for the most accurate result.

Radius

Adjust the radius to control the softness of shadows cast from this light. A large radius gives soft shadows, while a small radius results in harder shadows with crisply defined, sharp edges.

Note

The effect of radius depends on the size of models. Larger models may require a higher radius value for a similar effect.
IES Light

When using IES Light, you will need to load an IES profile by clicking on the folder icon in the editor. As soon as you load the profile you will see the shape of the IES profile in the material preview. You will also see the shape in form of a mesh in the Real-time View.

File

This displays the name and location of the IES profile being used. Click the folder icon to change to a different IES profile.

Color

Here, you can choose the color the light will cast. Use the Kelvin scale to select accurate lighting temperatures.

Multiplier

Adjust the intensity of the light with this slider.
Radius

Adjust the radius to control the softness of shadows cast from this light. A large radius gives soft shadows, while a small radius results in harder shadows with crisply defined, sharp edges.

Note:

The luminous flux (luminous power of the light) is embedded in the IES file itself as a value in Lumen. The Multiplier adjusts this value. For the most accurate result, the Multiplier should be left at a value of 1. Values between 0 and 1 can be used to simulate the behavior of a dimmer.

Radius = 0 mm
(The unit depends on the Scene Units.)

Radius = 5 mm

Radius = 10 mm

Radius = 20 mm

Light Axis

Here you can control the axis of your IES Light source.

Tip
If you have imported a scene where the axis orientation is different from the one in your light sources, you don't have to rotate them - just choose the appropriate up-axis.

Note

The effect of radius depends on the size of models. Larger models may require a higher radius value for a similar effect.
Spotlight

A Spotlight can be thought of as a Point Light where the output is clipped, so that the light is emitted in a cone. This will function similarly to spotlights used in stage lighting to create pools of light.

Color

Here you can set the color of the light. You can also place a stencil texture in front of the light source to control the shape and color of the emitted light - as you see it in real-life gobos.

Color Stencil Diameter

If you use a texture on the spotlight, this slider specifies the width of a virtual stencil disc that always fits the Spotlight's beam exactly.

Tip

The stencil diameter is related to the width of the texture. If both are the same width the texture will fit the beam. If the texture is wider than the stencil it will be cropped, while textures that are smaller than the stencil will be repeated.

Color Stencil example

The following image is used as a Color texture.
Power

Power determines how strong the light source is. It can be set in Lumen or Watt, where Lumen is recommended for the most accurate result.

Constant Light Output

This checkbox does not change the physical behavior or correctness of the Spotlight, but is there for convenience when adjusting Power or Beam Angle, depending on the preferred workflow. This setting allows to switch between constant total light output (checked) and constant illuminance (unchecked) when adjusting the Beam Angle.

Note

Illuminance is the luminous power incident on a surface.

Constant Light Output is checked

The entered Power value is the luminous flux of the clipped point light, i.e. the light emitted in the beam cone. The power of the Spotlight beam will be identical to the Power value. This also means that total light output with a large or small Beam Angle will be constant. Thus, illuminance will not be constant when changing the Beam Angle. Illuminance with a small Beam Angle will be higher than with a large Beam Angle, since the light is concentrated into a narrower beam.

The animation below shows the effect of checking Constant Light Output with an animated Beam Angle.
**Constant Light Output is unchecked**

The entered Power value is the luminous flux of the unclipped point light, i.e. the light ignoring the beam cone. The actual power of the Spotlight beam will be a fraction of the Power value, since the light output is clipped by the beam. Thus, total light output with a large Beam Angle will be higher than with a small Beam Angle. At the same time, **illuminance will be constant** when changing the Beam Angle.

The animation below shows the effect of unchecking Constant Light Output with an animated Beam Angle.
Sets the angle that determines the size of the beam - the higher the angle the wider the beam.

**Falloff**

Falloff determines the point from where the beam is dimmed toward the edges. The scale reflects the radius of the beam, where 0 is on the outer edge of the beam and 1 is in the center.

The higher the number, the softer the transition from light to dark will be.
Radius

Adjust the radius to control the softness of shadows cast from this light. A large radius gives soft shadows, while a small radius results in harder shadows with crisply defined, sharp edges.

Note

The effect of radius depends on the size of models. Larger models may require a higher radius value for a similar...
Increasing the radius will also blur any stencil texture projections.
Cutaway

The Cutaway material enables you to non-destructively subtract geometry from your model.

**Setting up the Cutaway Material**

Simply add the geometry you want to use for the cut, place it so it cuts into your model and assign the cutaway material to it.

**Tip**
You can import simple geometry (sphere, cube etc.) into your scene from the Main Menu, Edit, Add Geometry.

**Cap Types**

- **No Caps** - The cuts will be left open.
- **Inherit Caps** - The cuts will be capped with the material of the part that is cut into.
- **Color** - The cuts will be capped with a solid color. When this option is selected the cap color will be shown - click the color input to set another color.
- **Material** - Use another material for the caps. Drag a material from the Library to the material field in the cutaway material properties. Click the material field to edit the material.

**Excluded Objects**

If you only want to cut into some of the parts of your model you can exclude objects from the cutaway. Click the add button and select the nodes you want to exclude. To remove a part from the exclusion select it in the list and click the delete button.

**Limitations**

- Opacity maps on cutaway caps are not supported.
- Fade Animations are not supported with cutaway materials.
- Show Caps is intended to be used together with fully closed surfaces (solids). Caps may show artifacts with non-closed geometry.

**Known Issues**

- If you have two co-planar parts where one is excluded from the cutaway and you use inherit caps or material caps. Artefacts can occur on the surface of the excluded material.
- Cutaway material may interfere with shadows on the environment ground. If the cutaway object touches the environment ground it will cut that just as it cuts into regular parts.
  **Workaround:** Add a groundplane (Edit > Add Geometry > Add Ground Plane) and exclude it from the cutaway.
- When the Camera is inside the cutaway object, Color caps do not show and when using Material caps, all objects in the scene will be displayed with the cap material.
- Cutaway with Inherit caps used on transparent materials may produce artefacts. Following material types are affected:
  - Glass (solid)
  - Translucent
  - Dielectric
  - Gem
- Multi-Layer optics
- Plastic (Cloudy)
- Plastic (Transparent)

- Excluded objects have incorrect reflections - Objects excluded by cutaway show reflections of the inside of the object being cut.
- Bad Shadows on excluded objects.
- Basic Glass and Thin Film appear as metal when applied to an excluded cutaway object - Product mode only!
- Wrong shading on Toon material when used for cutaway with inherit caps or as material caps. The cut will appear to have color caps instead of the desired Toon appearance.

**Possible workaround:** Try to disable Material Contour in the Advanced settings of the Toon material.
Emissive material type can be used for small light sources such as LEDs, lamps or even illuminated screen displays. It is not meant to illuminate scenes as a main light source. The emissive material will need “Global illumination” enabled in “lighting” to illuminate other geometry in the realtime view. It will also need ground illumination to illuminate the ground plane as shown. Color textures can be mapped to the material and any colors included in the texture will be emitted as light. When using emissives, it is a good idea to enable “Bloom” under effects in realtime settings. This will create the glowing effect shown in the image.

Intensity
This will control the intensity of the light that is emitted.

Color
This will control the color of the light emitted from the material.

Advanced

Visible to Camera
Hide the emissive material from the camera, but the emissive material will still emit light.

Visible in Reflections
Hide the emissive material from any specular reflections. The effect of the emissive will only be seen on the diffuse component of materials.

Two-Sided
This will cause the emissive light to display on both side of the surface.

Use Color Map Alpha
This will allow you to use the alpha channel in the color map.
Ground

The *Ground* material type is a specialised material type for creating a ground for rendered objects. It is a shadow and reflection catching material that blends with the Environment Background. The shadows and reflections will also have transparency when rendering to an image format that supports it.

Simply click *Edit* and select *Add Ground Plane*. This will add a ground plane into your KeyShot scene. The ground material can also be applied to imported geometry.

**Shadow Color**
The shadow that is being cast from the object will be displayed in this color. Clicking the color block will allow you to edit the color.

**Specular Color**
Controls the color of the specular light reflections on a material. When the specular color is set to black, a material will have no specular reflections and will not appear reflective or shiny. Specular color set to white will give 100% reflectivity for that material.

**Refraction Index**
This controls the shape of reflected objects on the surface.

**Reflection Contrast**
Controls the contrast for specular reflections. Can be used to enhance reflections on light backgrounds.

**Clip geometry below ground**
If any geometry is being displayed below the ground plane material, this option will clip the geometry below the ground plane, hiding it from the camera.
Toon
The Toon material type allows you to apply a solid color with contour lines to your 3D model. You are able to control the contour width, the number of contour lines, and whether or not shadows are cast onto surfaces. This is useful for creating sketches, product concepts, or technical illustrations. The Toon material type contains the following properties:

Color
This will control the fill color of the Toon material.

Contour Color
This will control the outline of the model.

Shadow Color
This controls the color of the shadows on the model. Activated when the Environment Shadows under Advanced settings setting is enabled. A texture may be applied to control the appearance of the shadow.

Contour Width
This will control how thin or how thick your contour lines will be.

  Outline Width Multiplier
  Increase this value to create a “perimeter line” effect with your Toon material. This will help pop the part from your scene and create a stronger visual contrast.

  Part Width Multiplier
  Use this to increase the line width of part contours and interior edge contours. It will not affect the scene unless Part Contour is enabled.

Contour Angle
This will control the number of interior contour lines in the toon sketch. A lower value will increase the number of interior contour lines and a higher value will decrease the number of interior contour lines.

Shadow Strength
When the Environment Shadows or Light Source Shadows setting is enabled, this controls the strength of each shadow type cast onto the Toon material.

Transparency
Increasing this value will allow light to pass through the geometry. Use this feature on transparent parts, or to show interior views of your model.

Advanced

Contour Quality
This will control the quality of the contour lines. Use a lower value to obtain a rough sketch look, or a higher value for a more clean and precise stroke.

Contour width is in pixels
When enabled, the contour lines are defined using pixels. When this setting is disabled, the contour lines are defined using scene units.

Interior Edge Contour
This will show or hide the interior contour lines in your sketch.

Material Contour
This will allow you to show or hide the contour line that separates each unlinked Toon material. If the Toon materials are linked,
this setting will not have an effect.

Environment Shadows
This will reveal the shadows cast by the model onto itself due to the selected lighting environment.

Light Source Shadows
Controls the visibility of shadows produced by a Light Source (Point Light Diffuse, Point Light IES Profile, or Area Light Diffuse). The shadow appearance will change depending on the settings of your light source.
Wireframe

The Wireframe material type exposes the lines and vertices of each polygon of a surface.

**Width**
Controls the width of the lines (wires) in the wireframe.

**Width in pixels**
When enabled, the wires are defined using pixels. When this setting is disabled, the wires are defined using scene units.

**Wire Color**
This controls the color of the lines of the wireframe.

**Base Color**
This controls the overall color of material, excluding the wires.

**Base Transmission Color**
This value controls the base color transmission. A lighter color will give the appearance of transparency.

**Backside Base Color**
This controls the backside of the base color. On a cube this would be the inside of the cube.

**Backside Wire Color**
This controls the backside of the wire color.
**Axalta Paint**

As the leading manufacturer of auto body paints, Axalta has created several collections of KeyShot materials that are an accurate representation of the real world paints they provide.

You can find a selection of the materials in the Material Library and find even more materials on the [Axalta Collections website](http://www.axaltacollections.com).

As the paints are developed by Axalta you can not create new ones from scratch, but you can tweak the colors and make adjustments to roughness and reflection.

**Color Tweaker**
Advanced option for fine adjustments to the way the paint behaves when viewed at certain angles.

**Roughness**
This adds microscopic levels of imperfections to the surface of the material when the values are increased. When this is set to 0, a material will appear perfectly smooth and polished. When the value is increased, the material will appear more matte as light is diffused across the surface.

**Advanced**

**Refraction Index**
This slider provides controls the reflection on the surface. Increase the value to get more reflection intensity.

**Samples**
A low samples setting (8 or lower) will tend to make the surface look more noisy, which will give a more imperfect and rough look. As you increase the value, the noise will smooth out and provide a more evenly distributed roughness.
**Xray**

The Xray material type provides a useful tool for illustrative renderings. It is often used to create a faded view through an outer shell.

**Color**

When applied to a part, the Xray effect works by showing more of the material color on areas of the surface that are being viewed at more of an angle. The surface is nearly completely transparent where it is viewed at a direct angle.

Note: the Xray material does not cast shadows.

*Xray material with different colors.*
Color Library

Applying Colors

The KeyShot Color Library lets you drag and drop predefined colors onto any part or object in the Real-Time View. This will replace the primary color of the material. If you want to replace any of your materials other color parameters, you can press Alt while you drag the color onto the material. This will give you a choice between all color values of the material.

Search

Searching for colors can be done by clicking in the search box in the top right and typing the name of the color.

Find similar colors

Searching can also be achieved by clicking the crosshair icon in the top right area of the dialog. This will open a window with a color picker, where you can either enter the color you are looking for or use the eyedropper to select a color in the scene. This will filter the swatches in the current color group so only colors similar to the one you searched for are shown. Click refresh to clear the search again.

Import

You can import Color libraries from .KCP or .CSV files. Note that the imported colors will be placed in the currently active Color Group. So you may want to create a folder for the purpose before importing.

When creating a CSV file, the color entries need to follow these formats

- **RGB** - Name; R; G; B;
- **RGB (0-1)** - Name; R; G; B;
- **HEX** - Name; hex code (incl. #);
- **CMYK** - Name; c; m; y; k;
- **HSV** - Name; H; S; V;
- **CIE-L*ab** - Name; L; a; b;

The values can be separated by comma, semicolon, or tab.

Add color groups

You can create your own color groups for your custom colors. Select the folder where you want to add a color group to. Click the add folder icon and give the group a name.

Add color

You can add your own colors in two ways:

- When you are defining a color with the color picker e.g. for a material, click to save the color, choose Color Group and give the color a name.
• Right-click inside the color library and select Add Color. This will launch a color picker where you can define your color. Click OK to save the swatch an.

**Export Color Group**

You can also export color Groups - this will create a .kcp file.

**Read-only color groups**

Color groups that have a little lock icon next to the name, contain industry standard colors such as PANTONE, RAL and FED-STD 595 and these can not be added to or exported.
**Color Picker**

The Color Picker can be accessed anytime a color property is clicked. The Color Picker gives you the ability to both change colors quickly or test colors visually. Colors may be changed using the Color Bar, Color Map, Color Sliders (and their numerical inputs), or by dragging and dropping from the Color Swatches.

**Color Bar**

The Color Bar area contains the current color and a comparison of the *New/Old* color if the current color is changed. It also has the Eye Dropper tool and the option to save a color to the Library.

**Color Map**

KeyShot contains both a Hue Color Field (default) and a Traditional Triadic Color Wheel. These can be toggled at the lower left of the Color Map. The current color will be located on the Color Map by a white/black circle.

**Color Sliders**

The Color Picker also provides Color Sliders for various Color Spaces and Value scales. The Color Space can be changed from the Color Space dropdown menu at the lower right corner of the Color Map. The following options are available:

- **RGB** - Color channels for Red, Green and Blue
- **CMYK** - Color channels for Cyan, Magenta, Yellow, and Black
- **HSV** - Color channel for Hue, Saturation, and Value
- **Grayscale** - Value channel for Brightness
- **CIE-L*ab** - Value channels for Lightness (L), red-green (a), and blue-yellow (b)
- **Kelvin** - Value channels for Temperature

When a Color Map is selected, the Color Sliders will update to provide input for the corresponding Color Space. Though you won’t see the Color Map change when a new Color Space is selected, as you adjust the sliders and inputs the Color Bar and the Color Map will change to display to color selected or values entered. Likewise, the Model will display the new color in the Real-time View.

You can switch between Color Spaces without changing your color, however switching to Grayscale or Kelvin Value scales will limit the color range to those scales.
Color Options

Directly below the Color Map, you will see a gear icon with additional color options.

- **Use gamma corrected values for input**
  Checking this option will apply Gamma correction to the Color Sliders. (Selected on by default.)

- **Apply Image Gamma to colors in Swatches and Color Pickers**
  Checking this option will apply gamma correction to both the color swatches of materials and the Color Picker. This will only adjust the actual color preview, not the values. (Selected on by default.)

Color Swatches

The Color Swatch grid at the bottom of the Color Picker provides quick access to colors you regularly use across scenes. Here, you can quickly add color swatches, refine them and, if desired, save the individual colors to a color folder later. The Color Swatches are loaded with preset colors.

**Add new swatch**
The color(s) represented in the Color Bar at the top of the Color Picker (both **New** and **Old**) can be dragged and dropped to the Color Swatch grid to create your own color palette. Color swatches can be overwritten by simply dragging and dropping new colors onto existing colors or by dragging and dropping within the Color Swatch area itself.

Using the Color Picker

When you open the Color Picker you will see the Color Bar, the Color Map, the Color Sliders and the Color Swatches. The current color will be shown in the Color Bar, located in the Color Map by a white/black circle, and on the Color Sliders with vertical lines and a value corresponding to the Color Space selected from the Color Space dropdown menu.

With the cursor on another area of the Color Map, click to select a new color, or click-hold and drag to change colors dynamically. For finer control over the color, select a Color Space that corresponds to the color control you desire, then use the color/value channels and input fields to adjust to the color desired.

Using the Eye Dropper Tool

The Eye Dropper tool gives you the ability to select any color on your display. When you select the Eye Dropper tool, the color under your mouse cursor will appear in the New Color Bar area. Use the left mouse button to select the color or hit Esc to exit the Eye Dropper selection mode.

Saving a Color

When you have selected your desired color, you may drag and drop the color from the new area of the Color Bar to the Color Swatch grid for later use. To save a New color to your library, click the Save icon. A prompt will appear to choose a Color folder in the KeyShot Library where you would like to save your new color.
Add folder

To add a new folder to the Color Library, go to the Library Color tab and select the New Folder icon or right-click, at the location in the folder list where you want to add the new folder, and select Add. Likewise, the rename or remove a folder, right-click the folder and select Rename or Remove.
Material Graph

The Material Graph facilitates advanced material editing/creation. The feature is available only for users of KeyShot Pro.

You can access the Material Graph from the Material Tab in the Project window. Click the Material Graph button to launch the Material Graph. It opens in a separate window and displays materials, textures, labels and more as nodes in a graph view to visualize connections and relationships within complex materials.
Material Graph User Interface

There are five components of the Material Graph window: Menu bar, Ribbon, Materials & Textures Library, Material Properties, and the Work Area.

1. Material Graph Menu Bar

Material

- **New** This will replace the working material and any textures with a basic diffuse material to start from scratch.
- **Save to Library** will save the working material to the specified folder in your KeyShot Library.
- **Export** This will allow you to export your material as a KeyShot MTL file type in a specified folder.

Nodes

This provides quick addition of nodes to the Work Area.

View

- **Align nodes** This automatically arranges connected nodes in the Work Area.
- **Zoom** With complex materials the Work Area can quickly get crowded - the zoom options allow you to quickly adapt the Work Area to your current material.
- **Preview** Options for previewing individual node settings such as color, alpha, and bump in the Real-Time. You can also stop the preview within this menu as well.

Window

This gives access to hide/show the Material Properties window (4), Materials & Textures Library (5), and the Material Graph Ribbon (2).

2. Material Graph Ribbon

- **Save to Library** - saves the current material to your Material Library

- **Add material node** - adds an "Advanced Material" node*

- **Add Texture node** - adds a traditional texture map and opens the file browser window to select your image file*

- **Add Animation node** - adds a Color Fade node*

- **Add Utility node** - adds a Bump Add node*

*Adds the default node of the category - you can easily switch the node to another type of the same category in the Material Properties window.
To activate a preview mode, select a node you would like to preview. After selecting a node, the available preview modes will become selectable. Click on a preview mode to activate it, which will make the selected node red in the Work Area. To disable the preview mode, click on the activated preview mode again on the ribbon.

- **Align nodes** - align the nodes within the Work Area
- **Zoom to fit** - fit all the nodes within the Work Area
- **Zoom to 100%** - view the nodes at 100% zoom level

**Create Multi-Material** - will convert the current material to/from Multi-Material

**Refresh Geometry nodes** - The geometry shaders (displacement, bubbles and flakes) need to be refreshed before any edits will be visible in the Real-Time View.

### 3. Material Graph Work Area

The Work Area displays all nodes their connections in a graph view.

In the work area you have the following options:

- **Select a node or connection** - left click.
- **Select multiple nodes** - left-click and hold Ctrl (Cmd on Mac).
- **Select multiple nodes** - Shift + left-button hold and drag to use the marquee selection.
- **Delete/duplicate node** - Right click on a (selection of) node(s) to delete or duplicate.
- **Remove/disable connection** - right click on the connection and remove/disable/activate.
- **Add node** - Right click in the Work Area to access the context menu, where you can access the same nodes as those found in the Nodes menu.
- **Zoom in or out of the Work Area** - Use the middle mouse wheel.
- **Move the Work Area** - Click and drag the work area to move it around.

### 4. Material Graph Properties
The Material Properties dialog shows the associated properties for the current node being edited - similar to the Material tab in the Project window but with the option to change node type.

5. Material Graph Libraries

The Materials and Textures Library contains an organized thumbnail display of all the nodes available.
Material Graph Nodes

Nodes are displayed as gray boxes in the Work Area. Each node has different input and output channels depending on the type.

All materials have one Root node (marked with a thicker border) to which all nodes must be connected (either directly or through other nodes) to have effect on the material.

Channel connections are made by clicking on an output channel and dragging and releasing directly onto an input channel or onto the node itself. When it is released onto the node, a context menu will show all the available channel options. Once a connection is made, a blue line will appear connecting the 2 nodes. Right click the line to remove or disable the connection.

A disabled connection will be displayed as a grey dashed line. If you select a connection, it will turn light blue.
Material Node Types

Setting up Material nodes is initially the same as setting up Materials in the Material tab of the project panel - But with the Material Graph you can set up much more advanced materials using a combination of nodes - one thing you can do is add multiple bump textures to your material using Utility nodes ...and much more.

All Material Types are covered in our Materials section:

- Diffuse
- Flat
- Glass
- Glass (Solid)
- Liquid
- Metal
- Paint
- Plastic
- Thin Film
- Translucent
- Advanced
- Anisotropic
- Dielectric
- Gem
- Measured
- Metallic Paint
- Multi-Layer Optics
- Plastic (Cloudy)
- Plastic (Transparent)
- Scattering Medium
- Translucent (Advanced)
- Velvet
- Light Sources
- Cutaway
- Emissive
- Ground
- Toon
- Wireframe
- Axalta Paint
- Xray
Texture Node Types

Texture nodes are initially the same as adding textures in the Material Tab of the Project panel - But with the Material Graph you can set up much more advanced materials using a combination of nodes - one thing you can do is add multiple bump textures to your material using Utility nodes ...and much more.

See our Texture Types covered in our Textures section.

- Texture Map
- Tiled UV
- Tri-Planar
- Video Map
- Brushed
- Mesh
- Weave
- Brushed (Radial)
- Camouflage
- Cellular
- Color Gradient
- Curvature
- Granite
- Leather
- Marble
- Noise (Fractal)
- Noise (Texture)
- Occlusion
- Scratches
- Spots
- Vertex Color
- Volume Map
- Wood
- Wood (Advanced)
Animation Node Types
The Animation nodes are unique in that they allow you to create changing parameters of your materials.
When you add an Animation node to your material, it will automatically be added to the animation timeline as well.
You can select the node and change the settings in the animation properties window.
For more details about Animations, see the Working with Animations page.

Color Fade Animation
The Color Fade animation node allows you to create changing parameters of any of your custom material color swatches.

Color Bar
Here you can set when and what colors will fade from one to the the next. Click on the dropper circle to select it, then use the color swatch to choose a color.
The little triangles shows where the 2 colors are mixed 50-50 and they can be dragged to control the course of the blend.

Add Color Stop
If you would like to fade between more than 2 colors, click on the Add stop button below the color bar to create another color swatch. click and drag the color pins and the gradient apex slider to your desired animation effect.

Delete Stop
If you want to remove a color stop, just select it and click delete.

Time
To control the color change more precisely than by dragging the individual color stops on the timeline (color bar), you can select a color enter in where in the timeline it will become the selected color.

Blend
Check Blend if you want the colors blend into each other otherwise the color change will be instant, at the point of the color stop.

Time Settings
Use these settings to control the timing and duration of the animation - see the Motion Ease types here.

Number Fade Animation
The Number Fade animation node allows you to create changing parameters of any of your numerical properties within your custom material.

To see which parameters you can change for a specific node, connect the Number Fade animation node to the + socket.

**From**
Enter the numerical value you would like the animation to start at. Use the sliders, or type in a specific value.

**To**
Enter the numerical value you would like the animation to end at. Use the sliders, or type in a specific value.

Where the parameter originally is set you will now see the Animation node icon and the original value input will be disabled.

**Time Settings**

Use these settings to control the timing and duration of the animation - see the Motion Ease types here.
Utility Node Types

Utility nodes allow you to combine and add to the other node types.

**Bump Add**

Combine two bump texture maps or procedural textures. Control their interaction by defining the Ratio and Weight in which the two bumps are visible.

**Ratio and Weights**

The Ratio and Weights control the contribution of the two input bump maps to the final bump result.

The Ratio parameter allows to balance the contribution of both input bump maps with a single slider. The default value of 0.5 defines that both bump maps contribute equally to the final bump result. With a value of 0 only Bump 1 affects the material, whereas with a value of 1 only Bump 2 is visible.

The two Weight parameters work like a multiplier for the bump textures' respective Bump Heights. The default values of 1 define that the "strength" of the final bump result reflects those Bump Height values. When the Weight for a bump input is 0, the effect of that bump is nullified. Values higher than 1 amplify the bump effect in the final result.

**Bump Add example**

The following examples show a Plastic material with Bump Add to illustrate the concepts of Ratio and Weight.

---

**On this page**

- Bump Add
  - Ratio and Weights
  - Bump Add example
- Color Adjust
  - Color Adjust example
- Color Composite
  - Color Composite example with Label Opacity
- Color Invert
  - Color Invert example with Label Opacity
- Color Key Mask
  - Tolerance and Fuzziness
  - Color Key Mask examples
- Color To Number
  - Color To Number example with Roughness
- Color Curve Randomize
- Mapping 2D
  - Mapping 2D example
Plastic material with two bump textures
Bump Add with Ratio = 0.5, Weight 1 = 3 and Weight 2 = 1

Variations

Bump Add with Ratio = 0
Bump Add with Ratio = 1
Bump Add with Weight 1 = 1 (Ratio = 0.5 and Weight 2 = 1)
Bump Add with Weight 1 = 10 (Ratio = 0.5 and Weight 2 = 1)

Color Adjust
Colorize and/or modify the existing color of a texture map or procedural texture by adjusting Hue, Saturation, Value, and Contrast. Each of these parameters can be textured.

At default values the texture remains unchanged.

**Color Adjust example**

The examples below shows how a Color Adjust node can be used to easily adjust the color of wood textures.

**Base Material:**

![Wood material with procedural wood texture](image-url)
Material Graph

Color adjusted examples

Color Adjust with Colorize with a red color (HSV: 320, 65, 80)

Color Adjust with Colorize with a green color (HSV: 185, 65, 80)
Color Adjust with Value = 0.2
Color Adjust with Value = 2
Color Adjust with Value = Noise texture

Color Adjust with Contrast = 0.2
Color Adjust with Contrast = 3
Color Adjust with Contrast = Noise texture

Color Composite
Layer and combine two texture maps or procedural textures with control of Blend Mode and Alpha (transparency). The functionality is similar to working with image layers and blending modes in image editing software.

Color Composite nodes are commonly used to create Opacity masks from multiple textures or to add gradients to textures.

**Color Composite example with Label Opacity**

The examples below show how a Color Composite node can be used to create interesting Opacity masks for Label materials.
Flat material showing a Mesh texture

Flat material showing a Color Gradient texture

Flat material showing the blended result using Color Composite with Blend Mode Multiply

The Material Graph structure of above composite

Applying the Label mask
Color Invert

Invert the color of a source texture map or procedural texture. This is commonly done to convert glossiness maps (white = perfectly shiny) to roughness maps (white = maximum roughness), or invert opacity masks.

Color Invert example with Label Opacity
**Color Key Mask**

Mask a specified color within a texture map or procedural texture. Control the strength of the mask by adjusting Tolerance and Fuzziness.

The Invert option allows to easily invert the mask. This effectively turns the Color Key in the unmasked color.
*Tolerance and Fuzziness*

The Tolerance and Fuzziness parameters allow to define the extent of the color mask.

Any color in the source texture, at a "distance" below Tolerance from the Color Key color, will completely be included in the mask. Fuzziness gradually (with falloff) includes more colors beyond that, but does not fade the mask inside the tolerance.

The examples below show a cubic lattice of spheres to illustrate the concepts of Tolerance and Fuzziness.

*Cubic sphere lattice*

Pure red (RGB: 255, 0, 0), green (RGB: 0, 255, 0) and blue (RGB: 0, 0, 255) axes with additive blending

*Metal Label mask*

A Color Key Mask is used to drive the opacity of a Metal label. The Color Key is RGB: 128, 0, 255

<table>
<thead>
<tr>
<th>Tolerance</th>
<th>Fuzziness</th>
<th>Invert</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Color Key Mask examples

This example shows a model with a Mold-Tech plastic material onto which a solid-colored KeyShot logo Label is applied. Color Key Mask nodes can be used to mask out the individual colors.

The images below shows the result of using a Color Key Mask node to mask out the texture's pink color. For illustration, the output from the Color Key Mask node is connected to the Color parameter of a Flat material.
Depending on a texture's colors, the Threshold and Fuzziness values may have to be adjusted in order to achieve a precise and sharp (black and white) mask.

Color Key Mask with Tolerance = 0.25 and Fuzziness = 1 (default values)

Color Key Mask with Tolerance = 0.2 and Fuzziness = 0.4

The basic Material Graph structure for using Color Key Mask to drive a material's parameter: Texture > Color Key Mask > Material.

The two examples below show different applications of Color Key Mask.

Example 1: Label masks
Three Color Key Mask nodes are used to mask out the texture's three solid colors. The masks are connected to the opacity of three Label materials.
Example 1: Displacement mask
Two Color Key Mask nodes are used to mask out two colors of the texture.
One mask is connected to the opacity of a Label material, the other to a Displace node.
The Color To Number node converts color values to number values. This is usually done implicitly such that black is zero and white is 1, however there are times where you need more control. This is quite useful, for example, with roughness maps where you can use Color To Number to easily map a grayscale image to go from e.g. 0.05 to 0.10 – this would be hard to do otherwise.

**Color To Number example with Roughness**

The example below shows a model with a polished metal material onto which a roughness texture will be applied to achieve micro-imperfections on the surface. The third image shows the effect of directly applying above texture to the Roughness parameter of the metal material.
The examples below show the effect of using a Color To Number utility node between the texture and the Roughness parameter.

Color To Number effectively allows to limit the extent of the parameter it drives. The driving values will never exceed the range defined by the Output From and Output To parameters.
The basic Material Graph structure for using Color To Number for Roughness:
Texture > Color To Number > Material

Color Curve Randomize

Add color randomness to curves that are assigned a solid color, texture map, or procedural texture.
Mapping 2D

This node enables you to synchronize and control the position of your textures and labels in one place.

Connect the Mapping 2D node to all the textures you want to control with it and make sure the Mapping type is set to Node in the properties of each texture.

The texture Size and Mapping that is set in the Mapping 2D node is propagated to all textures it is connected to, thus aligning them. When the Mapping Type for the connected textures is set to Node, the Size and Mapping properties of the texture nodes function as offsets from the Mapping 2D properties. For example, Width and Height become scalar (unitless) and are effectively multipliers of the Width and Height set in the Mapping 2D node.

**Note:**
To maintain alignment of textures, Move Texture should only be used inside the Mapping 2D node.

Mapping 2D example

The examples below shows how a Mapping 2D node can be used to perfectly align multiple Labels.
Mold-Tech plastic material with two Labels that should be aligned.
The Width and Height of the colored 'KeyShot Icon' texture is set to 0.02 meter.
The Width and Height of the 'KeyShot Icon White' texture is set to 0.04 meter.
Both textures use Planar mapping and have Repeat disabled.

Mold-Tech plastic material with a Mapping 2D node connected to the Label textures.
The Mapping Type in the Mapping 2D node is set to Planar.
The Width and Height in the Mapping 2D node is set to 0.04 meter.
The Mapping Type in both Label textures is set to Node.
The Width and Height of the colored 'KeyShot Icon' texture is set to 0.5 (effective size = 0.02 meter).
The Width and Height of the 'KeyShot Icon White' texture is left at 1.
The Material Graph structure of this example.
The result of using Move Texture inside the Mapping 2D node.

The result of resizing inside the Mapping 2D node.
Geometry Node types

The Geometry nodes will transform the shape of your geometry in a non-destructive manner. This way you can always replace the material and the geometry will return to the original shape.

On this page
- Bubbles
- Displace
- Flakes

Bubbles

Use the Bubbles node when you want to add spheres inside the material of your object. Make sure the material is transparent to some degree - otherwise the bubbles will not be visible. Add a Bubbles node to the Geometry socket of the Root node.

Size
Set the size of the bubbles

Size variation
Fractional variation of flake size

Density
This slider will adjust how close the bubbles are to each other

Flake Limit
The Flake Limit slider allows you to limit the amount of polygons used to create bubbles. The limit is pr. object, not the overall for the material in the scene.

Density Texture:
If you do not want the bubbles to be distributed evenly inside the object, you can add a texture to control the density. This will act as a sort of mask on the density. Where the texture is black, no bubbles will be shown and the amount of bubbles will increase where the texture is lighter - where the texture is white, the density will be as defined in the Density parameter. In the example below the color gradient is white in the bottom of the material ball and black on top.
Displace

Use the Displace node when you want to transform the surface of the object. Add a Displace node to the Geometry socket of the Root node and add a Texture to the Displace socket of the Displace node.

Displacement Height
The textures's white areas are displaced with the value set in Displacement Height while black areas will not be displaced. Negative values will cut into geometry.

Offset
Adjusts the origin of the displacement. When the Offset is set to 0 (default) the black areas will be on the surface of your geometry.

Resolution
Set the size of the triangles that makes up the displacement.

Max Triangles
Here you can control how many triangles the displacement can use.

Displace: In order for the displacement to have effect on your geometry you need to connect a texture. The light areas of the texture will raise the surface of the geometry while black areas stay.

Note
When you are working with Bubbles/Flakes, it is important that your geometry is a closed mesh. If there are gaps in the mesh, the texture will not be applied.
The Texture has concentric circles of grey. From the center, 0% black, 20% black, 40% black etc.

Contrast = 1: The increase in displacement height is not linear.
Contrast = 0: Each step adds the same increase in displacement height.

Flakes

Use Flakes when you want your object to be made up of flakes of a specific material. Add Flake node to the geometry socket of the Root node.

Flake Shape
Choose if you want the flakes to be square or spheres

Size
Set the size of the flakes

Size variation
Fractional variation of flake size

**Density**
This slider will adjust how close the flakes are to each other

**Flake Limit**
The Flake Limit slider allows you to limit the amount of polygons used to create flakes. The limit is pr. object, not the the overall for the material in the scene.

**Vertex Colors**
With vertex colors enabled you can make the flakes different shades. In the example below the vertex is combined with a color gradient to make the flakes grey, light blue and dark blue.

**Flake UV**
Enables the use of uv maps on your flakes. In the example below the Keyshot Logo is applied as a UV map to each flake which
are made round using the same texture as an alpha opacity map.

*Can only be used with **Square** flakes

**Density Texture:**
If you do not want the flakes to be distributed evenly inside the object, you can add a texture to control the density. This will act as a sort of mask on the density. Where the texture is black, no bubbles will be shown and the amount of flakes will increase where the texture is lighter - where the texture is white, the density will be as defined in the *Density* parameter.

**Note**
Geometry nodes are the only nodes that does not update your material in real time when you edit/set them up.

To see any changes you make you must hit the *Execute Geometry Nodes* in the properties panel, the *Geometry Nodes* in the ribbon or use the hotkey Alt+G, before you can see the effect in the Real-Time View - this will refresh all geometry nodes in the scene.

**Tip**
If you want to bake your displacement into the geometry, you can export your displaced object and re-import it into your scene.

**Known Issues and Limitations**
- Bubbles, Displacement and Flakes are not supported in Render Nurbs Mode
- Attaching a Curve Color Randomizer to a Geometry node causes crash.
- When applying Displacement to geometry with hard edges, these edges become split.
Multi-Materials

Any material can be turned into a Multi-Material to facilitate non-destructive material swapping, variations or color studies. The Multi-Material allows you to cycle through a variety of materials within a single “container” material.

Converting to Multi-Materials

When editing a material select the three-arrow Multi-Material icon above the Material Type dropdown to convert a single material to a Multi-Material.

Warning

Dragging and dropping a material from the library onto the part will overwrite the multi-materials applied. Use Ctrl-Z/Cmd-Z to Undo.

Adding Multi-Materials

There are several ways to add a new material to the Multi-Material list:

- **Drag-and-drop**
  Simply drag-and-drop a material preset from the Materials library into the Multi-Material list.
- **New Plastic**
  Select the New Plastic icon on the left of Multi-Material list. This will add a standard Plastic material.
- **Duplicate Material**
  Select the Duplicate Material icon on the left of the Multi-Material list. This will duplicate the material selected along with any texture and/or label, but keep the textures and labels unlinked.
- **Duplicate Material and Link Textures**
  Select the Duplicate Material and Link Textures icon on the left of the Multi-Material list. This will duplicate the material selected along with any texture and/or label, but keep the textures and labels linked.

Viewing Multi-Materials

To view or edit the different materials in your list, simply select a material to make it active in the Real-time View. You may also use the arrow keys to cycle up or down through the list.

The thumbnail of in the In-Project Library will show the active material combined with a label signifying that the material is a Multi-Material.

Saving Multi-Materials

Like regular materials you create, you can also save Multi-Materials. To save a Multi-Material, select the save icon and select the folder you would like to save it in.
Removing Multi-Materials

To remove a material from the Multi-Material list, select the trashcan icon or hit Delete. Additionally, you may overwrite all materials added to the list by dragging and dropping another material onto the part or cancel Multi-Material setup by selecting the three-arrow Multi-Material icon to close the Multi-Material list.
Material Templates

Material templates automate the material application process e.g. when importing CAD models to the scene.

Material Templates are a powerful feature in KeyShot that automate the materials applied to your model in a scene. Anyone working with large assemblies can save time using Material Templates to automatically apply materials to parts in a scene. Once a material template has been created, it can be used to apply materials to a new model upon import.

With a material template, materials from the KeyShot library are applied to your model's parts based on the name of each part's original materials.

Launch the Material Template window from the Main menu > Window or from the material template icon in the Ribbon.

Create Template

Create a new template by clicking on the add icon.

Method

Two methods can be used in creating a material template, Automatic and Manual.

- **Automatic** – If a model is in KeyShot when you create a new template, the source and material names are automatically populated based on the material applications in the current scene. Only parts that have a KeyShot material will be recorded.

- **Manual** – An empty template is created and you can add template rules manually.

Type

You also have to choose whether the template should apply materials based on part name or original material name.

- **Part name** - This method will apply materials based on the names of the parts, so it requires that the naming of the models are consistent. You can use wildcards to target parts that are named alike e.g. parts with Holder in the example to the left.

- **Source material** - This will make the naming of the parts less important and apply materials based on the source material. If your models have been colored consistently, the source material may be the way to go.

Wildcard

The wildcard refers to the practice of applying a material to several parts using the source name. This can be activated by inserting asterisks (*) to the source name - e.g. Holder* this will apply the material in the destination to all the parts containing "Holder" when the material template is applied.

Each new template is added to the template list, which can be accessed with any scene opened in KeyShot.

Add Template rules

The Automatic approach will populate the template with rules for all KeyShot materials in the scene while the Manual approach requires you to pick the parts you want to set up rules for. You can at any time add rules to the template, no matter if it was created using the Manual or the Automatic method.
A template rule consists of a Source (either part name or source material name) and New Material name.

Use the button next to the template to create a new rule and add a source. Or drag a part from the Scene Tree onto the list - this will create a rule with the name or source file from the part.

Add a Material to the rule by dragging a material from the Material library/Material tab onto the rule in the template list.

Applying Templates

Applying templates can be done through the “Material Templates” window or the import window.

Material Template Dialog

Templates can be applied using the Apply button. This will give you two options: To Scene or To Selection.

- To Scene
  Apply the current template to the entire scene.

- To Selection
  Apply the current template to the selected model or part.

Import Dialog

Expand the Materials and Structure section to reveal the Use material template checkbox.

Enable this setting and select the desired template from the list.

Click Import to complete the import.
Textures
Textures allow images to be mapped to materials to create detailed effects such as wood grain, meshes, tile as well as fine imperfections such as brushed metals.

Texture Library
KeyShot comes with a number of textures which can be found in the Texture Library in the Library window - And more can be downloaded from KeyShot Cloud.

Texture Properties
Textures are applied in the Material properties tab under the Texture tab. Here you find
1. Map Types
2. Texture Types
3. Mapping Types
4. Move texture tool

All are described in the following section.
Texture Library

Access the KeyShot Textures Library by clicking the Library button on the main toolbar, selecting Window, Library from the main menu or by hitting the 'M-key'.

The textures located here provide a range of textures to use for bump maps, color maps, gradients, labels and more. These textures provide a fast way to start applying textures to your materials for added realism or a starting point for developing your own textures.

Search
Here you can search in the Texture Library. To narrow the search you can select a folder before you enter your keyword, then the search will be limited to that folder.

Add Texture folder
You can add your own custom folder to the library. just press the Add folder icon and give the folder a name. Note that the folder will be placed inside the currently selected folder.

Import
If you have textures of your own you want added to the library you can import them.

Refresh
Clears the search and displays all textures again.

More textures are available on KeyShot Cloud.
Texture Types

KeyShot has three primary types of Textures that can be applied to materials: Image Textures, 2D Textures, and 3D Textures. Each of these are accessible from the Project window, Material tab, Texture tab. Image Textures use an image file as a texture. 2D and 3D Textures are procedurally generated textures. The three types of Textures include:

<table>
<thead>
<tr>
<th>Non-Procedural</th>
<th>Procedural</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Textures</td>
<td>2D Textures</td>
</tr>
<tr>
<td>• Texture Map</td>
<td>• Brushed</td>
</tr>
<tr>
<td>• Tiled UV</td>
<td>• Mesh</td>
</tr>
<tr>
<td>• Tri-Planar</td>
<td>• Weave</td>
</tr>
<tr>
<td>• Video Map</td>
<td></td>
</tr>
</tbody>
</table>

Animation

In addition to the regular texture types users of KeyShot Pro can also add Animations (only to Color and Opacity maps)

• Color Fade
• Number Fade

About Procedural Textures

Procedural textures are computer-generated, customizable textures that allow you to control the values and color of the texture. KeyShot allows you to create textures in real-time viewing the changes as you make them. In comparison to traditional texture mapping, procedural textures wrap around your model without leaving seams or stretching, regardless of the model’s shape.

Use the Texture type drop-down to choose the procedural texture you would like to use.
Texture Map

A Texture Map is a type of Image Map. Texture maps and their settings can be viewed in the Project window, Materials, Textures tab.

Adding a Texture Map

Double-click the texture Map Type (e.g. Color, Specular, Bump) you would like to add a texture to. This will open a window where you can choose the image file to apply as a texture map. You may also drag and drop textures from the Textures library.

Removing a Texture Map

If you want to delete a Texture Map, right-click on the texture Map Type and select Delete or select the trashcan icon next to the Texture dropdown. This will remove the selected texture from your material. If you make changes to the image file used for the Texture Map, select the Refresh icon to update the Texture Map and see the changes. If you would like to replace the image file used for the Texture Map, select the File icon to choose a new image file.
Tiled UV

A Tiled UV texture is a type of Image Map. Tiled UV textures and their settings can be viewed in the Project window, Materials, Textures tab.

Tiled UV is KeyShot's approach to UDIM where multiple textures are positioned on the model using UV coordinates. The Tiled UV texture requires that the model have been made ready for it in your modelling software.
The same cubes with a plane plastic vs. Tiled UV texture.

**Applying Tiled UV**

Select your material and add a Tiled UV texture to e.g. the diffuse map.

Browse and select one of the texture tiles. If the tiles are properly named KeyShot will recognize the rest of the tiles and add them automatically.

**Texture Tiles**

To be sure the tiles are recognized and positioned correctly the tiles need to be named according to one of these conventions:

1. NameXXYY - Where you can choose to add a separator between the name and U and V values (e.g. cube_u0_v0, cube_u1_v0 ...)
2. NameUDIM - Where you can choose to add a separator between the name and the UDIM number (e.g. cube_1001, cube_1002 ...)

**Filtering**
For Tiled UV texture you can control the texture filtering for each texture directly:

- **Trilinear** is the simplest and fastest method, but may result in excessive blurring in certain cases.
- **Anisotropic** is higher quality than trilinear and should give less blurring and sharper textures in most cases
- **Elliptic** is the most accurate filtering but can be quite slow.

**Filter Bias**
Adjust the filtering method to give more blurry textures (negative values) or sharper textures (positive values).

**Color**

**Brightness**
Adjust the brightness of the texture tiles.

**Texture Gamma**
Specify the gamma of the source texture. If you use linear color textures set it to 1. If there is doubt about this value, it is likely 2.0 or 2.2. Can also be used as an ad-hoc control of the contrast of the texture.

---

**Note**
Most texture maps are created in 32 bit, which are not gamma corrected. This is why the default gamma value is set to 1. If you are using gamma corrected textures you will need to adjust the Gamma in order to get the right appearance of the colors.
**Tri-Planar**

*Tri-Planar* texture is an type of Image Map. Tri-Planar textures and their settings can be viewed in the *Project window, Materials, Textures* tab.

The *Tri-Planar* texture enables you to create materials that have different textures on the 3 planes of the object - which can be useful when creating such materials as plywood.

This texture type is only available as box mapping, as the essence of the texture type is that it projects a different texture onto each of the X Y Z planes.

**Move Texture**
When using the Move Texture tool the 2 textures that are parallel to each axis will be moved when translating along an axis.

**Angle**
See the *Move Texture* page for description.

**Blend Seams**
If your planes does not meet in hard edges, you will need to blend the 2 textures at the seam. Increasing the value will create a softer blend.

**Projection X Y Z**

**File**
Select the texture you want to be projected onto the X/Y/Z plane of the model.

**Size**
Set the Width and Height of the texture. Lock Aspect will secure a uniform scale of the texture and with reset you can always return to the original aspect ratio.

**Angle**
This will rotate the texture on the current plane.

**Color**

**Brightness**
Adjust the brightness of all 3 textures.

**Contrast**
Adjust the contrast of all 3 textures.

**Blend with color**
This will add a color-blend to all 3 textures.

**Sync**
Check sync if you want to keep this texture synchronized with the other textures on this material.
Video Map

A Video Map texture is an type of Image Map. Video Map textures and their settings can be viewed in the Project window, Materials, Textures tab.

With a Video Map textures, image sequences can be set as Textures (or Labels) to animate device displays and much more.

The supported formats include:

- avi
- mp4
- mpeg
- fiv
- webm
- dv
- flv
- m4v
- mov
- m1v
- mlv
- m4v
- hevc
- ogg
- ogv

Some formats may have variants encoding which are not supported (for example, avi may include encodings which may not be directly supported.)

Adding a Video Map

From Project, Materials, Textures select Video Map from the Texture drop-down menu or Add Label (Video) from the Labels tab. Select an image sequence in the file browser or a video file to extract the frames. This will create a node in the Animation in which you can position and adjust the animation similar to other Animation types.

Frames
To add frames you can:

- add a sequence of images
- select a video and KeyShot will extract the frames for you.

Blend Frames
When enabled the transition from one frame to another will be blended. This can be useful e.g. if the FPS of your video map is smaller than the overall animation in which case blending frames can prevent the video from flickering.

Size and mapping
See the Move Texture page

Color

Brightness
Adjust the brightness of the frames.

Contrast
Adjust the contrast of the frames
Blend with Color
Blend all frames with the selected color

Time Settings

Motion Ease
This will let you add acceleration and deceleration to the video texture. This not something you would usually use for regular
textures videos. But the Video map can also be used for e.g. changing displacement textures in which case motion ease is relevant.

Start, End, Duration

Playback mode
Determines how frames are distributed on the timeline.

- **Video** - All frames are distributed equally on the timeline so they will be visible for the same amount of time.

- **Slideshow** - The last frame is moved to the very end of the timeline and the rest of the frames are distributed accordingly.

This is relevant e.g. when operating with few FSP and blend frames are enabled as shown in the example below, where the
green cube is in video playback mode and the blue is in slideshow mode. Notice that in video mode the 5th frame is visible relatively longer than the other frames.

Playback Count
Here you can set the number of times the video is played.
**FPS** (Frames Per Second)
This sets the frame rate - increasing the frame rate will give a smoother video while decreasing the frame rate will produce a more blurred or even flickering result.
Brushed
The Brushed procedural texture simulates the effects of brushed metal. It is best used as a bump on a metal material with a low roughness value.

**Bump Height**
Use this to set the depth of the brushed texture

**Color**

**Color 1/2**
Use this to set the color for the highlights and shadows of the texture.

**Grooves**

**Length**
Use this to control the length of the brush strokes.

**Contrast**
Use this to control how defined the brush strokes are as a whole.

**Levels**
controls the amount of brush strokes.

**Levels falloff**
Use this to control how defined each brush stroke is.

**Variation**

**Grain**
This slider controls the amount of grain that is added to the brushed texture

**Grain size**
Here you can control the size of the grain

**Distortion**
this slider will add distortion to the brush strokes.

**Apply bump to labels**
When enabled the bump map will also be applied to any labels on the material.
Mesh
Create a pattern of shapes that can be used for meshes in the opacity map, or a shape pattern in color maps.

**Color**

*Color*
This sets the shape color. Set the color to black to create holes if you are using the texture as an opacity map.

*Background*
This sets the background color. Set the color to white if you are using the texture as an opacity map.

*Show Outline*
This enables you to add a colored/textured outline to the shape. The outline is placed on the inside edge of the shape.

*Blend Outline with Color*
When enabled the outline color/texture is blended with the color/texture of the shape.

*Outline Size*
Determines the width of the outline on a scale from 0-1, where 0 is right on the edge and 1 is in the center of the shape.

**Shape and Pattern**

*Scale Mesh*
Scales the size of the mesh affects both the size of the shape and the spacing.

*Shape*
Here you can choose between different shapes for your mesh.

*Falloff*
Adds feather to the edges of the shapes. The slider sets the width of the falloff. A value of 0 is equal to no falloff.

*Shape Diameter/Width and Height*
Depending on the shape size you can set the size of the shapes with diameter/width and height. When setting the width and height you can lock aspect to scale uniformly and reset to revert to the original aspect ratio.

*Shape Angle*
This will rotate the shape.

*Mesh Pattern*
Set the pattern you want to use for your mesh. You can either choose one of the standard patterns or define a custom pattern.

**Variation**

*Jitter*
Increase this value to add deviation to the pattern.

*Distort*
Increase this value to randomly distort the shape.

*Distort Scale*
Values above 1 decreases the distortion scale. Values below 1 increases the distortion scale.
Weave
The Weave procedural texture can be used to simulate many types of fabrics and fine woven meshes.

Color
Background Color
This sets the color of the gaps between the threads.

Warp Color
Sets the color of the vertical threads in the weave.

Weft Color
Sets the color of the horizontal threads in the weave.

Variation
Fibers
Adds a stroked effect to the threads that creates the appearance of fibers in the thread.

Grain
Adds grain to the threads.

Weave Distortion
Makes the threads uneven in thickness.

Color Variation
Adds variation to the intensity of the thread colors.

Width Variation
Makes some threads thinner and some thicker, giving the weave a more handcrafted look.

Threads
Warp Width
Adjust the width of the horizontal threads in the weave

Weft Width
Adjust the width of the vertical threads in the weave

Shape
with this slider you can adjust how flat/round the threads are. A value of 0 produces flat threads and 1 gives round threads. This setting is only relevant if the Thread Shadows are enabled

Thread Shadows
Enables the shadows that create the illusion of round threads.
Brushed (Radial)
Use the Brushed (Radial) procedural texture for a spun brushed metal finish.

Mapping Tool
Use the mapping tool to place the center of the brushed texture. See description here.

Scale
Use this to control the scale of the texture.

Angle
See description here.

Color 1/Color 2
Choose contrasting colors here to create a ringed brushed pattern.

Radius
Radius
Use this to control the amount of rings are generated.

Falloff
Increase this value to reduce the contrast between the colors selected.

Variation

Angle Noise
Increase this value to vary the width of the rings.

Distortion Noise
Increase this value to deviate the rings from a perfect circle. For a traditional spun brushed finish, you will want to leave this parameter at 0.

Advanced

Radial Axial Blend
Use this to create continuous textures on a cylinder that continues into a rounded cap. For most applications you will leave this at default.

Sync
Textures on this material node with sync enabled will be scaled/moved/adjusted concurrently.
Camouflage

Use the Camouflage procedural texture to simulate camouflage textures used in the real world.

Scale
Change the scale of the overall texture to fit the model.

Color 1/2/3/4
Set the mix of colors to be used in the texture.

Color Balance
Colors 1-4 are dispersed through the pattern in descending order, so there are more spots of color 1 than color 3 or 4. Increase this parameter to balance the ratio of colors, or reduce the parameter to increase the difference.

Distortion
Change this parameter to control the amount of shape complexity the spots have.

  Distortion Scale
  This controls the size of the grain that makes up the spots - Decreasing the scale will make the spots consist of many small irregular spots, while decreasing it will produce blocks of color.

Variation

Spray
Increase this parameter to feather the edges of the spots.

Mix Colors
Enable this option to allow the colors to blend as they overlap.

In this example the Camouflage texture is used as a Diffuse map.
Cellular

The Cellular procedural texture is an advanced tool that can create a wide variety of texture maps. You can create a crumpled texture as shown here, or you can create cracked surfaces, orange peel paint, hammered metal and many more.

Scale
Use this to adjust the scale of the texture to fit your model.

Cell Type
Choose between circular, square or diamond shaped cells.

Bump Height
Use this to control the overall intensity of the texture map.

Contrast
Contrast refers to the difference in the peaks and valleys of the bump map. Control them globally, or expand for finer controls.

Shape 1
Control the fractal shapes generated with this slider. Control them globally, or expand for finer controls.

Levels
Increase or decrease the levels of fractals being generated. Control them globally, or expand for finer controls.

Noise
Use this slider to add noise to the line quality of the fractal shapes.

The crumpled effect is created with the Cellular texture applied as a Bump map.
Color Gradient
The Color Gradient Procedural Texture allows you to mix two separate colors on a surface without having to create a custom texture map.

Mapping Tool
Use this to move the center line of the gradient.

Colors
Double click a color slider to select what color will be applied to the color gradient. Use the triangle slider to determine the midpoint of the gradient. To add another color to the gradient, click the icon. To delete a color, select the color slider to be deleted, and click the Trash icon.

Location
Adjust this to numerically control the selected color slider.

Gradient Type
Use the dropdown to choose a gradient type that suits your needs.

Scale
Use this to set the scale of the texture.

Angle
Use this to incrementally rotate the texture on the surface in degrees.

Shift
Use this to incrementally shift the texture on the surface.

Invert
Reverse the direction of the gradient.

In this example the Color Gradient is used as a Diffuse map.
Curvature

Use the Curvature procedural texture to analyze surface curvature in your model and parts or as opacity maps to create materials with worn edges etc.

**Negative Curvature**
Choose a color to display when surface curvature is going into the negative direction. The more severe the the angle, the closer to the set color the texture will be.

**Zero Curvature**
Choose a color to display where there is zero curvature. The closer to flat a surface is on the model, the closer color will become to the the chosen color.

**Positive Curvature**
Choose a color to display where the surface curvature is going into the positive direction.

**Cutoff**
Control the scale of the curvature. Decrease the value to have a smaller range of curvature. Increase to have a larger range of curvature.

**Radius**
Radius refers to the radius around each point on the surface in which curvature is estimated.

**Advanced**

**Samples**
Increase the samples to improve the quality of the gradations. Increasing this parameter also increases render time.

**Radius in Pixels**
If disabled the radius will be defined in the current scene unit.

**Sample Same Material Only**
Enable this toggle to use the curvature data from this material only.

In this example the Curvature texture is applied as an opacity map on a metal label on top of a black plastic.
Granite
The Granite procedural texture allows you to simulate the granite texture of a counter top, tile, or stone.

Color
This is the overall color of your granite texture.

Scale
This controls the scale of the grain in the granite.
Leather
The Leather procedural texture allows you to easily replicate a leather textured material.

**Scale**
This controls the scale of the leather grain.
It is highly suggested that you add a synced procedural leather bump to further simulate realistic leather.

**Color 1**
This is the color of the high points (bumps) in leather. This color should be lighter than color 2, but it should be as close to color 2 as possible for realistic looking leather.

**Color 2**
This is the color of the low points in leather. This color should be darker than color 1, but it should be as close to color 1 as possible for realistic looking leather.

In this example the Leather texture is applied both a diffuse and Opacity map.
Marble
The Marble procedural texture allows you to simulate the marble material on a counter top, tile, or stone.

Scale
This controls the scale of the veins in your marble texture.

Color
This is the overall color of your marble texture.

Vein Color
This is the color of the veins in the marble texture.

Vein Thickness
This allows you to adjust the thickness of the marble veins.

Vein Noise
This adds random fluctuations to the marble veins.

Vein Noise Scale
This adds fluctuations to the overall direction of the marble veins.

Marble Texture applied as a diffuse map.
Noise (Fractal)
The Noise (Fractal) procedural texture also allows you to simulate ripples and bumps in your material.

Colors 1 and 2
The noise procedural has light and dark colors that you can modify using these two settings.

Scale
This controls the scale of the fractal noise.

Levels
This adds more detail to the fractal noise.

Fall-off
This controls the color balance. Low values accentuate color 2, and high values accentuate color 1.

In this example the Noise texture has been added as a bump map to a glass material.
**Noise (Texture)**

The Noise (Texture) procedural texture is very similar to the stock noise texture in the textures library, and it allows you to simulate ripples in glass and liquid materials when used as bump.

**Colors 1 and 2**  
The noise procedural has light and dark colors that you can modify using these two settings.

**Scale**  
This controls the scale of the noise.

**Magnitude**  
This increases the intensity of color 2 and the contrast between the two colors.
Occlusion
The Occlusion procedural texture allows for the addition of proximity-based shading on a material. It can be used to accentuate or augment the self shadows cast on a material and along with the Material Graph, create interesting texture effects based on occluded and unoccluded areas.

Occluded
Choose a color that will be used where there are surface near each other. Examples would be a parting line, a fold of skin, or a narrow alley. For more natural results, choose a color that is a darker value of your "Unoccluded" color to create deeper shadows.

Unoccluded
Choose a color that will be used where there is least amount of surfaces near each other. this will most likely be the base color, although there are other creative applications of this procedural texture.

Radius
It is the maximum distance towards any occluding object. If an object is further away it will not be considered in the occlusion computation. This value will control how deep or far the shaded "Occluded" color will reach on the model.

Falloff
This value controls how blended the two color are.

Bias
The bias settings control the intensity of the occlusion on the model.

Normal
This setting adjusts the contrast between the "Unoccluded" and "Occluded" colors on the model

X/Y/Z Bias
These settings increase the intensity of the "Occluded" color in relation the X, Y, and Z directions of your scene.

Advanced

Samples
this setting controls the quality of rendered image.

Sample Same Material Only
Enabling this option with only calculate the occlusion in relation to parts with this material applied, ignoring other parts.

Inside
This will invert the normal values to determine occlusion. this is useful when applying this material on a part that was not modeled with interior surfaces.

Fast
Since the Occlusion procedural texture emulates what is happening with global illumination, you can choose to ignore GI calculations on this material for faster renders.

In this example the Occlusion texture is added as a diffuse map, enhancing shadows of the inside corners with a blue Occluded color.
Scratches

Using the procedural Scratches texture is a great way to add weathering and wear to materials, and to metal materials in particular. These are the settings available for the Scratches procedural.

Color
Set the color of the scratches. In cases where the texture is used for opacity maps set this to black.

Background
The color between the scratches.

Scale
Use this to set the overall scale of the scratch pattern generated.

Bump Height
Increase this value to obtain deeper scratches. It can also be set to a negative value to obtain very subtle scratches.

Density
Use this to control the number of scratches generated.

Size
Use this to set the size of the individual scratches. Expand to control the scratch thinness (width) and falloff (fade).

Directional Noise
This controls the randomness of the direction of the scratches. Decrease this value to have scratches in a more aligned direction. Expand to choose Direction Field mapping.

Noise
Controls the straightness of the scratches. Increase the value to have more irregular scratches. Expand to access the Noise Scale slider.

Levels
Controls the number of unique scratches that are generated. Expand to access the level scale.

In this example a layer of paint have been applied (as a label) on a metal material. The Scratches texture is applied as an opacity map on the label revealing the metal under the paint.
Spots
The Spots procedural texture is a method of creating a texture map of scattered spots on a surface.

Color
Use this to set the color of the spots generated.

Background
Use this to set the color of the background.

Scale
Use this to control the overall scale of the texture map.

Cell type
Select if you want circular, square or diamond shaped dots.

Density
Use this to control the number of spots that appear on your surface.

Radius
Use this to change the overall size of the spots generated.

Falloff
Feather the edges of your shapes with this parameter. Higher values produce softer edges.

Distortion
Increase this parameter to randomly warp the shape of the spots.

Distortion Scale
Use this parameter to change the amount of distortion applied to the spots.

Levels
Increase the amount levels of sizes that appear.

Levels Scale
This changes the difference in sizes between the various levels. Increase the value to greater than one to decrease the smallest spot size. Decrease the value to less than one to increase the largest spot size.

Intensity Modifier
Increase this parameter to have the spots decrease in opacity as they decrease in size.

Advanced

Invert
Enable this option to have the spots feather in to the outside color, creating rings or bubble like silhouettes.

In this example the Spot texture is applied both as a Diffuse map and as an Opacity map.
**Vertex Color**

The Vertex Color texture is used only with geometry imported from other 3D applications that supports vertex color texture maps, such as ZBrush. Only use this texture if you are importing from a compatible 3D application, as it will have no affect otherwise.

**Default color**

controls the background color that is used for the alpha channel from an imported vertex texture.

**Multiplier**

Blend a color with the imported vertex color texture.
Volume Map

The volume map texture enables you to use OpenVDB files for your textures. It is primarily used as a density texture with Scattering Medium.

File
Browse for the texture file. Only .vdb files can be used for volume maps.

Center on
This enables you to quickly position the texture to the center of either the model or the part. For finer adjustment of the position use the Move Texture tool.

Move texture
This enables you to move the texture - see the Move Texture page for details.

Scale
Adjust the size of the texture with the slider. The scale is measured in the current scene units.

Fit to part
Scales the texture to fit the part.

This example shows a cube with a scattering medium material and a volume map as a density texture.
Wood
The Wood procedural texture allows you to customize the look of your wood materials. Most often, you will want to start out with the plastic material type and change the specular color to white.

**General Settings**

**Scale**
Use this to increase size of the grain. For best results, keep the scale small.

**Angle**
See description of angle on the Move Texture page.

**Color 1**
This sets the base color of the wood.

**Color 2**
This sets the color of the wood rings.

**Ring Width**
This adjusts the thickness of the wood rings.

**Variation**

**Ring Noise**
This adds random fluctuations in each ring.

**Axial Noise**
This adds fluctuations or waviness of the overall direction of the grain.

**Color Noise**
This creates random thick and thin areas to give a more organic look to the wood ring.

In this example the wood texture is added both as diffuse map and bump map.
Wood (Advanced)

The Wood (Advanced) procedural texture gives finer control than the basic wood procedural texture, and creates more realism in the map.

Scale
Use this to control the overall scale of the texture map.

Angle
See description of angle on the Move Texture page.

Winter/Spring/Summer/Fall
New wood formed in a tree during spring and summer is light in color. Toward the end of a growing season, new cells formed are smaller and have darker, thicker walls. Choose the color swatches to accurately color the rings in accordance with the seasons.

Ring Width
This adjusts the thickness of the wood ring.

  Ring Width Variation
  This enables you to add variation to the width of the wood rings.

Variation

Ring Spacing Variation
This parameter controls the contrast of thick and thin ring shapes to represent different rates of annual growth.

Ring Noise
This adds fluctuations or waviness to the rings.

Axial Noise
Increase this parameter to add variations to the circular shapes of the rings.

Color Noise
Increase this parameter to add more splotches of color in the rings.

Seasonal Color Noise
Add variation to each color swatch as it blends from each color.

Knots

Knot Color/Border
The knot color is blended into the main colors of the texture. Choose a grey value to darken the knots. The knot border should be darker than any of the other colors.

Knot Density
This parameter controls how many knots appear in the texture.

Knot Age
Increase this parameter to increase the number of rings that appear in the knots.

Knot Border Size
This parameter changes the thickness of the knot borders.
Knot Distortion
Use this to control the fluctuations and add irregularities in the knot shape.

Branch Scale
Control the overall size of the knots with this parameter.

Grain

Grain Color Bleed
This parameter controls the amount of color each ring blends into the rings on either side. Decrease to have very clearly defined rings or increase to give the rings a more blended appearance.

Axial Graininess
Increase this parameter to blur the texture.

Ring Graininess
This adjusts the thickness of the wood rings.

Grain Scale
This adjust the size of the grain striations between the rings.

Grain Thinness
Control the size of the grain striations with this parameter.

Advanced

Seed
Scrub through this parameter to add randomness to all of the previous parameters to create a more natural look.
Map Types

KeyShot has four primary Map Types along with a number of material and texture settings that can also accept textures.

Each Material Type uses texture map types depending on the material type and settings. You will see the available map types in the Project window, Material, Textures tab.

The Primary Map types are not the only texture maps you will encounter - Anywhere you find the texture icon in the material properties you will be able to add a texture to the property. Texture icon. Apply a texture by drag and drop from the library, right-click to select a type or click to load a texture from a file. When a property has a texture applied you can click it to adjust.

Primary Map types

**Diffuse**

The Diffuse (also seen as Color or Transmission) map type allows an Image texture or 2D/3D procedural texture to be applied to replace the basic solid Diffuse/Color/Transmission setting.

This map type provides full color information and will show transparency when a PNG with alpha transparency is used.
**Specular**

The *Specular* map type can use black and white values to indicate areas that have varying levels of specular intensity. Black will indicate areas of 0% specular reflectivity, whereas white will indicate areas of 100% specular reflectivity.

Notice on the example that while the material in itself is emitting specular reflections, the dots are not.
**Bump**

The *Bump* map type is used to create fine details in materials that would be unrealistic to include in the model, like the brushed metal in the example. Bump uses the texture to simulate deformation of the surface.

There are two methods of applying bump maps. The first and easiest is using a black and white image. The second way is by using a *Normal map*.

**Black and White Image**

When using a black and white image for a bump map, the black values are interpreted as lower and the white values are interpreted as raised.

**Normal Maps**

Normal maps contain more colors than the standard black and white bump maps. These additional colors represent different levels of distortion on X, Y and Z coordinates. This can create more complex bump effects than a black and white bump map which represents only two dimensions. However, most bump effects can look very realistic without the need for normal maps. Enable this setting when a Bump map is selected by checking *Normal Map*.

**Bump Height**

With Bump maps, *Bump Height* controls the effect of the map. Increasing this raises the peaks of the bumps, and helps exaggerate the bump when the texture needs to be more visible.

**Opacity**

The *Opacity* map type can use black and white values or alpha channels to make areas of a material transparent. This is useful for creating materials like the mesh material shown, without actually modeling the holes.

**Opacity Mode**

The opacity mode can be set to three different methods:

- **Alpha**
  
  This will use any alpha channel that is embedded in the image to create the transparency. If no alpha channel is present, no transparency will be shown.

- **Color**
  
  This will interpret black areas as completely transparent and white areas as completely opaque. 50% gray will be 50% transparent. This method is available to avoid the need for alpha channels.

- **Inverse Color**
  
  Inverse color is the opposite of color. White will be completely transparent, black will be completely opaque and 50% gray will be 50% transparent.
Tip
You can easily drag and drop textures from one Map Type to another (e.g. from Bump to Specular) by simply holding Ctrl (Windows) or Command (OS X) and dragging the texture to another Map Type. To copy a texture press Alt while dragging the texture from one map type to another.
Mapping Types

Image Textures and 2D Textures allow you to take 2D images and place them onto 3D objects. How they are applied will affect how they appear. KeyShot provides seven different mapping types for these types of textures. When an Image Texture or 2D Texture is active, you will see a Mapping Type option with the following mapping types.

- Planar
  The Planar mapping type will project a texture on the X, Y or Z axis. The orientation is set in the Interactive Move Texture tool. Surfaces of 3D models that are not oriented on the chosen axis will show stretching of the texture in the other two axes.

- Box
  The Box mapping type will project a texture from six sides of a cube in towards a 3D model. A texture will be projected from a side of the cube until stretching occurs, then the next best projection side will take over. Box mapping is a quick and easy solution that will work in most cases because there will be minimal stretching of textures.

- Cylinder
  The Cylinder mapping type will project a texture inwards from a cylinder. The texture will project the best on surfaces that are facing the inside of the cylinder. The texture on surfaces that do not face the inner walls of the cylinder will stretch inwards.

- Sphere
  The Sphere mapping type will project a texture inwards from a sphere. The texture will resemble the original image the most at the equator. The texture will start to converge as it reaches the poles of the sphere. As with box mapping, stretching is less of an issue when working on multi sided objects than it is with any of the planar mapping modes.

- UV
  The UV mapping type is a completely different method of applying 2D textures to 3D models. Using 3D applications such as 3D Studio Max or Maya, you can design how the texture map is applied to each surface. It is more time consuming and is much more widely used in the entertainment industry as opposed to the design/engineering world.

- Camera
  The Camera mapping type will keep the texture oriented with respect to the camera. This will provide a consistent texture appearance on the surface regardless of the position of the camera.

- Node
  The Node mapping type allows you to drive a texture with a UV mapped procedural. An example of this can be seen below.
Box Map as shown in the Move Texture Tool.

Cylinder Map as shown in the Move Texture Tool.
Move Texture

Move Tool

Fine tune the position of textures mapped to your mode with the texture move tool. The tool is accessed from the texture tab within the material editing menu, and it is available when in Planar, Box, Cylindrical and Spherical mapping modes.

Position

Use this to establish exactly where you want the center of your texture image to project. Once in position mode, you can simply click on the surface of the model to change the where your texture is projecting.

Translate

Use arrow handles to move the texture mapping position on the XYZ axes. To translate the mapping, click on any of the three axis arrows. The red, green and blue arrows correspond to the X, Y and Z axes.

Rotate

Use circle handles to rotate and align the texture mapping to your model. Hold SHIFT to constrain the rotation to 15 degree increments.

Axis

Select if the translation/rotation should use the global or the local axis.

Fit

Fit the texture to match geometry on the X,Y, Z axis.

Center on

- **Model** - This will position the texture relative to the model.
- **Part** - This will position the texture relative to the part.

Cancel or Confirm Changes

After adjusting the texture mapping with the mapping tool, click the green check mark to confirm the changes and close the mapping tool. Click the red X to cancel the changes and close the mapping tool.

Tip

Enable the sync option in the Size and Mapping section to move all your textures on the current material concurrently.

Size and mapping

Size and Mapping lets you scale and adjust the orientation of the texture. The parameters wary a little with the Texture Types and Mapping Types but the overall options are the same.

Use DPI for size

This lets you set the size of the texture in DPI instead of defining width and height.

Width and Height

Sets the width and height of the texture using the current scene unit.
**Lock Aspect** - Will secure a uniform scale of the texture.

**Refresh** - Will reset to the original aspect ratio of the texture.

**Shift U**
Moves the texture in the U direction. On the example to the right, the UV plane is shown with the orange box, where the V direction is shown with the small arrow. - this means that in the example Shift U will move the texture sideways.

**Shift V**
Moves the texture in the V direction. In the example to the right, Shift V will move the texture up/down.

**Angle UV**
This will rotate the UV plane (the orange squares in the example to the right) of the Map

**Angle**
This will rotate the entire map around the local Y axis. This is the same as rotation in the Move Texture tool and means that the entire box will be rotated around the green axis in the example to the right. Expand the setting for even more precise control.

**Axis Tilt**
This will tilt the local axes around the Global X axis.

**Axis Azimuth**
This will rotate the map around the global Y axis
If the tilt is 0 adjusting the azimuth will be the same as adjusting the overall angle.

**Center X**
Will move the center of the map along the global X axis.

**Center Y**
Will move the center of the map along the global Y axis.

**Center Z**
Will move the center of the map along the global Z axis.

**Flip Horizontal**
Will mirror the texture over the local Y axis.

**Flip Vertical**
Will mirror the texture over the local X axis.

**Two Sided**
This is only relevant for Planar and Box Mapping and has slightly different behavior for the two.

- Planar: When enabled the texture will be visible on both sides of the model, with a mirrored version on the "backside".
- Box: when enabled the texture will be mirrored on the back faces of the box, when disabled the texture is the same on
all faces.

---

**Repeat Horizontal**
When enabled the texture will be tiled horizontally.

**Repeat Vertical**
When enabled the texture will be tiled vertically.

**Sync**
Textures on this material node with sync enabled will be scaled/moved/adjusted concurrently.
Labels

Labels are designed for easy placement of logos, stickers or video that need to be placed freely onto a 3D model. You can also use Labels to create a layered appearance with another material on top of the main material.

Essentially labels are layers with materials/textures on top of your material.

In this example the material ball has 3 labels - 2 individually positioned "stickers" and a coat of paint with subtle scratches revealing the golden base material.

To make sure the scratches cut both the sticker and the paint, the same opacity map is used on both.

On this page

1. Layer List
   - Add Label
   - Delete Label
   - Layer order
   - Pick Label
2. Label Type
3. Label Properties
4. Label Textures
   - Map Types
   - Mapping Type
   - Move Texture
   - Texture Properties

Labels are added through the labels tab in a material’s properties or via drag and drop from the Library, either onto a part in the Real-Time View or into the Layer list.

1. Layer List

An unlimited number of labels can be added to a material. Each label can have its own mapping type. If an image has an alpha channel embedded, it will be retained and areas of transparency will not show.
Labels are added by clicking the “+” Icon and selecting Add Label (Texture), Add Label (Video) or Add Material. Once added, the label name will be displayed in the list. You can also choose “Duplicate” to create copies of existing labels.

Add Material will simply add a layer of the material selected in Label type (2) on top of your base material, while Add Label (Texture) and Add Label (Video) also will add a texture to the Diffuse map (4).

Delete Label

Labels can be deleted by selecting the label in the list and clicking the Trash Icon.

Layer order

Labels will be layered as they are added. If labels overlap on the model, they will stack in the same order as ordered in the Labels list. The label order can be shifted by pressing the up and down arrow buttons.

Pick Label

Lets you pick a label in the Real-Time View for editing.

2. Label Type

Each label will be assigned a material type. The default material applied to a label is plastic, but it can be changed to Diffuse, Flat, Metal, Paint, Translucent, Advanced, Anisotropic, Metallic Paint, Plastic (Transparent), Translucent (Advanced), Emissive, Toon, and Xray.

3. Label Properties

The Properties Tab will show the contextual settings for the label type selected. See the Material Types for more.

4. Label Textures

Map Types

Texture and video Labels will be added as Diffuse maps. In the Label Textures tab you can add other maps to your label similarly to the Textures tab for Materials. The type of texture maps available to a label type will be similar to the type of textures available to the material type.

Use the check-boxes in the list of texture types to enable or disable a texture map.

See the Map Types page for details about Bump, Diffuse, Opacity maps etc.
Mapping Type

The Textures are by default planar - see the Mapping Types section for more information about the different Mapping methods.

Move Texture

See the Move Texture page for details about Move Texture and Size and Mapping.

Drag and Drop
You can add your label by drag-and-drop onto the model. This will add and align the label to the point on the model where you dropped it. This may insert it at a different angle in the Label properties than what you expect.

If you drop your label into the Labels list, it will be inserted at 0 degrees (or 90 degrees depending on how the model was imported).

Keep Label Size
If you would like to use the dimensions of the label stored in the file for the initial label size, use a Photoshop .PSD file. When you import your label as a .PSD, KeyShot will check the DPI settings and set the DPI value to that stored in the .PSD file.

Texture Properties

See the Texture Types section for details on the properties of individual texture types.
Environments
The primary method of lighting a scene in KeyShot is through Environment Lighting. Environment Lighting uses spherical High-dynamic-range imaging (HDRI) to represent the full, physically accurate lighting of an interior or exterior space.

Environment Presets
KeyShot comes with many environment lighting presets to get you on your way fast. Access all environment preset from the Library window, Environments tab. Additional environments may be accessed on KeyShot Cloud.

Environment Tab
The Environment tab is where you control all the settings for your environment lighting. Access the settings from the Project window, Environment tab.

HDRI Editor
KeyShot Pro users will see the HDRI Editor button on the Environment tab directly beneath the HDRI preview.

In this section
- Adding Environments
- Adjusting Environments
- HDRI Editor
Adding Environments

KeyShot is designed to provide real-world lighting right out of the box. Through environment presets and the ability to modify them or create your own, your scene can be lit just the way you need with everything visible in real-time.

You can find environment presets in the Environment Library or KeyShot Cloud Library.

Environment List

The Environment tab of the Project window includes the ability to save different Environments and their settings to a list for fast access and navigation.

When a new scene is opened the Environment List is populated with the environment used in the Default Startup Scene specified in the General Preferences. All changes made to the settings will be recorded and saved with that environment.

Adding an Environment

You can add environments in the following ways:

- drag and drop from the Environment Library/KeyShot Cloud Library onto the Real-time View - this replaces the current environment.
- double click an environment in the Environment Library - this replaces the current environment
- drag and drop from the Environment Library/KeyShot Cloud Library onto the Real-time View while pressing ALT - this adds a new environment in the Environment List.
- drag and drop from the Environment Library onto the Environment List - this adds a new environment in the Environment List.

Creating a New Environment

To create a new Environment based your current settings, click the Add Environment icon at the top left of the pane.
Adjusting Environments

KeyShot allows you to adjust your HDRI lighting through a set of easily adjustable Settings found in the Project window, Environment tab.

File

Load a lighting environment from a file (.hdr, .hdz, .exr). Select the icon to open a new environment. Select the icon to reload the current environment. Hovering over the file name will display the file path. Right-click to display options to Copy Path, Show in Explorer, Reload or Open a new environment file.

Adjustments

- **Brightness** brightens or darkens the entire HDRI from the shadows to the highlights equally.
- **Contrast** increases the separation between dark and bright areas, making shadows darker and highlights lighter.

Transform

- **Size** determines the size of the environment.
- **Height** sets the vertical position of the environment in relation to the ground plane.
- **Rotation** allows you to rotate the environment.

Background

- **Lighting Environment** uses the image of the lighting environment as background in the scene.
- **Color** allows you choose a solid color for the background.
- **Backplate Image** allows you add and use an image as the background for the scene. Supported file formats include .jpg, .jpeg, .tif, .tiff, .bmp, .png, .gif, .dds, .hdr, .hdz, .exr, .tga, .ppm, .ktx, .psd.

**Note**

The background Color may also be set to a solid color through the Photographic Image Style, this will override any settings applied in the Environment tab.

Ground

- **Ground Shadows** is an option to change the visibility of ground shadows and allows you to set the base color.
- **Occlusion Ground Shadows** is an option to see occlusion shadows in place of drop shadows.
- **Ground Reflections** is an option to change the visibility of ground reflections.
- **Flatten Ground** will project the part of the environment that is below the ground onto the ground plane, correlating height and width if the lighting environment is visible as the background in the scene.
- **Ground size** allows you to set the size of the virtual ground plane and only affects the ground shadows.
HDRI Editor

The KeyShot HDRI Editor (Pro Only) is a simple way to make adjustments to lighting environments or create your own.

The HDRI Editor provides a unique system of adjustable light, image and gradient Pins to light your scene.

HDRI Editor Overview

The KeyShot HDRI Editor is fully integrated into the Environment tab located in the Project window.

All Pins and settings for Color, Adjustments and Transforms are embedded in the KeyShot file eliminating the need to save an individual .HDZ for each custom Environment you create. This provides a huge convenience and asset management benefit while greatly reducing the amount of data necessary to store locally and in KeyShot .KSP files.

The HDRI Editor has flexible features including:

- Export of HDR/EXR
- Gradient Background
- Draggable interactive Sun & Sky
- Sun & Sky Ground Color
- Sun Size parameter
- Rectangular Pin Rounded Corners
- Gradient Pins
- Image Pin Color Adjustments
- Extract pins from previous version HDZ files
- Pop out HDRI Editor canvas
HDRI Editor Pins

Pins are light sources that can be placed into the HDRI to further enhance the image file, and give the desired lighting effect on the object scene.

**Pin List**

Contains all the pins created in the HDRI editor. You can enable or disable a pin by clicking the checkbox to the left of its name. You can rename a pin by double clicking its name. Right click pins for options to delete or duplicate. The active pin being edited will be highlighted blue in the list and will be marked by a blue dot in the preview.

**Pin Options**

**Add Pin**

To Add a pin click one of the options above the Pin List, these include Add Pin, Add Gradient Pin, Add Image Pin, and Add Copy Pin. The Pin types will be described later on this page.

The new pin will be displayed in the Pin List as well as the preview window. To make a pin active for editing, select it in the Pin List or click on the pin handle in the preview window. Drag the pins by their handles to position them. The “Add Highlight”-pin is explained below in the “Set Highlight” section.

**Delete Pin**

Click on the trash can icon to delete the active pin.

**Move Pin Up/Down**

Click on the arrows to change the pin order in the pin list. The order is important as it will display and layer pins from the top down.

**Pin Folders**

Use pin folders to organize all your pins in your HDRI. Click on the “Add Folder” icon to add a folder to the list and drag pins into the folder.

**Set Highlight**

With the Set Highlight option you can create your pin by selecting a region on the model you want to highlight. Simply CTRL+Click/CMD+Click in the Real Time View anywhere on the surface of the model and a pin will be generated facing that point on the surface. When finished, click “Done.” Pins added this way can be edited as normal.

To set an existing highlight click onto “Set Highlight”, and then select an existing pin in the editor. Click on the object to set the highlight using the selected pin, and use your left mouse button to drag it into the right position.

**Pin Types Explained**

**Standard Pin**

Add Pin creates a pin in the center of the unfolded HDRI. Grab it to place it in the desired location. Use the controls explained in section Adjusting Pins to get achieve the desired effect.

**Gradient Pin**

A Gradient Pin allows you to place a light source with color and opacity variations.
Copy Pin
When this option is selected, a snapshot of a section of the background is used as a new pin. A pin handle and a marker of the copy-origin (yellow dot) will appear on the preview window.

After creating the copy pin, move the pin by the handle to place it where desired. Adjustment sliders similar to those used with the regular pin will be available with the same effects.

Image Pin
The image pin allows you to use HDR, HDZ, EXR, JPG, PNG, JPEG, and BMP as a pin. There are limitless usages for this pin, such as creating specific reflections, simulating a lighting array and using part of an HDR with another HDR among others.

When adding an image pin, you will be prompted to select an image to be used. Once selected, the image will be placed in the preview window.

Adjustment sliders will be available to edit the image pin. These sliders are similar to the regular pin sliders.

Adjusting Pins

Circular/Rectangular
This will toggle the shape of the pin. This is crucial when creating very specific shapes and reflections in your renderings.

Half
For either pin shape you can select the shape to be cut in half. This will cut the pin in half. All adjustments will work the same except that you are now only seeing half of the pin.

Radius (Circular)
This determines the pin size of circular pins.

Width/Height/Angle (Rectangular)
This determines the shape and size of rectangular pins.

Color
Use this to set what color the pin will project. For accurate real-world lighting, use the Kelvin scale.

Blend Mode
With this option, choose different ways to have the pins blend and interact with each other. Pin order becomes very important with this function.

Falloff Mode
This controls the falloff of the light from the center of the pin. Different modes have different behaviors. You can see the effect of the various modes both in the editor as well as in the KeyShot Real-Time View.

Falloff
This controls the softness of edge of the pin light. Increase the falloff for more blended, softer edges.

Brightness
Use this to adjust the overall intensity of the pin light.

Editor Options
Generate Full Resolution HDRI
While you are editing the pins the environment is using a "fast preview" mode, where you don't see the full effect of the changes. Click to force the environment to be displayed in the full resolution.

HDRI Editor Canvas
This will launch the HDRI editor, where you can edit the pins on a bigger canvas.

Save Environment
Here you can save your environment to the Library.

Export Environment
This enables you to export a .HDR/.EXR/.HDZ with your environment.
HDRI Editor Background
When you select the Background item in the HDRI Editor Pin List you have four options for your HDRI Editor Background: Color, Gradient, Sun & Sky and Image.

**Resolution**
The Image background is automatically set to the resolution of the selected image. But for the other 3 types you will have to set the Resolution. Overall a smaller resolution gives better performance, but a larger resolution gives better shadow and reflection quality. Normally it the default value will suffice. But if you are operating with highly reflective materials and half/square pins or pins with little/no falloff, you may need to increase the resolution.

![Cube images showing resolution differences](image)

In the example on the left the environment resolution is low. Notice that the edge of the highlight is not as sharp as in the example to the right, where the environment has a high resolution.

**Color**
Select a solid color as background for your environment. This should not be confused with the setting of a solid background color (can be set in Environment settings or Photographic Image style) as it will affect the lighting in the scene.

**Brightness**
Adjust the brightness of the background color.

**Gradient**
Color bar
Here you can set when and what colors will fade from one to the the next. Click on the dropper circle to select a color stop, then use the color swatch to choose a color.

The little triangles shows where the 2 colors are mixed 50-50 and they can be dragged to control the course of the blend.

Add Color Stop
If you would like to fade between more than 2 colors, click on the Add stop button below the color bar to create another color swatch. click and drag the color pins and the gradient apex slider to your desired animation effect.

Delete Stop
If you want to remove a color stop, just select it and click delete.

Stop Brightness
Select a color stop and adjust the brightness.

Latitude
Select a color stop and adjust the position of the color on the gradient. This can also be achieved by dragging the color stops on the color bar.

Brightness
Adjust the brightness of the whole gradient background.

Saturation
Adjust the saturation of the whole gradient background.

Sun & Sky

Resolution
Here, set the resolution of the sun and sky that will be generated. A smaller resolution has better performance, but a larger resolution has better shadow and reflection quality.

Location
Here, you can choose a preset city that is closest to where the scene is taking place for accurate portrayal of the sun and seasons at location.

Coordinates
Another option is to choose “Custom Location” and enter the geo coordinates of a location.

Date
Use this to set the date to the day the scene will be taking place for accurate portrayal of color temperatures of the seasons.

Custom Sun Position

Time
Use this to set the time the scene takes place for correct placement of the sun.

Turbidity
Increase this setting to add more haze to the sky. This will tint the sky with a warm tone and filter the sunlight that is cast in the scene.

Sun Size
Adjust the size of the sun.
Ground Color
Set the color of the ground on the background.

Color

Brightness
Adjust the brightness of the Sun & Sky background.

Contrast
Adjust the contrast of the environment

Saturation
Adjust the saturation of the environment

Hue
Adjust the hue of the environment

Colorize
Add a color that the environment will be blended with.

Blur
Adjust the blur of the environment background, increase to soften contours.

Transform

Tilt
This will tilt the vertical axis of the environment.

Rotation
Rotate the environment background without affecting any pins in the environment. If you want to rotate the entire environment you can do it in the Environment settings.

Image

Resolution
This is set by the image size. If you experience bad reflections with the environment you may need to use an image with a higher resolution.

Image
Select an image file for the environment background.

- browse for another image file

- Refresh the image file

- Remove the image file - this will change the environment type to Color.

Color

Brightness
Adjust the brightness of the Sun & Sky background.
Contrast
Adjust the contrast of the environment

Saturation
Adjust the saturation of the environment

Hue
Adjust the hue of the environment

Colorize
Add a color that the environment will be blended with.

Blur
Adjust the blur of the environment background, increase to soften contours.

Transform

Tilt
This will tilt the vertical axis of the environment.

Rotation
Rotate the environment background without affecting any pins in the environment. If you want to rotate the entire environment you can do it in the Environment settings.
Adjusting Legacy (KeyShot 6 and earlier) HDRI Environments

Handling of environments and environment lights (pins) changed with KeyShot 7. To adjust environments created prior to KeyShot 7 you will need to extract the image pins and/or background images to take advantage of the new, more efficient, handling of environments and pins.

You can convert HDRI environments from KeyShot 6 and earlier to KeyShot 8 by clicking the Extract HDZ icon located just above the pin list in the HDRI Editor tab. When you click Extract HDZ you may be prompted to save any images present in the HDZ file to your hard drive.

Note: If there are no image pins and the background is uniform, no files will be written out.
Lighting

The lighting in your scene comes from the Environment and/or form Light Source Materials. In the Lighting tab of the Project panel you can control the interpretation of light in your scene.

Environment Lighting

The primary method of lighting a scene in KeyShot is through Environment Lighting. Environment Lighting uses spherical High-dynamic-range imaging (HDRI) to represent the full, physically accurate lighting of an interior or exterior space. See the Environments section for more details.

Light Source Materials

Any piece of geometry can be turned into a local light source. It’s a completely different approach from traditional rendering applications allowing more flexibility for rendering light accurately in your scene.

There are four Light Source Material Types that provide different lighting capabilities:

Area Light Diffuse

Turn any object into an array of light. View and adjust the position in the real-time window. Control the intensity of the light using Watts or Lumens. See the Area Light page for more details.

Point Light Diffuse

Turn any object into a point light. View and adjust the position in the real-time window. Control the intensity either using Power Watts or Lumens. See the Point Light page for more details.

Point Light IES Profile

Load an IES profile by clicking on the folder icon in the editor and see the shape of the IES profile load in the material preview and in the form of a mesh in the real-time window. See the IES Light page for more details.

Spotlight

Turn any object into a spotlight. View and adjust the position in the real-time window. Control the intensity either using Watts or Lumens. See the Spotlight page for more details.

Adding A Light

On this page

- Environment Lighting
- Light Source Materials
  - Area Light Diffuse
  - Point Light Diffuse
  - Point Light IES Profile
  - Spotlight
  - Adding A Light
  - Moving a Light
  - Animating a Light
  - Interpretation of light
    - Performance
    - Basic
    - Product
    - Interior
    - Jewelry
A light source may be applied to any model you like. A light can be applied to imported geometry, existing geometry or to geometry available in KeyShot via the Edit, Add Geometry menu.

Applying a light material is similar to applying other materials. Drag and drop a light material preset from the Library window, Materials tab, Light folder. You can also double-click on an model, go to the Material Type dropdown, and choose one of the Light Sources from the list. KeyShot will change the object to a physical light.

When you change a model to a light source, KeyShot will identify the light source in the Project, Scene tree by adding a light bulb icon next to the model name.

**Apply a light to a sphere**

**Tip:** Here's a simple example for adding a light to a sphere. From the KeyShot menu, select Edit, Add Geometry, Sphere. Move the sphere to the location for the light. Go to the KeyShot Library, Materials tab and select the Light folder. Drag and drop a light onto the sphere. If you want to reduce the ambient environment light, go to the Project window, Environment tab, Settings and reduce the Brightness.

**Moving a Light**

Right-click the part that is assigned as a light and select Move Model. This will activate the Move Tool. You can also select the light source in the Project window, Scene tab, then select Move Tool from the Position tab. Additionally, the input boxes may be used for more precise positioning.

**Animating a Light**

Since light sources are materials applied to a part, they can be animated just like any other part. Simply select the light in the Scene Tree that you would like to animate, right-click and apply the animation you would like. Visit the Animation section to learn about the different types of animations.

**Interpretation of light**

In the Lighting tab you can control the interpretation of lighting in your scene. KeyShot comes with a number of presets which make applying global light settings faster. You can also set up custom presets - learn more here.

**Performance**

This preset disables light source materials and shadows with reduced bounces for the fastest performance possible. This is useful for scene setup and quick manipulation. The option is also available in the Ribbon.

**Basic**

This preset provides simple, direct lighting with shadows for basic scenes and fast performance. This is useful for rendering simple models illuminated by the environment.
**Product**

This preset provides direct and indirect lighting with shadows. This is useful for products with transparent materials illuminated by the environment and local lighting.

**Interior**

This setting features direct and indirect lighting with shadows that is optimized for interior illumination. This is intended for complex interior illumination with indirect lighting; although it can also be used to avoid noise created by local lights and provide more accurate sampling of HDRIs with very small and strong light sources such as Sun & Sky.

**Jewelry**

This setting features the same settings as the Interior preset with the addition of Ground Illumination, increased Ray Bounces, and Caustics.
**Custom Lighting Preset**

In the *Lighting* tab of the *Project Panel* you find the Lighting settings.

**Environment Lighting**

**Shadow Quality**
The slider determines the quality of shadows, in the sense of how high priority the rendering of shadows in the scene is when rendering with *Maximum Samples* or *Maximum Time*.

**Ground Illumination**
When *Ground Illuminations* are on, the rays bounced of the ground will produce indirect lighting.

**Self Shadows**
When *Self Shadows* are on, the objects in the scene will cast shadows on themselves, otherwise the objects will only cast shadows on the ground.

**General Lighting**

**Ray Bounces**
Ray bounces are the number of times rays of light are calculated as they bounce around a scene.

**Global Illumination**
Toggle if you want to see indirect ray bounces between objects in the scene.

**Global Illumination Bounces**
When *Global Illumination* is on, *Global Illumination Bounces* allow you to control the maximum number of times the light is reflected diffusely as it passes through the scene.

**Caustics**
Enable/disable caustics in the scene. See the *Refractive Index* page for more info about caustics.

**Rendering Techniques**

The Rendering techniques are optimized for different scenarios.

**Product mode**
is best for scenes where the camera "looks" at the objects from outside.

**Interior mode**
The interior mode is optimized for enclosed spaces.

---

**Note**
Interior Mode uses a different and more intelligent approach to samples than the one Product mode uses. The improved approach means that customization of *Material Samples* only has effect in Product Mode as it is not necessary in Interior Mode.

You can set material samples under the *Roughness* parameter in most materials and under *Advanced* in following...
Save Custom Preset

When you have customized the settings you can save them as your own preset by clicking the + icon next to the custom preset drop-down.
Cameras

The Camera tab controls the settings for all camera views in KeyShot and allows you to set the active KeyShot camera. It also allows you to save different camera views of your scene, which allows cameras to be re-used, modified, animated or used in Studios.

Cameras can be adjusted much like a real camera and include advanced functionality such as shift lenses, walkthrough mode and Depth of Field, along with KeyShot Pro features such as panoramic lenses, to produce cube or spherical maps for real-time VR rendering and output.

This section explains how to work with the different types of cameras and their respective settings.
Grid
- Stay Above Ground

Lens Settings
- Perspective
- Orthographic
- Shift
- Panoramic

Match Perspective

Perspective / Focal Length: 35 mm

Field of View: 54.432°

Ground Grid

Stereo

Depth of Field
Navigating Your Scene
The following explains how to use your mouse to change the view of your camera. It's important to realize that the mouse is moving the camera and not the model, unlike a 3D modeling application. In other words, when you use Left Mouse Button (LMB) to rotate, the camera is rotating around the model.

To change the position of the models, see Moving Models and Parts.

Mouse Controls

The mouse is the main method for controlling the position and orientation of the camera. With it, you can rotate, pan and change distance.

**Camera Tumble (Rotate)**
To tumble your camera, press and hold LMB while moving the mouse. This changes both the azimuth and inclination of the camera.

**Camera Pan**
To pan your camera press and hold the MMB while moving the mouse. This changes the position of the camera.

**Camera Dolly (Distance)**
To dolly your camera, roll the scroll wheel forward to increase distance or back to decrease distance.

Keyboard Controls

KeyShot also provides additional ways to navigate your scene and control your camera using the keyboard.

**Camera Dolly (Distance)**
To dolly your camera, press Alt + RMB (Windows/Mac) while moving the mouse. This changes the distance of your camera.

**Camera Perspective**
To change camera perspective, press Shift, Alt + RMB (Windows/Mac). This will adjust Distance, Perspective/Focal Length and Field of View.

**Camera Twist**
To twist the camera, press Ctrl, Alt + Wheel (Windows) or , Alt + Wheel (Mac).

**Standard Views**
To cycle through the standard view (front, back, left, right, top, bottom, isometric select Ctrl, Alt + 1-7 (Windows) or , Alt + 1-7 (Mac)

**Focal Length**
To change Focal Length press Alt + Wheel (Windows/Mac). This will adjust Perspective/Focal Length and Field of View.

**Set Camera Target**
To quickly center the camera on an area, select Ctrl, Alt + RMB (Windows) or , Alt + RMB (Mac).

**Next Camera/Viewset**
To toggle through cameras and viewsets, press Shift + N.

**Toggle DOF**
To toggle Depth of Field (DOF) press D.
All KeyShot hotkeys can be seen here.

Multi-touch Controls

Basic touch controls allow you to orient the camera on touch-enabled devices.

- 1 Finger – Tumble camera
- 2 Finger Pinch – Zoom
- 3 Finger Drag – Pan
- 5 Finger Touch – Reset camera

Learn more about multi-touch input here.
Camera List

The camera list at the top of the Camera tab contains all the cameras for the scene. In the camera list, the Free Camera is always available and cannot be locked or overwritten. It can always be selected and remains independent of camera animations.

Add Camera

To create a new camera, select Add new camera to the left of the camera list. This will add the current camera view to the Camera List.

Cameras can be renamed for easy identification and better organization, simply right-click and select Rename.

Add Camera and Environment Studio

The Add Camera and Environment Studio is a Pro feature that allows you to add a Studio along with the currently active camera and environment.

Note: This replaces the Viewset functionality from KeyShot 5/6. Read more information about the Studio feature and Viewset to Studio conversion here.

Edit camera

After a camera is saved, any change made while that camera is active will display (unsaved) after the camera name. To save the changes simply select Save Current Camera. If you do not want to apply changes, select Reset Camera to revert the active camera to its last saved state.

Adding a new camera to the list will add a camera with the current setup, while the previously selected camera will be reverted to the last saved state.

Locked Camera

Any camera can be locked by right-clicking on the name or by selecting the lock icon. When a camera is locked the Tumble/Pan/Dolly options in the ribbon will be disabled

Delete Camera

Any unlocked camera can be deleted using the Remove current camera.
Position and Orientation

All KeyShot cameras are defined by their position in 3D space in relation to the Camera Target. The Camera Target specifies the exact mathematical point or location the camera is "looking at." This relationship is critical to understand, especially when fine-tuning settings and creating camera animations.

Camera Mode - Spherical

Default setting for defining position and orientation of the camera.

When using the default Spherical definition all values reflect camera position in relation to the static Camera Target.

Distance

Distance between the Camera Target and Camera in scene units. Setting this value too low can lead to the camera being "inside" the 3D model. This can be controlled with the mouse scroll wheel. The direction can be inverted in Preferences.

Azimuth

Rotation around KeyShot up (Y) axis, measured in degrees.

Inclination

Defines camera tilt, or vertical rotation from horizontal plane.

Twist

Twists/rotates the camera around its own axis.

Camera Mode - Absolute

Here you can set the position of the camera (Position) and the camera target (Target) relative to the global X-axis, Y-axis, and Z-axis.

Position

Defines X/Y/Z coordinates of camera location in scene units.

Target

Defines X/Y/Z coordinates of Camera Target in scene units.

Keep View Direction

Locks View Direction for Position/Target changes. When unchecked, the camera will keep looking at the target while the Position values are changed. If the checkbox is checked, the camera direction will be kept and therefore the Target point will change as the Position is changed.
Twist

Twists/rotates the camera around its own axis.

Set Camera Target

With Set Camera Target you can click on a surface in the real-time view to define it as the camera target. The camera will now tumble, pan & dolly in reference to this exact point on the surface. In the Geometry panel you can always see where the camera target is.

Next to the button the position of the Camera Target is displayed as coordinate values.

The default Camera Target is always the center of geometry in the scene.

Tip

To reset the camera target, you can right-click in the Real-Time View and select Center and Fit Models. This will use the center of all objects in the scene and dolly to a distance where all parts are within view.

Walkthrough Mode

See Walkthrough Mode.

Standard Views

Quickly access camera presets based on common orthographic directions. Note that this does not automatically change the camera to the orthographic lens only the position of the camera.

Grid

Enables on-screen grid which can be helpful for image composition and camera placement. The grid will not be visible in rendered output.

Stay Above Ground

This option allows all camera movements to be restricted to the upper hemisphere. This is useful for scenes where bottom views are undesirable.
Walkthrough Mode
Walkthrough Mode allows you to move around inside your scene and see it from a "first-person" point of view.

To enter Walkthrough Mode go to Project window, Camera tab, Position and Orientation. Select Walkthrough Mode and the Walkthrough Mode HUD will appear and a camera called First Person will be added to the camera list.

Eye height
The eye height indicates the height of the camera in relation to the lower object.

Lock Eye Height
Locking the eye height will keep the camera at a constant height and will ignore the ground detection setting covered below.

Ground Detection
Ground detection will automatically adjust the camera height in order to keep it at the set Eye Height specified above. If you move towards an object such as stairs, the camera will appear to be going up the stairs and will respect the "new ground".

Collision Detection
Selecting this setting will keep you from moving through objects. This is used to make the walkthrough more realistic by not allowing you to move through objects that you should not be able to go through.

Arrows
Click and hold the arrows to "walk" around your scene in the arrow's direction.

Sensitivity
Like its name describes it, this adjustment will control the sensitivity of the controls in order to move around the scene in Walkthrough mode. You can either move the slider around or type a value in the box.

Accept/Cancel
- Clicking the X at the bottom right cancels any changes and deletes the camera from the list.
- Clicking the V at the bottom right accepts any changes and saves the First Person camera.

Walkthrough Navigation
To navigate within the scene in Walkthrough Mode, you can:

1. Use the arrows on your keyboard or the arrows in the widget.
2. Hold the left mouse button and drag in the direction you would like to move.
3. Hold the right mouse button and drag to rotate in place.
4. Hold the middle mouse button to pan the camera.
Lens Settings

The various Lens Settings can be found in the Projects window, under Camera tab, Lens Settings. The Lens types include:

- Perspective
- Orthographic
- Shift
- Panoramic
Perspective

The Perspective lens closely represents how a physical camera lens works.

**Tip**
When trying to match perspective in an backplate image, it is recommended to set the Perspective value to the camera lens focal length which is often included in the Exif data.

**Match Perspective**

Perspective Matching allows you to interactively match the Perspective camera to the camera with which a background image was taken. In order to activate Match Perspective, please load a Backplate. See Adjusting Environments for further information on this topic.

When clicking on the Match Perspective button, a widget apperas in the Real-Time View and you will also notice 2 or 3 sets of vanishing lines in different colors - The lines and colors correspond to the scene's coordinate system. X is blue, Z is red, and Y is green.

**Two-Point Perspective**

This is the mode used in most cases.
Adjust the vanishing lines according to the plane on which the object is placed.

**Three-Point Perspective**

Three point perspective is most commonly used when trying to place building or object when the camera is placed at a low or high eye level. Adjust the perspective with 3 sets of orthogonal lines to match the vanishing points to the plane on which the object is placed and of vertical lines. Make sure the up axis of the matched perspective is the same as the one in the scene.

**Lock Rotation**

When the rotation is locked any adjustments to the 3 sets of lines will not affect the azimuth.

**Ground Grid**

Turn on ground grid in the scene to help match the perspective. the grid will not be visible in rendered output.

**Reset lines**

Reset all sets of lines to their default position. The camera will update accordingly.

For best results we recommend to turn on Show Coordinate Legend, found under the View menu. It can also be toggled on and off using the Z' hotkey. This will help you identify the orientation of the model in the scene.
**Perspective / Focal Length**

The *Perspective / Focal Length* controls the amount of distortion (convergence) seen in the Real-time View; real world values can be used here to replicate camera lens focal lengths.

**Field of View**

*Field of View* (FOV) is inversely related to Perspective and controls the “cone of vision” seen in the Real-time View. Larger Perspective values will result in a smaller Field of View, while smaller Perspective values increase the amount that’s visible in the Real-time View.

**Ground Grid**

*Ground Grid* will overlay a 1:1 grid on the KeyShot ground plane; the density of the grid is controlled by the Environment size. This grid is useful for matching perspective and camera angles and will not be visible in rendered output.

**Popular focal lengths**

(Source: [Wikipedia](https://en.wikipedia.org/wiki/List_of_camera_focal_lengths))

- 14 to 21mm: Ultra-Wide — Dramatic distortion due to very short focal length.
- 24 to 35mm: Wide — Wider field of view than a standard lens. The resulting perspective can show some distortion.
- 50 mm: Standard — Some distortion but generally acceptable for most use.
- 85 mm: Portrait — Less distortion than standard lenses.
- 135 mm: Telephoto — Commonly used to capture faraway objects or in product photography for
- 200 to 500 mm: Super Telephoto — Specialized lenses for minimal distortion.

Tip

For the best results try to find orthogonal lines in the backplate image that you can use as guides when matching the perspective. Move the end points of the lines according to the coordinate layout to reference points in the background image. Notice the camera values update accordingly. Once aligned, pan and dolly the camera to position the object so it fits properly inside the scene.
Orthographic

An Orthographic lens uses parallel projection to view the scene: all lines parallel to each other appear parallel regardless of camera distance or position. An orthographic lens is most commonly found in CAD modelers and is not affected by perspective distortion, foreshortening, or parallax. This means that relative distance in the realtime view is always accurate for any parallel or perpendicular lines.
A shift lens is useful for recreating two-point perspective camera views. It allows you to keep a camera’s position while shifting the viewing plane to eliminate vertical distortion. Most commonly seen in architectural photography, a Shift lens can be used to remove the third (vertical) vanishing point in product photography.

**Estimate Vertical Shift**

To use the Shift lens, press the Estimate Vertical shift button. This will set your camera facing forward and calculate the Vertical Shift value, needed to achieve a 2 point perspective lens.

**Perspective/Focal Length and Field of View**

Perspective/Focal Length and Field of View controls the amount of distortion (convergence) seen in the Real-time View, real world values can be used here to replicate camera lens focal lengths.

**Vertical Shift and Horizontal Shift**

These control the vertical and horizontal movement of the camera’s viewing plane; these values can be adjusted beyond the slider extents (including negative values!) to control what’s visible in the Real-Time View.

Any time the camera position is changed, it is necessary to re-calculate the shift values by pressing the Estimate Vertical Shift button. This ensures that the values are correct for the current camera position and orientation.

**Ground grid**

Ground Grid will overlay a 1:1 grid on the KeyShot ground plane; the density of the grid is controlled by the Environment size. This grid is useful for matching perspective and camera angles and will not be visible in rendered output.

Learn more

A blog post showing the use of the Shift lens can be found here: https://blog.keyshot.com/2016/use-shift-lens-setting-keyshot
Panoramic

The Panoramic Lens Setting for Cameras allows you to render a Spherical or Cube Map image in real-time or rendered output. This feature can be used to render out your own spherical EXR images to use as environments to light KeyShot scenes or to load in your VR headset image viewer.

Whenever a Panoramic lens is used, the camera position will be limited to spherical 360 degree viewing and the camera target is used as a position reference.

Using the Panoramic Camera

In the Camera tab, under Lens Settings, select Panoramic. Select your desired format of Spherical or Cube Map from the Mode radio buttons. The Real-time View will display a Panoramic Preview message at the top to indicate you are Panoramic mode. This means the camera can be rotated spherically and the real-time rendering in the Real-time View will not occur.

Cube Map mode

When using the Cube Map Mode the Resolution in the Image tab will be locked at a 6:1 ratio. Cube Maps are essentially 6 squares that make up a cube, and they are primarily used with VR Headsets.

Spherical Mode

When using the Spherical Mode the Resolution in the Image tab will be locked at a 2:1 ratio. Spherical maps are 1 image and they can be used to create EXR images for.

Tip
If the map does not appear clear, try to increase the pixel count of the current Resolution in the Image tab.

Preview Map

Click the Preview Map button to open a flat preview of your Panoramic image.

Reset Panoramic Camera

In the bottom of the Real-Time View there is a button which enables you to return the camera to the original view.

Moving a Panoramic Camera

Since the Camera Position is limited to spherical 360 degree viewing, there may be times where you want to adjust the camera position. There are two ways to move a Panoramic Camera.

1. Position and Orientation
   You can use the Position and Orientation sliders or input boxes in the Camera tab to adjust Distance, Azimuth, Inclination and Twist. Grab the slider to make fast adjustments or enter a value into the input box for more precision.

2. Geometry View (Pro only)
   If you are using KeyShot Pro, you can move the camera in the geometry view. You can open the Geometry View (Window...
w, Geometry View...), select the Geometry View icon on the Ribbon or hit the O-key.
In the Geometry View, right-click the active camera and select Move Active Camera Position to adjust the camera. When you move the active camera, you will see it automatically adjust to keep the same camera target.
Stereo (VR)

Stereo mode will display when Perspective or Panoramic is selected in Lens Settings.

The Stereo setting allows for a scene to be viewed in real-time or output as still images and animations using virtual reality (VR) hardware.

Spherical and Cube Maps offer a 360-degree stereo viewing experience while Stereo Perspective shows a stereoscopic image of the viewport. For more information on using KeyShot with VR devices, please see the Virtual Reality section.

Head-Mounted Display (HMD)

Support is available for real-time viewing using Oculus Rift and HTC Vive Head-Mounted Display (HMD) viewing (currently Windows only). From the Camera tab, enable the Stereo option for your Perspective or Panoramic camera. Click the Head-Mounted Display button to select Oculus Rift or OpenVR for HTC Vive to open the HMD viewing window.

Note
An HMD must be connected for the Head-Mounted Display button to be enabled and viewing window to be activated.
**Depth of Field**

Depth of Field allows you to set the focus distance and the f-stop of the camera just like you would with a regular camera.

To enable the depth of field, go to Project Camera and click on the Depth of Field check box, or hit the D hotkey. Once enabled you can either use the *Select Focal Point* button or use the manual values to set the focal distance.

**Select Focal Point**

By clicking on the *Select Focal Point* button you can then click on any part of the real-time view and KeyShot will focus on that point and blur out rest of the scene in accordance with the F-stop.

**Focus distance**

The distance from the camera to where the image is the sharpest.

**F-stop**

Adjusts the virtual aperture of the camera. This determines the extent of the area that is "in focus".

High F-stop values will produce the deepest images, while smaller f-stop values result in more shallow images, where the front/background are blurred.

**Tip**

When Depth of field is enabled, turn on the Geometry View to see a visual representation of Focus Distance and F-stop.

Depth of field is only used with Perspective, orthographic or shift lenses.
Image
This section covers all items found in the Image tab of the Project window.

Note
Render Region have in KeyShot 8 been moved out of the Image tab. It can now be found in the Ribbon and when enabled the size can be entered in the Real-Time View.
Resolution

Resolution is the first item found in the Project > Image tab. This resolution defines the width and height in pixels of the real-time view and the aspect for final image output. For example, if you plan to render at 1920*1080px you want to make sure the resolution set in the Image tab has the same aspect.

🔒 Lock Aspect

When Lock Aspect is the active the Real-Time View will adapt to the size of the application window while maintaining the correct aspect ratio for the image. The aspect ratio set here also defines the the aspect of the final image output.

🔒 Lock Resolution

If you do not want the Real-Time View to adjust size as you resize the docked windows and application window you can enable Lock Resolution. This will make sure your image always matches the given pixel size.

Presets

KeyShot comes with a number of standard presets which can be selected from the Presets dropdown. This will automatically lock the aspect to the selected preset and the image will fit within the Real-Time View. Meanwhile if you have Lock Resolution checked and the application window is not docked when selecting a preset, the Real-time View will adapt to the size of the image and may even exceed the size of the monitor.

If your desired output resolution is not populated in the Presets dropdown you can manually type in the values or you can create a custom resolution or aspect preset by selecting Edit Custom from the Presets dropdown. Once created, you can access your custom presets through the Custom flyout menu in the Presets dropdown.

Tip

If the image does not adapt to the size of the Real-Time View automatically try to move the camera or resize one of the docked windows.
Image Styles

Image Style allow you to add non-destructive image adjustments to your scene and see the result instantly. The Image Style adjustments include tone, curve, color and image effect settings that can be applied and seen in the Real-time View or render output window.

Image Style List

The Image Style list allows you to add an unlimited of Image Style variations. Additionally, when setting up Studios, you can combine them with Cameras, Environments, Model Sets and Multi-Materials.

Image Style Types

KeyShot has two types of Image Styles:

- Basic Image Style - Includes basic adjustments for Exposure and Gamma.
- Photographic Image Style - Offers more versatile adjustments including Tone Mapping, Curve, Color and Layers.

Both Image Style types have options for Bloom, Vignette, and Chromatic Aberration.

Previous Versions

- Basic Image Style is almost identical to the Image Adjustments and Image Effects options in previous versions of KeyShot. If you open a scene from a previous version with Image Adjustments/Effects they will be added as a Basic Image Style.

How Image Styles Are Applied

Image Styles are applied in two ways. First, they can be set up in real-time and seen in the Real-time View as you work. When rendering, they are applied post-process (after the rendering), so they will not affect render performance or time. This also means that render previews in Network Rendering will not show the Image style adjustments.
Basic Image Style

**Adjustments**

- **Exposure** - Determines how affected the scene is by the light. Increasing the EV (exposure value) by 1 will double the amount of light in the image.
- **Gamma** - Adjust the image's intensity with gamma. Decreasing the gamma will make the image darker while increasing the gamma will lighten the image.

**Bloom**

- **Bloom Intensity** - The brightness of the light fringing or glow.
- **Bloom Radius** - Determines how far the bloom glow extents in pixels.

**Note**
The Bloom radius is defined in pixels and this value is not relative to the resolution. This means that the bloom radius will not scale in the Render Output if the Render Output has a larger resolution than the Real-Time View.

- **Bloom Threshold** - The clipping of the bloom glow to bright pixels. A value of 0 means no clipping. Larger values focus the bloom on the brightest pixels.

**Vignette**

- **Vignette Strength** - Determines how strong the vignette is, the higher the value the more solid the vignetting color will seem in the corners.
- **Vignetting Color** - Choose the color that the vignette fades into, defaults to black. Click in the color-field to trigger the color selector.

**Chromatic Aberration**

Chromatic Aberration occurs in real life when the camera lens is unable to focus all colors to the same point. This results in colored fringing along the edges of the object. With Image styles you get an approximation of the effect.

- **Aberration Strength** - Determines how strong the effect is.
- **Aberration Bias** - Controls the color of the distortion.

**Known Issue**
Using Chromatic Aberration on a model that exceeds the image size may cause artefacts near the edges.

**Legacy image styles**
If you open a KeyShot 7 scene with Image Adjustments/Effects they will be added as a Basic Image Style.
Photographic Image Style

The Photographic Image Style takes advantage of the HDR image and gives you more control when you want to enhance details in areas that would otherwise be perceived as underexposed or blown out. In the Basic Image Style, the range is linear and stops at pure white (Whites) while Photographic Image Style offers control of the range beyond Whites with Highlights.

Tone Mapping

- **Exposure** - Determines how affected the scene is by the light. Increasing the EV (exposure value) by 1 will double the amount of light in the image.
- **White Balance** - Adjust the color temperature of your image. Negative values will return warmer tones and positive will give cooler tones.
- **Contrast** - Determines the difference between black and white. When you lower the contrast, the colors will start melding together, while increasing the contrast will make bright parts brighter and dark parts even darker.

Curve

- **Histogram** - The histogram gives a visual representation of the shadows, midtones, lights, whites, and highlights in the image. Each control point is tied to a value and any changes made to either the input values or position of the control points will update respectively. The histogram can be hidden/shown by toggling the little triangle next to the histogram title.
- **Shadows** - Add detail in these areas by increasing the shadow value or make the dark areas of your image seem even darker by decreasing the value.
- **Midtones** - When adjusting the midtones, you affect the values mid-way between shadow and highlight. Increasing the value makes midtones lighter while decreasing makes midtones darker.
- **Lights** - Adjusting the Lights value will affect the lighter areas within the midtone range.
- **Whites** - This value represents the "white-point" e.i. the equivalent of white paper seen in daylight. Increasing the value will make whites seem "whiter" - while decreasing the value will make them more grey.
- **Highlights** - Adjusting Highlights affects the areas that are receiving the largest amount of light and are reflecting light source most efficiently. Add detail to these areas of your image by decreasing the highlight value or make the areas seem even brighter by increasing the value.

Color

- **Saturation** - Uniform increase/decrease of the intensity of the colors. Negative values will desaturate your image while increasing the value will make the colors in your image more saturated. 0 is neutral.
- **Vibrance** - Increases the intensity of more muted colors without adjusting the saturated colors.

Bloom

- **Bloom Intensity** - The brightness of the light fringing or glow.
- **Bloom Radius** - Determines how far the bloom glow extents in pixels.

Note

The Bloom radius is defined in pixels and this value is not relative to the resolution. - This means that the bloom radius will not scale if the Render Output has a larger resolution than the Real-Time View.

- **Bloom Threshold** - The clipping of the bloom glow to bright pixels. A value of 0 means no clipping. Larger values focus the bloom on the brightest pixels.
Vignette

Vignetting adds a light fall-off where the image typically gets darker towards the corners.

- **Vignette Strength** - Determines how strong the vignette is, the higher the value the more solid the vignetting color will seem in the corners.
- **Vignetting Color** - Choose the color that the vignette fades into, defaults to black. Click in the color-field to trigger the color selector.

Chromatic Aberration

Chromatic Aberration occurs in real life when the camera lens is unable focus all colors to the same point. This results in colored fringing along the edges of the object. With Image styles you get an approximation of the effect.

- **Aberration Strength** - Determines how strong the effect is.
- **Aberration Bias** - Controls the color of the distortion.

Known Issue

Using Chromatic Aberration on a model that exceeds the image size may cause artifacts near the edges.

Layers

- **Background Color** - Checking the background color will place model on a solid colored background, you can set the color here - click the color-field to trigger a the color selector.

Environment background

Using a background color in the Photographic Image style will override the Environment background setting. However the colors of the shadow will still be influenced by the environment settings - So to achieve the best shadows it is a good idea to use a black background in the environment, when using a Image Style Background color

- **Use Frontplate** - With Frontplate you can add an image-layer in front of the image.
  - Add image by pressing the folder icon or by dragging an image onto the input field either from a local folder or from the library. Supported file formats include .jpg, .jpeg, .tif, .tiff, .bmp, .png, .gif, .dds, .hdr, .hdz, .exr, .tga, .ppm, .ktx, .psd.
  - You can refresh the Frontplate by clicking the refresh icon .
  - To delete a Frontplate click the trash icon .

Note

Images used as Frontplates will be stretched to fit the current aspect ratio.
• **Opacity** - Set the opacity of the Frontplate by adjusting the slider or by entering a value from 0-1, where 0 is fully transparent and 1 is solid.
Studios
KeyShot Studios allow you to combine and save scene/model/material variations in one file for quick creation and presentation. Studios may contain any combination of Camera, Environment, Image Styles, Model Sets or Multi-Materials.

The Studios window
The Studios window is a dockable window - launch it via:
- Main menu under Window, Studios...
- the Studios icon in the Ribbon
- Hotkey: U

In the top of the Studios window is a list of all the Studios in the scene. The active studio will be highlighted with a blue background.

Inline with the Studio name are icons that indicate what elements are included in that Studio.

Next to the Studios list you find the options to Add new Studio, Delete Studio and Thumbnail settings.

Under the Studios list you find five drop-down menus that display the currently active Camera, Environment, Image Style, Model Sets and Multi-Materials.

Setting up a Studio
Click the Add Studio icon in the top left corner to add a new Studio. The new Studio will be pre-populated with the active elements in the scene - but only the active Camera and Environment are included (checked) by default. You can always check/uncheck any checkbox to include/exclude that element from the Studio.

To modify a Studio simply select a different Camera, Environment, Model Set or Multi-Material from the drop-down menus.

Camera
Select which Camera you want to use in your studio. If this is not set, the studio will use the active Camera.

Environment
Select which Environment you want to use in your studio. If this is not set, the studio will use the active Environment.

Image Style
You can add an Image Style to your Studio, this includes among other things Frontplates. Visit the Image Style Section to learn more.
If no Image Style is selected the active Image style will be used.

**Model Sets**

Multiple Model Sets can be added to a Studio by checking the corresponding boxes within the Model Sets drop-down menu.

**Multi-Materials**

When The Multi-Material is checked, you can select which material (of each of the multi-materials in the scene) you want displayed in the Studio. Select a multi-material in the drop-down and you will see a list of the materials (within that Multi-Material) below the drop-down.

**Note**

When you are using Studios with the Configurator, any Model Sets/Multi-Materials that are selectable in the configuration will not be considered to be tied to a studio. This means that only Model Sets containing “props” will switch with the Studio. This also applies to multi-materials where only materials of props can change with a studio.

**Thumbnails**

When a Studio is created a thumbnail is automatically generated. If the Camera is set to *Free Camera* the thumbnail will show the environment. You can generate thumbnails for each Studio by clicking the *Render Thumbnail* button in the bottom of the window. This will create a thumbnail using the active elements of the Real-Time view.

**Thumbnail Settings**

Thumbnails settings allow you to select if/how you want to show thumbnails in the Studios List. You can also choose to reset the thumbnail to the environment thumbnail.
Viewset to Studio Conversion

Viewset to Studio Overview

Prior to KeyShot 7, you could create a Viewset, a combination of a Camera and Environment, or a Scene Set, a combination of Camera/Viewset and Models. A Studio simplifies this by combining options for Camera, Environment, Models and Materials in one window.

Opening Scenes with Viewsets

In KeyShot 7, when a scene with Viewsets and/or Scene Sets is imported, each Viewset and Scene Set is converted to a Studio. When you import a scene that contains Viewsets or Scene Sets, you will see this message:

The Studio window should appear after you open the scene. If you do not see it, select Windows, Studios... or hit the U-key. Any previous Viewset or Scene Set will appear with the same name in the list of Studios.

Studio Workflow for Adding Camera/Environment Combos

Prior to KeyShot 7, when selecting 'Add new viewset' a Viewset would appear in the camera list with a unique Camera and Environment. The same can be done using Studios using the following workflow:

1. Adjust Camera to desired position.
2. Select Add Camera and Environment Studio, Add Locked.

Another approach is to set a Camera and Environment, then Add a Studio.

1. Select an existing Camera or Add New Camera.
2. Select an existing Environment in list or drag-and-drop an Environment into Environment list and select.
3. Select Add Studio from Ribbon or Studios dialog.

You can now cycle through the Studios to view the different Camera and Environment combinations you’ve created.

Notes on Studios
• When you add a Studio, it enables the active Camera and Environment
• If you add a new camera to the camera list, it will use the camera selected
• If the Free Camera is active when a Studio is created, Camera will not be enabled for the Studio
• If you add an Environment to the Environment list, it will use the environment selected
Render

Taking a screenshot of the Real-time View may be adequate for the initial design iteration process but eventually you will need to output high-resolution Still Images, Animations, a KeyShotXR or Configurations. You can do this through the Render dialog, which is found on the KeyShot Toolbar or in the Main Menu > Render > Render...

In this section

- Render Output
- Render Options
- Render Queue
- Render Output Window (image editor)
- Region Rendering
Render Output
The Output page is where you define the file specifications. The first step is to select the type of output you desire. There are four types of output:

Still Image
A static image and the default rendering output. View options.

Animation
An animation with optional video and individual frame output. Note: This option is only available in KeyShot Pro and if there are animations in the scene. View options.

Learn more about Animation.

KeyShotXR
An interactive KeyShotXR with all code and images. Note: This option is only available if you have the KeyShotXR add-on. View options.

Learn more about KeyShotXR.

Configurator
A series of still images and their accompanying Metadata of optional Model, Material, and Studio Variations.

Note: This option is only available in KeyShot Pro and if there are Configurations in the scene that were created through the Configurator Wizard.
Still Image Output

The Still Image output option provides output of a single static image as well as options for render layers, render passes and region rendering.

Output Options

Name
Set the file name of the render in the text field. If one is not entered, the default name will be the scene name with an incremental suffix.

Folder
Choose where the render will be saved. Unless a specific folder is chosen, it will be saved in your KeyShot 7 Renderings folder.

Resolution
Set the resolution of the render in pixels.

Print Size
Set the print size in inches.

Output Options

Layers and Passes

Region
Set the region of the render to be saved.

On this page

- Output Options
- Layers and Passes
- Region
Format
Choose from PNG, JPEG, EXR, TIFF, TIFF 32-bit, PSD and PSD 32-bit. All formats other than JPEG can include an alpha channel. When PSD or PSD 32-bit is selected you will see a checkbox appear in the Layers and Passes section to Add to PSD.

Note
The KeyShot output formats have various bit depths.

<table>
<thead>
<tr>
<th>BIT DEPTH</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>8-bit</td>
<td>PNG, JPEG, TIFF, PSD, EXR, TIFF 32-bit, PSD 32-bit</td>
</tr>
<tr>
<td>Floating point</td>
<td>EXR (16-bit half-precision), TIFF 32-bit, PSD 32-bit</td>
</tr>
</tbody>
</table>

Include Alpha (transparency)
If the selected format supports transparency you can choose to include it in your image.

Metadata
When this option is enabled a file will be output with your still image. Metadata provides useful reference information including: scene name, Camera name and properties, Environment name and properties, active Model Sets, active Studio, Lighting settings, material names and Render Quality settings.

Click to select the format of the metadata:
- .xmp - This file can be read by any text editor and can also be imported to Adobe applications.
- Simple (.meta) - This file is formatted for easier reading.

Resolution
Set the resolution of the render. Type it in or select from the presets.

Print Size
If final output is for print quality, enter in the dimensions of the print size as well as the desired DPI. After size has been set, the resolution will update with the correct dimensions.

Layers and Passes
See Layers and Passes section.

Region
Select the Region render checkbox to enable rendering a smaller portion of your overall image. Rendering a smaller region speeds up the rendering time. This is useful when only a small change to one part of a scene is needed. After enabling Region render, select and move the drag points to resize the region in the Real-time View window or enter a specific Left and Top location, or Width and Height. Note: Units are in pixels.
See the Render Region page for info about Render Region in the Real-Time View.
Output Options

Resolution
Set the resolution for the animation being rendered. Choose from the Preset drop-down, or enter in your own custom dimensions.

Time Range
Specify the range of the animation to be rendered. Default is “Entire Duration.” You can also set the designated work area to be rendered, as well a specific frame range. The “duration” and “frames” auto updates when time range is changed.

Video Output
Enable to output a video of the animation. Set the name and Folder location where the animation will be saved. Choose a file format in the drop-down.
Frame Output
Enable to output every frame used to create the animation. Set the file name and folder where the frames will be saved. The "%%d" in the name-input adds a sequenced postfix to the frame name. In order to modify the postfix change the "%%d" to i.e. "%%04d" if you want the frames to have the format frame.0001.png.

Layers and Passes
See Layers and Passes section.

Region
See the Region Rendering page.
The KeyShotXR output option is available if the KeyShotXR Add-on is installed. It provides setup and output of a KeyShotXR as well as options for render layers and render passes.

Most of the parameters set in the KeyShotXR Wizard can be edited in the KeyShotXR Render Output options. Additionally, there are other options for file format, file size, and iBooks output for viewing on iOS devices. There are also Advanced options for KeyShotXR control, customization and direct upload to a website via FTP.

**Output Options**

- **Name**
  Give the KeyShotXR a name. The frames will be located in a folder with the same name.

- **Folder**
  Set a destination folder the XR files will be added along side with a new folder containing all image files etc.

- **Viewing Resolution**
  Set the resolution

- **Format**
  Choose JPEG or PNG for the frames. Check Alpha if you want transparency on .png images.

- **File Size**
  Selecting the "Preview" button will render one frame from the KeyShotXR and has a compression slider that allows adjustments to the quality of the image, and updates in real-time. Be aware that a larger file size could increase the time to load the KeyShotXR in the browser.

- **Create iBooks Widget**
  If this is enabled, a HTML5 widget will be output in the same folder as your KeyShotXR which can be embedded in an iBook using iBooks Author.

Learn more about Embedding a KeyShotXR in iBooks.

**KeyShotXR Control**

- **Rotation Control**
  - **Environment**
    This option will set the center of rotation at the center of the scene.
  - **Object**
    Select an object in the scene as a center of rotation.
  - **Camera**
Use the current camera settings to use as your rotation center.

Look At
Use your current “Look At” as your rotation center.

Custom
This option allows you to select the center of rotation from your scene tree items.

Horizontal Environment Rotation
Enable this option to have the environment rotate with the KeyShotXR.

Smoothness Control

Animation Frames
If animation is applied to the scene, you will be able to create a KeyShotXR from this animation. Additional parameters will be shown if enabled. See previous page for animation frames settings.

Horizontal Frames
This controls the number of frames in the “X” direction. The higher the number of frames, the more smoothly your model will rotate.

Vertical Frames
This controls the number of frames in the “Y” direction. The higher the number of frames the more smoothly your model will rotate.

Number of Images to be Rendered
This shows the number of images to render based on the number of horizontal and vertical frames.

Horizontal/Vertical Angle Increments
This shows the degrees between each frame. This value will change depending on the number of vertical and horizontal frames and the starting and ending angles.

Angle Control
This is equal to the custom setting of the KeyShotXR Mode in the wizard and controls possible viewing angles of KeyShotXR. If you want to use presets such as Turntable, Spherical, Hemispherical or Tumble use the wizard.

Horizontal
This controls the beginning and end of the rotation on the “X” plane.

Vertical
This controls the beginning and end of the rotation on the “Y” plane.
**Advanced**

Advanced settings for KeyShotXR are located in a drop-down menu on the same window as the custom settings. This menu controls how your KeyShotXR interacts in the web browser.

**Rotation Damping**
Increasing this value will increase the smoothness of the camera rotation when panning inside the web browser.

**Mouse Sensitivity**
This controls the overall mouse sensitivity in the KeyShotXR. Increasing this value will increase the model movement with less mouse movement.

**Zoom-In**
Enabling zoom-in will allow you to zoom into the KeyShotXR when inside the browser. Use the “Maximum Allowed Zoom-In Percent” slider to control the amount the user can zoom in your KeyShotXR.

Note: To ensure the browser page will scroll when the mouse scroll wheel is used while over the KeyShotXR, this option will need to be disabled.

**Preserve Image Quality**
Enable this option to render the frames at larger resolution for optimal image quality when zooming in. The image quality will be preserved when zooming in by enlarging the rendered frame resolution accordingly. This is separate from the viewport resolution setting for each frame. This will also increase the KeyShotXR file size.

**Download on interaction**
Enabling this option will set the KeyShotXR to only load the images into the browser after the user interacts with the KeyShotXR.

**Allow Fullscreen Mode by Double-Click**
Double-clicking the left mouse button will enter full-screen mode.

**Show Loading Icon**
Enabling this will allow the loading icon to be shown when the KeyShotXR is loading in the browser. This image can be changed by selecting “Browse” and browsing to the image file you prefer.

**Name of Div**
This defines the KeyShotXR section in the HTML code.

**FTP Deployment**
Enable this option to allow KeyShot to load the rendered KeyShotXR directly into your FTP address.

**Confirm Before Deployment**
When the KeyShotXR is finished rendering, you will be prompted to accept the deployment to the FTP site.

**Generate Embeddable HTML Code**
This will give you the code necessary for implementing your KeyShotXR in a website using the iframe tag.
Embed FTP Settings in BIP File
This will save all the FTP credentials inside your KeyShot BIP file for easy deployment by another user.

Layers and Passes
See Layers and Passes section.
Configurator Output

The Configurator output option provides a series of still images and their accompanying Metadata of optional Model, Material, and Studio Variations that were setup via the Configurator Wizard.

**Output Options**

**Include**
This option allows you to specify which variations are included in the Configurator output.

**Images**
This value will display the total number of images to be output determined by the included variations. The value will update dynamically as the Include check-boxes are marked and unmarked.

**Name**
Set the file name of the render in the text field. If one is not entered, the default name will be the scene name. It is important to
keep the "%%d" as this will add incremental post-fixes to each variation.

Folder
Choose where the render will be saved. Unless a specific folder is chosen, it will be saved in your default rendering-folder.

Format
Choose from JPG, TIF, EXR, TIF 32 Bit, PNG, PSD, and PSD 32 bit. All formats other than JPG can include an alpha channel.

Resolution
Set the resolution of the render. Type it in or select from the presets.

Print Size
If final output is for print quality, enter in the dimensions of the print size as well as the desired DPI. After size has been set, the resolution will update with the correct dimensions.

Layers and Passes
See Layers and Passes section.

Region
Select the Region render checkbox to enable rendering a smaller portion of your overall image. Rendering a smaller region speeds up the rendering time. This is useful when only a small change to one part of a scene is needed. After enabling region render, select and move the drag points to resize the region in the Real-time View window or enter a specific Left and Top location, or Width and Height. Note: Units are in pixels.

See the Region Rendering for more info.
Layers and Passes

KeyShot supports output of render layers and render passes. Render layers output specific parts and models assigned to layers, while a render pass outputs a specific attribute of the scene on its own layer. For example, a Lighting pass will output all the lighting on a single layer while a Shadow pass will output all the shadows on a single layer.

Output of layers and passes is used to separate out all the various aspects of the scene to provide more control in post processing operations. For example, you may want to adjust the intensity of light, shadows or a materials color. Having any of these on a separate layer gives you this control.

An image like the example below can be decomposed in individual render layers and render passes.

The model in this scene was created by dk and downloaded from GrabCAD

**Render Layer Output**

This option is only available if you have assigned parts and models to a render layer. Select All Render Layers checkbox to enable layer output. Select the gear icon 🛠️ to show the Render Layer Settings dialog and select the Alpha (Transparency) Mode for the layers.

**Alpha Modes**

The Render Layer alpha modes include:

- **Straight Alpha - Unmatted** - (Default) This alpha mode extends the color at the edges of Render Layers to the semitransparent pixels of anti-aliased edges. This avoids any black fringing when
compositing the Render Layers in post-processing. This alpha type is the default, as it provides the best results in most situations.

- **Premultiplied Alpha - Matted with Black** - This alpha mode premultiplies the Render Layer image by blending or matting any semi-transparent pixels, due to anti-aliasing, with black. This can cause black fringing when compositing the Render Layers, if the image editing application does not support specifying the black matting color and adjusting for it. In Photoshop, the issue can be remedied by trying one of the matting options, found under Image > Matting.

- **Aliased - Opaque Fringe** - This alpha mode extends the color at the edges of Render Layers and creates fully opaque (aliased) edges. This avoids any transparent gaps between adjoining Render Layers when compositing the Render Layers in post-processing. Due to the negative visual consequences of aliased edges, this mode should only be used if gaps between Render Layers are a dealbreaker. Rendering at higher resolutions will make the aliasing less noticeable though.

The example below shows the Still Image rendering of two interlocking rings.

The outer (blue) and inner (white) rings were put on two separate Render Layers.

The examples below show the result for the different Alpha Modes when compositing the Render Layers on a solid green background color. Click the images to enlarge.
With "Straight Alpha - Unmatted" enabled, the Render Layer edges don’t show fringing (black matting), and the green background color bleeds through the anti-aliased gap between the two Render Layers.

With "Premultiplied Alpha - Matted with Black" enabled, the Render Layer edges show black fringing, and the green background color bleeds through the anti-aliased gap between the two Render Layers.

With "Aliased - Opaque Fringe" enabled, the Render Layer edges show opaque and aliased fringing, and there is no gap between adjoining Render Layers, so that the green background color does not bleed through.

**Note**
Enabling the render layers option will render all render layers created. To create a render layer go to the Project window, Scene tab. Go Properties, Render Layer to create a render layer. Select a part or group of parts and select the render layer you would like it to be on.

**Render Layer example**
The examples below show the different render layers of above scene.
Render Pass Output

Select All Render Passes checkbox or the checkbox next to the individual pass type to enable pass output. Doing so will render the selected pass(es), along with the original image format specified on the output tab. Select the PSD or PSD 32-bit option from the Format drop-down menu to enable the Add to PSD checkbox. This will compile all your passes into a single PSD file.

Note
Render Passes are always saved as separate EXR files. This is done to allow maximum flexibility and quality in post-processing. Most modern image editing and compositing applications can work with EXR files.

Please note that when rendering to PSD (not 32-bit) with "Add to PSD" enabled, all Render Passes are embedded in a 8-bit PSD file. As a consequence, some information will be lost. If maximum flexibility is desired, PSD 32-bit should be used instead.

KeyShot supports 12 types of render pass output, including:

Diffuse Pass

The Diffuse pass creates an image containing the diffuse color of all materials in the scene, including Labels.
Lighting Pass

The Lighting pass creates an image containing only the direct component of the lighting in the scene. Furthermore, this pass is multiplied by the materials' diffuse color.
Global Illumination Pass

The Global Illumination pass creates an image containing only the indirect component of the lighting in the scene. Furthermore, this pass is multiplied by the materials' diffuse color.

Note:
When Global Illumination is disabled in the Lighting tab, the Global Illumination pass will result in a completely black image.
Caustics Pass

The Caustics pass creates an image containing the lighting from caustics in the scene.

**Note**

When Caustics is disabled in the Lighting tab, the Caustics pass will result in a completely black image.
Reflection Pass

The Reflection pass creates an image containing the reflections of all reflective materials in the scene.

Note
The Reflection pass does not include the specular reflections of Light Source materials.
**Refraction Pass**

The Refraction pass creates an image containing the refractions of all refractive materials in the scene.
Shadow Pass

The Shadow pass creates an image containing shadows from all light sources in the scene, both HDRI lighting and physical lights (light source materials).
Ambient Occlusion Pass

The Ambient Occlusion pass creates an image where unoccluded surfaces are colored white, and occluded surfaces black. This pass can be used in compositing to accentuate crevices and internal model edges.
Clown Pass

The Clown Pass creates an image where each material is displayed as a flat color for easy selection and masking in an image editor or compositor. When the Clown Pass is enabled you have the option to "Separate Labels in Clown Pass" which can be accessed from the icon.

Color differentiation follows these rules:

- Pure primary rgb colors are assigned first, then secondary colors, then tertiary.
- The colors are only distributed among objects that are set to show in the currently active Model Set(s).
- This means that the less materials that are active the better the clown results will be.
Clown Pass with "Separate Labels in Clown Pass" disabled (default)
Depth Pass

The Depth pass creates a depth map, which is an image that contains information relating to the distance of surfaces to the camera. Depth maps are used in other applications like Adobe Photoshop and Adobe After effects to simulate effects like depth of field.

Tip
Since each pixel in the Depth pass represents an actual distance from the camera to the model surface, this pass might display with unexpected results in an image editor. Typically, the Depth pass will show as completely white. To reveal a greyscale image in Photoshop you can perform the following steps: Image > Adjustments > HDR Toning > Method: Equalize Histogram.
Depth Pass as displayed in an image editor (preview completely white)
**Normals Pass**

The Normals pass creates an image where each pixel represents the geometry's orientation, using the surface normals in the scene. By default, the normals are generated in world space (relative to the scene). When the Normals Pass is enabled you have the option to enable "Camera Space Normals" which can be accessed from the icon.

A Normals pass can be helpful for quick relighting in post without having to rerender the scene.

**Tip**

A Normals pass with "Camera Space Normals" can directly be used as a normal map for bump on materials.
Normals Pass with "Camera Space Normals" disabled (default) - Normals are in World Space
Labels Pass

When this is enabled all Labels will be output on a single image with alpha.

Tip
A Clown pass with "Separate Labels in Clown Pass" enabled can be used to select or mask the individual Labels.
Compositing examples with Render Passes

Render Passes can be used in various ways during post-processing. Below are two basic examples of compositing workflows with Render Passes, using Photoshop to explain the concepts.

Reconstruct Beauty image from Passes

Passes can be used to reconstruct the rendered still image, commonly called the "beauty pass" in compositing workflows. Adding together the Lighting, Global Illumination, Caustics, Reflection and Refracti on Passes allow to achieve the beauty image.

In Photoshop, adding is done by setting each pass layer's blending mode to "Linear Dodge (Add)".

Note
Some discrepancies may exist between the rendered still image and a composite using Render Passes. Furthermore, Render Passes do not capture some of the more complex material effects like translucency (Translucent material).
Adjust Beauty image with Passes

The same passes from the workflow above can also be used to strengthen or weaken their effect on the beauty image.

In Photoshop, strengthening the effect of a pass is done by setting the pass layer’s blending mode to “Linear Dodge (Add)”. Weakening the effect is done by setting the blending mode to “Subtract”. In both cases, the beauty image should be the base layer, positioned below the passes.

The example below shows the effect of adding the Reflection pass to the beauty image.
The composited result: beauty + reflection

The rendered still image (beauty pass) for reference

The example below shows the effect of subtracting the Global Illumination pass from the beauty image.

The composited result: beauty - global illumination

The rendered still image (beauty pass) for reference

Formats for Render Layers and Passes
Below is an overview of the image formats of Render Layers and Passes for the different output formats.

<table>
<thead>
<tr>
<th>Output Format</th>
<th>Render Layer Format</th>
<th>Render Pass Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>PNG</td>
<td>PNG</td>
<td></td>
</tr>
<tr>
<td>JPEG</td>
<td>PNG</td>
<td></td>
</tr>
<tr>
<td>EXR</td>
<td>EXR</td>
<td>EXR</td>
</tr>
<tr>
<td>TIFF</td>
<td>TIFF</td>
<td></td>
</tr>
<tr>
<td>TIFF 32-bit</td>
<td>TIFF 32-bit</td>
<td></td>
</tr>
<tr>
<td>PSD</td>
<td>Last used format</td>
<td></td>
</tr>
<tr>
<td>PSD 32-bit</td>
<td>Last used format</td>
<td></td>
</tr>
</tbody>
</table>

Notes
1. The Clown Pass is always saved as a separate PNG file (except for PSD and PSD 32-bit with "Add to PSD" enabled).
2. The Depth Pass is always saved as a separate EXR file (except for PSD 32-bit with "Add to PSD" enabled).
3. When rendering to PSD with “Add to PSD” checked, all Render Layers and Passes will be embedded in the PSD file.
Render Options

The Render Options window contains all settings for Render Mode, CPU Usage, and Render Quality. These options are specific for the Still Image, Animation and KeyShotXR output.

Mode

Default

The Default render mode simply allows you to render immediately after adjusting your render output settings or, if using KeyShot Pro, to send your render to the render queue.

Background (PRO)

The Background render mode option allows you to run the render in the background and continue working. Note: the Real-time View will be paused by default when the render is started. Select Render and un-checkPause Real-time Render to un-pause the Real-time View and continue working.

Send to Network

If you use KeyShot Network Rendering, the Send to Network render mode allows you to send your render to the KeyShot Network Rendering Monitor. Make sure the Monitor is installed and running to send a job to be rendered on the network. Visit the KeyShot Network Rendering Overview for more information.

CPU Usage

For Default and Background render modes, the CPU Usage setting allows you to specify how many CPU cores you want to utilize for rendering your project. Selecting Use Realtime CPU Settings will use the CPU Usage settings defined on the KeyShot Ribbon.

Quality

KeyShot has three output options for quality based on your needs.

Maximum Samples

The Maximum Samples option controls how many times the image or animation frame will be calculated and refined. Each additional sample will further smooth out noise/grain in the image. This option uses the same rendering technique as you see when working in the Real-time View. (This technique is also used in Maximum Time option, but differs from the method used in Custom Control option.)

Samples

This controls how many times each pixel in the rendered image is calculated for increased accuracy. Too low of a value will result in an image that has excessive noise. Increasing samples will reduce the noise, however, increasing this setting too high will increase render times without a noticeable difference in quality.
**Samples Per Frame**

The Maximum Samples option will read Samples Per Frame when the Animation tab is selected under the Output section. This option is ideal for animation output as it guarantees that each frame will be rendered at the same quality. Therefore, as the animation plays through the frames you will not see changes/flickering in shadows or noise patterns on materials.

**How many samples should I use?**

Generally speaking, a simple scene will require fewer samples and a scene with more complex lighting and materials will require more samples. Start low and increase the samples if you still see noise or the render looks grainy. Before rendering out an animation using Maximum Samples, test your samples with a still image render first.

**Samples and Resolution**

A sample calculates the color of a pixel. There is a point of diminishing returns where you increase samples past the point of added quality, and just increase the render time.

Something important to be aware of is that as you increase the resolution of your image or animation, each pixel covers relatively less area of the image. This means you can use a lower samples setting when rendering at higher resolutions. Note that this does not apply to rendering with area lights, caustics or interior mode as increasing samples while using those features will still increase the quality.
This method is typically preferred over the time-based output for animations, as some frames may require substantially more time to reach the same quality level as levels of detail and complexity change through the course of your animation. Using the time-based output will lead to more noise in the more complicated frames.

**Maximum Time**

The *Maximum Time* option for render quality will progressively refine the render for the amount of time set. This option uses the same rendering technique as what you see in the Real-time View. This technique is also used in Maximum Samples option, but differs from the method used in Custom Control option.

When rendering an animation, you may set the maximum time for each frame to render, or set a total duration for the entire animation.

**Custom Control**

The *Custom Control* option allows control over all quality settings available in KeyShot. This mode typically produces smoother results in areas of high noise or shadow.

The example below shows a Custom Control rendering with a blue plastic material. Custom Control can be a good option for efficiently rendering noise-free images of scenes with diffuse materials like plastics.
The model in this scene was created by dk and downloaded from GrabCAD

Samples
This will control the amount of rays per pixel that will be sent into the environment to gather information to determine that pixel’s final shade. It is best to control this setting per material and set a value between 8 and 16 in the render settings.

For information on samples and setting samples per material, please see the section on roughness and glossy samples.

Ray Bounces
Ray bounces are the number of times rays of light are calculated as they bounce around a scene. Ray bounces are initially set in the Lighting tab and any values entered there will be inherited by the Renderer Dialog. The value set in the Render Dialog is not however inherited by the lighting tab. This way you can adjust the amount of ray bounces for the specific rendering without affecting the general setting.

Learn more about Ray Bounces on the Custom Lighting Preset page.

Anti Aliasing
Anti aliasing is a method for smoothing out jagged edges that are created by pixels. Since pixels are made up of squares, they can produce a jagged look where edges meet. Anti aliasing smooths out these edges. In most cases, the default value of 1 is sufficient.

Increasing the anti aliasing quality can help to avoid artifacts that may occur when rendering with alpha (transparency) with objects having a very similar color to the background. For illustration, a synthetic example will be used.

The example below shows the Still Image rendering of a Flat material sphere with a Color Gradient texture whose color matches the background on one side.
The examples below show composites of the transparent rendering on a solid black background color for an Anti Aliasing quality of 1 and 5. Click the images to enlarge.

| Anti Aliasing Quality = 1 | Anti Aliasing Quality = 5 |

When the Anti Aliasing value is 1 the blue side of the sphere shows artifacts. These artifacts are absent when an Anti Aliasing quality of 5 is used.

**Shadow Quality**
Shadow quality will control the shadow quality for ground and object shadows. Note that increasing Sh
Shadow Quality dramatically increases render time. This setting will have most effect for bright diffuse materials, like for example white plastics.

| Shadow Quality = 1 | Shadow Quality = 3 |

Global Illumination Quality
This will control the quality of all indirect light. Increasing this value can dramatically increase render time. It is rarely necessary to set a value above the default value of 1. If Global Illumination is turned off, this parameter will be grayed out. Global Illumination is enabled/disabled in the Lighting tab of the Project panel.

| Global Illumination Quality = 1 | Global Illumination Quality = 2 | Global Illumination Quality = 4 |

Pixel Blur
This will apply a slight blur to the image to reduce the overly sharp look that computer-generated
images can have. Higher values will have more blur. This does not increase render time. It is advised to leave this setting at the default value of 1.5. Higher values will cause low resolution images to look overly blurry, but can be used for high resolution renderings. A value of 1 disables pixel blurring.

<table>
<thead>
<tr>
<th>Pixel Blur = 1</th>
<th>Pixel Blur = 1.5</th>
<th>Pixel Blur = 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>(No pixel blurring)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

DOF (Depth of Field)
This will control the quality of depth of field if it is enabled in the camera tab. Increasing this value will have an effect on render time. For production quality a value between 3 – 5 is recommended. If Depth of Field is not activated, this parameter will be grayed out. Please see the section on cameras for more information on depth of field.
Caustics
Increasing this value will improve the samples and quality of the caustics. If caustics are not enabled, this parameter will be grayed out. You can enable caustics in the Lighting tab of the Project Panel. The maximum value that can be entered is 50. Increasing the value will increase memory consumption, and high values will require a lot of system memory. Please see the Refractive Index page for more information about caustics.

The examples below show the effect of increasing the Caustics quality for a scene with a Solid Glass material, lit by a Spotlight.
Sharp Shadows
This will allow sharp shadows to be cast across 3D geometry when the lighting scenario would create a sharp shadow. It is more accurate to have this checked and it is enabled by default. It is generally recommended to leave this on.
Sharper Texture Filtering
This will attempt to preserve detail in textures when viewed at grazing angles. For example, imagine being eye level with a wood table and seeing the wood grain compress together. Detail can get lost in the compressed areas. This setting reduces the loss of detail. This feature can increase render time so enable only when using textures with glancing angles.

Global Illumination Cache
Disabling Global Illumination Cache replaces the potential dirty shadows and black spots with noise. These artifacts can appear when the scene has transparent materials with diffuse surfaces behind them. Increasing Global Illumination Quality will reduce the noise. Increasing the Samples will also help in reducing the noise.

The examples below show the effect of toggling Global Illumination Cache for a scene with a Cloudy Plastic material.

| Global Illumination Cache = enabled | Global Illumination Cache = disabled |

Limitation
Disabling Sharp Shadows for Custom Control also disables Global Illumination for rendering.
Render Queue

The Render Queue is used for batch processing your still image, animation, KeyShotXR, and Configurator rendering jobs.

The Queue list will display the job type, name, format, resolution, and frame count. You can hover over a job to see a larger thumbnail preview, when the job was added, the render mode and number of samples.

Add/Delete Job

Use these buttons to add and remove jobs from the queue list. Jobs are added with the current settings specified in Output and Options. Each job can have unique settings.

Send to Network

If you have KeyShot Network Rendering installed, the option to Send to Network will become available. Select/highlight one or more jobs in the Queue and click the Send to Network button.

Add ... to Queue
Add Cameras
Send saved Cameras to the Render Queue. This button is active if more than one Camera exists. Click the **Add Cameras** button to open the Camera Queue window and check the Cameras you want to add to the queue.

Add Model Sets
Send saved Model Sets to the Render Queue. This button is active if more than one Model Set exists. Click the **Add Model Sets** button to open the Model Sets Queue window and check the Model Sets you want to add to the queue.

Add Studios
Send saved Studios to the Render Queue. This button is active if more than one Studio exists. Click the **Add Studios** button to open the Studios Queue window and check the Studios you want to add to the queue.

Add Multi-Material
Send all sub-materials of a selected Multi-Material to the Render Queue. This button is active if one or more Multi-materials exist in a scene. Click the **Add Multi-Material** button to open the Multi-Material Queue window and select which variant of each Multi-Material you want to add to the Queue.
Move Up/Down

You can select a job in the list and click *Move Up* or *Move Down* to change the order of the job in the list. Jobs at the top render first. You can use the check box next to the job to turn off that job. The job will then be skipped during processing of the queue.

Process Queue

When you are ready to start the queue, click the *Process Queue* button. All jobs with a blue check-mark will be processed. You can enable/disable a multi-selection of jobs via the right-click menu.
Render Output Window (image editor)
The Render Output window shows the progress of the rendering based on the Render settings selected. This window also provides options for applying image adjustments while the image is being rendered that can be saved out when the render is complete.

Close
While the rendering is still in progress you can abort by clicking the red x this will give you the option to save the rendering at the current state or discard the image. When the rendering is finished the image is automatically saved in the selected location. Click the green check-mark to close the render output window.

CAUTION: all unsaved adjustments made in the adjustments panel will be lost. Be sure to save your render after making adjustments before closing the render output window.

Save image to file
Select the Save icon to save the current render as it appears in the Render Output window.

Hide/Show Image Styles Panel
Toggles the Image Styles panel. Here existing Image Style may be applied or new Image Styles created. Refer to Image Styles or more on how to create and apply image adjustments.

Zoom to fit
Fits the Image to the size of the view-port.

Zoom to 100%
Zooms the image to its full size regardless of the size of the view-port.

Zoom slider
When the view-port is smaller than the full size of the image, the slider allows incremental zooming the image between fitting the view-port and full size.
Region Rendering

When working on scenes in KeyShot with complex lighting or materials, you may notice the Real-time View can take longer to resolve. Real-Time Region Render can help maintain a fast workflow by allowing you to render specific regions of your scene in real-time.

To initiate Real-Time Region Rendering click the Region Rendering icon in the Ribbon.

The smaller the Real-time Region is, the faster the image will resolve, allowing you to maintain that speedy workflow.

Set up Render Region

When the Region Rendering is enabled you can control the region in 2 ways:

- Drag the corners of the region render box to set the size and drag the entire region by click+drag inside the region. To move the camera click+drag in the black area.
- Set the size and position by entering the height/width and distance from the top-left corner. The panel can be dragged to any position you want inside the Real-Time View.

When it's time to start your final render, be sure to disable Region Rendering icon in the Ribbon or uncheck the Region Render box in the Render Dialog if you want to render the extents of the Real-time View.

KeyShot is known for being a tool that offers great results in very little time. Real-time Region Rendering is one of the many features that allows you to maximize your creative output and reduce the time it takes to produce that final shot.
Scripting

Scripting allows you to unleash the power of KeyShot for automation, batch processing and more. Scripting functionality includes control for camera, lighting presets, materials and material templates, environment, background and backplates, rendering (images, animations, and XR) and opening, saving and importing files.

KeyShot scripting uses Python 3.6. To access the Scripting console go to Window, Scripting Console. You can use KeyShot's predefined scripts or create your own custom scripts inside the Scripts tab. You can also input one-line commands inside the python interpreter, located at the bottom of the Console tab.

For additional documentation that includes a quick start guide, click here.
Script Location

Scripts are located in the KeyShot Resource folder, e.g. `KeyShot 8\Scripts`. To change this location or add another location, select `Edit, Preferences, Folders` and change the path for the `Scripts` folder. Scripts in the folder will be visible in the `Scripts` tab of the `Scripting` window.
Creating A Script

To create a script, select Create from the Scripts tab. Provide a name for the script and the author.

If Python 3.6 is installed locally on the machine, then KeyShot will detect Python and all of the installed modules, such as NumPy, SciPy, PIL, etc., that can then be freely used for scripting in KeyShot (this can be disabled in the General preferences section). You may also import a script or edit an existing script using the corresponding buttons on the Scripts tab.

Vector and matrix classes are made available in the luxmath module to help with doing calculations. They are named luxmath.Vector and luxmath.Matrix respectively.

<table>
<thead>
<tr>
<th>Name</th>
<th>Author</th>
<th>Version</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Standard Views</td>
<td>Luxion</td>
<td>0.1.2</td>
<td>Creates a new camera for each of the standard views</td>
<td>File</td>
</tr>
<tr>
<td>Encode Video</td>
<td>Luxion</td>
<td>0.3.0</td>
<td>Encodes video from separate frames into a single movie</td>
<td>File</td>
</tr>
<tr>
<td>Random Scattering</td>
<td>Luxion</td>
<td>0.1.3</td>
<td>Duplicates and randomly scatters each object</td>
<td>File</td>
</tr>
<tr>
<td>Render Ambient Occlusion</td>
<td>Luxion</td>
<td>0.2.3</td>
<td>Renders ambient occlusion of current scenes</td>
<td>File</td>
</tr>
<tr>
<td>Render Animation Passes</td>
<td>Luxion</td>
<td>0.3.3</td>
<td>Renders animation frames with ctti</td>
<td>File</td>
</tr>
<tr>
<td>Render Images</td>
<td>Luxion</td>
<td>0.6.1</td>
<td>Renders all models with a chosen configuration</td>
<td>File</td>
</tr>
<tr>
<td>Render Panoramic Frames</td>
<td>Luxion</td>
<td>0.4.0</td>
<td>Renders frames similar to a panoramic shot</td>
<td>File</td>
</tr>
</tbody>
</table>
Script Examples

In this page you will find KeyShot's predefined scripts and instructions on how to use them. These scripts are listed under the Scripts tab inside the Scripting window.

Create Standard Views

Creates seven standard view cameras: front, back, top, bottom, left, right, and isometric.

How to use:

- Select script and press Run. You will receive confirmation message: Successful!
- Click OK.
- You will find the seven standard views under Project > Camera.

Encode Video

On this page

- Create Standard Views
- Encode Video
- Render Ambient Occlusion
- Render Animation Passes
- Render Images
- Render Panoramic Frames
Encodes video using an image sequence over a specific range of frames.

How to use:
- Select script and press Run. The user prompt appears.
- Click the browse button and select a folder with the image frames.
- For frame format, copy the name of the file, replacing the frame number with %d, e.g. my_new_animation.%d.jpg.
- Enter the start frame – the number in the name of the first image, e.g. 1 on my_new_animation.0001.jpg.
- Enter the end frame – the number in the name of the last image, e.g. 60 on my_new_animation.0060.jpg.
- Enter FPS for the video.
- Enter the video name.
- Click OK to begin the process.

Render Ambient Occlusion

Renders an ambient occlusion pass of your scene.

How to use:
- Select script and press Run. The user prompt appears.
- Click the browse button and if you wish to change your output folder.
- Set the output image name.
- Set the output width and height.
- Set the render time. The default value is 20 seconds. Increase the render time better quality.
- Add to queue should be enabled if you wish to add your job to the local render queue. Otherwise your job will be rendered according to your render mode options: default, background, or network.
- Decide if you wish to process your local queue after adding the job. If you disabled the "Add to queue" checkbox, then this box should also be disabled.
- Click OK to begin the process.

Render Animation Passes

Renders your animation frames with the option to output "ambient occlusion" and/or "toon outline shading" passes. Please note that in order to run this script, you must first apply animations to your scene.

How to use:
- Select script and press Run. The user prompt appears.
- Click the browse button and if you wish to change your output folder.
- Set the output file format. KeyShot uses %d to keep track of the frame number and you should leave this symbol in the name (e.g. my_new_animation.%d.jpg).
- Set the output width and height.
- Enter the start frame – the number in the name of the first image, e.g. 1 on my_new_animation.0001.jpg.
- Enter the end frame – the number in the name of the last image, e.g. 60 on my_new_animation.0060.jpg.
- Select the passes that you wish to render.
- Add to queue should be enabled if you wish to add your job to the local render queue. Otherwise your job will be rendered according to your render mode options: default, background, or network.
- Decide if you wish to process your local queue after adding the job. If you disabled the "Add to queue" checkbox, then this box should also be disabled.
- Click OK to begin the process.
Render Images

Imports all CAD files within a folder and renders them one at a time. This script can be used to render an animation from an obj file sequence. Once your images are rendered, you may stitch them up and compile the video with the Encode Video script above.

How to use:

- Select script and press Run. The user prompt appears.
- Click the browse button and select the folder with the geometry (.obj) sequence.
- For input, type the extension of the geometry without the dot (obj).
- For output, type the extension of the image format without the dot (png).
- Input the width and height of the output images in pixels.
- If you created a material template for automatic material assignment, then select your template. Otherwise, use "None".
- Click OK to begin the process.

Render Panoramic Frames

Renders a series of frames that can be used to create a panoramic view of the product (that is, 360 degrees along the vertical axis Y). Once your images are rendered, you may stitch them up and compile the video with the Encode Video script above.

How to use:

- Select script and press Run. The user prompt appears.
- Select which camera you’d like to use. The center of the camera will be the pivot of rotation.
- Set the number of frames to render. The default number of frames is 50. Since the camera rotates a full 360 degrees, this comes out to about 7 degrees per frame (360 / 50).
- Set the output file format. KeyShot uses %d to keep track of the frame number and you should leave this symbol in the name (e.g. my_new_animation.%d.jpg).
- Click the browse button and if you wish to change your output folder.
- Set the output width and height.
- Add to queue should be enabled if you wish to add your job to the local render queue. Otherwise your job will be rendered according to your render mode options: default, background, or network.
- Decide if you wish to process your local queue after adding the job. If you disabled the "Add to queue" checkbox, then this box should also be disabled.
- Choose the direction of rotation: clockwise (checkbox ON) or counterclockwise (checkbox OFF).
- Click OK to begin the process.

*Animation is only available in KeyShot Pro edition.
Animation

KeyShot Animation allows you to animate your models, materials and cameras in no time.

To translate a part across the scene, simply right-click the part in the scene tree, select Animation > Translation, and tweak the animation settings. Similarly, to animate a camera: right-click a camera in the scene tree, select your animation type, and make the desired changes.

You may also launch the Animation Wizard (Animation > Animation Wizard) and follow the prompts.

Animations in KeyShot are represented by rectangular nodes in the animation timeline. Each node has a start time (left side), an end time (right side) and a duration (the rectangle's length). You may move them around, scale them, stack them, or line them up in sequence to achieve different effects.
Animation Types

Types

Part Animations
Part animations affect your model's position, orientation, and visibility in the scene. See Part animation types here.

Material Animations
Material Animations enables you to create animations of a material's value based or color properties. See Material animation types here.

Camera Animations
With camera animations you can animate as well as switch between cameras. See the Camera animation types here.

Timeline appearance
Each animation type will appear with a color in the Animation timeline.

- Part animation are green.
- Material animations are red.
- Camera animations and switch events are blue.

Furthermore you can add folders to structure your animations, these are yellow in the timeline.

Time Settings
Common for all animation types are the **Time Settings**, where you can control the timing and duration of your animation.

**Motion Ease**
Select if you want to add motion ease to the animation - see the **Motion Ease** types.

**Start**
Set the start time for the animation

**End**
Set the end time for the animation

**Duration**
The duration will automatically be calculated from the **Start** and **End** time. Alternatively, you can enter the **Duration** and **Start** time - this will automatically fill the **End** time.
Part Animations

Part animations affect your model's position, orientation, and visibility in the scene. They allow you to translate, rotate, and fade all while maintaining your model's hierarchy. Thus, animations applied to your model's top assembly will also affect all parts under that assembly.

Adding a Part animation

To add a part animation right-click the part or group you want to animate, select Animation and the desired animation type. Or use the Animation Wizard to help you set up the animation.

The part animation is represented as an green node in the timeline.

Adjust the properties for your animation and you good to go. See the Animation Timeline page for more information about the options in the timeline.

Part Animation Types

Translation

A Translation is an animation in which a model or any one of its parts moves along the X, Y, and Z axis and changes position.

Translate X, Y, Z
Controls movement along the X / Y / Z axis.

Axis Orientation

When you apply a rotation to your model, you must choose the rotation axis: X, Y, or Z axis. However, these axes have two states: Original Local and Global.

- **Original Local** - The Original Local state uses the rotating part's local axis. If Y pointed up originally, rotating the part over 45 degrees means that the Y axis is now also tilted 45 degrees. Use this axis state your model's axis orientation is not square (slightly tilted) with KeyShot's global axis. To reveal the global axis, press the "Z" key on your keyboard.

- **Global** - This is KeyShot's global axis. To reveal the global axis, press the "Z" key on your keyboard. Y axis always
Rotation
A Rotation is an animation in which a model or any one of its parts rotates around its own or some other part's pivot point.

Rotation
Degrees
Controls the angle of rotation in degrees.

Axis
Determines the reference axis of rotation. There are three mutually-exclusive options: X, Y, or Z.

Axis Orientation
When you apply a rotation to your model, you must choose the rotation axis: X, Y, or Z axis. However, these axes have two states: Original Local and Global.

- **Original Local** - The Original Local state uses the rotating part's local axis. If Y pointed up originally, rotating the part over 45 degrees means that the Y axis is now also tilted 45 degrees. Use this axis state your model's axis orientation is not square (slightly tilted) with KeyShot's global axis. To reveal the global axis, press the “Z” key on your keyboard.
- **Global** - This is KeyShot's global axis. To reveal the global axis, press the “Z” key on your keyboard. Y axis always points up. Even if you have rotated a part using your modeling software.

Pivot Point
A pivot point is the point around which a part/model will rotate. When you apply a rotation animation, the pivot point is set to
*Self* by default. To select a different pivot point from the scene tree or in your scene, click the *Pick* button.

**Center and Origin**

By default, the pivot point is always at the center of the model. Change this to *Origin* if your wish to use the model’s origin instead. For example, it is possible that a cube’s origin lies at one of its eight vertices.

**Tip**

You may use a helper object for even more control over your pivot point (find useful primitives under *Edit > Add Geometry*). Then, position the primitive and click the *Pick* button to select it from your scene tree or your scene.

**Dynamic Pivot Points**

This setting will allow the rotating part or model to follow a moving helper object. Dynamic pivot points should also be enabled when there are two or more rotations (each with different helper objects) applied to the same part or model.

Note that not all moving helper objects are dynamic pivot points. For example, let’s say that you wish to animate a part orbiting around a helper object while the second is moving. In this case, enabling dynamic pivot point will not provide you with the desired result. Instead, make sure that the orbiting object is a child under the helper object in your scene tree hierarchy.

**Tip**

When dealing with complex animations consisting of multiple pivot points, we recommend a top-down hierarchy structure in your scene tree. Click [here](#) for a full article on how to animate hinges and multiple pivot points.

**Fade**

The Fade animation provides a smooth transition between two opacity values.

**Fade From**

This is your model’s starting opacity level. Accepted values are between 0% and 100%, where 0% means that the model is invisible and 100% means that the model is entirely visible.

**Fade To**

This is your model’s opacity level by the end of the animation. Accepted values are between 0% and 100%, where 0% means that the model is invisible and 100% means that the model is entirely visible.

**Known issue**

Fade animations are not supported with the Cutaway material.
**Turntable (only model/group)**

When you are adding an animation to a model/group you can also select a Turntable animation. This is similar to the *Rotation* animation but is limited to rotations around the up-axis.

**Center of Rotation**

Choose if you want your model/group to rotate around the center of the model/group or the center of the environment.

**Direction**

Set the rotation to go either Clockwise or Counter Clockwise.
Material Animations

Material Animations enables you to create animations of a material's value based or color properties.

**Adding a Material Animation**

The Material animations can currently only be added through the Material Graph.

1. Right click the material you want to animate either in the **Real-time View** or in the **In-Project Library** and select **Edit Material Graph**.
2. Inside the **Material Graph** go to **Nodes > Animation** and select the type of animation you want to add.

This will add a folder (yellow node) in the timeline which contains all animations of the material. The Material animation nodes are represented as red nodes in the timeline.

---

**Material Animation Types**

**Color Fade**

Provides a smooth transitions between two or more color values. You can apply a Color Fade to your material's diffuse, specular, and opacity map. You may also apply a Color Fade to any material value like roughness, refraction index, power, contour width, etc.

Learn about the [Color Fade Node](#).

**Number Fade**

The Number Fade animation provides a smooth transitions between two numerical values. You can apply a Number Fade to your material's diffuse, specular, and opacity map. You may also apply a Number Fade to any material value like roughness, refraction index, power, contour width, etc.

Learn about the [Number Fade Node](#).

---

This video shows how to add Animation nodes in the Material Graph.
Note

The material animation is tied to the material and thus will apply to all parts with the affected material. If you only want to affect the material of a specific part, you have to unlink it.

Unlike the other animation types the material animations will not be listed in the scene tree under any group or part. Rather, the material animation “lives” inside the Material Graph.
Camera Animations

With camera animations you can animate camera movement, rotation, focal length etc. as well as switch from one camera to another.

The instructions below assume that you've already created the cameras in your scene and set their targets.

Add Camera Animation

Right-click your camera in the scene tree (Project > Scene) and select the desired camera type. You can also set up Camera Animations via the Animation Wizard.

The camera animations will be represented blue node on the timeline and switch events with a blue dot.

Adjust the properties for your animation and you good to go. See the Animation Timeline page for more information about the options in the timeline.

Camera Animation Types

Orbit

A camera Orbit rotates the camera around its target.

Properties

Degrees
Control your orbit span in degrees.
**Panorama**

The camera Panorama rotates the camera around its own axis to simulate a full panoramic view. You may use this type of animation for showing a car interior or an architectural interior.

**Properties**

**Degrees**
Control your Panorama span in degrees.

**Inclination**

The camera Inclination rotates the camera up and down around its target.

**Properties**

**Degrees**
Control your inclination span in degrees.
Dolly

While the Zoom animation changes the focal length of the camera to achieve its effect, the Dolly animation physically moves the camera closer to the subject. Use this camera animation when you want to dynamically change your camera location. The instructions below assume that you’ve already created a camera in your scene and set its target.

Properties

Dolly
Control your Dolly distance. The Distance slider is calibrated to your scene units.

Translation
Camera Translation allows the camera to move on the X, Y and Z axes.

**Properties**

**Translate X, Y, Z**
Controls movement along the X / Y / Z axis.

**Axis Orientation**
When you apply a rotation to your model, you must choose the rotation axis: X, Y, or Z axis. However, these axes have two states: Original Local and Global.

- **Original Local** - The Original Local state uses the rotating part’s local axis. If Y pointed up originally, rotating the part over 45 degrees means that the Y axis is now also tilted 45 degrees. Use this axis state your model's axis orientation is not square (slightly tilted) with KeyShot's global axis. To reveal the global axis, press the “Z” key on your keyboard.
- **Global** - This is KeyShot's global axis. To reveal the global axis, press the “Z” key on your keyboard. Y axis always points up. Even if you have rotated a part using your modeling software.

**Path**
Camera path animation creates a path through which the camera can travel. This is useful for walkthroughs, or for more dynamic camera movements.

**Camera Path**
Here you compose the path you want the camera to follow, by adding control points. The first control point is the current camera position.

**Walkthrough**
In walkthrough mode the control point will dictate both position and target of the camera.

**Target**
In target mode the camera will always point to the selected target and the control points will only dictate the position of the camera. Target mode is especially powerful with an animated target.
**Add new Control Point**
Adjust your camera and click *Add new Control point* - Repeat till you have all the points of the path.

**Closed Path**
When enabled the first and last control points will be connected and create closed loop.

<table>
<thead>
<tr>
<th>Tip</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Geometry View can help you keep track of which camera positions you have added.</td>
</tr>
</tbody>
</table>

**Properties**

**Control Point list**
Lists all the Control Points in the path, the order they are listed is also the order of the path. Right click to rename.

- Add a new control point -
- Change order of the selected control point.
- Move control point - this will launch the geometry view, where the selected control point can be adjusted with the move tool.
- Remove Control Point

**Tension**
This enables you to adjust the sharpness of the path. Increasing the value will sharpen the change in direction at the control points while negative values will produce a smoother path.

**Depth of Field**

The camera Depth of Field animation animates your camera's focus point. Before you can add this type of animation to a camera, you need to enable Depth of Field under the camera's settings.

**Properties**

**Start/End Focus distance**
Set the distance from the camera to where the image is the sharpest.

The focus point picker enables you to pick a part to focus on.

**Start/End F-stop**
Adjusts the virtual aperture of the camera. This determines the extent of the area that is "in focus".

**Zoom**

The camera Zoom changes the camera's focal length.

If your camera is set to Perspective the focal length will also control the amount of distortion (convergence) seen in the Real-time View. Read about Focal Length in the Camera, Perspective section.

**Properties**

**Start/End Focal Length**

Adjust the Zoom by setting the start and end focal lengths.
**Switch**

The camera Switch animation is an instant change between the current camera view and another camera in the scene.

**Properties**

**From Camera**
This will be fixed to the camera to which you added the switch event.

**To Camera**
Select which camera you want to switch to.
Animation Wizard

he Animation Wizard is the easiest way to create animations step-by-step. You start out by choosing an animation type and the wizard walks you through very step in the animation setup. The instructions below assume that your KeyShot version includes animation.

For more information about each animation type, see the Animation Types section.

How to launch the Animation Wizard

1. Click the Animation button in the Toolbar.

2. Click the Animation Wizard button in the animation timeline.

Setting up the animation

The Animation wizard has 3 steps regardless of what type of animation you want to add.

1. Select the type of animation
2. select what you want to animate
3. adjust the settings of the animation. See the Anim
3. Animation Types section for detailed descriptions of each type.

Once you have set up the animation it will appear in the timeline. If you want to adjust any of the settings you chose in the wizard, simply click the animation node in the timeline and the properties will be available for editing.

See the Animation Timeline page for more information about the options in the timeline.

1 Currently, the Animation Wizard does not include Material Animations.
Working with Animations

Animations are represented with nodes in the timeline and labeled according to the name set in the animation properties. When an animation node is clicked in the timeline, the properties will be displayed.

Animations can be shifted in time and scaled interactively to control timing and duration.

Groups of animations can be consolidated in a single folder for organization. These folders can also be scaled and shifted to control timing and duration.

Managing Animations

Animation management utilities can be found by right-clicking on animations in the animation list. To change the animation order or to move an animation into an existing folder, click and drag the animation. To multi-select animations, hold CTRL (PC) or Command (Mac) while selecting multiple nodes.

Add Folder
Right-click on a blank area in the animation list to display this option.

Duplicate
To duplicate an animation or animations, right-click on the animation(s) you would like to copy and select Duplicate.

Mirror
Right-click on the animation(s) you would like to have a reverse duplicate animation of. This is useful for exploded view
animations and for situations where you need to have the animation end where it began, such as for a looping video.

**Lock/unlock**
This will lock/unlock the current animation node, this means that the animation is still visible but can not be edited. Locked nodes appear with a color a shade lighter that the unlocked nodes.

**Hide/show**
Deactivates/activates the current node. This is the same as toggling the checkbox in front of the node name.

**Hide and lock**
Deactivates and locks the current node.

**Show only**
Deactivates all other camera or part animations.

**Rename**
This will let you rename the current node, without going through the properties.

**Delete**
Select this option to delete one or more animations from the timeline.

**Animation Properties**
Selecting an animation will display its properties on the right side of the Animation window. These settings are the same used when creating an animation via the *Animation Wizard*. You may change all existing animation settings as well as the name of the animation in the animation properties. See the *Animation Types* for detailed descriptions.

If the *Animation* window is docked, or if you are using the window with a short window, you can collapse sections of the properties to see the parameters that are most useful to you at that time.
Deformation Animations
A model deformation is any change in the model's shape: twists, expansions, contractions, and character rigging.

These types of animations required advanced techniques available in CAD packages such as Maya and 3DS Max. While KeyShot does not offer a “deformation” animation, it does still support deformations set up in CAD and exported to an Alembic (.ABC) file.

How to import your deformation animations from an Alembic file:

1. Click the Import button (or File > Import) in KeyShot.
2. Browse to your Alembic (.ABC) file and click Open.
3. From the KeyShot Import dialogue > Animation enable Deformable Meshes and confirm your Import.
4. Click Play in the animation timeline to play a preview in realtime. You may also click and drag the time scrubber in the timeline.

The file will import and appear as an animation node on the Animation Timeline where it may be positioned and re-sized.
Animation Effects
Animation Effects add realism to your animations. These effects include:

- Motion Blur
- Motion Ease
**Motion Blur**

KeyShot “Motion Blur” provides a real-time preview of motion applied to the scene where movement is blurred. Capture the motion of objects or cameras as they rotate or move across the screen before you even play an animation or render an image.

To apply “Motion Blur” to objects in motion, check “Motion Blur” button on the Animation window tool bar. Click the arrow to toggle the motion blur to Model/Part or Camera animation. If you already have objects or cameras with animations applied to them, the real time view will update to show the objects in motion.

“Motion Blur” can be seen quickly after turning the option on by adding a “Translation” animation to an object or an “Orbit” animation to a camera. The amount of motion blur is controlled through the “Animation” settings by adjusting how fast and how far an object or camera is moving. When “Motion Blur” is enabled, the real time preview of the motion is dependent on the FPS setting.
Motion Ease

Motion easing will create a more natural look when applied to rotations, translations and camera animations. This will add acceleration and deceleration to motion.

For example, if a car goes from one stop sign to another and reaches a maximum speed of the 35 miles per hour, it is not traveling that speed for the entire time. The car has to start moving, accelerate to its top speed and then slow down as it approaches the next stop sign. Without motion easing, the car would start and stop abruptly and travel 35 miles per hour the entire time it is in motion.

Linear

Ease In

Ease Out

Ease in/Ease Out
KeyShotXR

Note: KeyShotVR has been renamed to KeyShotXR to avoid confusion with the VR capabilities in KeyShot and better capture the extended, interactive features in KeyShotXR.

KeyShotXR gives you the ability to turn your 3D renderings into interactive visuals. With KeyShotXR, you can create and present high-quality, touch-enabled, 3D content in any web browser. The content can be viewed using touch-enabled devices (or mouse) and does not require a browser plugin to work.

How is KeyShotXR different from other 360° viewers?

KeyShotXR goes beyond the standard 360° turntable viewing capability of other viewers. With KeyShotXR you can:

- Create turntable, spherical, hemispherical, tumble and animated interactive visuals.
- Use the camera as a pivot point to create a first person point-of-view or panoramic shot
- Ensure your visuals provide high-quality, scientifically accurate material and lighting representation
- Have full control over your visual with advanced features and customization
- Export direct to Apple iBooks for use on both iPad Retina and iPad Mini

Learn more and see examples here.
KeyShotXR Wizard

Create a KeyShotXR using the KeyShotXR Wizard. The KeyShotXR Wizard is accessed by pressing the KeyShotXR button on the KeyShot Toolbar, through the main menu by selecting Window, KeyShotXR..., or by hitting the X-key.

Pick KeyShotXR Mode

There are six KeyShotXR modes to choose from. When you select one of the six modes, you will see an animated preview of the KeyShotXR view rotation. After choosing a mode, click Next.

- **Turntable**
  Creates a standard turntable view to rotate a model up to 360 degrees.

- **Spherical**
  Creates a fully-spherical view to see all sides of the model.

- **Hemispherical**
  Create a half spherical view to rotate around only a portion of the model.

- **Tumble**
  Create a view that rotates around the model center.

- **Custom**
  This will enable you to set up a custom viewing angle, you will find the settings in one of the following steps.

- **Animation**
  If an animation is present, you will be able to create a KeyShotXR based on the animation. This is different from the other options where the camera that is rotated around the model. See KeyShotXR Animation.

Pick KeyShotXR Rotation Center

Next, you will be able to select the center of rotation for your KeyShotXR. After selecting a center of rotation, click Next.

- **Environment**
  This option will set the center of rotation at the center of the scene.

- **Object**
  This option will set the center of rotation at the object center.
Select an object in the scene as a center of rotation.

**Panoramic Camera**
Use the current camera position as your rotation center. This works well with scenes showing interior.

**Camera target**
Use your current camera target as your rotation center.

**Custom**
This option allows you to select the center of rotation from your scene tree items.

**Horizontal Environment Rotation**
Enable this option to have the environment rotate with the KeyShotXR.

---

**Pick Initial KeyShotXR View**

Next, you can fine tune the initial camera view of your KeyShotXR. Set the **Distance**, **Azimuth**, **Inclination**, and **Perspective** as you would on the Camera tab. Use the **Grid** option to help locate or center the model for optimal rotation. You can adjust the camera using mouse, pen or touch in the Real-time View or by using the sliders.

Once finished choosing your initial camera view, click **Next**.

**Distance**
Distance between the Camera Target and Camera in scene units. Setting this value too low can lead to the camera being "inside" the 3D model. This can be controlled with the mouse scroll wheel. The direction can be inverted in Preferences.

**Azimuth**
Rotation around KeyShot up (Y) axis, measured in degrees.
Inclination
Defines camera tilt, or vertical rotation from horizontal plane.

Perspective
Controls the amount of distortion (convergence) seen in the Real-time view; real world values can be used here to replicate camera lens focal lengths.

Grid
This provides the option to overlay the Real-Time View with a Halves, Thirds, or Quarters grid - useful to help locate objects in the view to optimize the interaction or rotation.

Tip
If you have edited the camera position it is a good idea to save the camera. Otherwise, when rendering, KeyShot may ask if you want to reset to the latest saved state of the camera, which will override any fine tuning you have made in this step of the wizard.

Set KeyShotXR Smoothness
This step allows you to control the smoothness of your KeyShotXR. The options you see below will depend on the KeyShotXR Mode selected. You will see a preview of the KeyShotXR in the Real-time View which will give you an idea about the smoothness of the KeyShotXR with the options entered. Once the number of frames has been set, click Next.

Smoothness Control
These settings allow you to control the smoothness of the KeyShotXR rotation. Here, you will also find details on the number of frames that will be rendered and what the horizontal and vertical angle increments will be.

Horizontal Frames
Sets the number of horizontal rotation frames rendered, e.g. a value of 18 will render out 18 frames to capture the rotation.

Vertical Frames
Sets the number of vertical rotation frames rendered and multiplies the amount of horizontal frames rendered by the value entered, e.g. a value of 18 horizontal frames and 3 vertical frames will render out 54 frames total to capture the rotation.

This option will not be seen for Turntable KeyShotXR Mode.

**Tip**
A higher value for horizontal and/or vertical frames will increase the smoothness of the rotation on the model inside a web browser, but it will also increase the total number of frames to be rendered and may affect load times of the KeyShotXR in the browser.

**Angle Control**

If Custom KeyShotXR Mode is chosen, you will also see options for Angle Control. Angle Control allows you to enter beginning and end angles for both the horizontal and vertical rotation.

- **Horizontal Angle Begin**
  Start angle for the horizontal movement. Default is -180 degrees.

- **Horizontal Angle End**
  Finish angle for the horizontal movement. Default is 180 degrees.

- **Vertical Angle Begin**
  Start angle for the vertical movement. Default is -90 degrees.

- **Vertical Angle End**
  Finish angle for the vertical movement. Default is 90 degrees.

**Set KeyShotXR Output**

In the final step, you configure the KeyShotXR output as well as the viewing resolution for the KeyShotXR.

**KeyShotXR Output**

- **Name**
  Choose a name for your KeyShotXR.

- **Folder**
  Choose the location of where it will be saved on your computer.

**Viewing resolution**

- **Width/Height**
  Set the resolution of your KeyShotXR or choose a preset from the pull down.
Presets
Provides a set of present resolutions based on the resolution of the Real-time View (set in the Project, Image tab).

Tip
Keep in mind that, when creating content for online use, size does matter. Make sure that your viewing resolution is only as big as needed. Larger images will impact performance without adding to the experience.

Loading icon
Each KeyShotXR has a default image for the loading icon. To change the icon, click Browse and select an image file to replace the default image. Maximum image size is 80px x 80px.

Time to Render!
After you've gone through each step, you have three options to continue:

1. Select Back to change any of the settings in the previous steps.
2. Select Render Now to start rendering the KeyShotXR.
3. Select Render Options to open the Render window to adjust additional KeyShotXR Output options.

How do I access other KeyShotXR options?
Selecting Render Options when you are done in the KeyShotXR Wizard will open the KeyShot Render window, KeyShotXR Output with more options for the KeyShotXR. Additional options include the ability to create an iBooks widget, adjust damping control and mouse sensitivity, along with deploying directly to FTP and/or generating Layer or Render Passes.
KeyShotXR Animation

If an animation is applied in the scene, the Animation option will be shown as an available KeyShotXR mode. Any animation type can be included as a KeyShotXR. Select Animation in the KeyShotXR Wizard.

Frames
Use the slider or input field to set the number of frames to render in the KeyShotXR.

Time Range
Select if you want to use the entire animation for your KeyShotXR or if you want to limit it to the current Work area selected in the Animation timeline.

Resulting FPS
This determines the overall smoothness of the KeyShotXR when it is used in a browser. Increasing the Frames slider increases the frame rate. A higher value will give a smoother transition, but be aware that internet speeds can also affect frame rate.

Loop Animation
This option will provide an infinite looping for the KeyShotXR Animation. Additional options can be accessed by selecting Render Options on the final step of the KeyShotXR Wizard.
**KeyShotXR Variables**

Below is a list of KeyShotXR variables. These variables are set in the .html file created by KeyShot when the KeyShotXR is rendered. These variables can be edited after the KeyShotXR is created if minor edits are needed, rather than recreating the KeyShotXR over again. The .html file can be edited using a standard text editor.

**Variable Location**

All KeyShot variables are located in the KeyShotXR .html file <head> section, within a <script> tag, and are called by the initKeyShotXR() function.

```html
<head>
    <script type="text/javascript">
        var keyshotXR;

        function initKeyShotXR() {
            var nameOfDiv = "KeyShotXR";
            // Other variables follow here...

            keyshotXR = new keyshotXR(nameOfDiv, /* The other variables ... */);
        }

        window.onload = initKeyShotXR;
    </script>
</head>
```

**nameOfDiv**

The div id of the KeyShotXR. This is where the KeyShotXR content is located.
Variables

General Settings

**Folder Name - folderName**

The name of the folder that contains all the files for the KeyShotXR. This is set under Render, Output options in the KeyShotXR tab, Name entry.

**Usage Example:**

```javascript
var folderName = "material_ball_XR.10";
```

**Download only on click - downloadOnInteraction**

This variable allows a KeyShotXR only to be loaded after it has been clicked. This option is set in the KeyShotXR settings, under Render, Output options in the KeyShotXR tab, under Advanced.

**Usage Example:**

```javascript
var downloadOnInteraction = false;
```

**Image type - imageExtension**

This variable is the image extension for the frames generated for the KeyShotXR. Only one extension type may be used. This is
set in the KeyShotXR settings, under Render, Output options in the KeyShotXR tab, under KeyShotXR Control, Format.

```
Usage Example:

var imageExtension = "jpg";
```

**BackgroundColor - backgroundColor**

The background color of the .html page in hexadecimal notation. This will be the color behind/surrounding the KeyShotXR. The default is white (#FFFFFF). This option can only be set from in the .html file.

```
Usage Example:

var backgroundColor = "#FFFFFF";
```

Frame number

**Horizontal - uCount**

This is the number of horizontal frames in the KeyShotXR. This is set under Render, Output options in the KeyShotXR tab, under KeyShotXR Control, Smoothness Control.

```
Usage Example:

var uCount = 18;
```

**Vertical - vCount**

This is the number of vertical frames in the KeyShotXR. This is set under Render, Output options in the KeyShotXR tab, under KeyShotXR Control, Smoothness Control.
Start Frame

**Horizontal - uStartIndex**

This controls the horizontal start frame for the KeyShotXR. This is set by viewing angle in the KeyShotXR settings, under `Renderer, Output` options in the `KeyShotXR Control, Angle Control` tab.

**Usage Example:**

```
var uStartIndex = 1;
```

**Vertical - vStartIndex**

This controls the vertical start frame for the KeyShotXR. This is set by viewing angle in the KeyShotXR settings, under `Renderer, Output` options in the `KeyShotXR Control, Angle Control` tab.

**Usage Example:**

```
var vStartIndex = 0;
```

ViewPort Size

**Width - viewPortWidth**

The width of the KeyShotXR in pixels. This is set under `Renderer, Output` options in the `KeyShotXR Control, Angle Control` tab.

**Usage Example:**

```
var viewPortWidth = 18;
```
**Height - viewPortHeight**

The height of the KeyShotXR in pixels. This is set under *Render, Output* options in the *KeyShotXR* tab, *Viewing Resolution*, second text field entry.

```
var viewPortHeight = 640;
```

**Rotation settings**

**Continuous horizontal rotation - uWrap**

This allows the KeyShotXR to continue rotation after last frame in the horizontal direction when set to `true`.

```
var uWrap = true;
```

**Continuous vertical rotation - vWrap**

This allows the KeyShotXR to continue rotation after last frame in the vertical direction when set to `true`.

```
var vWrap = true;
```
Rotation damping - rotationDamping

This controls the speed at which the rotation slows down when a KeyShotXR is rotated. Increasing this value will increase the duration of rotation before coming to a stop. This is set in the KeyShotXR settings, under Render, Output options in the KeyShotXR tab, under Advanced.

```
Usage Example:

var rotationDamping = 0.96;
```

Mouse Sensitivity

Horizontal - uMouseSensitivity

This controls the horizontal mouse/touch sensitivity for the KeyShotXR. Changing the value to/from a negative value will change the direction of the KeyShotXR rotation. This is set under Render, Output options in the KeyShotXR tab, under Advanced.

```
Usage Example:

var uMouseSensitivity = -0.0055;
```

Vertical - vMouseSensitivity

This controls the vertical mouse/touch sensitivity for the KeyShotXR. Changing the value to/from a negative value will change the direction of the KeyShotXR rotation. This is set under Render, Output options in the KeyShotXR tab, under Advanced.

```
Usage Example:

var vWrap = true;
```
Zoom levels

**Minimum - minZoom**

This controls the minimum zoom level for the KeyShotXR. Setting to a negative value will allow Zoom out capability. Increasing the value above 1 will change the zoom level of the KeyShotXR when loaded. This is set in the KeyShotXR settings, under **Render**, **Output** options in the **KeyShotXR** tab, under **Advanced** by checking the **Zoom-In** checkbox.

**Usage Example:**

```javascript
var minZoom = 1;
```

**Note**

KeyShot automatically calculates the resolution when rendering the KeyShotXR based on this setting when 'Preserve image quality' option is enabled. If changed afterward, grainy images may be experienced.

**Maximum - maxZoom**

This controls the maximum zoom level for the KeyShotXR. Increasing this number, increases the amount a KeyShotXR can be zoomed in. This is set in the KeyShotXR settings, under **Render**, **Output** options in the **KeyShotXR** tab, under **Advanced** by checking the **Zoom-In** checkbox.

**Usage Example:**

```javascript
var maxZoom = 1;
```
Loading icon

*Show loading icon - showLoading*

If this variable is set to `true`, the loading icon will be shown. If set to `false`, it will not be shown. This option is set in the KeyShotXR settings, under *Render, Output* options in the KeyShotXR tab, under *Advanced* by selecting the *Show Loading Screen* option.

```javascript
var showLoading = true;
```

*Set loading icon - loadingIcon*

This allows a different loading icon to be used. The variable is the filename of the icon located in the KeyShotXR files folder. This option is set in the KeyShotXR settings, under *Render, Output* options in the KeyShotXR tab, under *Advanced*, by selecting the *Default loading icon*.

```javascript
var loadingIcon = "ks_logo.png";
```

Screen size

*Automatic resizing (responsive size) - downScaleToBrowser*

This variable controls the automatic resizing of a KeyShotXR when a browser is resized; it allows a KeyShotXR to be responsive. This is set to true by default and can only be changed in the `.html` file.

KeyShot automatically calculates the resolution when rendering the KeyShotXR based on this setting when 'Preserve image quality' option is enabled. If changed afterward, grainy images may be experienced.
var downScaleToBrowser = true;

**Allow full screen - allowFullscreen**
This variable allows a KeyShotXR to be viewed fullscreen when it is double-clicked in desktop browsers. This option is set in the KeyShotXR settings, under Render, Output options in the KeyShotXR tab, under Advanced, by selecting Allow Fullscreen Mode by Double-Click.

var allowFullscreen = true;

**Move Direction**

**Reverse horizontal direction - uReverse**
This variable will reverse the horizontal direction of rotation when set to true.

var uReverse = false;

**Reverse vertical direction - vReverse**
This variable will reverse the vertical direction of rotation when set to true.
var vReverse = false;

Deprecated variables

```addDownScaleGUInButton```

With KeyShot 6 this option has been deprecated. The option is still available for legacy KeyShotXRs that require this from in the .html file.

```var addDownScaleGUInButton = false;```
Embedding KeyShotXR

There are several methods for embedding a KeyShotXR. This section will provide the instructions for embedding a KeyShotXR within various media.

In this section
- Embedding a KeyShotXR in iBooks
- Embedding a KeyShotXR in PowerPoint
- Embedding a KeyShotXR in Wordpress
Embedding a KeyShotXR in iBooks

The following instructions describe the process for creating and embedding a KeyShotXR in an iBook using iBooks Author.

**Prerequisites**

You will need the following to embed a KeyShotXR in an iBook:

- iBooks Author
- A KeyShotXR iBooks widget

**Creating a KeyShotXR iBooks Widget**

To create an iBooks Widget of your KeyShotXR, follow the process below:

1. Open the Render dialogue by selecting Render from the Toolbar or use Ctrl-P (Windows)/Cmd-P (Mac).
2. Select the KeyShotXR tab in the Output section.
3. Check the Create iBooks Widget under the KeyShotXR Control section.
Embedding a KeyShotXR iBooks Widget into iBooks

To use the iBooks Widget, follow the process below:

1. Open iBooks Author and create a new book or open an existing book.
2. Locate the iBook Widget you created and drag it to the book, or select Insert, Widget, HTML from the iBooks Author menu.

Your widget will be added to the page. You can verify with the widget inspector by selecting View, Show Inspector, selecting Widget Inspector and choosing the widget.

Viewing a KeyShotXR in an iBook
Viewing the iBook can be done by selecting Preview while an iOS device is connected to the computer. The iBook can also be exported and transferred using iTunes.
Embedding a KeyShotXR in PowerPoint

If you want to add your KeyShotXR in a presentation (Powerpoint/KeyNote) you have to install a plugin to achieve it. There are a number of plugins out there - The one we have tried is LiveSlide, which is a free plugin that works with both PowerPoint and Keynote.

You must be online to view web content on your slides.

**Windows (Powerpoint)**

**Works with**

- Windows XP or later
- PowerPoint on Office 2007 Service Pack 3 or later

**Add slide**

1. Download and install the Live Slides Plugin
2. Launch PowerPoint - in the ribbon you will now find a Live Slides tab
3. Click Live Slide in the insert section
4. LiveSlide will add a placeholder slide where the KeyShotXR will be displayed when the presentation is launched.

**Mac (PowerPoint/KeyNote)**

**Works with**

- OS X Yosemite or later
- PowerPoint on Office 2011 for Mac or later
- Keynote 5.3 or later

**Add Slide**

1. Download and install the Live Slides Plugin
2. Launch PowerPoint/KeyNote
3. Launch LiveSlide.app and enter the link to the webpage
4. LiveSlide will add a placeholder slide where the KeyShotXR will be displayed when the presentation is launched.

**Test KeyShotXR**

You can find a Test KeyShotXR here [https://www.keyshot.com/vr/keyshot6/motox/motox.html](https://www.keyshot.com/vr/keyshot6/motox/motox.html).
Embedding a KeyShotXR in Wordpress

After you have created the KeyShotXR, you will find the files in your KeyShot Resources folder under Animations or in the location you selected in the KeyShotXR Wizard. Displaying the KeyShotXR on a Wordpress website, is much like displaying a KeyShotXR on any website with static pages. Follow the instructions below to upload and display your KeyShotXR.

Note
You will need FTP/SFTP access to your webserver or request your site admin to upload for you.

How to embed

- Upload the entire KeyShotXR folder to a folder on your webserver. (Ex. uploading my_keyshotxr folder to /srv/www/wordpress/xr/my_keyshotxr would display the KeyShotXR at yourwebsite.com/xr/my_keyshotxr)
- Copy and paste the KeyShotXR code (found in the instructions.html file) to the location in the post or page you want the KeyhotXR to appear.
- Ensure that you select the Text tab (not the Visual tab) on the Wordpress post/page edit screen. Copy and paste the code into this area.
  * Make sure the src url location of the html file in the code matches the location of the upload.
  * If you are uploading to a secure website with SSL, make sure to use https instead of http in the src url.

Examples

Here are two example embed code snippets for a KeyShotXR:

```html
KeyShotXR Embed Script Example #1

<div style="left: 0px; width: 100%; height: 0px; position: relative; padding-bottom: 100%; overflow: hidden;">
<iframe style="position: absolute; top: 0px; left: 0px; height: 100%; width: 1px; min-width: 100%; *width: 100%;" src="https://www.keyshot.com/vr/keyshot6/motox/motox.html" frameborder="0" scrolling="no" allowfullscreen="allowfullscreen"></iframe>
</div>
```
The difference you will notice between the two code snippets is the `padding-bottom` value. This helps maintain the aspect ratio of the KeyShotXR and is set automatically when the KeyShotXR is generated. A 1:1 ratio (square) will have `padding-bottom` value of 100%, while a 16:9 ratio (rectangular) will have a 56.25% ratio.
Configurator

The KeyShot Configurator is a tool available in KeyShot Pro for presenting model and material variations in real-time for design reviews and interactive point-of-sale displays.

The model in this scene was created by dk and downloaded from GrabCAD

KeyShot Configurator Wizard

The KeyShot Configurator Wizard can be accessed from the KeyShot Ribbon. The Wizard guides you through the setup of Parent Models, Components, and their relationships. You can also define Material Variations, Material Ways, Studios to include, and Layout options. To view the Configurator, enter Presentation Mode and use the interactive menus to control which model and material is displayed.
Overview

The first step of the Configurator Wizard is to select what you want to present - Model Variations, Material Variations, or both.

Model Variations
Use to set up a Configurator to display different model configurations.

Material Variations
Use to set up a Configurator to display different materials for a model.

Model and Material Variations
Use to set up a Configurator to display different model configurations and materials for any model configuration.

Parent Models

The second step is to define the Parent Model, which is the top-level product variation you wish to present. This is required even if you are only presenting Material Variations. If this is the case you can simply select the Default Model Set as your Parent Model.

Select existing Model Sets
If you already have separated Parent Models and components into Model Set, choose the Model Sets that you want to be parent models.
Select geometry from Scene
If you have not got each of your Parent Models and Components in separate Model Sets, you can create them here by using the option to Select geometry from the scene. To do so, check the box next to the model or parts you want to define as the Parent and click the Add Model Set button above the Parent Models list. This will automatically create a Model Set in the Project window. Once one or more Parent Models have been added in the Configurator Wizard you can select in the list and click the Preview button to view and confirm in real-time.
Components

If you wish to present part or accessory variations that are dependent on Parent Models you will need to add Components.

Once again you can select existing Model Sets if you have already separated them in the Scene tab or select geometry from the scene manually.
Add Components

Components are part of accessory variations dependent on Parent Models. Each Component will be created as an individual Model Set if not already created as one.

How do you want to add Components?
- Select existing Model Sets
- Select geometry from the scene

Components
- Small flames
- Big/Small
- Wheels type1
- Wheels type2
- Brake
Component Groups

If you have defined Components you will next need to add Component Groups. These define the relationship between Parent Models and their dependent Components.

Component Groups
A Component Group can be seen as the choice, where the components are the options. You can also select None as an option if you wish to display the Parent Model with no Component. In this example of a car with wheels it would not make sense to do so.
Parent Models can have several Component Groups - e.g. a Car can have a choice of different wheels and different grills.

**Add Component Groups**
Simply click the inline link to *Add Component Group* and check the respective Components in the list on the right. Repeat this until all relationships are defined. You can also select None as an option if you wish to display the Parent Model with no Component. In this example of a car with wheels it would not make sense to do so.

**Remove Component Groups**
To remove a component from the component group uncheck in the Components list. To remove a Component group, right-click the group and select delete.

---

**Material Variations**
In this step you can add further materials to existing Multi-Materials or convert “simple” materials to Multi-Materials

The List displays all the Multi-Materials in the current scene. When you click one of the multi-materials, the lower list (pictured in the example at the right) will display all materials it consists of.

**Add to existing Multi-Materials**
To add to an existing Multi-Material simply click the material in the list and drag new materials from the *Library* and drop them into the lower list.

**Add New Multi-Materials**
New Multi-Materials are added by selecting the desired material/part in the Real-time View, then dragging and dropping materials into the lower list. You will then see the material spheres populate the list to select and preview.

Once materials are in the list you can give the Material Variation a name i.e. Wheel Accent. This material will become a Multi-Material in your scene that can also be accessed and further edited from the Material tab.

**Remove Material Variations**
To remove variations from a Multi-Material select the Multi-material either in the list or by selecting a part (with the material) in the Real-time View. Now the bottom list shows the variations of the Multi-Material. Select the variation you want to remove and click . You can repeat this until there is only one variation left, reverting the Multi-Material to a single material.

**Material Sets**
With Material Sets you can group Multi-Materials that you want to be able to change concurrently with Material Ways.

Click *Create New Material Set* and check the Multi-Materials you want to group.

Once a Material Set is in the list you can rename it.

You can have multiple Material Sets but a Multi-Material can only be a part of a single Material Set. Any Multi-Materials that are already a part of a...
Material Set will be disabled in the list.

To delete a Material Set, select it in the list and click [Delete], this will make the Multi-Materials available for re-selection.

Material Sets

Material Sets are the options within a Material Set.

Select a Material Set in the drop-down and click Add Material Way. Then select the material combination you want in the current Material Way, by marking them with the blue bullet.

Make sure to give each Material Way a useful name, as they will be used in presentation mode/KeyShot Viewer.
Studios

Studios can be enabled in order to change preset Cameras, Environments Image Styles and prop/scene geometry created as Model Sets.

Select which Studios you want included in the presentation by checking/unchecking them or add a new studio if necessary.

If no studios are selected, the Studios tab in presentation mode will not be displayed and the presentation will use the current environment and camera position.
Camera
You can lock/unlock the Camera by clicking the lock icon next to the camera drop-down. If a Studio contains a locked camera, it will also be locked in presentation mode and the user will not be able to tumble/pan/dolly. In Presentation mode this is shown by a small lock icon in the top right corner.

Model Sets and Multi-materials
Any Model Sets/Multi-Materials that can be set as a part of the configuration will be ignored when you switch Studio in the presentation, even if they are set up to belong to a Studio. This means that only “prop” Model Sets/Multi-Materials can be displayed/hidden/changed with Studio switch.

Thumbnails
If the default thumbnail that is generated does not contain the elements you want displayed, you can select which Model Sets to include in the drop-down at the bottom of the page and re-render the thumbnail.

Layout
The Layout section is where you define the style of Presentation Mode for each given Configurator scene. You can choose between a Compact toolbar or Touch Friendly thumbnail interface.

When using the Touch Friendly mode you can set the size of the panels, and adjust thumbnail sizes.

Preview
The optimal size values, button and tab visibility, and tab names will vary
from scene to scene. Preview lets you see your edits while you are making them.

**Style Sheet**
The Style Sheet editor lets you adjust the appearance of Presentation mode.

**Note:**
If you have created a configuration in KeyShot 7, where you have adjusted the style sheet. You may need to update it when you open the scene in KeyShot 8, as the layout in presentation mode have been updated.

**Render All Materials**
The first time a material is present in the configuration a thumbnail is automatically rendered, but if you have made changes to your materials you may need to re-render.
Summary

The Summary section allows you to see an overview of the number of variations in your Configurator and to preview each of the variations in the Real-time View before entering Presentation Mode. You can reorder Model and Material variations from this page by selecting the item you want to move and using the arrows to the left of the list.
Using the KeyShot Configurator

In this video, we show how to use the KeyShot Configurator to present model and material variations in real-time for design reviews or touch-enabled customer experiences.

This video was made for KeyShot 7. In KeyShot 8 a few things have changed, but the video gives a good overall idea about the Configurator and how to use it.
KeyShot Viewer

What is it?

KeyShot Viewer is a free, stand-alone, touch-enabled, desktop application for Mac and Windows that enables KeyShot scenes to be securely shared with anyone for interactive viewing, presentation and configuration. KeyShot Viewer uses the same CPU-powered ray-tracing render engine as KeyShot to produce amazing photo-realistic visuals in real-time.

How it works

Downloading, installing, and opening files

KeyShot Viewer can be downloaded at keyshot.com/viewer by entering your name and email address. Once KeyShot Viewer is installed you’ll be able to open any KeyShot Package file (.ksp) to interact with the scene.

When KeyShot Viewer is launched you’ll be prompted with a splash screen where you can browse to open a file or select from those recently opened.

You can also open .ksp files by dragging and dropping onto the splash screen, into the KeyShot Viewer application window or by the file menu if a scene is currently open.

The file menu is accessible when the application is in a windowed state, which can be reached from full-screen presentation mode by pressing the Esc key or clicking the exit icon. To enter full-screen presentation mode again, maximize the window or click the presentation mode icon.

KeyShot viewer comes with 2 demo scenes. Additional configurator scenes can be found here.
Depending on how the scene was saved from KeyShot Pro you may be prompted to enter a password.

Moving the camera view

When you move the camera view or make changes the scene will update instantly - with the image quality improving as you let it sit until 256 samples has been reached.

To move the view, simply use your mouse or finger on a touch-enabled device. The toolbar has three icons indicating if tumble, pan, or dolly is active for the left mouse button or single-finger input.

If you're using a mouse you can also pan using the middle mouse button and dolly using the middle mouse wheel or by scrolling on a touch-pad. To
reset the view click the camera reset icon on the toolbar.

The KeyShot Watch Configurator demo scene is included in the KeyShot Viewer installation.

**Studio, Model, and Material variations**

Users of KeyShot Pro can use the Configurator to include Studio, Model, and Material variations, which will be available when KeyShot Viewer is in full-screen presentation mode. Simply click or tap on any of these variations to update the real-time view. Use the tabs to navigate the various options that have been setup in the scene.

For information about using the Configurator in KeyShot Pro to setup Studio, Model, and Material variations for output to KeyShot Viewer click here.

The auto-hide icon allows you to hide the Studio, Model and Material variation panels after 10 seconds of inactivity. To show again simply mouse over or tap in the area the panels occupy.
Taking a Screenshot

If included in your scene, click or tap the screenshot icon on the toolbar to save an image. If your scene includes watermarking it will also be included in screenshot output; however, the UI panels will not.

By default screenshots will be saved in your documents folder. In Preferences you can select another destination folder or choose to be asked for destination every time you take a screenshot. To find Preferences on Windows click "Edit, Preferences..." and on Mac "Keyshot, Preferences..."

The Viewer can also output a metadata file in XMP or .meta format. The metadata file indicates which variations are active along with camera information that can be referenced to make changes to the original scene back in KeyShot. You enable/disable metadata output in preferences, where you can also choose the format by clicking the gear icon.

KeyShot Pro allows you to present a configurator for unlimited Studio, Model and Material variation.
The option to add watermark is included when exporting a KeyShot Scene for KeyShot Viewer.

FAQs

1. How do I remove the watermark logo pattern?
   The inclusion of the KeyShot watermark logo pattern is defined when saving for KeyShot Viewer from KeyShot Pro. You will need to ask the provider of the file to remove this.

2. How do I remove the “Powered by KeyShot” logo in the upper right corner?
   The inclusion of the “powered by KeyShot” logo is defined when saving for KeyShot Viewer from KeyShot Pro. You will need to ask the provider of the file to remove this.

3. I see a message “Camera is locked”. How do I unlock it?
   The camera state is defined in KeyShot Pro. You will need to contact the scene provider to get a version of the scene that is saved with the camera in an unlocked state.

4. What if I don’t know the password to open a scene?
   You will need to contact the provider of the scene.

5. Why is my real-time view not using the entire screen space?
   In order to be efficient about CPU usage the real-time view in KeyShot Viewer is limited to 1920x1080 resolution. If you wish to take advantage of the entire screen space on high-resolution displays you will need to use Presentation Mode in
6. How do I know if I’m using the latest version of KeyShot Viewer?
   If there is an update to KeyShot Viewer available a notification will appear on the splash screen.

7. Where are the Watch and Ring demo scenes located on my computer?
   Windows: C:\Users\Username\AppData\Local\Luxion\KeyShot Viewer 8
   Mac: Library/Application Support/KeyShot Viewer 8

8. Why does it say “Rendering Complete” at the top of the screen?
   The real-time view will not render more than 256 samples so the CPU isn’t continuously used when KeyShot Viewer is
   left sitting.

9. Does KeyShot Viewer support Animation?
   No. A file loaded with Animation included will show the scene at 0s and cannot playback any Animations.
Virtual Reality

KeyShot allows you to experience both real-time rendering mode and rendered visuals in virtual reality (VR) using a VR headset. This section describes how to setup and use VR hardware with KeyShot.
VR Overview

The VR capabilities in KeyShot allow you to use VR devices, such as the Oculus Rift and the HTC Vive, to view KeyShot scenes. There are two applications for using VR with KeyShot:

1. Render VR Images
   View rendered panoramic images rendered in KeyShot. This mode is compatible with any type of VR device capable of viewing VR images. Please check with the manufacturer of the device to know what type of image is necessary. Learn more

2. Work in Real-time VR
   View and render the Real-time View through the VR headset. This mode is compatible with the Oculus Rift and the HTC Vive only. Learn more

Accessing KeyShot VR Settings

VR capabilities are a KeyShot Pro feature. (Compare KeyShot versions.) All VR settings are accessed from the Project window, Camera tab, under the Lens Settings and Stereo sections.

Terminology

**Cube Map**
- In this mode, six views will be rendered side by side.
  - The views are: Front, Back, Right, Left, Top, Bottom.
  - If your device supports stereo cub maps it will automatically orient the images for you to view them correctly.

**Spherical**
- As described by the name, this image will look like a flattened out sphere.
- This mode will be compatible with most devices out there.
Side-by-side

- In order to see the image in 3D via the headset, you need to have the same image played in both eyes. In this mode both images are stitched next to each other.

Over-under

- In order for you to see the image in 3D in the headset, you need to have the same image played in both eyes. In this mode both images are stitched one on top of the other.

Eye Distance

- This is to set the distance between your eyes. This is a setting that you configured when setting up your Oculus Rift or HTC Vive. Use the same distance set when setting up your device.

Pole Merging Angle
- This is a parameter for stereo rendering. It is the angle at which pole merging begins. It helps avoid artifacts when looking upward and downward. The eye distance value is kept the same until the viewing angle reaches the specified angle after which the eye distance is gradually decreased until it reaches a value of 0 when looking directly downwards or upwards.
Render VR Images
This section will guide you through the steps necessary to render out an image to view on a VR head-mounted display:

1. Open and setup the scene of your choice in KeyShot.
2. Go to the Project window’s Camera tab and open the Lens Settings accordion.
3. Select Panoramic mode.
4. Depending on the type of VR device you have, you may need to select Cube Map or Spherical, i.e. Oculus Rift and HTC Vive can use both, but Google Daydream needs a Spherical image.
5. Enable the Stereo radio button.
6. Go to the Render menu by using the Render button in the toolbar or by going to the top menu under Render, Render...
7. Render the image as you would any other image. Keep in mind that you will be "immersed" in the scene, so the bigger the image resolution the more realistic it will look.
8. Upload your rendered image to your headset to view the VR image. This step can be different for each VR headset device. Please consult the headset manufacturer for specific instructions for loading a VR image.

Related Pages

Content by label

There is no content with the specified labels
Work In Real-Time VR

This section will guide you through the steps necessary to view the real-time window through a VR head-mounted display:

- This will only work with the Oculus Rift and the HTC Vive.
- These instructions assume that you have the Oculus Rift or the HTC Vive already installed and ready to go.
- These instructions assume that you are wearing the Oculus Rift or the HTC Vive HMD.

Perspective Realtime View

1. Open and setup the scene of your choice in KeyShot.
2. Go to the Project window’s Camera tab and open the Lens Settings accordion.
3. Select Perspective mode.
4. Enable the Stereo radio button.
5. You can change the stereo settings if you know specifically what you need or you can just leave the default settings the way they are.
6. Click on the Head-Mounted Display drop-down and choose which VR device you have. For the Oculus choose Oculus Rift and for the HTC Vive, choose OpenVR.
7. It might take a few seconds for the VR device’s software to load but you can now put your headset on to view your scene.

Panoramic Real-time View

Workflow 1:

1. Open and setup the scene of your choice in KeyShot.
2. In the top menu, go to Camera Enable VR.
3. Choose between Cube map mode or Spherical mode.
4. Choose your desired resolution. Keep in mind that the higher you go the more powerful your machine will need to be. For example, if you are working on a laptop, you should stay at lower resolution.
5. Choose which VR device you have. For the Oculus choose Oculus Rift and for the HTC Vive, choose OpenVR.
6. Click Start. (It might take a few seconds for the VR software to start)

Workflow 2:

1. Open and setup the scene of your choice in KeyShot.
2. Go to the Project window’s Camera tab and open the Lens Settings accordion.
3. Select **Panoramic** mode.

4. Choose between **Cube map mode** or **Spherical mode**.

5. Enable the **Stereo** radio button.

6. You can change the stereo settings if you know specifically what you need or you can just leave the default settings the way they are.

7. Click on the **Head-Mounted Display** drop-down and choose which VR device you have. For the Oculus choose **Oculus Rift** and for the HTC Vive, choose **OpenVR**.

8. It might take a few seconds for the VR device's software to load but you can now put your headset on to view your scene.
KeyShot Cloud

KeyShot Cloud is an online library where you can share your own custom materials and resources, as well as having access to resources uploaded by other KeyShot users.

You can access Keyshot Cloud here: https://cloud.keyshot.com - or launch it inside KeyShot via the KeyShot Cloud icon in the bottom left corner of the Toolbar.
KeyShot Cloud User Interface

1. Search Field
2. Display Style
3. User account/settings
4. Category Tabs
5. Total number of resources within a category
6. Search Results, the number shows how many search results there are within the category.
7. "Download" Button
8. "Like" Button
9. Details
KeyShot Cloud Account
You only need an account if you want to upload or like resources.

Login/Create Account
Create an account by clicking the user icon in the top right corner of KeyShot Cloud and click login - On this page you will find an option to register.
If you are not logged in when trying to upload or like you will be asked to login/register before you can proceed.

Log Out
To log out, click the settings icon in the upper right of KeyShot Cloud window and click Log out.

Delete Account
If you for some reason want to delete your account, just login, click on Account Settings in the dialog click Delete My Account.
When your account is deleted Luxion will delete any information that can be associated with you and resources uploaded by you will be redelegated to a Luxion account.
KeyShot Cloud Search
KeyShot Cloud has robust search capability. You can use the filters or do a more advanced search using our search syntax.

Sorting and Filters
The search results may be organized using the Order By and the Results Since dropdown menus.
Search Syntax

If you want to perform a more specific search you can use search syntax.

- Normal Search: term
- User Search: @username
- Include: +term
- Exclude: -term
- User Likes: L@email/username
- User Downloads: D@email/username
- Resource ID search: #resource ID
- Search phrase: "Search phrase"

You can find examples of the search syntax by clicking the little question mark in the search field.

Resource Details

Click on a resource entry to bring up the details of that specific resource such as the size, description, tags, creator, and more. The details section will also contain the Download button to download the resource to your KeyShot Library, as well as a Report button to flag any resource as offensive or copyright-infringing material.

Compatible Version
When you access KeyShot Cloud from KeyShot, the resources will only be shown if they are compatible with the current version of KeyShot. If you are browsing directly on the site, see the resource details for information about compatible version.
Uploading/Downloading Resources

Uploading Resources

To upload your custom resources to the Cloud Library,

- Select the resource(s) you want to upload and click the **Upload** button on the bottom right of the KeyShot library panel. Alternatively, you can right-click the resources and select **Upload To Cloud Library**.
- If you are not yet logged in, you will be asked to do so.
- Describe the resource, edit the name if necessary, and add tags to help other users search for your resource. If you don’t know what tags to use, you can click Suggestion and KeyShot will auto-generate tags for you. The check mark icon next to the input fields will let you know if your input is OK.
- Click **next** to input information about the next resource, if any.
- The final step displays a confirmation of resources to be uploaded - Click **Upload** to send your resource to the cloud.

**Note**
The name may not include special characters and these will be ignored when typed.

Upload Guidelines

To ensure the quality of resources in the KeyShot Cloud remains high, all resources will have to be approved by Luxion staff before they will be available on the Cloud. This will be done within 48 hours.

The approval procedure considers both the quality of the resource and the name and description. If you want to know the guidelines, you can always find them in the bottom left corner of the upload dialog.

It is not possible to upload KeyShot stock resources, Procedural Environments, and Multi-Materials to KeyShot Cloud.
Downloading Resources

To download a resource, click the blue Download button on the resource in the overview or in the resource details. You can also drag-and-drop the resource on the Real-Time View.

If you are accessing KeyShot Cloud outside KeyShot, KeyShot will be launched and the downloaded resource can be found in the Download folder.

The resource will be automatically downloaded to your downloads folder in the appropriate tab, and you will then be able to move it to an existing or custom folder.
KeyShot Cloud Release Notes

1.1.2

This is a rejuvenated version of KeyShot Cloud which has a lot of updates, fixes, and improvements since version 1.0.25.

- KeyShot Cloud launches directly in the KeyShot user interface as a dockable window (KeyShot 8 only).
- When viewing in KeyShot, it only shows materials that are compatible with the version of KeyShot.
- Login is no longer needed to browse the site and download resources! (It is, however, needed for uploading new resources and for user actions such as liking assets or browsing likes and downloads.)
- Login prompt shown instead of redirecting to login page (when not shown inside KeyShot).
- Correctly identify if site is running inside KeyShot or not.
- "My Downloads" and "My Likes" browse options show only when logged in.
- Download link exposed on download button.
- Support searching for resources via ID: #ID. Example: #123
- Removed upload modal dialog - now located in KeyShot.
- Use active type for initial resource count instead of always materials.
- Simplified registration process to avoid confusion.
- Simplified password reset (account recovery) process to avoid confusion.
- Dragging the thumbnail, in details view, to KeyShot will drag the link instead.
- Toggle password visibility for login.
- CSS fallbacks to support KeyShot v5 (older web engine).
- Show compatible KeyShot version for materials in details view (though it's hidden for version <= 5).
- Commenting has been disabled.
- Squashed various bugs.
- General improvements.

1.0.25

- Implemented account deletion under account settings in relation to GDPR.
- Updated thumbnail generation.
- Various other fixes.
- Approval process for newly upload resources.
Network Rendering

KeyShot Network Rendering allows you to connect multiple computer systems in your office network and utilize the available hardware to reduce rendering times significantly. In fact, the correlation between render time and number of cores in your network is approximately linear and inversely proportional. In other words, by doubling the number of cores you potentially cut your render time in half.* In addition, rendering over the network is convenient. You may continue working in KeyShot or any other application without slowing down your system while the designated rendering stations process your render “jobs”.

The KeyShot Network Rendering software is compatible with Mac and PC systems.

The more cores you have, the faster your images and animations will render.**

* Please note that this is an approximation under optimal conditions. Render times are subject to hardware specs, core count differences between slaves, scene complexity, unit of time, multi-tasking, and network traffic.

** Please note that Luxion does not sell or rent cores. All computer hardware (i.e. processor cores) is provided by the customer.

More on KeyShot Network Rendering and Network Rendering Installation can be found in the KeyShot 8 Network Rendering Manual.

View KeyShot 8 Network Rendering Manual
Preferences

This section describes where to find the KeyShot Preferences (options/settings) and what they do.

You can find the KeyShot Preferences in the Main Menu

- **Windows**: Edit, Preferences...
- **Mac**: Keyshot, Preferences...

After making changes, make sure to select the *Save Changes* button. In some instances you maybe required to restart KeyShot in order for the changed settings to take effect. To prevent any changes from taking effect simply select the *Cancel* button.

The follow sections describe what preferences are available in each tab of the *Preferences* window.
Interface Preferences

Interface Preferences

Language
Select the desired language in the menu.

Theme
Select desired color for the KeyShot interface. This can also be set from the Ribbon > Workspaces drop-down.

Font Size
Select the desired font size in the drop-down. This is useful when working on high-resolution displays without system scaling applied.

Selection outlines
Displays an orange outline around selected parts.

Use CPU for selection outlines
Enable this if selection outlines are unstable on GPU.

Include camera changes in undo/redo
This will include all camera movements in the undo stack.

Reverse camera distance scrolling
Reverse the scrolling on the camera when dollying the camera.

Enable sub menus in Real-time View
Rather than showing a list of functions in the right click menus, these functions will be logically grouped into sub menus.

Disable scene tree hierarchy changes
Prevents you from making any changes to the scene tree hierarchy by dragging and dropping parts.

Lock pivot to target
When it is enabled the pivot moves with the target when you pan the camera.

Scene Tree object preview tooltips
When checked you will see a spinning OpenGL shaded preview of an object when hovering over it in the scene tree.

Respect animation ordering
If you perform multiple animations on a part/group any translations will by default be executed last, as this will move the pivot point. With this setting you can force the animation to respect the order set in the Scene Tree (top to bottom).

Show support tool in Help menu
Enable the support tool for support troubleshooting purposes.

Use GPU (enable effects)
When checked, enables the Bloom, Vignetting and Chromatic Aberration effects under Project window, Image tab, Image Styles.

Progressive Image Sampling
When checked, KeyShot will down-sample the scene while the camera is moved to enable faster performance. On machines with many cores this function may be turned off to ensure a smooth camera movement without loss of quality.

Disable outline for large models
Makes it possible to disable selection outlines based on the size of the model. *Auto* will disable the outlines based on the available GPU memory and *Custom* will disable them when your model reaches the specified amount of triangles.

**Render Output window memory limit**
This controls the amount of memory reserved for the image buffer in the output window. If the rendered image takes up more memory than this limit, it will be downscaled until it is below the limit. This is useful if you are rendering gigapixel images and your scene takes up a lot of memory. It does not affect the output image itself (as specified in the Render Settings), but does affect images saved directly from the output window.

**Materials**

**Show in-project material list under material properties tab**
All in-project materials will be displayed.

**Use gloss instead of roughness for materials**
Replaces all roughness sliders with gloss sliders and converts all roughness values to gloss values. Useful if you are working with a Gloss-meter to measure your materials.

**Use UV mapping as default**
Replace the default mapping type from *Box* to *UV-mapping*.

**Link materials of duplicate parts**
When checked the material of duplicate parts will be linked. Learn more about linked materials on the Assigning Materials page.

**Link duplicate materials when assigning from Library**
When checked all instances of a material applied to parts in the scene will be linked. Learn more about linked materials on the Assigning Materials page.

**Log**

The log can be accessed under the Help menu in the KeyShot menu bar. It will contain a log of all errors that occurred while running KeyShot.

**Threshold**
This dropdown menu contains the lowest level of warning that will be captured in the log. Warning levels are: *Information* (default), *Warning*, *Critical*, *Fatal*.

**Display log window on critical errors**
When checked, the log window will open up automatically as soon as a critical error occurs.

**History back buffer**
Sets the number of entries in the log.

**3Dconnexion Settings**
KeyShot supports input devices from 3Dconnexion on both Windows and Mac. Make sure a 3Dconnexion device is connected in order to be able to change these settings. Learn more about 3Dconnexion.

**3D mouse sensitivity**
Set the sensitivity of the 3D mouse.
Restrict to dominant axis
Only allows one axis movement at a time.

Invert axis
Inverts camera movement direction.

Use global up axis
When checked (default) the camera will always rotate around the global up axis, even when tilted.
General Preferences

General

Show Welcome Window at Start Up
Displays a splash-screen at startup with recent scenes, demo scenes, news and info.

Adjust aspect ratio to backplate
Automatically resizes the Real-time View to the same aspect ratio of any backplate image that is loaded into the Real-time View.

Auto Update
Prompts you to download and run the update installer when a newer version becomes available.

Pause KeyShot when sending jobs to Network Rendering
Pause rendering in the Real-time View and stop the usage of your CPU when jobs are submitted to KeyShot Network Rendering.

Pause Real-time Render after time or samples
Select an amount of time or render samples to automatically pause the rendering in the Real-time View and stop the usage of your CPU.

Screenshots

Format
Select the format for the saved screenshot (JPEG or PNG).

Quality
Determines the compression of the saved image. Higher settings mean less compression yet better quality, but the file size will also increase. The default value is 99.

Include Alpha (Transparency)
If the format is set to PNG you can choose to include alpha, this will hide the lighting environment and make ground shadows transparent.

Ask where to save each screenshot
KeyShot will prompt you to specify a location when saving a screenshot from the Real-time View.

Save a camera with each screenshot
When checked, KeyShot will save a camera view for every screenshot that is saved out. These views can be accessed from the camera tab in the project window.

Save metadata with each screenshot
When checked, KeyShot will save metadata about the image. In the settings drop-down you can choose the format of the metadata.

Default Startup Scene

This lets you set the default startup scene when you start KeyShot. The startup.bip scene is set as the default. Any KeyShot scene may be set as a startup scene. To change, simply click on the Folder icon and browse to the scene you want
Backup Revision

Create a serialized backup revision with each save
When checked, the Revision Manager will become enabled. KeyShot will create a serialized backup every time that you save rather than overwriting the scene. This results in a full copy of the original scene.

Backup history depth
Determines how many instances of the scene will be saved before the oldest one get overwritten. By default the value is 5. When the scene is saved a 6th time, the first (oldest) version of the scene will be overwritten. The maximum value is 99.

Save Reminder

Display save reminder notification every:
KeyShot will prompt you to to save at the interval selected. These times include every 5, 10, 15, 30 and 60 minutes. Select Never if you do not want a Save Reminder to appear.

Cloud Library

This shows the login status for the KeyShot Cloud Library. Learn more about KeyShot Cloud.

Clear Cache
Resets the KeyShot Cloud window to default, by clearing visited links, http cache and local storage.

Clear don't show again

Restore All Messages and Warnings...
All dialogs that can be disabled by marking "Don't show again" will be enabled and shown when applicable.

Network

This section allows the user to configure the proxy settings in order to communicate with Luxion's software update server and the KeyShot Cloud Library. This may be necessary when KeyShot is installed in environments with tight firewall security.

Proxy type dropdown
This dropdown menu provides four options: No proxy, Automatic proxy detection (default), HTTP, SOCKS v5.

Host
This option becomes available when HTTP or SOCKS v5 are selected. Enter the hostname of the proxy server as recognized on the network, or the host's IP address.

Port
Enter the port the proxy server is using to communicate through the firewall.

Enable proxy authentication
It may be necessary to enable proxy authentication on the server. To do so, check this checkbox.
Username
Enter the user name that the user has been assigned to communicate with the proxy server.

Password
Enter the password for the user account on the proxy server.

LiveLinking
LiveLinking connects KeyShot to a modeling application via a custom plugin. When enabled, LiveLinking allows you to run KeyShot in parallel with supported 3D modeling software, and update the geometry inside of KeyShot without losing any of the material assignments, cameras, lighting, etc. All plugins developed by Luxion or a partner company may be found here.

Enable LiveLinking
When checked (default), KeyShot will start and connect to supported 3D modeling software through the installed plugin. Note: these plugins for 3D software are different from plugins for KeyShot explained in the Preferences.

LiveLinking Network port range
This is the port range the installed plugin is using.

Scripting
This section provides the setting to take advantage of using local Python library installations for KeyShot’s Scripting capabilities. Learn more about Scripting here.

Use local Python paths
If checked, and if the user has Python libraries like PIL or SciPy installed locally, it will be possible to use those libraries inside of KeyShot. However, only version 3.4 is supported which is the same version that is being used inside KeyShot. If not checked, then only the Python modules exposed inside KeyShot will be available to the scripts running inside.
Folders Preferences
The folders tab allows you to specify folders or shared folders for following KeyShot Resources:

- Textures
- Backplates
- Environments
- Materials
- Renderings
- Scenes
- Animations (including KeyShotXR files)
- Material Templates
- Colors
- Scripts and Plugins.

Specify location for all folders
This option sets the default location for all resource folders.

Resources
Select the folder icon 🗄️ to set the default location for all KeyShot Resource folders.

Customize each folder
This option allows you to set the locations for each resource independently or add additional folders or shared directories.

Shared Folders
Shared folders will allow you to point KeyShot to access files in folders that are shared on a server or local computer. All shared folders will show inside of the KeyShot Library.

To use shared folders you will need to select Customize each folder and click the folder icon 🗄️ to the right. The Configure Folders dialog will open. From there you can select the plus icon to add a new folder path. Selecting a folder and clicking Edit will allow you to edit the folder and change the path or switch to a default folder. At least one default folder is required for each resource.
Plugins Preferences
Plugins are primarily used for connecting KeyShot with various modeling applications. Most plugins will be executed in the modeling application but some will be run from KeyShot (e.g. OnShape). The Plugin Preferences are only concerning plugins that executed inside KeyShot.

Visit our Plugins page to see available plugins.

Plugins

Enable/Disable
The Plugins window will show all installed KeyShot compatible plugins with checkboxes to enable or disable the plugin when KeyShot starts.

Uninstall
Plugins are installed via Windows or Mac OS X installation files and uninstalled through the operating system options.
Color Management
Compensate for Image Gamma when applying Library Colors
Gamma corrects color values when applying them to a material directly from the Color Library. This will try to keep the appearance of the color in the Library. With this option selected, the color of the material in the Real-time View and in the Library will always match, if you don’t change the Image Gamma after applying the color.

Enable Color Management
Enable this option to use ICC color profile files in KeyShot.

Select the folder icon to load your desired color profile. Both .ICC and .ICM file formats are supported.

The status window will show if the color profile was loaded and color profile created. Select Save Changes to save your color profile settings. To delete the color profile simply remove the file location or disable by unchecking Enable Color Management.

If I activate the Adobe RGB (1998) color profile, why does everything looks great in the Real-time View, but different in the final render?

KeyShot uses the sRGB color profile internally.

The color profile set in the Preferences is only applied to the Real-time View to ensure the color output is correct on your screen.

It is important to note that the rendering is not done in the Adobe RGB. When the color profile is set in Preferences, the Real-time View output is just translated from sRGB to Adobe RGB to ensure the colors look correct on your screen.

The rendering result will still be in sRGB and is directly saved to the output file as sRGB without applying the color profile.

Since sRGB is a widely used color profile for web applications this is sufficient for most users. And since it’s a widely use color profile, most image editing applications are able to translate from sRGB to Adobe RGB for further editing.
Hotkeys Preferences

You can customize all existing hotkeys inside KeyShot. Hotkeys are categorized as Simple Hotkeys, Mouse Actions and Camera Controls. Depending on the type of hotkey you select, either the Simple Hotkey or the Mouse Action input fields will become active. Camera Controls are always active.

Filter/Hotkey List

This allows you to search for a specific Action/Group or Hotkey in the list. The Hotkey List shows all of the KeyShot commands capable of having a key combination assigned. Actions with empty Hotkey entries do not have a hotkey assigned.

Simple Hotkey

Select a Simple Hotkey, i.e. a hotkey that doesn't contain any mouse actions from the list of hotkeys. To edit, simply start typing in the input field. You can always change the hotkey back to its default setting by selecting Change to Default.

Mouse Action

Select a Mouse Action hotkey from the list, and start modifying the hotkey by changing the mouse action from the pull-down menu, and select up to three modifier keys, i.e. Alt, Shift, Ctrl.

Camera Control

This function allows you to change the camera controls based on your favorite modeling application. In the hotkey list you can see what application has been selected to change the camera controls.

Hotkey Presets

Simply select the 3D modeling software from the dropdown menu, and all camera controls will adjust accordingly. Support is included for:

- 3ds Max
- Alias
- 3D Studio Max
- Maya
- NX
- PTC Creo
- Rhino
- Solid Edge
- SOLIDWORKS
- SpaceClaim
- ZBrush

Import/Export Hotkeys
**Import...**

You can import your own custom hotkeys file that has been exported from a KeyShot installation previously. KeyShot hotkey file format is .KSH.

**Export...**

Choose this function to export your custom hotkeys to use on another machine.

**Reset to Default**

**Reset selection**

This will reset the hotkey that is currently selected in the HotKey List

**Reset All**

This will reset all hotkeys to their default settings.
End-User License Agreement

Luxion KeyShot® 8

© 2010 - 2018 Luxion ApS. All Rights Reserved.

Protected by US patents 8,913,065; 9,043,007; 9,183,654.

Copyright law and international treaties protect this computer software program. Unauthorized reproduction or distribution of this software program, or any portion of it, will be prosecuted to the maximum extent possible under law and may result in civil and criminal penalties.

KeyShot®, KeyShotXR™, KeyVR™, and LiveLinking™ are a Trademark or Registered Trademark of Luxion ApS.

PLEASE READ THE FOLLOWING CAREFULLY AS IT AFFECTS YOUR LEGAL RIGHTS:

THE LICENSE GRANT MADE TO YOU PURSUANT TO THIS END-USER LICENSE AGREEMENT (THIS "AGREEMENT") IS CONDITIONED UPON YOUR ACCEPTANCE OF ITS TERMS. IF YOU DO NOT AGREE WITH THIS AGREEMENT'S TERMS, YOU SHOULD RETURN THE SOFTWARE AND ANY DOCUMENTATION, AND YOU WILL RECEIVE A FULL REFUND FOR ANY MONIES PAID FOR THE SOFTWARE.

1. License. The software (the "Software"), no matter how delivered (e.g. as a download online, in CD form), as well as any and all related documentation ("Documents") are licensed to you by Luxion ApS, a Denmark corporation. This License is non-exclusive, with Luxion retaining the right to license the Software and/or Documents to any other party at Luxion's sole discretion. This license is not a sale and except for the license granted below, Luxion retains all right, title and interest in and to the Software and Documents and any copies thereof. The node-locked License allows you to use the Software and Documents on a single fixed personal computer system or on a single mobile computer system (the "Host System"). The floating License allows you to use the Software and Documents within your organization by checking out no more than the number of purchased licenses from a license host. You are also allowed to make one copy of the Software in machine-readable form and one copy of the Documents in hard-copy form for backup purposes only. You must reproduce on any such copy (in whatever form such copy may be) the Luxion copyright notice and any other proprietary legends that are on the original copy of the Software and Documents. Annual maintenance includes all updates and releases for the prepaid year as well as phone-in support.

2. Restrictions. The Software contains copyrighted material, trade secrets, and other proprietary information, and in order to protect them, you may not reverse engineer, disassemble, or otherwise reduce the Software to a human-perceivable form except to the extent that it is unallowable to prohibit such acts under applicable law. You may not modify, network, rent, lease, loan, sell, distribute, or create derivative works based upon the Software or Documents in whole or in part. You may not electronically transfer the Software from one computer to another over a network. In addition, you may not remove, obscure, or alter any proprietary rights or notices affixed or contained in the Software or Documents. All rights not expressly granted are reserved by Luxion.

3. Termination. This License is effective until terminated. You may terminate this License at any time by destroying the Software or Documents and all copies thereof. If you fail to comply with any provision of this License, this License will terminate immediately without notice from Luxion. Upon termination, you must destroy the Software, Documents and all copies thereof.

4. Export Law Assurances. You agree and certify that the Software will not be exported from the jurisdiction in which you acquired it except as permitted by the applicable laws of such jurisdiction.

5. U.S. Government Restricted Rights. The Software and Documents are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19 and successors thereof, as applicable. Contractor/manufacturer is Luxion ApS.

6. Disclaimer of Warranty on Software. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE SOFTWARE IS AT YOUR SOLE RISK. THE SOFTWARE AND DOCUMENTS ARE PROVIDED "AS IS" AND WITHOUT WARRANTY OR CONDITION OF ANY KIND AND LUXION EXPRESSLY DISCLAIMS ALL WARRANTIES AND CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. LUXION DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT ANY DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, LUXION DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE OR DOCUMENTS IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY LUXION OR AN
AUTHORIZED REPRESENTATIVE THEREOF SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT LUXION OR ANY AUTHORIZED REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. SOME STATES AND JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

7. **Limitation of Liability.** UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL LUXION OR ITS SUPPLIERS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, CONSEQUENTIAL DAMAGES OR RELIANCE THAT RESULT FROM THE USE OF OR INABILITY TO USE THE SOFTWARE OR RELATED DOCUMENTATION, EVEN IF LUXION OR A LUXION AUTHORIZED REPRESENTATIVE HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF ANY LIMITED REMEDY. SOME STATES AND JURISDICTIONS MAY NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

In no event shall Luxion’s total liability to you for all damages, losses, and causes of action (whether in contract, tort (including negligence), or otherwise) exceed the amount paid by you for the Software.

8. **Controlling Law and Severability.** This license shall be governed by and construed in accordance with the laws of Denmark. If for any reason a court of competent jurisdiction finds any provision of this license, or portion thereof, to be unenforceable, that provision of the license shall be enforced to the maximum extent permissible so as to effect the intent of the parties, and the remainder of this license shall continue in full force and effect.

9. **Injunctive Relief.** You acknowledge and agree that your obligations and promises of under this Agreement are of a unique, intellectual character that gives them particular value. You acknowledge and agree that a breach of any of the promises or agreements contained in this Agreement will result in irreparable and continuing damage to Luxion for which there will be no adequate remedy at law and, in the event of a breach, Luxion will be entitled to injunctive relief and/or a decree for specific performance, and any other additional relief as may be proper (including monetary damages if appropriate).

10. **Assignment.** You may not assign any rights or obligations arising under this Agreement without Luxion’s prior written consent. Luxion may assign any rights or obligations under this Agreement without your prior written consent. Subject to this restriction on assignment, this Agreement will inure to the benefit of and bind the successors and assigns of each of Luxion and you.

11. **Waiver.** A waiver of a breach or default under this Agreement will not be a waiver of any other default. Failure by either party to enforce compliance with any term of this Agreement will not be a waiver of that term.

12. **Arbitration.** The Parties agree that any and all disputes arising out of the terms of this Agreement, their interpretation, and any of the matters herein released shall be subject to binding arbitration, to the extent permitted by law, in Denmark. The Parties agree that the prevailing party in any arbitration shall be entitled to injunctive relief in any court of competent jurisdiction to enforce the arbitration award. The Parties further agree that the prevailing party in any arbitration shall be entitled to reimbursement of their reasonable attorneys’ fees and costs incurred in the arbitration. THE UN CONFERENCE ON CONTRACTS FOR THE INTERNATIONAL SALE OF GOODS IS HEREBY EXPRESSLY DISCLAIMED.

13. **Entire Agreement; Amendments.** This Agreement states the final, complete, and exclusive agreement between the parties with respect to the subject matter and supersedes any previous oral or written communications, representations, understandings, or agreements with respect to that subject matter. Any representations, warranties, or statements made by either party that differ from the terms of this Agreement will be given no force or effect. No course of dealing or usage of trade or course of performance will be relevant to explain or supplement any term expressed in this contract. The terms of this Agreement may be modified only in writing signed by you and an authorized representative of Luxion.